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읽기  안내

이 매뉴얼을 읽는 방법

본 매뉴얼의 각 항목은 동일한 구성으로 작성되어 있습니다. 왼쪽에는 조작 경로와 기술적 세부 정보가, 오
른쪽에는 따뜻한 색의 사이드바에 항상 간단한 설명이 표시됩니다. 줄 머리에 있는 작은 아이콘을 보면 곧이
어 어떤 종류의 정보가 나오는지 한눈에 파악할 수 있습니다.

네  가지  아이콘

어디에 있습니까? 앱 내에서의 구체적인 클릭 경로입니다 — 메뉴 바, 인스펙터 섹션 또는 초보자 
모드의 단계를 가리킵니다. 관련된 키보드 단축키도 여기에 함께 표시됩니다. 아이콘은 지도 위의 
핀으로, 해당 기능이 사용자 인터페이스의 어느 위치에 있는지를 보여줍니다.

세부 정보. 기본값, 값 범위, 코드 경로입니다. 메뉴 항목이 아닌 숫자 매개변수인 학습 설정 항목에
서 특히 자주 등장합니다. 아이콘은 작은 사양 카드를 나타냅니다.

기술적 설명. 해당 기능이 내부적으로 무엇을 수행하는지, 어떤 매개변수가 영향을 주는지, 무엇에 
반응하는지, 그리고 어떤 부작용이 있는지를 설명합니다. 보닛 아래에서 무슨 일이 일어나고 있는지
를 이해하고자 하는 독자를 위한 항목입니다. 아이콘은 슬라이더 블록으로, 내부 조정 장치를 상징
적으로 나타냅니다.

간단히 말하면. 전문 용어나 코드 없이 핵심 내용을 명확한 언어로 전달합니다. 기능의 용도와 사용
해야 할 시점을 빠르게 알고 싶다면 먼저 이 섹션을 읽으십시오. 아이콘은 말풍선으로, “요점만 정
리하면”을 의미합니다. 이 영역은 항상 따뜻한 모래색 배경으로 칠해져 있어 눈에 잘 띕니다.

장별  색상

각 장에는 고유한 강조 색상이 있으며, 각 항목 제목 왼쪽에 있는 ID 마크 (예: M1 ) 와 그 앞에 있는 작은 
아이콘으로 식별할 수 있습니다. 페이지를 넘길 때 현재 어느 장에 있는지 한눈에 알 수 있습니다.

1 메뉴 2 인스펙터 3 설정 4 보조 창 6 학습

7 프리셋 8 내보내기 9 SfM 10 초보자 모드

탐색  팁

빠른 시작. 조작 방법만 알고 싶다면 곧바로 제 10 장 — 초보자 모드 로 이동하십시오. 사전 지식이 
전혀 필요 없는 4 단계 가이드 형식입니다.



깊이 있는 학습. 제 2 장 — 인스펙터 와 제 7 장 — 프리셋 에서는 전문가 모드에서 사용할 수 있는 
조작 요소와 사전 설정된 품질 프로파일을 설명합니다.

참조. 목차와 PDF 전문 검색을 사용하면 특정 기능을 찾을 수 있습니다. 매뉴얼을 처음부터 끝까지 
읽을 필요는 없습니다.



R A D I A N C E K I T

장

소개 — 알아두어야 할 사항

RadianceKit이란?

RadianceKit은 일반적인 사진 묶음 또는 동영상으로부터 걸어 다닐 수 있는 3D 재구성을 만들어 주는 네
이티브 macOS 앱입니다. 입력 데이터는 예를 들어 대상 주위, 실내 공간 또는 풍경 위에서 촬영한 50장에
서 500장 정도의 사진들입니다. 출력은 이른바 Gaussian Splatting 장면입니다 — Mac에서 모든 시점
에서 실시간으로 볼 수 있고, 내보내어 웹사이트에 임베드할 수도 있으며, 주요한 측면에서 사실적으로 보이
는 3D 모델입니다.

이 앱은 Mac에서 완전히 로컬로 실행됩니다 — 어떤 이미지도 클라우드에 업로드되지 않고, 로그인이 요구
되지 않으며, 구독도 없습니다. Apple Silicon Mac (M 시리즈) 의 GPU를 집중적으로 활용합니다. 전체 
학습은 장면과 프리셋에 따라 2분에서 수 시간이 걸릴 수 있습니다. 계산이 진행되는 동안에도 Mac에서 평
소처럼 다른 작업을 계속할 수 있으며, RadianceKit은 백그라운드에서 실행되어 결과가 완성되면 알림을 
보냅니다.

조작 모드는 두 가지입니다. 초보자 모드 (Simple Mode) 는 가져오기 → 프리셋 선택 → 학습 → 내보내
기 워크플로를 4단계로 안내합니다. 전문가 모드 (Expert Mode) 에서는 모든 설정 항목을 갖춘 큰 인스
펙터와 실시간 미리보기 창, 그리고 진단 차트가 열립니다. 모드 사이는 언제든 전환할 수 있으며, 장면 데이
터는 그대로 유지됩니다.

Gaussian Splatting이란?

Gaussian Splatting (흔히 줄여서 3DGS 또는 단순히 Splatting) 은 2023년 그라츠와 INRIA의 논문
에서 발표된 비교적 새로운 사실적 3D 표현 기법입니다. 아이디어는 단순합니다. 장면을 고전적인 폴리곤 
메시 (삼각형) 나 복셀 그리드로 모델링하는 대신, 수백만 개의 작고 부드러운 3D 구름으로 구성합니다 — 
각 구름은 3D 가우시안 분포 (이름이 여기서 유래합니다) 이며 자체적인 위치, 크기, 형태, 색상, 투명도를 
가집니다. 이 구름들은 입력 사진의 모든 시점에서 함께 보았을 때 올바른 이미지가 얻어지도록 학습됩니다.

실제로 말하자면 Gaussian Splatting은 반사, 하이라이트, 부드러운 잎, 머리카락, 커튼 같은 것을 고전
적인 3D 모델링으로는 불가능하거나 막대한 비용을 들여야만 가능한 방식으로 표현할 수 있습니다. 그 대
신, 결과는 고전적인 의미에서 편집할 수 있는 3D 모델은 아닙니다 — 벽 하나를 옮기거나 꽃병 하나를 교
체하거나 하는 작업은 할 수 없습니다. 오히려 자유롭게 걸어 다닐 수 있는 공간의 얼어붙은 한 컷 에 가깝습
니다. 건축 시각화, 제품 프레젠테이션, 가상 투어, 법과학, 문화유산 보존과 같은 많은 용도에서는 바로 이
런 점이 적합한 강점이 됩니다.
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입력 이미지로부터 3D 장면을 만들기 위해서는 두 단계가 필요합니다. 먼저 앱은 Structure-from-
Motion (SfM) 이라는 기법을 사용하여 각 사진을 촬영할 때 카메라가 있던 위치를 계산합니다. 그 과정에
서 부산물로 장면의 거친 점 구름이 생성됩니다. 그런 다음 본격적인 Gaussian Splatting 학습이 시작됩
니다. 이 거친 점 구름에서 출발하여 수백만 개의 3D 구름이 단계적으로 분포되고, 확대되고, 정교화되며, 
위치와 색상이 미세 조정되어 모든 입력 시점에서 일치하는 이미지를 만들어내게 됩니다.

RadianceKit을 사용하기 위해 이러한 내부 동작을 반드시 알아야 하는 것은 아닙니다. 초보자 모드는 이 
단계들을 완전히 숨겨 줍니다. 그러나 전문가 모드의 진단 수치 (Iteration, Loss, Gaussians, SSIM …) 
가 무엇을 의미하는지, 또는 왜 어떤 장면은 다른 장면보다 더 아름다워지는지 이해하고 싶다면, 매뉴얼 후
반부의 장들에서 답을 찾을 수 있습니다.
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장

제 1 장 — 메뉴 바

RadianceKit의 메뉴 바는 메인 윈도우나 인스펙터에 직접 노출되지 않은 모든 기능을 분류합니다. 여기
에는 우선적으로 장면 전체에 작용하는 동작 (열기, 저장, 새 프로젝트), 학습 제어 (시작, 일시 정지, 계
속), 뷰포트 조작 (자동 회전, 스크린샷, 배경색), 그리고 다양한 3D 형식 및 미디어 형식으로의 내보내
기가 포함됩니다. 거기에 더해 모든 보조 창 (User Guide, Pareto Dashboard, Holdout Analysis, 
BayesOpt Console) 으로의 점프 포인트도 함께 모여 있습니다.

키보드 단축키는 각각 메뉴 항목 오른쪽에 표시됩니다. 규칙은 다음과 같습니다. ⌘ 는 Command 
키 (애플 키) 를, ⇧ 는 Shift, ⌥ 는 Option (Alt), ⌃ 는 Control을 의미합니다. 예: ⇧⌘T 는 
Shift+Command+T를 나타냅니다. 본 문서에 기록된 모든 단축키는 추가로 Help → Keyboard
Shortcuts (⌘/​) 의 별도 개요 창에서도 일람할 수 있습니다.

다음의 42개 항목은 인벤토리 순서 (M1–M42) 로 정리되어 있으며, 연관된 최상위 메뉴별로 그룹화되어 
있습니다. 모든 항목은 현재 코드 상태 (175–477행) 와 대조하여 검증되었습니다. 인벤토리에 대비해 제
거되거나 노후화된 항목은 없습니다. 새로 추가된 Edit 메뉴 항목 (Cmd-Z 의 “Remove Image”) 은 시
스템의 NSUndoManager 프레임워크에 의해 자동으로 받아들여지므로 RadianceKitApp 코드에는 나
타나지 않습니다 (장 마지막의 참고 사항 참조).

File 메뉴

그림 1:  File 메뉴 펼침 — 항목 M1부터 M6까지
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File 메뉴는 Apple의 기본 “New Window” 항목을 프로젝트 관련 동작으로 대체합니다. 장면을 불러오
기/저장하기, 동적 Recent 목록, Workspace 가져오기, 그리고 빈 상태로의 강제 초기화가 포함되어 있
습니다.

M1 File > Open Scene…

위치

메뉴 바 → File → Open Scene… (⌘O).

기술적  설명

RadianceScene  번들, .ply , .splat , .spz  형식에 
대한 파일 선택 대화창을 엽니다. 단일 선택이며, 파일과 디렉터
리 (번들 형식의 경우) 를 모두 표시할 수 있습니다. 선택이 완
료되면 경로가 Recent 목록에 등록되고 장면이 비동기적으로 
로드됩니다 — 기존 장면은 대체되고 학습 파이프라인은 로드된 
상태로 초기화됩니다. PLY/SPZ/Splat 파일은 각각의 형식 로
더를 통해 읽히고, .radiancescene  번들은 매니페스트, 클
라우드 스냅샷, SfM 결과를 포함하는 디렉터리입니다.

간단히  말하면

이미 학습된 장면을 앱에 

다시 불러오는 방법입니다. 

RadianceKit 고유 형식과, 다른 

Splatting 프로그램이 생성하는 

표준 형식인 PLY, SPLAT, SPZ에서 

동작합니다. 예: 어떤 장면을 밤

새 학습시킨 뒤 다음 날에 작업

을 이어가거나 내보내려는 경우

에 사용합니다. 여는 즉시 메인 

윈도우의 현재 상태가 대체되므

로, 현재 장면이 중요하다면 먼

저 저장하십시오. 경로는 자동으

로 “Open Recent” (M3) 에 등록되

어 다음에는 더 빨리 접근할 수 

있습니다.

M2 File > Save Scene…

위치

메뉴 바 → File → Save Scene… (⌘S).

기술적  설명

Content-Type이 RadianceScene  번들이고 파일 이름이 
scene.radiancescene으로 미리 채워진 파일 저장 대화창
을 엽니다. manifest.json , 직렬화된 Gaussian Cloud 
(PLY 스냅샷), 그리고 SfM 결과 덤프를 포함하는 디렉터리 패
키지를 작성하며, 다시 열었을 때 Continue Training도 동작
하도록 합니다. Gaussian이 아직 존재하지 않는 동안에는 항
목이 비활성화됩니다. 학습 로그 경로가 아니라 저장 대화창이 
가리키는 위치 — 일반적으로 ~/​Documents/​ 아래 — 에 저장
됩니다.

간단히  말하면

현재 장면을 파일 (정확히는 파

일처럼 보이는 패키지 폴더) 로 

저장합니다. 그런 다음에야 이 

장면을 “Open Scene…” (M1) 으

로 다시 열 수 있습니다. 패키지

에는 Gaussian Cloud와 SfM 결과

가 함께 들어 있으므로 나중에 

Continue Training (M12–M14) 도 

이어 붙일 수 있습니다. 학습을 

아직 완료하지 않은 동안에는 항

목이 회색으로 처리됩니다. 기본 

이름은 scene.radiancescene

이며, 저장 대화창에서 원하는 

이름을 지정할 수도 있습니다.
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M3 File > Open Recent > [장면 이름]

위치

메뉴 바 → File → Open Recent → (목록).

기술적  설명

최근에 열린 경로 (환경 설정에 저장됨) 의 목록에서 생성되는 
동적 서브 메뉴입니다. 각 목록 항목은 파일 이름으로 표시되
며 클릭 시 로드됩니다. 목록이 비어 있는 경우에는 비활성화된 
“No Recent Scenes” 레이블이 대신 표시됩니다. Apple 스
타일에 맞게 목록은 최근에 열린 N개 장면을 유지합니다 — 제
한은 환경 설정 기록 시 적용되며 메뉴 빌더 자체에는 적용되지 
않습니다.

간단히  말하면

여기에는 최근에 열었던 장면들

이 표시되며, 파일 대화창을 거

치지 않고 한 번의 클릭으로 다

시 들어갈 수 있습니다. 이제 막 

시작한 경우라면 목록이 비어 있

고 메뉴에 회색으로 표시됩니다. 

“Open Scene…” (M1) 을 통해 열

었던 모든 장면이 자동으로 이 

목록에 등록됩니다. 목록이 너

무 가득 차거나 개인 정보 보호

를 이유로 비우고 싶다면 “Clear 

Recent” (M4) 를 사용하십시오.

M4 File > Open Recent > Clear Recent

위치

메뉴 바 → File → Open Recent → Clear Recent.

기술적  설명

환경 설정에 있는 Recent 목록을 비웁니다. 확인 대화창 없
이 즉시 적용됩니다. 이 항목은 Recent 목록에 항목이 하나라
도 있을 때에만 서브 메뉴에 표시됩니다 (경로 아래 구분선 뒤에 
위치).

간단히  말하면

최근에 열었던 장면 목록을 지웁

니다. 테스트 데이터셋으로 이것

저것 시도해 본 뒤 더 이상 경로

를 보고 싶지 않을 때 편리합니

다. 장면 파일 자체는 삭제되지 

않으며, 메뉴의 연결만 사라집니

다. 동작은 확인 절차 없이 즉

시 적용되며, 그 후 서브 메뉴에

는 “No Recent Scenes”가 표시됩

니다. 이 항목은 목록에 장면이 

하나라도 있을 때에만 나타나며, 

목록이 비어 있으면 표시되지 않

습니다.
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M5 File > Import COLMAP / Metashape Workspace…

위치

메뉴 바 → File → Import COLMAP / Metashape 
Workspace… (⇧⌘I).

기술적  설명

폴더 선택기를 엽니다. COLMAP Workspace 레이아웃 (예: 
sparse/​0/​cameras.{bin,txt} 및 images/​) 을 가진 폴더
를 예상합니다. 선택 후 Workspace에 대한 사전 검사가 실행
됩니다 — 이 검사는 세 가지 레이아웃 (sparse/​0/​, sparse/​, 
루트) 과, 재구성이 바이너리 ( cameras.bin ) 인지 ETH3D 
텍스트 ( cameras.txt ) 인지를 판별합니다. 성공 시에는 
Workspace를 가져오고, 실패 시에는 앱 로그에 경고만 표시
됩니다. 자세한 파이프라인 로직은 제 9 장 “SfM 백엔드”의 
Q6를 참고하십시오.

간단히  말하면

Metashape, COLMAP, 

RealityCapture 또는 유사한 소프

트웨어로 카메라 재구성을 수행

하여 내보낸 결과가 있다면, 그 

폴더를 여기에 넣으면 됩니다. 

그러면 RadianceKit은 SfM 단계

를 건너뛰고 바로 학습으로 진입

합니다 — 큰 장면에서는 몇 시

간을 절약합니다. 메인 윈도우로 

드래그 앤 드롭하는 방식도 동

일하게 동작합니다. 예상되는 것

은 COLMAP 레이아웃 (sparse/​0/​

에 cameras.* 가 있고 images/​ 

폴더가 존재) 의 폴더입니다. 지

원되는 레이아웃과 워크플로에 

대한 자세한 내용은 제 9 장 “SfM 

백엔드”에 있습니다.

M6 File > New Project

위치

메뉴 바 → File → New Project (⇧⌘N).

기술적  설명

저장되지 않은 작업이 있는지 확인합니다. 있는 경우, 어떤 것
이 손실되기 전에 확인 대화창이 표시됩니다. 저장할 것이 없
다면 초기화가 즉시 실행됩니다 — 가져온 이미지, SfM 결과, 
Gaussian Cloud, 학습 상태, 의존하는 모든 UI 표시 항목이 
비워집니다. 주의: 사용자가 만든 프리셋 라이브러리는 앱 환경 
설정에 저장되며 프로젝트 상태에는 속하지 않으므로 그대로 유
지됩니다.

간단히  말하면

모든 것을 빈 시작 상태로 되돌

립니다 — 앱을 방금 새로 연 것

과 같은 상태입니다. 저장되지 

않은 작업이 있는 경우 앱이 먼

저 확인을 묻습니다. 완전히 다

른 장면으로 시작하려고 할 때 

사용합니다. 가져온 이미지, SfM 

결과, Gaussian Cloud, 학습 상태

가 모두 비워집니다. 직접 만든 

프리셋은 앱 환경 설정에 있고 

장면에 속하지 않으므로 그대로 

유지됩니다.
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Mode 메뉴

그림 2:  Simple과 Expert 모드 스위치가 있는 Mode 메뉴

가이드형 Simple Mode (마법사 형식, 4단계) 와 모든 조절기가 있는 고전적 인스펙터 레이아웃의 전체 
Expert Mode 사이를 전환하는 두 개의 간단한 스위치입니다.

M7 Mode > Simple Mode

위치

메뉴 바 → Mode → Simple Mode (⌘1).

기술적  설명

앱 상태를 Simple Mode로 전환합니다. 그러면 앱의 메인 영
역에 Expert 레이아웃 대신 가이드형 워크플로가 표시됩니다. 
모드 상태는 환경 설정에 저장됩니다 (제 3 장 Settings의 S1 
“Default Mode” 참고).

간단히  말하면

가져오기, 처리, 미리보기, 내보

내기를 앱이 단계별로 안내하는 

변형으로 전환합니다. 이제 막 

시작했거나 빠르게 결과가 필요

한 경우 권장됩니다. 대부분의 

세부 조절기는 숨겨져 있습니다 

— 합리적인 기본값으로 작업하

게 됩니다. 나중에 더 깊이 들어

가고 싶다면 간단히 Expert Mode 

(M8) 로 전환하면 됩니다. 앱 시

작 시 어느 모드가 활성화될지는 

환경 설정 (제 3 장, S1) 에서 정할 

수 있습니다.
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M8 Mode > Expert Mode

위치

메뉴 바 → Mode → Expert Mode (⌘2).

기술적  설명

앱 상태를 Expert Mode로 전환합니다. 그 결과 모든 섹
션 (Presets, TrainingConfig, Enhancements, Metrics, 
LossChart, ProjectNavigator) 을 포함하는 전체 인스펙터 
레이아웃이 나타납니다. Expert Mode에서는 모든 학습 매개
변수, COLMAP 선택기, Mid-Compact 토글, 진단 항목에 
접근할 수 있습니다. 실시간 미리보기도 이 모드에서만 작동합
니다.

간단히  말하면

모든 조절기가 있는 전체 보기

로 전환합니다. 여기서는 실시간 

Loss 차트를 보고, 모든 매개변수

를 미세 조정하며, 여러 비교 구

성을 프리셋을 통해 동시에 관

리할 수 있습니다. 학습이 내부

적으로 무엇을 하는지 이해하고 

싶거나 의도적으로 실험하려는 

경우 권장됩니다. 실시간 미리보

기, COLMAP 선택기, 진단 항목 

또한 이 모드에서만 접근할 수 

있습니다. 너무 많다고 느껴지면 

M7을 통해 Simple Mode로 돌아

가십시오 — 장면은 그대로 유지

됩니다.

Training 메뉴

그림 3:  Continue 서브 메뉴가 있는 Training 메뉴 — 항목 M9부터 M14까지

학습 실행과 관련된 네 가지 동작: 시작, 일시 정지, 취소, 그리고 정해진 반복 수만큼 연장. 세 개의 
Continue 항목은 모두 IAP에 의해 게이트가 걸려 있습니다 (무료 체험판 버전에서는 클릭할 수 없음).
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M9 Training > Start Training

위치

메뉴 바 → Training → Start Training (⇧⌘T).

기술적  설명

학습 파이프라인을 비동기적으로 시작합니다. 전제 조건: 
SfM 결과가 존재하고, 다른 파이프라인이 현재 실행 중
이지 않아야 합니다. 두 조건 중 하나라도 만족하지 않으
면 항목이 차단됩니다. 시작 시 현재 구성 값을 읽고, ~/​
Documents/​RadianceKit/​Logs/​training_​YYYY-MM-DD_​

HHmmss.jsonl 경로에 새 JSONL 로그를 생성하며, 전략 선
택에 따라 classic 경로 또는 MCMC 경로로 진행합니다. 학습 
상태는 “idle”에서 “training”으로 전환됩니다.

간단히  말하면

큰 녹색 버튼을 누릅니다 — 사

진을 가져오고 카메라 재구성

이 끝난 즉시 본격적인 Gaussian 

Splatting 학습이 시작됩니다. 앱

을 실행 상태로 두십시오. 프리

셋에 따라 1분 (Quick) 에서 몇 

시간 (MCMC Quality) 까지 걸

립니다. SfM 결과가 아직 없거

나 다른 파이프라인이 실행 중

인 동안에는 항목이 회색으로 유

지됩니다. 각 실행은 부수적으

로 ~/​Documents/​RadianceKit/​

Logs/​에 로그를 기록하며, 이는 

나중에 Pareto Dashboard (M40) 

에서 분석할 수 있습니다.

M10 Training > Pause Training

위치

메뉴 바 → Training → Pause Training.

기술적  설명

실행 중인 학습을 일시 정지합니다. 학습 상태가 “training”일 
때에만 활성화됩니다. 일시 정지는 다음 안전 동기화 시점에서 
반복 루프를 중단하고, 전체 GPU 상태 (Gaussian 버퍼, 옵티
마이저 모멘트, 스케줄러 위치) 를 유지한 채 “paused”로 전
환합니다. 재개는 동일 항목을 다시 누르면 됩니다 (항목 제목
은 정적이며 — 앱은 내부적으로 실제로 Pause/Resume 사이
를 전환합니다). 일시 정지된 학습은 앱 종료를 견디지 못합니
다. 그 경우에는 장면을 저장한 뒤 나중에 Continue Training 
항목 (M12–M14) 으로 연장하십시오.

간단히  말하면

진행 상황을 잃지 않고 학습을 

잠시 중단합니다. 컴퓨터가 잠

시 다른 중요한 일에 필요한 경

우에 편리합니다. 다시 클릭하면 

이어집니다. 앱 재시작을 넘어서

는 지속되지 않습니다 — 정말로 

나중에 이어 가고 싶다면 Cancel 

(M11) 로 학습을 종료하고, Save 

Scene (M2) 으로 장면을 저장한 

후 Continue Training (M12–M14) 

을 사용하십시오. 일시 정지 동

안 GPU는 완전히 휴식 상태이지

만 메모리는 점유된 상태로 남습

니다.
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M11 Training > Cancel Training

위치

메뉴 바 → Training → Cancel Training.

기술적  설명

실행 중인 학습을 중단합니다. 학습 상태가 “idle”이 아닐 때 활
성화됩니다. 학습 엔진에 Cancel 플래그를 설정하여 다음 동기
화 시점에 반복 루프를 안전하게 종료시키고, 최종 요약 항목을 
JSONL 로그에 기록하며, 상태를 “idle”로 되돌립니다. 지금까
지 학습된 클라우드는 보존되고 (저장하거나 내보낼 수 있음), 
“cancelled”로 표시됩니다.

간단히  말하면

실행 중인 학습을 최종적으로 중

단합니다. 지금까지의 상태는 남

아 있습니다 — 즉 수천 회 반

복 후 이미 어느 정도 보여줄 만

한 결과가 있다면 그 후에도 내

보낼 수 있습니다. 잠시 멈추고 

싶을 뿐이라면 Pause (M10) 를 사

용하십시오. 학습 로그에서는 실

행이 “cancelled”로 표시되며, 최

종 Loss 값도 함께 기록됩니다. 

중단된 장면은 앱이 중간에 종료

되지 않았다면 Continue Training 

(M12–M14) 을 통해 나중에 이어 

갈 수도 있습니다.

M12 Training > Continue Training > +5 000 iterations

위치

메뉴 바 → Training → Continue Training → +5,000 
iterations.

기술적  설명

학습을 5 000회 더 반복 진행합니다. 완료된 학습이 이어 갈 
수 있는 상태이고 정식 버전이 잠금 해제된 경우에 활성화됩
니다. 이어가기 가능 조건은 완료된 학습이 존재하고 전체 옵
티마이저 상태가 아직 메모리에 있어야 합니다. Continue 시 
Adam 모멘트와 LR 스케줄러는 그대로 이어지므로, 이어진 학
습은 25K/45K/60K 의 연속 실행처럼 동작하며 새 시작이 아
닙니다. JSONL 로그는 증분 설정에 대한 새 Config 항목을 
받습니다. 정식 버전에서만 사용할 수 있습니다.

간단히  말하면

학습 단계를 5 000회 더 추가합

니다. 첫 실행 후 결과가 가까이

는 왔지만 아직 충분히 선명하지 

않을 때 사용합니다. 유료 정식 

버전에서만 동작합니다. 완전히 

새 실행과 달리 옵티마이저 상

태가 유지되므로, 이어진 학습은 

단일 연속 실행처럼 느껴집니다. 

5 000회 이상이 필요하다면 M13 

(+10 000) 이나 M14 (+20 000) 를 

곧장 선택하십시오.
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M13 Training > Continue Training > +10 000 iterations

위치

메뉴 바 → Training → Continue Training → +10,000 
iterations.

기술적  설명

M12와 동일하나 추가 반복이 10 000회입니다. 동일한 전제 
조건, 동일한 LR 스케줄러 경로입니다. 초기 학습을 중간 등급 
프리셋으로 실행했고, 실행을 완전히 다시 시작하지 않고도 의
미 있는 품질 향상을 보고 싶을 때 권장됩니다.

간단히  말하면

학습을 10 000 단계만큼 연장

합니다 — 사용 가능한 세 가지 

Continue 값 중 중간입니다. 첫 

실행은 그런대로 괜찮았지만 분

명히 더 나아지고 싶을 때 좋은 

선택입니다. M12나 M14처럼 학

습률 진행이 새 시작 없이 매끄

럽게 이어집니다. 정식 버전에서

만 사용할 수 있습니다.

M14 Training > Continue Training > +20 000 iterations

위치

메뉴 바 → Training → Continue Training → +20,000 
iterations.

기술적  설명

M12 / M13과 동일하나 추가 반복이 20 000회입니다. 사전 
정의된 Continue 점프 중 가장 큽니다. MCMC 학습에서는 종
종 이것이 “그럭저럭 괜찮음”과 “벤치마크 등급” 사이를 가르는 
차이를 만들어냅니다. 35–40K 이상의 Classic에서는 경험상 
추가로 얻는 것이 많지 않습니다.

간단히  말하면

학습 단계를 20 000회 더 추가합

니다. Continue 값의 최대값입니

다. 마지막 한 방울의 품질까지 

끌어내고 싶을 때 사용합니다. 4

만 단계 후의 고전적 학습에서

는 더 큰 차이를 만들기 어려운 

경우가 많습니다 — 반면 MCMC

에서는 수렴이 느리게 시작되므

로 종종 가치가 있습니다. 장면

에 따라 상당히 긴 추가 실행 시

간을 예상하십시오. M12, M13과 

마찬가지로 이 항목도 정식 버전

에서만 사용할 수 있습니다.
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Viewport 메뉴

그림 4:  Edit Mode, 카메라 제어, 배경 서브 메뉴가 있는 Viewport 메뉴

3D 뷰포트를 제어합니다. Gaussian 선택과 정리를 위한 Edit Mode, 카메라 제어 (자동 회전, 재생, 녹
화), 스크린샷, 배경색, 그리고 리셋이 포함됩니다.

M15 Viewport > Enter/Exit Edit Mode

위치

메뉴 바 → Viewport → Enter Edit Mode (또는 상태에 따
라 “Exit Edit Mode”). ⇧⌘E.

기술적  설명

항목 제목은 동적이며 상태에 따라 “Exit Edit Mode” 또는 
“Enter Edit Mode”를 표시합니다. 누르면 뷰포트 렌더러의 
Edit Mode가 토글됩니다. Edit Mode를 빠져나갈 때에는 현
재 선택이 추가로 초기화됩니다. Edit Mode는 Gaussian 클
릭 선택, 박스 선택, 그리고 표시된 Gaussian의 삭제를 활성화
합니다 (UI의 Editor 영역 참조). 뷰포트 렌더러가 연결되어 있
지 않은 동안에는 비활성화됩니다.

간단히  말하면

일반 3D 보기와 개별 Gaussian 

(예: 배경의 플로터나 아웃라이

어) 을 표시하고 삭제할 수 있는 

편집 모드 사이를 전환합니다. 

모드를 빠져나갈 때 선택은 자동

으로 초기화됩니다. 뷰포트에 장

면이 아직 표시되지 않은 동안

에는 항목이 회색입니다. 라벨은 

상태에 따라 “Enter Edit Mode”와 

“Exit Edit Mode” 사이를 오갑니

다 — 따라서 현재 어느 모드에 

있는지 항상 확인할 수 있습니

다.
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M16 Viewport > Toggle Auto-Rotation

위치

메뉴 바 → Viewport → Toggle Auto-Rotation (⌘⌥T).

기술적  설명

장면 중심을 통과하는 수직 축을 중심으로 한 뷰포트 카메라의 
연속 회전을 켜거나 끕니다. 축과 속도는 카메라 제어 구성에서 
나옵니다. 자동 회전은 순수한 뷰포트 효과이며 학습이나 녹화
에 영향을 주지 않습니다 — Turntable 비디오 레코더 (M18) 
를 병행 사용하는 경우 자동 회전은 레코더가 캡처할 정확한 경
로를 제공합니다.

간단히  말하면

마우스를 끌지 않고도 모든 방향

에서 장면을 볼 수 있도록 카메

라를 천천히 계속 회전시킵니다. 

다시 클릭하면 회전이 중지됩니

다. 학습이 완료된 장면을 검토

하거나 라이브 데모의 배경 애

니메이션으로 활용하기에 편리

합니다. 비디오를 함께 녹화하는 

경우 (M18) 자동 회전은 레코더

가 캡처할 정확한 움직임을 제공

합니다.

M17 Viewport > Toggle Camera Playback

위치

메뉴 바 → Viewport → Toggle Camera Playback.

기술적  설명

카메라 경로 재생을 토글합니다. 기록된 카메라 경로가 존재하
는 경우 (예: 이전 녹화에서 또는 transforms.json 을 불러
와 생성된 경로), 그 경로가 재생됩니다 — 즉 뷰포트 카메라는 
더 이상 마우스/트랙패드 입력에 따라 움직이지 않고 프레임 단
위로 궤적을 재현합니다. 다시 누르면 재생이 일시 정지됩니다.

간단히  말하면

미리 기록되었거나 가져온 카메

라 이동을 재생합니다. 이를 통

해 장면이 촬영된 원래 경로를 

따라가 보거나, 비디오 내보내기 

전에 계획된 궤도 움직임을 점검

할 수 있습니다. 재생이 진행되

는 동안에는 마우스와 트랙패드 

입력이 비활성화됩니다 — 카메

라는 경로를 엄격히 따라갑니다. 

다시 클릭하면 재생이 일시 정지

됩니다. 카메라 경로를 로드하거

나 기록한 적이 없다면 아무 일

도 일어나지 않습니다.
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M18 Viewport > Record Turntable Video

위치

메뉴 바 → Viewport → Record Turntable Video.

기술적  설명

뷰포트 녹화를 토글합니다. 처음 누르면 프레임 녹화가 임시 경
로로 시작됩니다. 두 번째로 누르면 녹화가 종료되고 인코딩되
어 MP4 경로로 저장됩니다 (경로는 저장 대화창으로 물어봅니
다). 설정 가능한 시간의 고정 360° 경로를 생성하는 Export 
→ Media → Orbit Video (M31) 와 달리, Turntable 레코
더는 뷰포트에서 보이는 것을 실시간으로 기록합니다 — 즉 수
동 카메라 이동도 녹화할 수 있습니다.

간단히  말하면

뷰포트에서 직접 비디오를 녹화

합니다. 카메라가 자동으로 회전

하든 마우스로 직접 움직이든 — 

보이는 모든 것이 MP4 파일로 저

장됩니다. “Orbit Video” 내보내

기 (M31) 와 달리 카메라 움직임

을 직접 지정합니다. 처음 클릭

으로 녹화 시작, 두 번째 클릭으

로 녹화 종료 및 저장 위치 입력. 

고정된 궤도 움직임으로는 불가

능한 특정 디테일 회전을 보여 

주려는 경우에 편리합니다.

M19 Viewport > Save Screenshot

위치

메뉴 바 → Viewport → Save Screenshot (⇧⌘S).

기술적  설명

전체 렌더 해상도 (즉 윈도우 픽셀 레이아웃이 아닌 전체 렌
더 타깃 내용) 의 뷰포트 프레임 하나를 PNG 파일로 캡처합
니다. 경로는 저장 대화창으로 묻습니다. 배경색 (M21–M23) 
은 함께 구워집니다. Enhancements (I27/I28 참조) 의 
MetalFX/MPS 업스케일링 설정은 활성화된 경우 영향을 미칩
니다 — 따라서 스크린샷은 업스케일된 출력을 보여 줍니다.

간단히  말하면

현재 3D 보기를 PNG 이미지로 

한 컷 저장합니다. 마케팅 자료

나 빠른 비교에 편리합니다. 주

의: 배경은 이미지의 일부입니다 

— 투명도가 필요하다면 차라리 

장면 파일을 내보내십시오. 해상

도는 윈도우 크기가 아니라 내부 

렌더 타깃을 따릅니다 — 따라서 

이미지는 종종 윈도우에 보이는 

것보다 더 선명합니다. 인스펙터 

→ Enhancements 의 업스케일링 

설정 또한 함께 반영됩니다.
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M20 Viewport > Copy Camera Info

위치

메뉴 바 → Viewport → Copy Camera Info.

기술적  설명

현재 뷰포트 카메라 포즈 (위치, Look-At 지점, Up 벡터) 와 
FOV 값을 카메라 제어에서 읽어 여러 줄 텍스트로 클립보드에 
기록합니다. 형식은 사람이 읽을 수 있도록 라벨 = 값 형태로 한 
줄씩 표시되며, JSON은 아닙니다. 특정 보기를 디버깅용으로 
재현하거나 지원팀과 공유할 때 편리합니다.

간단히  말하면

현재 카메라 위치와 시선 방향을 

텍스트로 클립보드에 복사합니

다. 예: 장면의 어떤 지점이 이상

하게 보이는지 다른 개발자에게 

보여 주려는 경우 텍스트를 메일

이나 채팅 창에 붙여 넣으면 됩

니다. 형식은 사람이 읽을 수 있

는 (값마다 한 줄) 모양이며 JSON

은 아닙니다. 주로 버그 리포트

나 지원 문의용으로 의도되었습

니다.

M21 Viewport > Background > Dark Gray

위치

메뉴 바 → Viewport → Background → Dark Gray.

기술적  설명

뷰포트 배경색을 짙은 회색 (RGB 0.1/0.1/0.1) 으로 설정합니
다. 렌더러는 이 색을 Gaussian이 합성되는 배경으로 사용합
니다. 앱 시작 시의 기본 색상은 Settings 옵션 S3 “Default 
Viewport Background”가 제어합니다.

간단히  말하면

3D 뷰포트의 배경을 짙은 회색

으로 칠합니다. 대부분의 장면에 

적합한 기본 선택입니다 — 순수

한 검정이나 흰색에 시각이 머무

르지 않으면서 밝은 Gaussian과 

어두운 Gaussian 모두에 좋은 대

비를 제공합니다. 색상은 스크린

샷 (M19) 과 Orbit 비디오 (M31) 에

도 적용됩니다. Dark Gray가 너무 

평범하다면 비교를 위해 Black 

(M22) 또는 White (M23) 도 시도

해 보십시오. 앱 시작 시 어느 색

이 활성화될지는 설정 (S3) 에서 

지정할 수 있습니다.
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M22 Viewport > Background > Black

위치

메뉴 바 → Viewport → Background → Black.

기술적  설명

뷰포트 배경색을 순수한 검정 (RGB 0/0/0) 으로 설정합니다. 
장면에 밝은 플로터가 많고 식별하려는 경우, 또는 어둡고 분위
기 있는 마케팅 자료에 적합합니다.

간단히  말하면

검은색 배경입니다. 매우 밝은 

장면이나, Edit Mode에서 회색

에 묻혀 보이지 않는 작고 밝

은 Gaussian (플로터) 을 찾고 

싶을 때 좋습니다. 어둡고 극적

인 분위기의 마케팅 자료에도 이

상적입니다. 색상은 스크린샷과 

Orbit 비디오에 구워지므로 — 이

후 합성에서 투명도가 필요하다

면 검정은 최악의 선택입니다. 

어두운 플로터의 경우 반대로 

White (M23) 로 전환하십시오.

M23 Viewport > Background > White

위치

메뉴 바 → Viewport → Background → White.

기술적  설명

뷰포트 배경색을 순수한 흰색 (RGB 1/1/1) 으로 설정합니다. 장
면이 주로 어두운 내용으로 구성되어 있고 어두운 플로터 (전형
적인 야외 배경 노이즈) 를 보고 싶을 때 유용합니다.

간단히  말하면

흰색 배경입니다. 모티프가 밝

은 위에 어두운 방식으로 더 잘 

드러나는 경우, 또는 Edit Mode 

(M15) 에서 이후 제거할 어두운 

아웃라이어를 찾아내는 데 편리

합니다. 야외 장면에서는 일반적

인 야외 플로터가 어두운 편이므

로 흰색이 검은색보다 더 유용한 

경우가 많습니다. 다른 배경 옵

션과 마찬가지로 색상은 스크린

샷과 비디오에 반영됩니다.
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M24 Viewport > Reset Camera

위치

메뉴 바 → Viewport → Reset Camera.

기술적  설명

뷰포트 카메라를 초기화하고, Training Camera 보기를 벗어
나며, 자동 회전을 멈춥니다. 그 결과 카메라가 초기 위치 (일반
적으로 장면 앞쪽, 약간 위에서 내려다보는 방향) 로 되돌아가
고, 자동 회전은 꺼지며, 렌더러가 막 Training Camera (SfM 
포즈 중 하나) 를 보여 주고 있었다면 Free Camera로 되돌아
갑니다.

간단히  말하면

뷰포트 카메라를 시작 위치로 되

돌립니다. 이리저리 돌리다가 길

을 잃었거나 장면을 화면 밖으로 

밀어냈다면 — 여기를 한 번 클릭

하면 다시 보아야 할 것을 볼 수 

있게 됩니다. 동시에 자동 회전

이 실행 중이라면 끄고, 고정된 

Training Camera에 있는 경우 자

유 보기로 되돌립니다. 어떤 경

우든 보기의 깔끔한 재시작을 보

장합니다.

Export 메뉴

그림 5:  세 개의 서브 메뉴 그룹 (3D Formats, Media, Photogrammetry) 이 있는 Export 메뉴

여덟 가지 내보내기 대상과 두 가지 Photogrammetry 내보내기가 세 섹션 (3D Formats, Media, 
Photogrammetry) 으로 그룹화되어 있습니다. 처음 여섯 가지는 공통 헬퍼 루틴을 통해 구성되며, 각각 
저장 대화창을 열고 형식 카탈로그에 내보내기를 등록합니다. Photogrammetry 항목은 개별 로직을 가
집니다. 모든 Photogrammetry 항목과 일부 3D 내보내기는 정식 버전에서만 사용할 수 있습니다.
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M25 Export > 3D Formats > Export PLY…

위치

메뉴 바 → Export → 3D Formats → PLY (⌘E).

기술적  설명

기본 파일 이름이 gaussians.ply 인 저장 대화창을 엽니
다. 확인 시 현재 Gaussian Cloud가 표준 ASCII/Binary 
PLY 형식으로 기록됩니다 — SuperSplat, PolyCam, 
PlayCanvas 및 모든 일반적인 3DGS 뷰어와 호환됩니다. 완
전한 SH 계수, 완전한 정밀도 (필드당 Float32). 파일 크기는 
≥ 500K Gaussian의 경우 종종 수백 MB에 이릅니다.

간단히  말하면

3D 장면을 표준 PLY 파일로 저

장합니다. 가장 보편적인 형식

입니다 — SuperSplat, PolyCam, 

PlayCanvas 등 거의 모든 소프트

웨어가 이것을 불러올 수 있습니

다. 다만 파일은 커지며 종종 수

백 메가바이트에 이릅니다. 전체 

품질로 작업을 이어가거나 보관

하고 싶을 때 PLY를 사용하십시

오. 웹을 통해 공유하려는 경우

라면 SPZ (M27) 나 Compressed 

PLY (M26) 를 살펴보십시오 — 훨

씬 작습니다.

M26 Export > 3D Formats > Export Compressed PLY…

위치

메뉴 바 → Export → 3D Formats → Compressed PLY.

기술적  설명

위치, 스케일, 회전, SH 필드의 사용자 정의 양자화로 압축
된 PLY 형식으로 Gaussian Cloud를 기록합니다. 시각적 손
실이 최소인 상태에서 비압축 PLY (M25) 보다 5–10배 작
은 파일입니다. Compressed PLY 표준을 읽는 SuperSplat 
및 PlayCanvas와 호환됩니다. 기본 파일 이름은 gaussians_​
compressed.ply입니다.

간단히  말하면

일반 PLY와 비슷하지만 5–10배 

작습니다. 품질은 거의 그대로 

유지됩니다. 파일을 온라인으로 

공유하거나 이메일로 보내려는 

경우에 사용합니다. SuperSplat 

및 PlayCanvas에서 바로 동작합

니다. 대상 시스템이 더 작은 

파일을 요구하는 경우 (모바일, 

브라우저 데모) 에는 대신 SPZ 

(M27) 를 사용하십시오 — 더 공

격적으로 압축됩니다. 전체 편

집 품질을 원한다면 비압축 PLY 

(M25) 를 사용하십시오.

20 / 216



R A D I A N C E K I T 제 1 장 — 메뉴 바

M27 Export > 3D Formats > Export SPZ…

위치

메뉴 바 → Export → 3D Formats → SPZ.

기술적  설명

Gaussian Cloud를 SPZ 형식으로 기록합니다 — Niantic
이 공개한 압축 Splat 형식으로 공격적인 양자화 (비압축 PLY 
대비 약 90% 더 작음) 를 사용합니다. 특히 웹 뷰어와 모바
일 앱에 최적화되어 있습니다. Niantic Splatt3R, gsplat.js, 
Niantic 브라우저 뷰어와 호환됩니다.

간단히  말하면

가장 작은 형식 중 하나입니다. 

일반 PLY보다 약 10배 작습니다. 

특히 브라우저에서 장면을 보여 

주거나 모바일 앱으로 열람하려

는 경우 사용하십시오. 최대 품

질이 목적이라면 PLY가 더 나

은 선택입니다. SPZ는 Niantic이 

개발했으며 gsplat.js, Splatt3R, 

Niantic 웹 뷰어에서 직접 동작합

니다. 강한 압축 때문에 SPZ 파일

은 더 이상 쉽게 추가 학습이 불

가능합니다 — 편집에는 PLY를 

사용하십시오.

M28 Export > 3D Formats > Export glTF…

위치

메뉴 바 → Export → 3D Formats → glTF.

기술적  설명

KHR_gaussian_splatting 확장이 포함된 .glb  파
일 (Binary glTF) 을 기록합니다. 표준을 준수하며 
KHR_gaussian_splatting 확장을 구현한 Babylon.js나 
Three.js 같은 glTF 엔진을 사용하는 파이프라인에 적합합니
다.

간단히  말하면

장면을 glTF 형식으로 저장합니

다. 많은 3D 프로그램과 웹 엔진

이 이해하는 형식입니다 — 단, 

Gaussian Splatting 확장을 지원

해야 합니다. 그것을 이해하는 

특정 3D 파이프라인 (예: Three.js 

또는 Babylon.js) 이 있다면 이

것이 적합한 형식입니다. 파일은 

바이너리 .glb 로 나옵니다 — 

모든 것을 담은 단일 패키지입

니다. 고전적인 Splatting 워크플

로에서는 더 많은 도구가 직접 

이해하기 때문에 보통 PLY 또는 

SPZ가 더 나은 선택입니다.

21 / 216



R A D I A N C E K I T 제 1 장 — 메뉴 바

M29 Export > 3D Formats > Export .splat…

위치

메뉴 바 → Export → 3D Formats → .splat.

기술적  설명

Antimatter15의 .splat  형식을 기록합니다 — Gaussian
당 고정 32바이트 (위치 = 3× Float32, 스케일 = 
3× Float32, 회전 = 4× Uint8 정규화 쿼터니언, 
RGB+Opacity = 4× Uint8). DC보다 높은 SH 계수
는 없습니다. 브라우저 직접 호환성을 갖춘 최소 파일입니다. 
gsplat.js 및 antimatter15의 온라인 데모 뷰어용입니다.

간단히  말하면

가장 단순한 웹 뷰어 형식입

니다. 작고 어떤 브라우저에서

든 즉시 표시 가능합니다. 그러

나 세부 조명 정보를 잃습니다 

(높은 SH 계수가 사라집니다 — 

Splat이 빛에 반응하는 대신 어

느 시점에서나 동일하게 보입니

다). 최대 웹 성능에는 좋지만 사

진 사실감을 원한다면 SPZ나 PLY

를 사용하십시오. antimatter15 

온라인 뷰어와 gsplat.js에서 작

동합니다. 각 Gaussian은 고정 

32바이트를 차지하므로 형식이 

단순하고 호환성이 좋습니다 — 

단, 디테일 깊이를 그 대가로 잃

습니다.

M30 Export > 3D Formats > Export SOG…

위치

메뉴 바 → Export → 3D Formats → SOG.

기술적  설명

Gaussian Cloud를 SOG 형식으로 기록합니다. SOG 
(“Self-Organizing Gaussian”) 는 텍스처 아틀라스 레이아
웃과 양자화된 데이터의 WebP 압축을 사용하는 PlayCanvas 
형식입니다. PLY 대비 15–20배 더 좋은 크기 비율로 확장됩니
다. 내보내기 시 내부적으로 외부 도구 cwebp 를 호출합니다 
— 따라서 Sandbox 버전 (App Store) 에서는 잠재적으로 제
한될 수 있습니다.

간단히  말하면

PlayCanvas 워크플로용 매우 작

은 형식입니다. 데이터가 텍스

처 아틀라스 레이아웃으로 패

킹되고 WebP로 압축되므로 PLY

보다 약 15–20배 작습니다. 

PlayCanvas 워크플로가 없다면 

SPZ나 Compressed PLY가 보

통 더 나은 선택입니다. 내보

내기 시 내부적으로 외부 도구 

cwebp 를 호출합니다 — App 

Store 버전 (Sandbox) 에서는 이 

단계가 제한될 수 있습니다.
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M31 Export > Media > Export Orbit Video…

위치

메뉴 바 → Export → Media → Orbit Video.

기술적  설명

장면 중심을 도는 360° 궤도를 렌더링하여 MP4 (H.264) 또
는 MOV (HEVC, 시스템 기본값에 따라) 로 인코딩합니다. 
M18 (실시간 녹화) 과 달리 경로는 여기서 고정됩니다 — 시간
은 설정 또는 Simple Mode 내보내기 단계에서 선택합니다.

간단히  말하면

장면 주위의 회전 영상을 자

동으로 생성합니다. 수동 이동

이 필요 없습니다. 소셜 미디어

나 빠른 데모에 좋습니다. 카

메라를 직접 제어하고 싶다면 

Record Turntable Video (M18) 를 

사용하십시오. 경로는 고정입니

다 — 장면 중심 주위의 완전한 

360° 궤도이며, 시간은 설정 또

는 Simple Mode 내보내기 단계

에서 선택합니다. 시스템에 따라 

비디오는 H.264 MP4 또는 HEVC 

MOV로 출력됩니다.

M32 Export > Media > Export Web Viewer…

위치

메뉴 바 → Export → Media → Web Viewer.

기술적  설명

독립형 HTML 뷰어 (gsplat.js 기반) 와 Base64로 인코딩된 
Gaussian 데이터를 단일 .html  파일로 패키징합니다. 이 
파일은 모든 최신 브라우저에서 오프라인으로 실행됩니다 — 서
버 의존성도, 외부 URL도 없습니다. 파일 크기는 Base64 오
버헤드 때문에 SPZ 변형보다 약 1.3배 정도 큽니다.

간단히  말하면

장면을 자체 실행되는 웹페이지

로 저장합니다. HTML 파일을 더

블 클릭 → 브라우저가 열리고 

→ 인터랙티브 3D 장면 완성. 인

터넷 없이 동작하고, 이메일로 

전송할 수 있으며, 결과를 친구

나 고객과 공유하는 가장 간단

한 방법입니다. 파일에는 전체 

gsplat.js 뷰어와 Gaussian 데이

터가 단일 문서로 들어 있습니다 

— 웹에서 추가로 로드되는 것이 

없습니다. 파일 크기는 SPZ 내보

내기보다 약 3분의 1 더 큽니다. 

그 대가로 수신자 측에 추가 소

프트웨어가 필요 없습니다.
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M33 Export > Photogrammetry > Export SfM (transforms.json)…

위치

메뉴 바 → Export → Photogrammetry → Export SfM 
(transforms.json).

기술적  설명

Gaussian Cloud가 아니라 SfM 결과를 내보내기 때문에 별
도의 내보내기 경로 (공통 헬퍼 루틴이 아님) 입니다. 기본
값 transforms.json  및 Content-Type json 으로 저
장 대화창을 엽니다. 확인 시 카메라 인트린식, 포즈 (NeRF 
규약의 4×4 행렬), 프레임 경로를 포함하는 nerfstudio 호환 
transforms.json 이 기록됩니다. UI의 도움말 텍스트는 학
습 이미지가 자매 폴더 images/​로 함께 복사되어야 한다고 안
내합니다. SfM 결과가 존재하고 정식 버전이 잠금 해제된 경우
에만 활성화됩니다.

간단히  말하면

SfM 결과를 nerfstudio, Brush, 

gsplat 또는 OpenSplat 같은 다

른 소프트웨어에서 계속 사용하

려는 경우, 여기서 카메라 위치

를 내보냅니다. 학습 이미지는 

추가로 transforms.json  파

일 옆의 images/​ 폴더에 두십시

오 — 그렇지 않으면 대상 프로

그램이 이미지를 매칭할 수 없습

니다. SfM 결과가 아직 없는 동안

에는 항목이 회색이며, 무료 체

험판 버전에서는 잠겨 있습니다. 

COLMAP Workspace 워크플로의 

경우 대신 M34를 사용하십시오.

M34 Export > Photogrammetry > Export SfM (COLMAP Workspace)…

위치

메뉴 바 → Export → Photogrammetry → Export SfM 
(COLMAP Workspace).

기술적  설명

기본 이름이 colmap-workspace  (폴더이므로 확장
자 없음) 인 저장 대화창을 엽니다. sparse/​0/​
cameras.bin, images.bin , points3D.bin 을 포함하
는 표준 COLMAP Workspace를 기록합니다. RadianceKit
에서 계산되었거나 가져온 SfM 재구성을 Postshot, 
Nerfstudio, Meshroom 같은 다른 도구에서 열거나, A/B 재
실행 시 미리 계산된 입력으로 RadianceKit 자체에서 (M5를 
통해) 다시 로드하는 것을 허용합니다 — 계산 시간을 절약합니
다. SfM 결과가 존재하고 정식 버전이 잠금 해제된 경우에만 활
성화됩니다.

간단히  말하면

M33와 유사하지만 nerfstudio 

대신 COLMAP 형식입니다. 
Postshot, Meshroom, Nerfstudio 

또는 COLMAP 워크플로를 사용

하는 다른 도구를 쓴다면 이것이 

적합한 내보내기입니다. 유용한 

부수 효과: 이 폴더를 나중에 M5

를 통해 RadianceKit으로 다시 불

러와 다음 실행에서 SfM 계산 시

간을 절약할 수 있습니다 — 특히 

큰 장면에서 몇 시간을 절감하게 

됩니다. M33처럼 SfM 결과가 있

을 때에만 사용 가능하며, 무료 

체험판 버전에서는 잠겨 있습니

다.
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Help 메뉴

그림 6:  문서, 폴더, 분석 항목이 있는 Help 메뉴

일곱 항목: 두 문서 창 (User Guide, Keyboard Shortcuts), 세 폴더 바로 가기 (Training Logs, 
Exports, Storage), 그리고 세 분석 창 (Pareto Dashboard, Holdout Analysis, BayesOpt 
Console). Apple 스타일에 따라 Help 메뉴는 가장 오른쪽에 표시됩니다. 기본 Help 메뉴는 완전히 
RadianceKit 고유 변형으로 대체됩니다.

M35 Help > User Guide

위치

메뉴 바 → Help → User Guide (⌘?).

기술적  설명

User Guide 창을 엽니다. 주제 사이드바와 스크롤 가능 세부 
영역이 있는 내비게이션을 기본 크기 860×640으로 표시합니
다. 콘텐츠는 정적으로 내장되어 있으며 (Markdown에서 파싱
되지 않음).

간단히  말하면

앱 내장 매뉴얼을 엽니다. 이 매

뉴얼 전체를 다 읽고 싶지 않다

면 그곳에서 가장 중요한 단계를 

프로그램 안에서 바로 찾을 수 

있습니다. 안내서는 주제 사이드

바가 있는 별도의 창으로 구성되

어 있어 개별 주제로 곧장 이동

할 수 있습니다. 콘텐츠는 이 문

서보다 짧으며 가장 일반적인 워

크플로에 집중하고 있습니다.
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M36 Help > Keyboard Shortcuts

위치

메뉴 바 → Help → Keyboard Shortcuts (⌘/).

기술적  설명

Keyboard Shortcuts 창을 엽니다 — 모든 앱 단축키가 최상
위 메뉴별로 그룹화된 단순 스크롤 레이아웃입니다. 기본 크기 
440×560. 콘텐츠도 정적으로 내장되어 있습니다.

간단히  말하면

모든 키보드 단축키의 전체 목

록이 있는 창을 엽니다. 예: 어

떤 키로 학습을 시작하는지 기억

나지 않을 때 여기를 들여다보

면 됩니다. 요약은 이 장 끝에도 

있습니다. 목록은 최상위 메뉴별

로 그룹화되어 있으므로 올바른 

영역으로 빠르게 이동할 수 있습

니다. 마우스 스타일에서 키보드 

스타일로 옮겨 가는 중이라면 도

움이 됩니다.

M37 Help > Open Training Logs…

위치

메뉴 바 → Help → Open Training Logs… (⇧⌘L).

기술적  설명

로그 폴더를 ~/​Documents/​RadianceKit/​Logs로 계산하고, 
필요한 경우 생성한 뒤 Finder에서 엽니다. 각 학습 실
행은 거기에 고유한 JSONL 파일 training_​YYYY-MM-DD_​
HHmmss.jsonl을 기록합니다.

간단히  말하면

지금까지의 모든 학습 프로토콜

이 있는 폴더를 Finder에서 엽니

다. 어떤 것이 잘못되었거나 학

습이 정확히 언제 어떤 값으로 

수렴했는지 살펴보고 싶을 때, 

JSONL 파일에서 그 답을 찾을 수 

있습니다. 학습 실행당 정확히 

하나의 타임스탬프 파일이 생성

됩니다 — 다른 도구로 가져오거

나 메일로 지원팀에 보낼 수 있

습니다. 그래픽 평가를 원한다면 

Pareto Dashboard (M40) 가 더 나

은 시작점입니다.
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M38 Help > Open Exports Folder…

위치

메뉴 바 → Help → Open Exports Folder…

기술적  설명

M37과 유사하지만 ~/​Documents/​RadianceKit/​Exports
를 사용합니다. 첫 번째 자동 테스트 실행 또는 첫 번째 클릭 시 
생성됩니다. 이후 모든 자동 테스트 내보내기 (예: autotest_​
<timestamp>.ply) 의 기본 경로가 거기에 저장됩니다. 저장 
대화창을 통해 수동으로 선택된 내보내기는 반드시 여기에 들어
가지 않으며 사용자가 저장하는 위치에 저장됩니다 — 따라서 
이 폴더는 주로 자동 테스트에 관심이 있습니다.

간단히  말하면

앱이 자체 내보내기 (특히 자동 

테스트 실행) 를 저장하는 폴더

를 엽니다. 저장 대화창으로 다

른 곳에 수동 내보내기를 했다

면 그 위치에 있지 이 폴더에 있

지 않습니다. 정리하거나 이전 

테스트 내보내기가 차지하는 용

량을 확인할 때 편리합니다. 로

그와 장면 번들을 포함한 전체 

개요가 필요하다면 대신 Manage 

Storage (M39) 를 사용하십시오.

M39 Help > Manage Storage…

위치

메뉴 바 → Help → Manage Storage…

기술적  설명

Storage 브라우저를 엽니다 (제 4 장 Auxiliary Windows의 
ID W7–W12 참조). ~/​Documents/​RadianceKit/​ 폴더의 
모든 영구 장면, 학습 로그, 내보내기, 캐시를 크기와 함께 나열
하고, 각 항목에 대해 Reveal-in-Finder와 휴지통 이동을 가
능하게 합니다.

간단히  말하면

RadianceKit이 디스크에서 차지

하는 공간을 장면, 로그, 내보내

기별로 보여 주는 윈도우 브라

우저를 엽니다. Finder로 가지 않

고 개별 항목을 바로 삭제할 수 

있습니다. 장기간 사용 후 디스

크가 가득 차는 경우 편리합니다 

— 이전 로그와 자동 테스트 내

보내기가 수 기가바이트에 달할 

수 있습니다. Reveal-in-Finder를 

통해 언제든 기본 보기로 돌아갈 

수 있습니다.
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M40 Help > Pareto Dashboard…

위치

메뉴 바 → Help → Pareto Dashboard… (⇧⌘D).

기술적  설명

Pareto Dashboard를 엽니다 (제 4 장 ID W13–W22 참
조). 대시보드는 ~/​Documents/​RadianceKit/​Logs/​에 있는 
모든 JSONL 학습 로그를 로드하고, 장면과 프리셋별로 정렬
한 뒤 Pareto 산점도 (기본값: Loss vs Gaussians, 선택적
으로 Loss vs Wallclock 또는 PSNR vs Iterations) 를 그
립니다.

간단히  말하면

지금까지의 모든 학습 실행에 대

한 개요를 다이어그램으로 엽

니다. 어느 실행이 품질과 크기

의 가장 좋은 균형을 제공했는

지 한눈에 알 수 있습니다. 여

러 프리셋을 비교하고 싶을 때 

편리합니다. 기본 다이어그램은 

Loss 대 Gaussian 수를 표시하지

만 — Wallclock 시간이나 PSNR로

도 전환할 수 있습니다. 데이터

는 JSONL 학습 로그 (M37) 에서 

가져옵니다. 실행이 많을수록 분

석이 더 의미 있어집니다.

M41 Help > Holdout Analysis…

위치

메뉴 바 → Help → Holdout Analysis… (⇧⌘H).

기술적  설명

Holdout 분석 창을 엽니다 (제 4 장 ID W23–W29 참조). 
transforms.json 을 로드하고, 카메라를 3D 글로브로 그
리며, Train/Test 폴드 분할 (각도 또는 선형, 2–8 폴드) 을 허
용합니다. 출력은 fold-assignment.json이며, 학습은 해당 
학습 구성에서 이를 테스트 세트로 사용할 수 있습니다.

간단히  말하면

카메라 촬영을 학습 및 테스트 

세트로 나누어 — 학습이 보지 않

은 이미지에서 장면이 얼마나 좋

은지 객관적으로 측정할 수 있도

록 도와줍니다. 다소 연구 및 벤

치마크용 도구입니다. 카메라는 

3D 글로브로 표시됩니다. 2개부

터 8개까지의 폴드를 각도별로 

균일하게 또는 순서별로 선형으

로 선택할 수 있습니다. 결과는 

작은 JSON 파일이며, 학습은 이

를 테스트 세트로 사용합니다.
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M42 Help > BayesOpt Console…

위치

메뉴 바 → Help → BayesOpt Console… (⇧⌘B).

기술적  설명

BayesOpt 콘솔을 엽니다 (제 4 장 ID W30–W39 참조). 사
전 정의된 탐색 공간 (예: “MCMC scale-reg + opacity-
reg + ssim”) 을 로드하고, Bayesian Optimization 시도
를 비동기적으로 실행하며, 수렴 곡선과 시도 로그를 실시간으
로 표시합니다.

간단히  말하면

내장 자동 튜너 콘솔입니다. 다

양한 매개변수를 수동으로 시험

하는 대신 앱이 밤새 직접 실행

하고 마지막에 장면에 대한 최

적 값을 제안할 수 있습니다. 매

우 고급 도구입니다 — 대부분의 

워크플로에는 좋은 프리셋 (제 

7 장 참조) 으로 충분합니다. 사

전 정의된 탐색 공간 (예: “MCMC 
scale-reg + opacity-reg + ssim”) 

을 선택하면 수렴 곡선과 시도 

로그를 실시간으로 볼 수 있습니

다. 설정에 따라 몇 시간에서 며

칠을 예상하십시오.

참고: Edit 메뉴의 Cmd-Z

2026년 5월 이후 Expert Mode의 Project Navigator는 마이너스 버튼 또는 Backspace 키로 가져
온 이미지의 삭제, 그리고 Cmd-Z 를 통한 되돌리기를 지원합니다. 이 Cmd-Z 동작은 삭제된 이미지를 복
원할 수 있는 동안에는 “Undo Remove Image”로 macOS Edit 메뉴 (SwiftUI에서 제공) 에 나타납니
다. 표준 NSUndoManager 시스템을 통해 등록되며, RadianceKitApp에는 등록되지 않습니다. 따라서 
인벤토리에 별도의 M-ID 항목이 없습니다.
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키보드 단축키 개요

메뉴 항목 단축키

File > Open Scene… ⌘O

File > Save Scene… ⌘S

File > Import COLMAP / Metashape Workspace… ⇧⌘I

File > New Project ⇧⌘N

Mode > Simple Mode ⌘1

Mode > Expert Mode ⌘2

Training > Start Training ⇧⌘T

Viewport > Enter/Exit Edit Mode ⇧⌘E

Viewport > Toggle Auto-Rotation ⌘⌥T

Viewport > Save Screenshot ⇧⌘S

Export > 3D Formats > PLY ⌘E

Help > User Guide ⌘?

Help > Keyboard Shortcuts ⌘/

Help > Open Training Logs… ⇧⌘L

Help > Pareto Dashboard… ⇧⌘D

Help > Holdout Analysis… ⇧⌘H

Help > BayesOpt Console… ⇧⌘B

Edit 메뉴 (시스템 제공, Expert Mode에서 Project Navigator 선택이 활성일 때):

동작 단축키

Undo Remove Image ⌘Z

Remove Selected Image Backspace / Delete
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장

제 2 장 — 인스펙터 (Expert View)

그림 7:  Expert 모드 비어 있음 — 왼쪽에 Project Navigator (Images 0, Cameras, Log), 가운데 빈 뷰
포트, 오른쪽 인스펙터에 Presets/Training Configuration/Enhancements/Training Metrics 섹션

가져오기 전의 빈 인스펙터: 왼쪽 사이드바에 Images 카운터 0과 드롭 힌트 “Drop images here / 
or tap + to import”가 표시됩니다. 오른쪽 인스펙터는 완전히 작동하지만 프리셋은 정보용일 뿐입니
다 (활성 학습 없음). 기본 프리셋 “Preview” (5K iters) 가 표시되어 있습니다. Camera Alignment
는 Apple Photogrammetry, Densification은 Classic, SSIM Weight는 0.20, Render Scale은 
50%입니다. Training Metrics (“Start training to see live metrics”) 와 Loss History (“Loss 
curve will appear during training”) 의 비어 있는 상태도 표시됩니다.
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그림 8:  60개의 flowers 이미지를 로드한 인스펙터 — 이미지 사이드바가 frame_0001.jpg 이후의 파일 이름
을 보여 주고 헤더에 “60 images ready”

가져오기 후의 인스펙터: 헤더 상태 “60 images ready”. 이미지 사이드바는 60개의 가져온 프레
임 ( frame_0001.jpg 에서 frame_0945.jpg  까지, 빠른 반복을 위한 부분 집합으로 960-Cam 
Bouquet 데이터셋의 16번째 프레임마다 하나) 을 모두 나열합니다. 자동 Render Scale 로직은 이미지 
해상도 (1536×2048 = 3.1 MP) 를 검사하여 Render Scale을 그에 맞게 조정합니다. Play 버튼 (왼쪽 
아래 녹색) 이 이제 활성화되어 있고 활성 프리셋으로 학습을 시작합니다.

그림 9:  학습 중인 인스펙터 — 실시간 뷰포트가 flowers-Bouquet 재구성을 보여 줌, 하단에 메트릭 바 
(Loss / LR / Gaussian-Count / Iterations), 매개변수가 조정된 경우 “Modified” 배지가 붙은 프리셋 카

드 “Preview”

학습 중인 인스펙터: 제목 표시줄에 전체 진행률 “RadianceKit — Training NN %”가 표시됩니다. 뷰
포트는 실행 중인 Gaussian 재구성을 실시간으로 렌더링합니다 (50회 반복마다 업데이트됨 — Live 
Preview 간격은 Settings → General → Training → Live Preview에서 설정 가능). 뷰포트 아래의 
메트릭 바: 현재 Loss, Learning Rate, Gaussian Count, 그리고 반복 카운터 (예: Preview 프리셋
의 경우 1,600/5,000). 인스펙터 프리셋 카드 “Preview”는 어떤 매개변수든 내장 기본값에서 벗어나면 
“Modified” 배지를 표시합니다. 사이드바 “Log”는 SfM 및 학습 단계 이벤트를 수집합니다.
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그림 10:  학습 완료 후 인스펙터 — 뷰포트가 완성된 flowers-Bouquet 재구성을 보여 줌 (5K 반복 후 2,991 
Gaussians을 13초에 완료), 제목 표시줄 “Training Complete — 2,991 Gaussians”

학습 후의 인스펙터: 제목 표시줄에 최종 Gaussian 수 (여기서는 2 991 — 합성 Blender Bouquet 장
면이 밝은 배경에 단순한 형상을 갖고 있어 매우 작음) 가 표시됩니다. 뷰포트는 완성된 점 구름을 보여 줍
니다 — 궤도형 드래그 내비게이션 활성화 (장면 중심을 회전축으로). Training Metrics 섹션은 이제 최종 
값들로 채워져 있고, Loss History 차트는 5 000회 반복 전체의 진행을 보여 줍니다. 아래의 Export 섹
션이 이제 활성화되어 있습니다 (모든 형식 버튼이 활성).

인스펙터는 Expert Mode (⌘2) 의 오른쪽 사이드바입니다. 학습 관련 모든 매개변수를 일곱 개
의 접을 수 있는 섹션으로 묶어 둡니다. 첫 실행 시 위에서 아래로의 기본 순서는 다음과 같
습니다: Look, Presets, Training config, Metrics, Loss chart, Enhancements, Export. 
“Look” 섹션 (post-Training 이미지 조정) 은 이전 “Finishing” 섹션의 실제 UI 이름 변경입
니다 — 내부 Enum- rawValue 는 영속성 이유로 “Finishing” 으로 유지되지만, 표시되는 헤딩
은 “Look”입니다. 각 섹션은 헤더를 클릭하면 접을 수 있고, 순서는 드래그 앤 드롭으로 재배열
할 수 있습니다 (InspectorView.swift:81-97). 첫 실행 시 일곱 개 섹션이 모두 접혀 있습니다 
(inspectorCollapsedSections의 기본값은 Set(InspectorSection.allCases)); 그 후 앱 상태
는 접기 및 순서 설정을 앱 시작 간에도 유지합니다.

인스펙터의 일부 조작 요소는 거의 동일한 형태로 설정 (제 3 장) 에서도 나타납니다 — 일반적으로 SfM 
백엔드, Sky Masking과 유사한 기본값들입니다. 분리는 의도적입니다. 설정은 새로 만든 프로젝트에 대
한 앱 전역 템플릿을 제공하고, 인스펙터는 현재 열려 있는 프로젝트에 대해 이 값들을 재정의합니다. 한쪽
의 조작 논리를 알면 다른 쪽도 익숙하게 사용할 수 있습니다.

Expert Mode의 왼쪽 열 — Project Navigator — 은 인스펙터에 속하지 않지만 바로 옆 이웃입니다. 
거기서는 가져온 이미지를 클릭하여 선택하고, 스페이스 바로 Quick Look으로 미리 보고, 마이너스 버튼
이나 Delete 키로 삭제할 수 있습니다 (Cmd-Z로 되돌리기). 인스펙터는 현재 사이드바 선택을 따라 컨텍
스트 별 세부 정보를 표시하지만, 일곱 개의 주요 섹션은 항상 사용 가능한 상태로 유지됩니다.

Look 섹션 (L1–L5)

Look 섹션 (내부 rawValue 는 여전히 “Finishing”) 은 인스펙터의 최상단 섹션으로 post-Training 
이미지 조정을 한곳에 모읍니다. 모든 슬라이더는 비파괴적으로 작동합니다. 각 슬라이더는 변경되지 않은 
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Pristine 스냅샷 (원본 DC 색상, Opacity, 스케일링) 에 FinishingPass 를 다시 적용합니다 — 따라
서 조정은 누적되지 않고 멱등적입니다. 결과는 뷰포트에 실시간으로 나타나며 (WYSIWYG, 이후 내보내
기와 정확히 동일) 모든 내보내기에 구워 넣어집니다. 이 섹션은 학습 실행이 완료된 후에야 사용할 수 있습
니다 (그 전에는 “Available after a training run completes.” 가 표시됨); 값은 새 학습마다 재설정됩
니다. 내보내기가 실행되는 동안에는 모든 슬라이더가 잠깁니다 — 잠금 힌트 “Locked while exporting 
— the file uses the current settings.” 가 나타나고 GroupBox가 비활성화됩니다.

L1 Saturation 슬라이더

위치

인스펙터 → Look 섹션 → GroupBox → Saturation.

기술적  설명

슬라이더 0.5–1.2, 두 자리 표시 (예: “1.00”). 각 Splat의 
SH-DC 채도를 휘도 값에 대해 스케일합니다: 1.0 = 변경 없
음, < 1.0 = 채도 감소 (색상이 그레이스케일로 당겨짐), > 1.0 
= 더 강렬. 수학적으로 DC 색상은 Pristine 스냅샷에서 역산되
므로 ( desaturateDC ) 반복적으로 밀어도 누적되지 않습니
다. DJI 드론 소재 (Pensford Viadukt) 에서 검증되었는데, 
이 소재는 과도하게 채색되는 경향이 있어 드론 기본값이 0.82
입니다. 색상 베이스 (SH 차수 0) 에만 작용하고 더 높은 SH 
계수는 영향을 받지 않습니다.

간단히  말하면

완성된 Splat의 색상이 얼마나 

강렬한지를 정합니다. 1.00은 학

습된 그대로 두고, 그 아래 값은 

색상을 회색 쪽으로 당깁니다 — 

종종 과채도로 나오는 드론이나 

비디오 소재에 좋습니다. 1.0을 

넘는 값은 더 강렬하게 만듭니

다. 앱이 항상 변경되지 않은 원

본 상태에서 다시 계산하기 때문

에 “쌓이는” 일 없이 마음껏 앞뒤

로 밀 수 있습니다. 뷰포트에 실

시간으로 보이며 내보내기에서

도 정확히 그대로입니다.

L2 Splat length 슬라이더

위치

인스펙터 → Look 섹션 → GroupBox → Splat length.

기술적  설명

슬라이더 0.3–1.0, 두 자리 표시. 각 Gaussian의 세 
스케일링 축을 로그 공간에서 평균값 쪽으로 당깁니다 
( shortenScale , 계수 alpha ): 1.0 = 변경 없음, 작은 값
은 길쭉한 “바늘” Splat을 더 둥글게 만들고, 0이면 순수한 구
가 됩니다. 전체 크기를 바꾸지 않고 바늘 모양의 과도하게 늘
어진 Splat을 손보아 전형적인 “콘페티” 아티팩트를 줄입니다. 
Pristine 스냅샷 (원본 로그 스케일링) 에서 적용되므로 멱등적
입니다. 둘 다 로그 공간에서 작동하므로 Splat size (L3) 와 
교환 가능합니다.

간단히  말하면

지나치게 긴, 파편 같은 Splat을 

더 둥글게 만듭니다. 1.00은 형태

를 학습된 그대로 두고, 낮은 값

은 길게 늘어진 “바늘”을 더 둥

근 덩어리로 압축합니다 — 콘페

티 아티팩트에 시달리는 거친 재

구성을 진정시킵니다. 전체 크기

는 그대로 유지되며 길쭉함만 다

룹니다. Splat size (L3) 와 안전하

게 조합할 수 있습니다.
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L3 Splat size 슬라이더

위치

인스펙터 → Look 섹션 → GroupBox → Splat size.

기술적  설명

슬라이더 0.5–2.0, 두 자리 표시. 각 Gaussian을 세 축 모두
에서 균일하게 스케일합니다 ( sizeScale ): 1.0 = 변경 없
음, < 1.0 = 더 작고/조밀하고/선명, > 1.0 = 더 크고/“폭
신” (Splat 사이의 틈을 채움). 스케일링이 로그 공간에 있
으므로 곱셈은 가산적 log(factor)  오프셋으로 실현됩니다 
— 상수 오프셋이 평균으로부터의 편차를 건드리지 않기 때문에 
Splat length (L2) 와 교환 가능합니다. Pristine 스냅샷에서 
적용되므로 멱등적입니다. 이 버전에서 새로 추가됨.

간단히  말하면

모든 Splat을 균일하게 크게 또

는 작게 스케일합니다. 1.00은 학

습된 상태이고, 그 아래 값은 점 

구름을 더 조밀하고 선명하게 만

들며, 그 위 값은 Splat 사이의 

틈을 덮습니다 (더 부드럽고/“폭

신”하게 작용). 구멍 난 재구성을 

시각적으로 메우거나 반대로 더 

많은 디테일을 드러내는 데 유용

합니다. Splat length (L2) 와 문제

없이 어울립니다 — 두 슬라이더

는 서로 영향을 주지 않습니다.

L4 Fade far region (서브 슬라이더 포함)

위치

인스펙터 → Look 섹션 → GroupBox → 토글 “Fade far 
region” 및 서브 슬라이더 “Fade start ×radius” 와 “Fade 
floor”.

기술적  설명

카메라 중심으로부터의 거리에 따른 방사형 Opacity 감
쇠를 활성화하는 토글입니다 — 배경에서 약하게 관
측된 “Far 콘페티”가 흐려집니다. 궤도 촬영 전용: 
finishingContext.fadeEligible가 false이면 (선형 비
행, 카메라가 너무 적거나 퇴화) 토글이 비활성화되고, 서브 슬
라이더 대신 “Far-fade applies only to orbit captures 
(not this scene).” 라는 힌트가 나타납니다. 적합성은 카메라 
위치의 방위각 커버리지로 판정됩니다 (궤도는 중심을 돌며 많
은 나침반 섹터를 채우고, 선형 비행은 ~2개만 채움). 두 서브 
슬라이더가 형상을 제어합니다: Fade start ×radius (1.0–
3.0) 는 완전 Opacity가 적용되는 내부 반경을 궤도 반경의 
배수로 설정하고; Fade floor (0.0–1.0) 는 Fade 반경 너머 
멀리서의 Opacity 계수입니다. 중요: Fade는 Sky-Dome 
영역을 건너뜁니다 (인덱스 [0, frozenCount) 의 frozen 
Gaussian), 의도적으로 재구성된 배경 돔이 함께 어두워지지 
않도록.

간단히  말하면

장면 바깥 가장자리의 흐릿한 잔

여물을 흐려지게 합니다 — 정

확히 둥근 촬영에서 저 멀리 

떠 있는 “Far 콘페티” 덩어리들

입니다. 실제 궤도/둘러싸는 촬

영에서만 작동합니다; 직선 드

론 비행이나 카메라가 너무 적

으면 스위치가 회색으로 비활성

화되고 힌트가 이유를 설명합니

다. 활성화되면 두 개의 미세 조

정기가 추가됩니다: “Fade start 

×radius”는 어느 거리부터 (둘

러싸는 반경의 배수로) 흐려짐

이 시작되는지를 정하고, “Fade 

floor”는 먼 Splat이 끝에 얼마나 

보이게 남는지를 정합니다 (0 = 

완전히 사라짐, 1 = 변경 없음). 

의도적으로 재구성된 Sky-Dome 

(I44) 은 이때 결코 건드리지 않

습니다 — 하늘은 유지됩니다.
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L5 Reset finishing 버튼

위치

인스펙터 → Look 섹션 → GroupBox → “Reset 
finishing” (하단, 작은 버튼).

기술적  설명

모든 Look 설정을 기본값으로 되돌리고 
(FinishingPass.Settings() = Saturation 1.0, Fade 꺼
짐, Splat length 1.0, Splat size 1.0) 즉시 Finishing
을 다시 트리거하여 뷰포트가 변경되지 않은 학습 상태로 되돌
아가게 합니다. controlSize(.small). 전체 Look 스택이 
Pristine 스냅샷에서 멱등적으로 계산하므로 “기본값으로 되돌
리기”는 정확히 원래 학습 출력입니다 — 여러 번 앞뒤로 해도 
품질 손실이 없습니다. 섹션의 모든 슬라이더와 마찬가지로 내
보내기가 실행되는 동안 잠깁니다.

간단히  말하면

한 번의 클릭으로 모든 Look 슬

라이더를 표준으로 되돌립니다 

(Saturation 1.00, Fade 꺼짐, 두 

Splat 슬라이더 모두 1.00) — 그 

후 뷰포트는 다시 정확히 갓 학

습된 결과를 보여 줍니다. 이것

저것 만지작거리다가 깔끔하게 

처음부터 시작하고 싶을 때 유용

합니다. 앱이 항상 원본 상태에

서 계산하므로 이때 품질 손실

이 없습니다. 내보내기가 실행되

는 동안에는 버튼이 (슬라이더처

럼) 잠깁니다.

Presets 섹션 (I1–I11)

Presets 섹션은 검증된 구성을 가장 빠르게 적용하는 방법입니다. 내장 프리셋 (Capture Class, 
Classic, MCMC, Hybrid) 은 560+ 개의 문서화된 실험에서 나온 재현 가능한 시작점을 제공하고, 자
체 프리셋은 저장, 내보내기, 가져오기, 공유할 수 있습니다. 목록은 카테고리 (Capture Class, Classic, 
MCMC, Hybrid, Custom) 별로 그룹화되어 있으며, 한 번에 둘 이상의 카테고리를 펼칠 수 있습니다. 
컨텍스트 메뉴 (행 마우스 오른쪽 클릭) 를 통해 Export, Duplicate, 그리고 — 자체 프리셋의 경우 — 
Delete에 접근할 수 있습니다.
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I1 Save… 버튼

위치

인스펙터 → Presets 섹션 → Save… 버튼 (하단 동작 표시
줄).

기술적  설명

텍스트 필드와 Save/Cancel 버튼이 있는 팝오버를 엽니다. 현
재 TrainingConfig 상태가 새로운 사용자 정의 프리셋으로 영
구화됩니다 (JSON 인코딩, 앱 전역으로 저장). 저장 동작은 
81개의 학습 매개변수와 현재 Densification 전략을 모두 복
사합니다. 프리셋은 어떤 내장 프리셋에서 파생되었는지에 관계
없이 자동으로 Custom 카테고리에 들어갑니다. 빈 이름과 순
수 공백만 입력하면 거부됩니다. 이미 존재하는 이름은 거부되
지 않습니다 — 각 프리셋은 자체 내부 ID를 가지며, 중복 이름
은 기술적으로 허용되나 실제로는 혼란을 줍니다.

간단히  말하면

현재 구성을 재사용 가능한 프리

셋으로 저장합니다. 버튼을 누르

고 팝오버에 이름을 입력한 뒤 

Save를 클릭하면 — 81개의 모

든 매개변수가 Densification 전

략을 포함하여 선택한 이름 아래 

Custom 카테고리에 저장됩니다. 

공들여 작업한 설정이 있고 다음 

프로젝트에서 처음부터 다시 만

지작거리고 싶지 않을 때 필요

합니다. “Drone 4K”나 “Indoor 빠

른” 같은 반복적인 설정에 특히 

편리합니다. 중복 이름은 기술적

으로 허용되지만 실제로는 혼란

스럽습니다 — 차라리 무언가 의

미 있는 이름을 사용하십시오.

I2 Preset Name 텍스트 필드

위치

Save 팝오버 → “Preset Name” 텍스트 필드.

기술적  설명

둥근 테두리의 단순한 텍스트 필드, 넓은 형태입니다. Save 버
튼을 클릭하면 값이 프리셋 이름으로 전달됩니다. UI에는 길이 
제한이 없지만, 저장된 이름은 JSON 인코딩이 가능해야 하고 
UI 목록에 표시될 수 있어야 합니다 — 이모지와 움라우트는 작
동합니다. 팝오버를 열 때 내용은 자동으로 빈 문자열로 재설정
됩니다. 필드가 트림 후 비어 있는 동안에는 Save 버튼이 비활
성화 상태로 유지됩니다. 자동 추천은 없고 현재 활성 프리셋 이
름이 미리 채워지지도 않습니다.

간단히  말하면

여기에 프리셋 이름을 입력합니

다. “Drone 4K 30fps”나 “Indoor 

빠른” 같이 의미 있는 이름을 선

택하십시오 — 나중에 Custom 

카테고리에서 다시 찾는 데 도움

이 됩니다. 이모지와 움라우트가 

허용되고 엄격한 길이 제한은 없

습니다. 필드가 비어 있거나 공

백만 있는 동안에는 Save 버튼이 

회색으로 유지됩니다. 팝오버를 

다시 열면 필드가 다시 비어 있

습니다 — 활성 프리셋 이름은 미

리 채워지지 않습니다.
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I3 Cancel 버튼 (Save 대화창)

위치

Save 팝오버 → Cancel 버튼 (왼쪽).

기술적  설명

저장하지 않고 팝오버를 닫습니다. 텍스트 필드 내용을 폐기합
니다 — 다음에 열 때 Save… 버튼 로직 (I1) 을 통해 다시 비워
집니다. 표준 버튼 스타일, 확인 대화창 없음, 단축키 없음. 저장 
경로가 실행되지 않았기 때문에 현재 TrainingConfig는 변경
되지 않습니다.

간단히  말하면

아무것도 저장하지 않고 Save 팝

오버를 닫습니다. 마음이 바뀌었

거나, 입력 오류가 있거나, 대화

창을 실수로 열었다면 — 그저 

Cancel을 클릭하십시오. 아직 아

무것도 기록되지 않았으므로 현

재 학습 구성은 변경되지 않습니

다. 다음에 팝오버를 열면 이름 

필드가 다시 비어 있는 상태로 

시작합니다. 확인 절차 없음, 단

축키 없음 — 클릭 한 번으로 사

라집니다.

I4 Save 버튼 (Save 대화창)

위치

Save 팝오버 → Save 버튼 (오른쪽, 강조된 스타일).

기술적  설명

실제 영구화를 트리거합니다. 비어 있지 않은 이름을 다시 한 번 
검증하고 (방어적 점검) 현재 TrainingConfig를 JSON으로 
앱 저장소에 기록합니다. 그 후 팝오버를 닫습니다. 파란색으로 
강조되며, 텍스트 필드가 비어 있는 동안에는 회색입니다. 저장
이 실패할 경우 (예: 앱 저장소가 가득 차서 — 매우 드묾) 현재 
표시되는 오류 대화창은 없습니다. 그 경우 프리셋은 다음 앱 시
작 시 단순히 나타나지 않게 됩니다.

간단히  말하면

Save를 클릭하면 이름이 적

용되고 현재 설정이 새 프

리셋으로 기록됩니다. 팝오버

가 닫히고, 프리셋이 즉시 프

리셋 목록의 Custom 카테고

리에 나타나며 이후 클릭 한 

번으로 활성화할 수 있습니

다. 버튼은 파란색으로 강조되

며 ( borderedProminent ), 이

름 필드가 비어 있는 동안에는 

회색으로 유지됩니다. 저장이 실

패하면 (예: UserDefaults가 가득 

참) 가시적인 오류 대화창이 없

습니다 — 프리셋은 다음 앱 시작 

시 그저 누락됩니다.
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I5 Export… 버튼

위치

인스펙터 → Presets 섹션 → 동작 표시줄 → Export… 버튼.

기술적  설명

현재 선택된 프리셋을 .radiancepreset  파일 (내부는 
JSON) 로 내보냅니다. 프리셋이 선택되지 않았다면 비활성화
됩니다. 클릭 시 앱은 미리 정해진 파일 이름 (프리셋 이름 + 
.radiancepreset  확장자) 이 있는 저장 대화창을 엽니다. 
저장된 형식은 전체 TrainingConfig와 메타데이터 (이름, 카
테고리, ID, 내장 플래그) 를 포함합니다. Finder에서 더블 클
릭하면 앱이 열리지만 자동으로 가져오기를 실행하지는 않습니
다. 사용자는 가져오기 버튼 (I6) 을 사용해야 합니다.

간단히  말하면

목록에서 프리셋을 선택하고 

Export를 클릭하십시오 — 그러

면 .radiancepreset  파일로 

저장할 수 있고 예: 동료에게 보

내거나 두 번째 Mac으로 옮길 수 

있습니다. 수신자는 Import… 버

튼 (I6) 으로 다시 불러옵니다. 내

장 프리셋과 자체 Custom 프리

셋 모두에 동일하게 잘 작동합니

다. 목록에서 아무것도 클릭하지 

않은 동안에는 버튼이 회색입니

다. 팁: 컨텍스트 메뉴 (I8) 를 사

용하면 더 빠릅니다 — 프리셋을 

먼저 선택할 필요가 없습니다.

I6 Import… 버튼

위치

인스펙터 → Presets 섹션 → 동작 표시줄 → Import… 버튼.

기술적  설명

.radiancepreset  파일만 허용하는 파일 대화창을 엽니다 
(다중 선택 비활성화). 선택 시 JSON 파일이 로드되고 검증되
어 Custom 카테고리에 삽입됩니다 — 내장 프리셋과의 충돌을 
방지하기 위해 새 내부 ID로 등록됩니다. 가져오기는 내보낸 프
리셋이 원래 예: 내장이었더라도 카테고리를 자동으로 Custom
으로 설정합니다. 손상된 파일이나 이전 스키마 버전과 호환되
지 않는 파일은 오류 대화창 없이 조용히 거부됩니다 (콘솔 로그
에는 정보가 제공됨).

간단히  말하면

.radiancepreset  파일을 디

스크에서 읽어들입니다. 누군가

가 검증된 설정을 보내왔거나, 

자신의 즐겨찾는 프리셋을 여러 

Mac에 동기화하려는 경우 유용

합니다. 가져온 프리셋은 항상 

Custom 카테고리에 들어갑니다 

— 원래 내장에서 내보낸 경우라

도 마찬가지입니다. 손상되었거

나 오래된 파일은 조용히 무시되

며, 콘솔 로그에 이유가 표시됩

니다. 대화창의 다중 선택이 비

활성화되어 있으므로 클릭당 파

일 하나만 가능합니다.
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I7 프리셋 행 (클릭으로 활성화)

위치

인스펙터 → Presets 섹션 → 각 카테고리의 각 프리셋 행.

기술적  설명

프리셋 행을 클릭하면 TrainingConfig의 모든 필드가 프
리셋의 값으로 대체되고, 활성 프리셋의 ID가 기록되며, 
Modified 상태가 초기화됩니다. 행 앞의 활성 체크 마크는 
프리셋이 선택되고 동시에 수정되지 않은 경우에만 나타납니
다. TrainingConfig의 어떤 값이 변경되는 즉시 (다른 인
스펙터 섹션의 슬라이더, 스테퍼, 토글), 이름 뒤에 주황색 
“Modified” 배지가 나타납니다. 내장 프리셋은 덮어쓸 수 없습
니다 — 수정 시 Save 버튼 (I1) 을 통해 자체 복사본을 만들어
야 합니다.

간단히  말하면

행을 클릭하면 프리셋이 활성

화되고 거기에 저장된 모든 값

이 현재 학습 설정에 적용됩니

다. 이름 앞의 체크 마크는 현

재 활성 프리셋이 어느 것인지

를 표시합니다. 그 후 다른 섹션

에서 슬라이더, 스테퍼, 토글을 

조정하는 즉시 이름 뒤에 주황

색 “Modified” 배지가 나타납니

다 — 설정이 이제 프리셋과 다

르기 때문입니다. 내장 프리셋은 

덮어쓸 수 없습니다. 변경 사항

을 보존하고 싶다면 Save… 버튼 

(I1) 을 통해 자체 복사본을 만들

거나 프리셋을 복제 (I9) 하십시

오.

I8 컨텍스트 메뉴 “Export…”

위치

각 프리셋 행 마우스 오른쪽 클릭 → 첫 번째 항목 “Export…”.

기술적  설명

I5 (Export… 버튼) 와 기능이 동일하지만 더 편리하게 접근
할 수 있습니다 — 프리셋을 먼저 선택할 필요 없이. 클릭된 행
의 프리셋을 직접 내보냅니다. 모든 프리셋 카테고리 (내장 또는 
Custom) 에 동일하게 작동하며 제한이 없습니다. 내보내기에
는 내장 플래그와 원래 카테고리가 포함되지만, 다시 가져올 때
는 I6에 설명된 대로 카테고리가 Custom으로 매핑됩니다.

간단히  말하면

내보내기로 가는 빠른 길 — 원하

는 프리셋을 마우스 오른쪽 버튼

으로 클릭하고 “Export…”를 선택

합니다. 먼저 클릭 후 Export… 버

튼을 누르는 우회 경로를 절약합

니다. 모든 카테고리에 동일하게 

작동하며 내장에도 적용됩니다. 

생성된 .radiancepreset  파

일은 I5의 것과 동일합니다. 이후 

다시 가져오면 자동으로 Custom 

카테고리에 저장됩니다.
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I9 컨텍스트 메뉴 “Duplicate”

위치

각 프리셋 행 마우스 오른쪽 클릭 → 두 번째 항목 
“Duplicate”.

기술적  설명

프리셋을 Custom 카테고리에 복제합니다. 새 내부 ID를 생성
하고 이름에 “ Copy”를 추가한 뒤 복사본을 저장합니다. 내장 
프리셋에도 작동합니다 — 그러면 복제본을 편집할 수 있습니
다. 원본은 그대로 유지됩니다. TrainingConfig는 값별로 복
사됩니다 (JSON 라운드트립). 따라서 원본과 복사본 사이에 
참조 결합이 없습니다.

간단히  말하면

Custom 카테고리에 편집 가능

한 프리셋 복사본을 생성합니다. 

예: 내장 “Quality” 프리셋을 시

작점으로 삼고 SSIM 슬라이더만 

약간 조정하고 싶을 때 편리합

니다. 워크플로: 복제, 이름 변경 

(컨텍스트 메뉴 또는 새 Save… 

실행), 조정, 완료. 원본은 그대

로 유지됩니다 — 언제든지 돌아

갈 수 있습니다. 내장에도 작동

하며, 이는 그 값들을 기반으로 

삼고 동시에 편집 가능하게 만드

는 유일한 방법입니다.

I10 컨텍스트 메뉴 “Delete”

위치

자체 프리셋 행 마우스 오른쪽 클릭 → 마지막 항목 
“Delete” (빨강, destructive).

기술적  설명

Custom 프리셋에서만 표시됩니다. 내장은 삭제할 수 없습니
다. 항목은 파괴적인 것으로 표시되며, 컨텍스트 메뉴에 빨간색
으로 나타나고 실수로 클릭하지 않도록 구분선 뒤에 배치됩니
다. 확인 대화창은 없습니다 — 한 번 클릭하면 프리셋이 즉시 
삭제됩니다. 삭제된 프리셋은 복원할 수 없습니다 (Cmd-Z가 
여기서는 작동하지 않습니다 — 현재 빌드에서 Undo는 이미지 
목록에만 있고 프리셋 작업에는 없음). 삭제된 프리셋이 막 활성 
상태였다면 현재 TrainingConfig는 변경되지 않고 활성 프리
셋 선택만 해제됩니다.

간단히  말하면

자체 프리셋을 삭제합니다. 내

장 (Quick, Preview, Balanced, 
Quality, Ultra Detail, Drone / 
Aerial, 360° Walkaround, Photo / 

Object 등) 에서는 “Delete”가 아

예 표시되지 않습니다 — 실수로 

죽일 수 없습니다. 주의: 확인 절

차도 Undo도 없습니다. 한 번 클

릭하면 프리셋이 사라집니다. 확

신이 없다면 먼저 Export… (I5/I8) 

로 디스크에 백업 복사본을 만들

어 두십시오 — 언제든지 다시 가

져올 수 있습니다. 프리셋이 막 

활성 상태였다면 TrainingConfig

는 변경되지 않고 체크 마크만 

사라집니다.
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I11 카테고리 헤더 (펼치기/접기)

위치

인스펙터 → Presets 섹션 → 각 카테고리 헤더 (Capture 
Class, Classic, MCMC, Hybrid, Custom).

기술적  설명

카테고리별 접기 상태는 서로 다른 기본값을 가집니다. 큐
레이션된 Capture Class 그룹은 펼쳐진 상태로 시작하고, 
Classic, MCMC, Hybrid, Custom은 접힌 상태로 시작합니
다. 상태는 영구화되지 않습니다 — 앱 재시작 시 모든 카테고
리가 다시 기본 상태로 돌아갑니다. 셰브런 화살표는 애니메이
션으로 회전합니다. 헤더 오른쪽의 숫자는 이 카테고리의 프리
셋 수를 표시합니다. 클릭 히트 영역은 전체 헤더 영역을 포함합
니다.

간단히  말하면

카테고리를 펼치거나 접어 프

리셋 목록을 정돈된 상태로 유

지합니다. 앱 시작 시 Capture 

Class 그룹이 열려 있고, Classic, 

MCMC, Hybrid, Custom은 닫혀 있

습니다. 헤더 (전체 영역 클릭 가

능) 를 클릭하면 목록이 짧은 셰

브런 애니메이션과 함께 위아래

로 펼쳐지거나 접힙니다. 오른쪽

의 작은 숫자는 카테고리에 몇 

개의 프리셋이 있는지 보여 줍니

다. 앱을 재시작하면 기본 상태

로 돌아옵니다 — 앱은 이 접기 

설정을 의도적으로 저장하지 않

습니다.

Training Configuration 섹션 (I12–I22)

그림 11:  Training Configuration 섹션만 크롭 — Camera Alignment (Apple Photogrammetry 활성, 
Native (Beta) 비활성), Densification (Classic 활성), Max Iterations 5,000 / Densify Until 3,500 
링크 심볼 포함, SSIM Weight 슬라이더 0.20, Render Scale 슬라이더 100 % (1,536×2,048 = 3.1 MP)

여기에는 핵심 레버가 모입니다. 어떤 SfM 백엔드가 계산할지, Densification이 어떻게 작동할지, 몇 
번의 반복을 수행할지, SSIM 가중치를 얼마로 할지 등입니다. MCMC 전략의 경우 두 가지 추가 토
글 (“MCMC Quality”와 “Auto-scale by scene”) 이 나타나며, Classic 모드에서는 숨겨집니다. 
Native SfM 백엔드의 경우 FOV 재정의 필드가 추가되며, EXIF 초점 거리가 없는 비디오 프레임에만 필
요합니다.
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I12 Camera Alignment 선택기

위치

인스펙터 → Training Configuration → Camera 
Alignment (상단 세그먼트 선택기).

기술적  설명

Apple Photogrammetry와 Native (Beta) 두 가지 옵션이 
있는 세그먼트 선택기입니다. 선택은 다음 카메라 재구성에서 
사용되는 SfM 백엔드를 결정합니다. 동시에 어떤 추가 인스펙
터 요소가 표시될지에도 영향을 줍니다. Native는 EXIF가 없는 
비디오 프레임에만 필요한 FOV 재정의 (I13) 를 추가로 표시합
니다. 참고: 매우 큰 야외 촬영의 경우 외부 도구 (Metashape 
또는 COLMAP) 의 결과를 Workspace 가져오기로 적용할 
수 있습니다 — 제 1 장 (M5) 과 제 9 장 (Q3, Q6) 참고.

간단히  말하면

여기서 카메라 위치가 어떻게 재

구성될지 선택합니다 — 최종 품

질에 가장 중요한 스위치입니

다. Apple Photogrammetry는 빠

른 표준이며 대부분의 객체 스

캔에 충분합니다. Native (Beta) 

는 App Store 호환 자체 개발판

이며, 궤도와 턴테이블 장면에 

좋고, EXIF가 없는 비디오 프레

임에는 FOV 재정의 (I13) 가 필

요합니다. 매우 큰 야외 세트의 

경우 대신 Metashape나 COLMAP

에서 카메라를 계산하고 결과

를 Workspace 가져오기로 불러

올 수 있습니다. 장면 유형별 자

세한 내용과 권장 사항은 제 9 장

에 있습니다.

I13 FOV Override 필드 (Native SfM)

위치

인스펙터 → Training Configuration → FOV Override 
(Camera Alignment = Native일 때만 표시).

기술적  설명

숫자 텍스트 필드 (범위 0-170°), 기본값 0 = EXIF 또는 휴리
스틱으로부터의 자동 결정. 입력 이미지가 초점 거리 메타데이
터가 없는 비디오에서 추출된 경우 수동 입력이 필요합니다. 일
반적인 값: iPhone Wide ≈ 73°, DJI Mavic Wide-Crop ≈ 
70°, 풀프레임 센서 드론 ≈ 84°. 값은 [0, 170] 으로 클램프
됩니다 — 범위 외 값은 직접 잘립니다. Native SfM 파이프라
인 (Q4/Q5) 에만 영향을 줍니다. Apple Photogrammetry
는 이 값을 완전히 무시합니다.

간단히  말하면

이미지에 EXIF가 없는 경우 (추출

된 비디오 프레임에서 일반적), 

여기에 카메라의 수평 시야각

을 도 단위로 입력합니다. 경험

값: iPhone Wide ≈ 73°, DJI Mavic 

Wide-Crop ≈ 70°, 풀프레임 센서 

드론 ≈ 84°. 0이면 앱이 직접 추정

합니다 — 종종 잘 동작하지만 드

문 렌즈에서는 실패할 수 있습니

다. 170°를 초과하는 값은 자동으

로 잘립니다. 이 필드는 Camera 

Alignment (I12) 로 Native를 선택

한 경우에만 표시되고 유효합니

다 — Apple Photogrammetry는 

완전히 무시합니다.

43 / 216



R A D I A N C E K I T 제 2 장 — 인스펙터 (Expert View)

I15 Densification 선택기

위치

인스펙터 → Training Configuration → Densification (세
그먼트 선택기, 항상 표시).

기술적  설명

두 Densification 전략 사이를 전환합니다: Classic 
(Clone/Split/Prune과 Gradient Threshold를 사용하
는 원본 3DGS 방법) 와 MCMC (Relocation과 함께 
Stochastic Gradient Langevin Dynamics, NeurIPS 
2024). Classic에서 MCMC로 전환할 때 앱은 MCMC 특
정 필드를 검증된 기본값으로 자동 설정합니다 (Reg-Weights 
= 0, MCMC-Cap-Multiplier 3.0, Sample/Noise 스케
줄). 이러한 자동 초기화가 없으면 오래된 프리셋이 있는 세
션이 1.4.4 MCMC-Collapse 버그 (460K→5 Gaussians, 
Watchdog Kill) 의 영향을 받습니다. 선택기 선택은 또한 어
떤 인스펙터 요소가 표시될지 결정합니다 — MCMC에서는 
I16/I17이 나타납니다. 자세한 필드 효과는 제 6 장, T11–T16 
(Classic) 과 T61–T73 (MCMC) 에 있습니다.

간단히  말하면

Gaussian 수 증가에 대한 핵심 전

략 선택입니다. Classic은 459회 

실험에서 잘 조정되어 있고, 빠

르고 고품질의 결과를 생성하며, 

MCMC 필드를 알 필요가 없습니

다. MCMC는 더 새로운 접근 방

식 (NeurIPS 2024) 이며 더 재현 

가능하고 수동 임곗값 조정이 필

요 없습니다 — 하지만 비슷한 품

질에서 약 6배 더 오래 걸립니

다. MCMC로 전환할 때 앱은 1.4.4 

Collapse를 방지하기 위해 안전

한 기본값을 자동으로 설정합니

다. 전략 필드에 대한 자세한 내

용은 제 6 장 (T11–T16 Classic, 

T61–T73 MCMC) 에 있습니다.

I16 MCMC Quality 토글

위치

인스펙터 → Training Configuration → MCMC Quality 
(Densification = MCMC일 때만).

기술적  설명

Gradient Accumulation을 2단계 (활성) 또는 1단계 (비활
성) 로 전환합니다. 옵티마이저 스텝이 실행되기 전에 연속된 두 
개의 카메라 뷰의 그래디언트를 누적합니다. 경험적으로 (세션 
33, V544a) 최종 L1 오류를 약 6% 줄입니다 (Horse-Full-
MCMC에서 3-trial 평균으로 Quality 포함 0.0246, 미포함 
0.0261). 대가: 학습 시간 2배. 매우 긴 학습 (200K 반복) 의 
경우 추가로 10분 이상의 대기 시간이 발생합니다 — 따라서 마
지막 몇 퍼센트의 품질이 정말로 필요할 때만 가치가 있습니다. 
학습에만 영향을 주고, 내보내기 형식이나 뷰포트 표시에는 영
향을 주지 않습니다.

간단히  말하면

두 뷰에 대한 Gradient 

Accumulation이 있는 MCMC의 

Quality 모드입니다. 경험적으로 

최종 결과를 약 6% 개선합니다 

(Horse 테스트에서 L1 0.0261 대

신 0.0246). 대신 두 배 더 오래 

걸립니다. 이미 200K MCMC 학습 

(보통 2시간) 을 실행 중이라면 

거의 1시간이 추가됩니다. 최종 

쇼케이스 렌더링이나 품질 스윕 

세션 마지막에 가치가 있고, 일

상 워크플로에는 적합하지 않습

니다. Densification이 MCMC (I15) 

일 때만 표시됩니다.
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I17 Auto-scale by scene 토글

위치

인스펙터 → Training Configuration → Auto-scale by 
scene (MCMC일 때만).

기술적  설명

활성화되면 효과적인 Max-Gaussians 상한이 SfM Init 포인
트 수 × MCMC-Cap-Multiplier (기본 3.0) 와 함께 확장
됩니다. 예: SfM이 250K 초기 점을 제공하고 베이스 Cap = 
150K, Multiplier 3.0 → 효과적 상한 = max(150K, 750K) 
= 750K. 비활성화되면 베이스만 엄격히 적용됩니다. v1.4.5
를 위해 도입되었습니다. 1000 프레임 이상과 상응하는 높은 
SfM 점 밀도의 큰 야외 촬영이 경직된 150K 기본 Cap에 의해 
Densification을 굶주리게 했기 때문입니다 — 잉여 점들은 남
고 새 점들은 생길 수 없었습니다. Custom 프리셋에서는 OFF 
기본, MCMC 내장에서는 ON. 학습 시에만 효과, 내보내기에
는 영향 없음.

간단히  말하면

Gaussian의 최대 수를 장면 크

기 (정확히는 SfM 초기 점 수) 와 

함께 확장하도록 허용합니다. 작

은 장면에서는 차이를 거의 느끼

지 못합니다. 큰 야외 장면에서

는 종종 품질에 결정적입니다 — 

그렇지 않으면 학습이 “질식”합

니다. 150K의 기본 상한이 장면

에 비해 너무 낮기 때문입니다. 

v1.4.5를 위해 특별히 도입되었

습니다. 매우 큰 야외 세트 (1000 

프레임 이상) 가 눈에 띄게 Cap

에 걸리는 것을 확인한 후입니

다. MCMC 내장 프리셋에서는 미

리 켜져 있고, 자체 프리셋에서

는 기본으로 꺼져 있습니다.

I18 Max Iterations 스테퍼

위치

인스펙터 → Training Configuration → GroupBox → 
Max Iterations.

기술적  설명

범위 1 000–100 000, 단계 1 000인 스테퍼입니다. 옵
티마이저 반복의 총 수를 결정합니다. 학습 시간과 선형 상
관 (절반 = 약 50% 시간). 경험적 스위트 스폿: 20K 
(Classic Balanced, L1≈0.028), 40K (Classic Quality, 
L1≈0.023), 200K (MCMC Full, L1≈0.0246). Classic에
서 40K 이상은 평균적으로 거의 개선을 가져오지 않습니다 — 
Diminishing Returns. 변경 시 Link 기능 (I19) 이 활성이
면 Densify Until이 비례적으로 함께 끌려갑니다 (기본 비율: 
0.5, 즉 Densify-Until = Max/2).

간단히  말하면

얼마나 많은 학습 단계를 수행할

지 — 더 많을수록 더 좋지만 그

만큼 선형적으로 더 많은 시간

이 듭니다. 경험 법칙: 좋은 품질

에 20 000, Classic 전략의 최적에 

40 000 (그 이상은 평균적으로 

거의 더 가져오지 못함). MCMC

는 훨씬 더 많이 필요하며, 200 

000이 여기서 표준입니다. 반복

을 두 배로 늘리면 학습 시간이 

대략 두 배가 됩니다. Link 버튼 

(I19) 이 활성이면 Densify Until이 

비례적으로 함께 끌려갑니다 — 

실제로 항상 원하는 동작입니다.
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I19 Link/Unlink 버튼 (Densify ↔ Iterations)

위치

인스펙터 → Training Configuration → GroupBox → 
Max Iterations와 Densify Until 사이의 작은 Link 버튼.

기술적  설명

Densify Until과 Max Iterations의 비율을 고정하는 토글 버
튼입니다. 활성 (Link 아이콘 강조) 일 때는 Max Iterations의 
변경 시마다 Densify Until이 비례적으로 따라옵니다. Unlink 
(Link-Plus 아이콘) 일 때는 값이 독립적으로 유지됩니다. 기
본은 linked입니다. 이것이 일반적인 상관관계를 반영하기 때문
입니다 — 학습을 두 배 반복으로 늘리면 보통 Densification
도 비례적으로 더 오래 실행하기를 원합니다. 비율은 Link 버튼 
설정 시 현재 값에서 계산됩니다. 일반적인 비율은 0.5입니다 
(Densify-Until = 반복 수의 절반).

간단히  말하면

Max Iterations와 Densify Until 사

이의 작은 괄호 버튼입니다. 활

성 (Link 아이콘 강조) 일 때는 두 

값이 함께 이동합니다 — 반복을 

두 배로 늘리면 Densify Until도 

같은 비율로 두 배가 됩니다. 아

닐 때 ( link.badge.plus  아이

콘) 는 독립적으로 설정할 수 있

습니다. 기본값은 linked입니다. 

일반적인 상관관계 — 더 긴 학습

은 보통 더 긴 Densification 단계

를 원합니다 — 를 반영하기 때문

입니다. 99%의 경우 잠긴 상태로 

두십시오.

I20 Densify Until 스테퍼

위치

인스펙터 → Training Configuration → GroupBox → 
Densify Until.

기술적  설명

범위 500–50 000, 단계 500인 스테퍼입니다. Clone/Split 
(Classic) 또는 Relocation (MCMC) 을 통해 새 Gaussian
이 더 이상 추가되지 않는 반복 인덱스를 결정합니다. 도달 후
에는 위치와 색상만 정제됩니다. 값이 클수록 = Gaussian 
더 많음 = 더 큰 파일, 더 긴 반복당 시간 (스텝당 GPU 시
간 +30-60%). 일반적인 값: 15K (30K Max-Iter용), 20K 
(40K용), 100K (200K MCMC용). Link (I19) 가 활성이
면 자동으로 함께 확장됩니다. Classic과 MCMC에서 다르
게 작용합니다: Classic은 성장을 완전히 중지하고, MCMC는 
Relocation 로직을 중지하지만 Sample/Noise 적응은 계속 
실행됩니다.

간단히  말하면

어느 반복까지 새 Gaussian이 추

가될 수 있는지 — Classic의 경

우 Clone/Split을 통해, MCMC의 

경우 Relocation을 통해. 그 후에

는 기존 점의 색상과 형태 정제

만 진행됩니다. 높을수록 = 더 많

은 세부 정보, 그러나 더 큰 파

일과 스텝당 +30-60% GPU 시간. 

일반적인 값: 15K (30K Max-Iter), 

20K (40K), 100K (200K MCMC). 일

반적으로 Link (I19) 를 통해 Max 

Iterations에 매여 있습니다 — 수

동으로 분리하는 것은 거의 의미

가 없습니다.
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I21 SSIM Weight 슬라이더

위치

인스펙터 → Training Configuration → GroupBox → 
SSIM Weight.

기술적  설명

0.05 단계로 0.0–1.0 슬라이더, “0.20”으로 표시됩니다. L1 
Loss (0.0) 와 SSIM Loss (1.0) 를 혼합합니다. L1은 픽셀당 
밝기를 조이고, SSIM은 구조적 유사성 (가장자리, 로컬 통계) 
을 조입니다. 기본값 0.2는 원본 3DGS 논문 (Kerbl 2023) 
의 값이며 수많은 세션에서 강건한 타협안으로 역설계되었습니
다. 더 높은 값 (0.5+) 은 세부 보존을 선호하지만 로컬 밝기 
오류를 무시할 수 있습니다. 더 낮은 값 (< 0.1) 은 선명한 가
장자리에서 세부 손실로 이어집니다. SSIM 계산은 셰이더에서 
11×11 Gaussian 윈도우로 실행됩니다. 성능: 0.0 (L1만) 에
서 학습이 약 8-12% 더 빠릅니다. 셰이더에서 SSIM 계산이 
건너뛰어지기 때문입니다.

간단히  말하면

순수한 밝기 비교 대비 구조적 

이미지 유사성 (가장자리, 로컬 

패턴) 의 가중치가 얼마나 강할

지. 0.2는 원본 3DGS 논문의 표

준이며 거의 모든 장면에 충분합

니다. 머리카락, 모피 또는 식물 

같은 미세 구조에서는 더 높이 

(0.5+) — 거기서는 더 많은 구조 

가중치가 도움이 됩니다. 더 낮

게 (0.0) 하면 학습이 약 8-12% 더 

빨라집니다. 셰이더에서 SSIM 계

산이 건너뛰어지기 때문입니다. 

대신 선명한 가장자리의 세부 정

보를 잃습니다. 변경에 대한 충

분한 이유가 없다면 0.2를 그대

로 두십시오.

I22 Render Scale 슬라이더

위치

인스펙터 → Training Configuration → GroupBox → 
Render Scale.

기술적  설명

0.25 단계로 0.25–1.0 슬라이더, “100%”로 표시됩니다. 원
본 이미지 크기 대비 학습 렌더링 해상도를 확장합니다. 성능에
서 가장 큰 레버: 50%는 GPU 시간을 약 75% 줄이고 (4배 
적은 픽셀이므로), 25%는 약 94%. Gradient Threshold
는 자동으로 함께 확장됩니다. 슬라이더 아래에 MP 단위의 
실시간 해상도 표시가 나타납니다 (예: “2304×1296 (3.0 
MP)”). 현재 값이 권장값과 다른 경우 주황색 글자로 “— 
recommended: 50%”가 표시됩니다. 권장 사항은 ~3 MP 
효과적 해상도를 목표로 합니다 — Apple Silicon GPU가 가
장 효율적으로 처리할 수 있는 범위입니다. 예: 4K 원본 이미지
는 자동으로 25%, FullHD 이미지는 100%가 권장됩니다. 변
경 시 버퍼 재할당도 트리거됩니다.

간단히  말하면

학습이 어떤 해상도로 렌더링할

지 — 성능에서 가장 큰 레버 중 

하나입니다. 전체 (100%) 는 최

고 품질을 제공하지만 큰 이미지

에서는 많은 GPU 시간이 듭니다. 

반 (50%) 은 약 75% GPU 시간을 

절약합니다. 네 배 적은 픽셀이 

계산되기 때문입니다 — 4K 원본

에 완벽합니다. 슬라이더 아래에 

효과적 해상도가 메가픽셀로 표

시됩니다. 앱은 약 3 MP를 목표

로 합니다. Apple Silicon에서 가

장 효율적으로 실행되기 때문입

니다. 값이 거기서 벗어나면 앱

이 주황색 “recommended” 힌트

를 표시합니다 — 보통 따르는 것

이 좋습니다.
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Enhancements 섹션 (I26–I29, I42–I44)

그림 12:  Enhancements 섹션만 크롭 — 세 행: Post-Training Compactification (토글 켜짐), 
Viewport Scaling (세그먼트 선택기 Off/MetalFX/Lanczos), Perceptual Loss (슬라이더 “Off”). 각 행

은 기능을 설명하는 부제목 포함

Enhancements 섹션은 핵심 학습 루프 자체를 변경하지 않고 이미지 품질을 개선하는 세 가지 기
능을 그룹화합니다. 처음 두 가지 (I26-I27) 는 Post-Training 또는 Viewport 단계 입니다. 
Compactification은 학습 종료 후 정리하고, Viewport Scaling은 순수한 뷰포트 렌더러로 실행 중인 
학습에 영향을 주지 않습니다. Perceptual Loss (I29) 는 섹션 소속에도 불구하고 학습 구성 요소입니다 
— 학습 중에 추가 Loss 항으로 활성화되므로 구분선을 통해 뷰포트 토글과 분리됩니다. v1.6부터 이 섹션
에는 Outdoor 그룹 (I42–I44: Sky Masking, Mid-Training Floater Cleanup, Reconstruct Sky 
Dome) 도 있습니다 — 이전에 설정 창에 있다가 이제 프로젝트별로 여기에 자리 잡은, 하늘 플로터에 대응
하는 학습 옵션입니다.
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I26 Post-Training Compactification 토글

위치

인스펙터 → Enhancements → Post-Training 
Compactification.

기술적  설명

V443 Post-Processing을 활성화합니다. 학습 반복 종료 
후 Opacity 0.01 (1% 가시성) 미만의 Gaussian이 삭제됩
니다. 경험적으로 이는 시각적 품질 손실 없이 파일 크기를 
~55-58% 줄입니다 — 이러한 Gaussian은 어쨌든 시각적으
로 기여하지 않기 때문입니다. Compactification은 GPU 컴
팩트 패스로 실행되며 Gaussian 수에 따라 1초 미만에서 몇 초
까지 걸립니다. 학습 성능에는 영향을 주지 않습니다. 이 토글
이 꺼져 있으면 보이지 않는 Gaussian도 내보내집니다 — 추
가 학습 단계 (Continue Training) 용으로 형식을 사용하려는 
경우에만 관련성이 있고, 그렇지 않으면 저장 공간 낭비입니다.

간단히  말하면

학습 후 어차피 볼 수 없는 

Gaussian (Opacity 1% 미만) 을 정

리합니다. 시각적 품질 손실 없

이 내보낸 파일을 약 절반 크기

로 줄입니다 ( 55-58% 크기 감

소). 마지막 반복 후 짧은 GPU 패

스로 실행되며 1초 미만에서 몇 

초만 걸립니다. 실질적으로 항상 

켜져 있어야 합니다 — 이를 끄는 

유일한 이유는 나중에 Continue 

Training으로 학습을 이어 가고 

싶고 보이지 않는 Gaussian도 보

관해야 하는 경우입니다. 일반적

인 내보내기 워크플로에서는 그

냥 켠 상태로 두십시오.
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I27 Viewport Scaling 선택기

위치

인스펙터 → Enhancements → Viewport Scaling (세 가
지 옵션 Off, MetalFX, Lanczos가 있는 세그먼트 선택기).

기술적  설명

뷰포트 업스케일러를 선택하는 단일 세그먼트 선택기로 — 세 
옵션은 상호 배타적입니다. 학습 해상도 (I22 Render Scale 
을 통해) 가 뷰포트 크기보다 낮은 경우 선택된 모드가 렌더링
된 프레임을 디스플레이 크기로 업스케일합니다. Off = 단순
한 바이리니어 확대. MetalFX = Apple의 ML 기반 Spatial 
Upscaler로, 가장 선명한 옵션 (ML 모델이 선명한 가장자
리에 최적화됨), M3 GPU에서 프레임당 약 1-2ms 오버헤
드. Lanczos = Apple의 Metal Performance Shaders
와 8-Tap Sinc 재샘플링으로, ML이 없는 고전적 방식, 최소 
오버헤드 (< 0.5ms), 품질은 MetalFX보다 낮지만 ML 특유
의 미세한 선 구조 “부드럽게 다리기”가 없습니다. 렌더러 파이
프라인은 전환 시 실시간으로 재구성됩니다 — 재시작 없이 즉
시 보입니다. 배경: 이전에는 두 개의 별도 토글 (MetalFX + 
Lanczos) 이었고 동시에 켜질 수 있었습니다 — MetalFX가 
조용히 Lanczos를 덮어쓰는 모순된 상태였습니다. 선택기는 
이 상태를 제거합니다; 오래된 세션에서 상속된 “둘 다 켜짐” 상
태는 다음 전환 시 스스로 MetalFX로 치유됩니다. 실시간 뷰포
트에만 작용하고, 렌더링된 내보내기 (Orbit 비디오, 스크린샷) 
에는 작용하지 않습니다 — 그것들은 전체 원본 해상도로 렌더
링됩니다.

간단히  말하면

뷰포트의 실시간 이미지를 선명

하게 끌어올립니다 — 특히 축

소된 학습 해상도 (Render Scale 

50%, I22 참고) 로 작업할 때 유

용합니다. 항상 하나만 활성화되

는 세 단계: “Off”는 단순히 픽셀

을 늘리고, “MetalFX”는 Apple의 

머신 러닝으로 가장 선명한 가장

자리를 제공하며 (실질적으로 항

상 최선), “Lanczos”는 ML이 없는 

고전적 필터입니다 — MetalFX

가 어떤 장면에서 선을 매끄럽

게 만들거나 아티팩트를 보이면 

대체로 사용하십시오. 재시작 없

이 실시간으로 적용됩니다. 실시

간 뷰포트에만 작용하고 내보낸 

Orbit 비디오나 스크린샷에는 작

용하지 않습니다 — 그것들은 전

체 원본 해상도로 렌더링됩니다. 

이전과 달리 더 이상 실수로 두 

모드를 동시에 선택할 수 없습니

다.
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I29 Perceptual Loss 슬라이더

위치

인스펙터 → Enhancements → Perceptual Loss.

기술적  설명

0.01 단계로 0.0–0.2 슬라이더, 0.0에서 “Off”로, 그렇지 
않으면 “0.05” 등으로 표시됩니다. 렌더링의 다중 스케일 
Gaussian Blur를 Ground Truth 이미지와 비교하는 추가 
Loss 항을 활성화합니다 (3 Blur 스케일). L1+SSIM만으로는 
인식하지 못하는 구조적 차이를 포착합니다. V460 구현. 경험
적으로 0.05-0.1의 값은 세션의 L1 점수를 몇 퍼센트 개선하지
만 ~5% 학습 시간이 듭니다 (Blur 커널을 통한 추가 Forward 
Pass). 0.15 이상에서는 학습이 불안정해지고 L1이 다시 악화
됩니다 (Loss 항이 최적화를 지배). 학습 중에 작용하고 Post-
Processing에는 작용하지 않습니다 — “Enhancements” 
섹션의 위치에도 불구하고 순수한 후속 업그레이드는 아닙니다.

간단히  말하면

세 가지 흐림 단계에서 구조적 

이미지 유사성을 점검하는 추가 

Loss 부분입니다. 머리카락, 천 

또는 식물 같은 미세 구조가 있

는 장면에서 특히 도움이 됩니

다. L1+SSIM만으로는 보지 못하

는 패턴을 포착하기 때문입니

다. 작은 값이 더 안전합니다 — 

0.05에서 0.1이 스위트 스폿이

고, 0.15 이상에서는 학습이 불안

정해지고 Loss가 다시 악화됩니

다. 0 (Off) 에서는 기능이 완전

히 꺼져 있고 비용이 없습니다. 

활성이면 Blur 커널을 통한 추가 

Forward Pass에 약 5% 학습 시간

을 소비합니다. “Enhancements” 

섹션에도 불구하고 학습 중에 직

접 작용하고 Post-Processing에

서는 작용하지 않습니다.
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I42 Sky Masking

위치

인스펙터 → Enhancements (Outdoor 그
룹) → “Sky Masking” 토글. 연결: 
AppState.trainingConfig.skyMaskingEnabled (프로
젝트별, @DefaultFalse ). 기본값: false .

기술적  설명

학습 전 Apple Vision 기반 하늘 픽셀 세분화를 활성화합니
다. 학습 시작 전 각 입력 카메라의 하늘 영역이 Apple Vision 
Foreground Mask (Sky = Background) 를 통해 추출되
어 해당 카메라의 픽셀별 마스크로 할당됩니다. 학습 중 픽셀당 
Loss 기여는 하늘 마스크의 보수와 곱해집니다 — 하늘 픽셀은 
그래디언트에 0으로 기여하므로 하늘로 투영되는 Gaussian은 
최적화 신호를 받지 않고 따라서 “더 밀도가 높아지거나” “더 
밝아지지” 않습니다. 야외/드론 장면의 플로터 (하늘의 어두운 
덩어리) 를 상당히 줄입니다. 고전적 40K 학습에서 ~3% L1 
회귀 비용이 발생합니다 (memory/​dev_​outdoor-floater-
reduction.md 참고). 명확하게 인식 가능한 하늘이 있는 야외 
장면에서만 의미가 있습니다. 실내 장면 또는 흰색 배경에서는 
하늘 세분화가 잘못된 영역을 식별하고 유효한 Loss 신호를 차
단합니다. 이 값은 이제 프로젝트별로 저장되며 (더 이상 앱 전
역이 아님) 프리셋 / 장면 파일을 따릅니다.

간단히  말하면

하늘이 보이는 야외 촬영에서

는 종종 하늘에 검거나 다채로

운 덩어리가 생깁니다 — 이른

바 “플로터”. 이 옵션은 하늘

이 어디에 있는지 자동으로 인

식하고 학습에게 “하늘은 그대

로 두라”고 말합니다. 드론 비

행과 풍경 장면에서 매우 잘 작

동합니다. 실내나 어두운 배경

에서는 이미지를 악화시킬 수 

있습니다 — 따라서 실제 하늘

이 보일 때만 켜십시오. 자세한 

내용: memory/​dev_​outdoor-
floater-reduction.md.
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I43 Mid-Training Floater Cleanup

위치

인스펙터 → Enhancements (Outdoor 그룹) → 
“Mid-Training Floater Cleanup” 토글. 연결: 
AppState.trainingConfig.floaterCleanupEnabled 
(프로젝트별, @DefaultFalse ). 기본값: false .

기술적  설명

Classic 40K 학습 (프리셋 “P4 Quality”) 에서 두 가지 추
가 Density Control 패스를 켭니다: 반복 20 000과 30 
000. 두 패스는 세 가지 기준으로 모든 Gaussian을 검색합니
다: (a) 매우 낮은 Opacity (표준 0.005), (b) 작은 Screen 
Space 크기, (c) 지난 1000회 반복 동안 Loss 기여 없음. 
세 조건을 모두 충족하는 Gaussian은 정리됩니다. 효과: 학
습 종료 시 ~5–15% 적은 Gaussian, 드론/야외 장면의 하늘
에서 어두운 덩어리가 눈에 띄게 적음. 클로즈업 실내 장면에
서 ~1–3% L1 회귀 비용이 발생하므로 기본값으로 활성화되
지 않습니다. 값은 재시작 간에 기억됩니다 (S7과 달리). 두 정
리 반복 (20K, 30K) 은 단단히 정의되어 있으며 현재 UI를 통
해 변경할 수 없습니다. 더 짧은 학습 (예: P2 Preview 5K) 
에서는 토글이 반복 표시에 도달하지 않으므로 효과가 없습니
다. 신규: 이 토글은 이제 활성 프리셋이 Classic Densifier를 
사용할 때만 조작할 수 있습니다 (densificationStrategy 
== .classic). MCMC나 Hybrid에서는 비활성화되고 인라
인 힌트가 나타납니다. 이러한 전략은 죽은 Gaussian을 어차
피 자체적으로 처리하기 때문입니다 (MCMC는 Relocation, 
Hybrid는 결합된 Reloc-/Noise 로직) — 그곳에서는 수동 
Cleanup Pass가 효과가 없거나 역효과를 낳습니다. 코드 
참조: RadianceKitApp.swift, General 탭. 자세한 내용: 
memory/​dev_​outdoor-floater-reduction.md.

간단히  말하면

학습 중에 가끔 이미지 품질에 

더 이상 기여하지 않지만 메모리

를 차지하는 “죽은” Gauss 점이 

생깁니다. 이 옵션은 긴 학습 중

에 두 번 (20K와 30K 반복에서) 

정리하고 이 시체를 제거합니다. 

하늘이 있는 야외 장면에서는 대

부분의 플로터가 거기에 모이므

로 특히 유용합니다. 작은 학습

이나 가구 클로즈업에서는 별

로 필요하지 않습니다. 이 스위

치는 프리셋이 Classic Densifier

를 사용할 때만 켤 수 있습니다 

— MCMC나 Hybrid 프리셋에서

는 회색으로 비활성화됩니다 (짧

은 설명 포함), 그것들은 죽은 점

을 스스로 정리하기 때문입니다.
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I44 Reconstruct Sky Dome

위치

인스펙터 → Enhancements (Outdoor 그룹) 
→ “Reconstruct Sky Dome” 토글. 연결: 
AppState.trainingConfig.skyDomeEnabled (프로젝트
별, @DefaultFalse ). 기본값: false .

기술적  설명

학습 전 하늘 돔 투영 (V549e MVP) 을 활성화합니다. SfM 
후, 학습 시작 전에 각 입력 카메라에 대해 S7과 공유된 Apple 
Vision 하늘 마스크가 이미지에서 추출되고, 하늘 픽셀은 카메
라 인트린식과 함께 가상 구체 표면 (표준 반경 8× 장면 반경) 
으로 역투영됩니다. 이 구체에서 ~5000개의 새 Gaussian
이 투영된 하늘 픽셀의 평균 색상값, 매우 큰 스케일 (장면 단
위 1.0), 초기 Opacity 0.95로 초기화됩니다. 이 5000개의 
Gaussian은 고전적 의미의 Sky Mask가 아닙니다 — 다른 것
들과 마찬가지로 학습되지만 높은 초기 Opacity를 통해 얇은 
껍질로 남습니다. 결과: 야외/드론 장면의 360° 새 시점에서 어
두운 컨페티 덩어리 대신 실제 하늘 색상과 구름 구조가 나타납
니다. 값은 재시작 간에 기억됩니다. 최소 360° 카메라 커버리
지가 있는 야외 장면에서만 의미가 있습니다. 하늘 뷰가 없는 순
수 객체 캡처에서는 효과가 없습니다. 상태: 실험적, 추가 야외 
세트에 대한 더 폭넓은 A/B 검증이 아직 남아 있습니다.

간단히  말하면

학습이 몇 픽셀의 보이는 부분에

서 하늘을 “추측”하려고 시도하

는 대신 (이는 플로터로 이어짐), 

RadianceKit은 학습 시작 전에 하

늘 픽셀을 장면 주위의 가상 구

체에 직접 투영합니다. 완성된 

장면을 360°로 회전하면 검은 덩

어리 대신 실제 하늘이 보입니

다. 실제로 하늘이 보이는 야외 

촬영에서만 작동합니다. 거실 스

캔이나 스튜디오 촬영에서는 아

무 효과도 없습니다.
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Metrics 섹션 (I30–I38)

그림 13:  Bouquet에서 학습 완료 후 Training Metrics 섹션만 크롭 (5K 반복, 최종 2 991 Gaussians) — 
학습 메트릭 테이블 (Iteration, Loss, SSIM Loss, Combined Loss, Gaussian Count, Learning Rate, 

Elapsed, ETA)

학습이 실행되는 동안 Metrics 섹션은 학습 루프의 아홉 가지 실시간 값을 표시합니다. 학습 시작 전에는 
섹션이 비어 있습니다 (“Start training to see live metrics”). 모든 값은 ~30회 반복마다 업데이트됩
니다 (AsyncStream 업데이트 빈도). 섹션은 읽기 전용입니다 — 어떤 요소도 클릭하거나 변경할 수 없습
니다. 더 깊은 분석을 위해서는 ~/​Documents/​RadianceKit/​Logs/​ 아래의 JSONL 학습 로그를 참고
하십시오 (스크립트 python3
scripts/​analyze_​logs.py best 5).
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I30 Iteration

위치

인스펙터 → Metrics → Iteration. 읽기 전용.

기술적  설명

“4523 / 40000” 형식으로 표시됩니다 — 현재 반복과 계획
된 총 반복. 학습 루프와 동기적으로 카운트되며, 루프는 ~30 
Iter마다 값을 푸시합니다. 두 번째 숫자는 시작 시점의 Max 
Iterations 값에 해당합니다. 사용자가 그 후 스테퍼를 조정해
도 변경되지 않습니다 — 실행 중인 실행은 자체 스냅샷 복
사본을 사용합니다. 학습 메뉴를 통해 앱이 반복을 추가하면 
(Continue Training +5K/+10K/+20K) 분모가 증가합니다.

간단히  말하면

학습이 지금 어디에 있는지. 

“4523 / 40000”은 40 000 단계 

중 4523 단계가 끝났다, 즉 약 

11%가 완료되었다는 의미입니

다. 왼쪽 숫자는 초 단위로 증가

합니다. 몇 분 동안 멈춰 있으면 

학습이 막혀 있는 것입니다 — 일

반적으로 GPU 스로틀링이나 경

쟁 앱의 표시입니다. 오른쪽 숫

자는 학습 시작 시 Max Iterations 

값 (I18) 에 해당하며, 나중에 스

테퍼를 조정해도 변경되지 않

습니다. Continue Training (+5K/

+10K/+20K) 의 경우 추가 단계만

큼 함께 증가합니다.

I31 Loss

위치

인스펙터 → Metrics → Loss. 읽기 전용.

기술적  설명

소수점 6자리의 Float 값 (예: “0.024385”). 결합된 
L1+SSIM Loss (I21 SSIM Weight를 통해 혼합 제어) 와 
선택적으로 Perceptual Loss (I29) 및 기타 정규화 항을 
측정합니다. 스케일은 절대적이지 않고 장면별이며 — 대부분
의 비교에 동일한 데이터셋이 필요합니다. 좋은 구성의 일반적
인 최종 값: - Classic Quality 40K iters: 0.022–0.025 
(Horse, Truck, Garden) - MCMC Full 200K iters: 
0.024–0.028 - Outdoor Drone 30K: 0.030–0.060 (형
상 때문에 더 나쁨) - Indoor 아파트: 0.018–0.025

5K 반복 후 0.10 초과 값은 SfM 문제 (나쁜 카메라 포즈) 를 
시사합니다 — 중단하고 SfM을 다시 계산하십시오.

간단히  말하면

렌더링된 이미지가 원본에서 얼

마나 벗어났는지 — L1, SSIM, 필

요 시 Perceptual Loss의 결합입

니다. 작을수록 좋습니다. 0.03 

미만은 대부분 정말 좋고, 0.05 

미만도 괜찮으며, 야외 장면은 

형상 때문에 0.03-0.06 정도입니

다. 수천 회 반복 후 0.10 이상은 

경고 신호입니다 — 보통 카메라 

재구성 (SfM이 깨끗하게 작동하

지 않음) 때문입니다. 스케일은 

절대적이지 않고 장면별입니다. 

같은 데이터셋 안에서만 비교하

십시오. 숫자가 갑자기 위로 뛰

면 보통 Gradient Explosion 이벤

트가 발생한 것입니다.
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I32 Learning Rate

위치

인스펙터 → Metrics → Learning Rate. 읽기 전용.

기술적  설명

과학적 표기법 표시 (예: “1.60e-04”). 위치 매개변수에 대한 
현재 학습률 (3DGS에는 위치, SH-DC, SH-Rest, Opacity, 
Scale, Rotation에 대한 여섯 개의 독립적인 LR이 있으며 
— 여기에는 위치 LR이 대표값으로 표시됨). 기본 시작값은 
1.6e-4이며, 지수 감쇠를 통해 학습 종료 시 ~1.6e-6까지 떨
어집니다. 감쇠는 학습 구성의 LR Schedule 필드 (제 6 장 T 
필드) 를 통해 조정할 수 있습니다. LR이 비정상적으로 높게 유
지되면 (예: 10K 반복 후 1e-3 이상) 잘못 로드된 구성을 시사
할 수 있습니다.

간단히  말하면

최적화 단계가 지금 얼마나 큰

지 — 구체적으로 Gaussian 위치

에 대한 학습률입니다. 1.60e-04

에서 시작하여 학습 종료 

시 약 1.60e-06까지 지수적으

로 감쇠합니다 (“1.60e-06” = 

0.0000016). 진행은 자동으로 실

행되며 여기서 조정할 필요가 없

습니다. 10 000+ 반복 후에도 값

이 1e-3보다 크다면 잘못된 구

성이 로드되었을 가능성이 큽니

다 — 학습을 중단하고 프리셋을 

새로 선택하십시오. 내부적으로 

3DGS는 여섯 개의 독립적인 학

습률 (Position, SH-DC, SH-Rest, 

Opacity, Scale, Rotation) 을 가집

니다. 여기서는 대표로 Position 

LR만 보입니다.

I33 SH Degree

위치

인스펙터 → Metrics → SH Degree. 읽기 전용.

기술적  설명

정수 0-3. 색상 표현에 대한 Spherical Harmonics 차수. 0 
(DC 성분만, 즉 Gaussian당 방향 독립적 색상 — 즉 RGB 상
수 하나만) 에서 시작하여 학습 진행 과정에서 점진적으로 3까
지 상승합니다. 표준 스케줄은 1000/2000/3000 반복에서 차
수를 1씩 올립니다. SH-3은 Gaussian당 48개의 색상 계수에 
해당합니다 (RGB 채널 3개 × SH 기저 함수 16개). 더 높은 
SH 차수 = 더 많은 방향 의존성 반사 (광택 표면이 다른 시점
에서 올바르게 다르게 보임), 그러나 더 많은 메모리와 더 느린 
학습.

간단히  말하면

Gaussian당 색상 표현이 지금 얼

마나 복잡한지. 0 (점당 하나

의 방향 독립적 색상만) 에서 

시작하여 단계적으로 3까지 올

라갑니다 — 일반적으로 1000, 

2000, 3000 반복에서. 3단계는 

Gaussian당 48개의 색상 계수를 

의미하며 방향 의존성 반사를 허

용합니다. 즉 광택 표면이 다른 

시점에서 올바르게 다르게 보입

니다. 적극적으로 조정할 필요가 

없습니다. 스케줄은 자동으로 실

행됩니다. 더 높은 차수는 더 많

은 메모리가 들고 학습을 약간 

느리게 합니다 — 그러나 그것이 

사실적인 하이라이트의 대가입

니다.
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I34 Gaussians

위치

인스펙터 → Metrics → Gaussians. 읽기 전용.

기술적  설명

현재 모델의 Gaussian 수로, Locale 구분자로 형식화됩니다 
(예: “524.318”). 성장: - Classic: SfM 초기 점 (일반적으
로 50K-300K) 에서 시작하여 Clone/Split을 통해 Densify 
Until 직전까지 성장한 뒤 학습 종료까지 정적 (Pruning 제
외) - MCMC: MCMC Cap까지 샘플 포인트 추가, 그 후 
Relocation만

건강한 최종 값: - Classic Quality: 400K-700K (Horse 
524K, Garden 800K) - MCMC Full: 정확히 Cap 위 (기
본 150K, Auto-Scale Multiplier × SfM Count로 장면에 
따라 500K-1.5M)

MCMC에서 숫자가 Cap의 < 60%로 떨어지면 → 이상 
(Collapse 지표, 너무 공격적인 정규화 항을 시사).

간단히  말하면

3D 모델이 지금 얼마나 많은 

Gaussian 점을 가지고 있는지. 

Densify Until (I20) 에 도달할 때

까지 학습 중에 증가합니다. 그 

후에는 숫자가 실질적으로 일정

하게 유지됩니다. 더 많은 점 = 

더 많은 세부 정보, 그러나 더 

큰 파일과 더 느린 뷰포트 렌더

링. 500.000 Gaussian은 중간 장

면의 Classic Quality의 일반적인 

평균값이고, MCMC Full은 Auto-

Scale (I17) 에 따라 500K에서 

1.5M에 달합니다. MCMC에서 숫

자가 갑자기 Cap의 60% 미만으

로 떨어지면 Collapse 지표입니

다 — 대개 너무 공격적인 정규화 

항입니다.

I35 GPU Memory

위치

인스펙터 → Metrics → GPU Memory. 읽기 전용.

기술적  설명

Gaussian 수 × 616 바이트 (Memory Style로 형식
화) 로 Gaussian 버퍼 메모리 사용량의 추정치. 616 바
이트는 완전히 갖춰진 Gaussian의 경험적 크기입니다 (위
치, 스케일, 회전, Opacity, SH 계수 차수 3, Gradient 
Accumulator). 표시는 렌더러 오버헤드 (Tile Buffer, Sort 
Buffer, Backward Buffer) 를 포함하지 않습니다 — 실
제 GPU 메모리 요구량은 일반적으로 이 값의 2-3배입니다. 
500K Gaussian에서: 표시 ~290 MB, 실제 ~700 MB. 
1.5M Gaussian에서: 표시 ~880 MB, 실제 ~2.5 GB. 64+ 
GB 통합 메모리의 M3 Max에서는 문제가 없지만, 18 GB의 
M3 Pro에서는 이미 한계입니다.

간단히  말하면

Gaussian 자체가 차지하는 GPU 

메모리의 추정 — 점당 약 616 바

이트. 실제 GPU 사용량은 표시값

보다 2-3배 높습니다. 렌더러가 

자체 Tile, Sort, Backward Buffer

를 추가하기 때문입니다. 16-18 

GB 통합 메모리의 MacBook에서

는 500K Gaussian 미만으로 유

지해야 합니다. M3 Max나 Studio 

(64+ GB) 에서는 1.5M 이상까지 

여유롭게 실행할 수 있습니다. 

학습이 갑자기 충돌하거나 시스

템이 스왑하면 보통 여기서 한

계에 도달한 것입니다 — Render 

Scale (I22) 을 내리거나 Densify 

Until (I20) 을 줄이십시오.
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I36 Speed

위치

인스펙터 → Metrics → Speed. 읽기 전용.

기술적  설명

소수점 한 자리의 초당 반복 수 (“24.3 it/s”). 트레이너에 의
해 최근 ~100 반복에 대한 슬라이딩 평균으로 계산됩니다. 일
반적인 값: - Quick Preset (1K iters): 80-120 it/s (짧음, 
Steady State 없음) - Classic 20K @ 1.0 Render Scale 
(Truck 장면, M3 Max): 25-35 it/s - Classic 20K @ 
0.5 Render Scale: 80-120 it/s - MCMC 200K @ 0.5 
Render Scale: 25-50 it/s (Relocation 때문에 더 느림) - 
1M+ Gaussian과 전체 해상도: < 10 it/s

학습 진행 과정에서 Speed 감소는 정상입니다 — 더 많은 
Gaussian = 반복당 더 많은 컴퓨팅. 갑작스러운 하락 (예: 30 
→ 5 it/s) 은 GPU 열 스로틀링이나 경쟁 앱을 시사합니다.

간단히  말하면

학습이 얼마나 빠르게 실행되는

지, 초당 반복 수로. 일반적으

로 20-50 it/s이고, 감소된 Render 

Scale (50%) 과 작은 장면에서는 

80-120 it/s도 있습니다. 학습 진

행 과정에서 자연스럽게 감소합

니다. 더 많은 Gaussian = 반복

당 더 많은 작업이기 때문입니

다. 갑작스러운 하락 (예: 30 → 5 

it/s) 은 GPU 열 스로틀링이나 경

쟁 앱을 시사합니다 — 비디오가 

있는 브라우저 탭, Time Machine 

백업, Photos 인덱싱. 앱을 전면

에 두고 백그라운드 프로그램을 

닫는 것이 종종 도움이 됩니다. 

1M+ Gaussian과 전체 해상도에

서는 10 it/s 미만이 정상입니다.

I37 Elapsed

위치

인스펙터 → Metrics → Elapsed. 읽기 전용.

기술적  설명

이미 경과한 시간으로 “4:23” (m:ss) 또는 
“1:23:45” (h:mm:ss). 1시간부터 형식이 전환됩니다. 순수한 
학습 시간만 측정합니다. 선행 단계 (SfM 계산, 이미지 가져오
기) 는 포함되지 않습니다. Pause/Resume 시 시계는 계속 흐
릅니다 — 즉 Wall Clock 시간이며 CPU 시간이 아닙니다.

간단히  말하면

학습이 이미 얼마나 오래 실행

되었는지, 순수 스톱워치 (Wall 

Clock 시간) 로. 형식은 한 시간까

지 “m:ss”, 그 후 “h:mm:ss”입니

다. “CPU 시간”이 아니라 “얼마

나 오래 기다리고 있는지” 입니

다 — 따라서 Pause 시간도 함께 

계산됩니다. 순수한 학습 단계만 

측정합니다. 선행하는 SfM 계산

이나 이미지 가져오기는 측정하

지 않습니다. ETA (I38) 와 비교

에 유용합니다 — Elapsed가 원

래 ETA를 훨씬 초과하면 학습이 

어디선가 계획보다 느려진 것입

니다.
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I38 ETA

위치

인스펙터 → Metrics → ETA. 읽기 전용.

기술적  설명

추정 남은 시간으로 “17:42” 또는 “1:12:35”로 표시됩니다. 
계산: (Max Iterations − 현재 Iteration) / 초당 반복 수. 
Speed가 현재 0인 경우 (가장 처음 또는 일시 정지 시) 
“–”를 표시합니다. 추정치는 학습 종료 시의 일반적인 감속에 
적응하지 않습니다 — 특히 MCMC와 큰 Densify Until 값
의 Classic은 더 많은 Gaussian이 이미지에 들어오면서 느
려지는 경향이 있습니다. 실제로는 일반적으로 초기 ETA보다 
10-20% 정도 더 오래 걸립니다.

간단히  말하면

얼마나 오래 더 기다려야 할지 

— 남은 반복과 현재 Speed (I36) 

에서 계산됩니다. 대략적인 추

정입니다. Mac이 갑자기 느려지

면 (Densify 단계부터 더 많은 

Gaussian, 열 스로틀링, 다른 앱) 

표시된 것보다 더 오래 걸릴 수 

있습니다. 앱은 학습 종료 시의 

일반적인 감속을 계산에 넣지 않

으므로 실제 종료는 대개 초기 

ETA보다 10-20% 더 초과됩니다. 

15%를 더해 두면 대개 맞습니다. 

Speed가 막 0일 때 (학습 시작 또

는 일시 정지) “–”를 표시합니다.
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Loss Chart 섹션 (I39–I41)

그림 14:  학습 완료 후 Loss History 섹션만 크롭 — Current 0.0064, Min 0.0035 (녹색), 파란색 진
행 0.027 (Iteration 1) 에서 0.0035 (Iteration 5K) 로, Iter 200 즈음의 특징적 꺾임 포함, 아래에 주황색 

Gaussian Count 차트

Loss Chart 섹션은 학습 진행을 시간에 따라 시각화합니다. 두 차트로 구성됩니다. 큰 Loss Curve 차
트 (위, 파란색) 와 작은 Gaussian Count 차트 (아래, 주황색) 입니다. 둘 다 학습 중에 실시간으로 구축
되며 다음 학습 시작까지 유지됩니다. 첫 학습 전에는 영역이 비어 있습니다 (“Loss curve will appear 
during training”). 차트는 순수 SwiftUI Path 드로잉 (Swift Charts 프레임워크 없음) 이므로 100K+ 
포인트에서도 매끄럽게 렌더링됩니다.
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I39 Current Loss (표시)

위치

인스펙터 → Loss Chart → 왼쪽 레이블 영역 “Current: 
0.0287”. 읽기 전용.

기술적  설명

마지막 Loss 샘플 포인트의 Float 값으로, 소수점 4자리로 형
식화됩니다. I31 (Metrics 섹션의 Loss) 과 동일하지만 여
기서는 더 간결하게 형식화됩니다. 출처는 Loss History — 
~30회 반복마다 항목을 받는 목록입니다. 유한한 값만 목록에 
추가됩니다 — NaN/Infinity (Gradient Explosion 버그의 
경우 매우 드물게) 는 필터링됩니다.

간단히  말하면

Metrics 섹션보다 더 짧은 표기

법의 현재 Loss 값 (소수점 4

자리). 내용적으로 I31과 동일하

지만, 여기서는 표시가 Loss 차

트 바로 옆에 있어 곡선을 관찰

할 때 정확한 숫자 값을 제공합

니다. 모든 실시간 메트릭과 마

찬가지로  30회 반복마다 업데

이트됩니다. NaN이나 Infinity 값 

(Gradient Explosion 버그에서 극

히 드물게) 은 앱이 자동으로 필

터링합니다. 다이어그램을 보면

서 다른 섹션으로 이동할 필요가 

없도록 유용합니다.

I40 Min Loss (표시)

위치

인스펙터 → Loss Chart → 오른쪽 레이블 영역 “Min: 
0.0245” (녹색). 읽기 전용.

기술적  설명

현재 학습 실행에서 본 모든 Loss 값의 최솟값. Loss History
에서 실시간으로 재계산됩니다 — 별도의 영속성 없음. 녹색 글
자로 표시됩니다. “Min” = “Best so far”이기 때문입니다. 차
트 하단의 점선 녹색 선은 이 Y 위치를 시각적으로 표시합니다. 
Continue Training 세션의 경우 최솟값 추적이 새로 시작됩
니다 — 이전 History는 UI에서 새 것으로 대체됩니다 (추가되
지 않음). 현재 학습이 이전보다 더 나쁘게 실행되면 Min 표시
가 이전 최종 결과보다 클 수 있습니다.

간단히  말하면

이 학습이 지금까지 본 가장 낮

은 Loss 값 — 녹색으로 표시됩

니다. “best so far”이기 때문입

니다. 차트 하단의 점선 녹색 선

도 이 위치를 시각적으로 표시합

니다. 현재 곡선이 그보다 훨씬 

위에 있다면 운이 좋다면 아직 

개선의 여지가 있습니다. 그러

나 대개 Min은 나중에 관심 있는 

최종 결과 지표입니다. Continue 

Training 세션의 경우 Min 추적이 

새로 시작됩니다. 이전 History

가 UI에서 새 것으로 대체되기 때

문입니다 — 그래서 Min 값이 이

전 최종 결과보다 더 나빠 보일 

수 있습니다.
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I41 Gaussian Count Chart

위치

인스펙터 → Loss Chart → 아래의 두 번째 차트 (주황색). 읽
기 전용.

기술적  설명

학습 반복에 대한 Gaussian 수의 선 다이어그램. 출처: 
Gaussian Count History (트레이너에 의해 ~30 Iter마다 
채워진 (Iter, Count) 쌍의 목록). Y 스케일은 History의 최솟
값과 최댓값 사이에서 동적입니다. Classic 전략의 경우 곡선
은 일반적으로 다음과 같이 보입니다: Densify Until까지 지속
적으로 증가, 그 후 평평 (작은 Pruning 변동 포함). MCMC
의 경우: Cap까지 가파른 상승, 그 후 수평선 (Relocation은 
숫자를 일정하게 유지). 활성 학습에도 불구하고 곡선이 떨어지
면 Densification이 너무 공격적으로 Prune하는 것 — 잘못
된 기본값 또는 알려진 MCMC-Collapse 버그 (v1.4.4 핫픽
스 주제) 의 표시.

간단히  말하면

Gaussian 수가 학습 시간에 따

라 어떻게 전개되는지 — Loss 

곡선 아래의 작은 주황색 차트. 

Classic 전략에서는 선이 Densify 

Until (I20) 에 도달할 때까지 지

속적으로 증가하고, 그 후 작은 

Pruning 변동과 함께 평평하게 

유지됩니다. MCMC에서는 가파

르게 Cap에 올라가고 그 후 수

평으로 유지됩니다. Relocation

이 숫자를 일정하게 유지하기 때

문입니다. 활성 학습에도 불구하

고 곡선이 갑자기 아래로 꺾이

면 Densification이 너무 공격적

으로 Prune하고 있는 것 — v1.4.4

의 MCMC Collapse 버그의 고전

적 표시. 그러면 앱 업데이트나 

Classic으로의 전환이 도움이 됩

니다.

Loss 곡선을 어떻게 읽는가?

Loss 차트는 인스펙터에서 가장 중요한 진단 도구입니다 — 다른 어떤 지표도 학습이 유용하게 진행
되고 있는지 또는 막혀 있는지를 이렇게 직접적으로 보여 주지 못합니다. 일반적인 건강한 형태는 처음 
1000-3000 반복에서의 빠른 하락 ( 0.15에서  0.05로), 그 다음 학습 종료까지의 느리고 균일한 하락 
(0.020-0.030으로) 입니다. 로그 스케일에서 곡선은 매끄러운 대각선처럼 보입니다.

Loss에서의 평탄 구간은 무엇을 의미하는가? 곡선이 수천 회 반복 동안 평평하게 유지되면 두 가지 가능
한 해석이 있습니다. (a) 학습이 “수렴”했음 — 주어진 데이터와 설정으로 모델이 가능한 만큼 좋기 때문
에 Loss가 더 이상 의미 있게 감소할 수 없습니다. 이것이 바람직합니다. 이것이 “완료”입니다. (b) 학습이 
“막혀 있음” — Loss가 실제로 더 감소할 수 있지만 최적화가 정체되어 있습니다 (지역 최소값, 학습률이 
너무 작음, Densification 꺼짐). 구분: Loss 값이 일반적인 좋은 범위에 있고 (0.020-0.030 Indoor/
Object, 0.040-0.060 Outdoor) 곡선이 5K 반복 동안 평평하면 수렴된 것입니다. 비교 가능한 장면보
다 값이 훨씬 더 높으면 (예: 0.08) 막혀 있는 것입니다.

주의 Gaussian 평탄 구간 ≠ Loss 평탄 구간. Gaussian 수의 평탄 구간은 “학습이 완료됨”을 의미하지 
않습니다. Densification이 새 점을 추가하는 것을 중단했다는 것만 의미합니다 — Densify Until에 도
달했거나 (Classic) MCMC Cap이 가득 찼기 때문입니다. 그 후에도 학습은 계속 실행되며 기존 점만 정
제합니다. 실제 “완료” 신호는 Loss 곡선과 Iteration 표시 (I30) 에서 읽어야 하며 여기서는 아닙니다.

중단을 위한 경험 법칙: Loss 곡선이 5000+ 반복 후에도 0.08을 넘고 거의 감소하지 않으면 높은 확률로 
SfM 재구성이 잘못된 것입니다. 학습을 중단하고 제 9 장에서 선택한 SfM 백엔드가 장면에 적합한지 확
인하고, 필요 시 COLMAP/Native로 전환한 뒤 새로 시작하십시오. 잘못된 카메라 정렬로 2시간의 학습을 
하는 것보다 더 나은 SfM에 10분을 투자하는 것이 낫습니다.
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언제 인스펙터를 사용해야 하는가?

빠른 참조: 일반적인 사용 사례별로 어떤 섹션 + 어떤 컨트롤?
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일반 작업 섹션 컨트롤 ID

완성된 Splat의 색상 채도 낮추기 Look L1 (Saturation)

바늘/콘페티 Splat 둥글게 만들기 Look L2 (Splat length)

구멍 난 구름 채우기 / Splat 키우기 Look L3 (Splat size)

궤도에서 먼 “Far 콘페티” 흐려지게 
하기

Look L4 (Fade far region)

Look 조정 버리기 Look L5 (Reset finishing)

사전 만들어진 설정 로드 Presets I7 (행 클릭)

자체 설정 저장 Presets I1 → I2 → I4

동료와 설정 공유 Presets I5 (Export) 또는 I6 (Import)

SfM 백엔드 전환 (예: Apple PG가 
너무 불안정해서)

Training 
Configuration

I12 (제 9 장 참고)

EXIF 초점 거리가 없는 비디오 프레임 
처리

Training 
Configuration

I13 (FOV Override)

COLMAP 성능: Classic 대신 
GLOMAP

Training 
Configuration

I14

Classic에서 MCMC로 전환 Training 
Configuration

I15

학습을 더 오래 실행 Training 
Configuration

I18 (Max Iter)
1. I20 (Densify Until) — I19로 연

결

GPU 시간 절반으로 줄이기 Training 
Configuration

I22 (Render Scale 50%)

학습 품질 +6% (MCMC) Training 
Configuration

I16 (MCMC Quality)

SfM 점이 많은 야외 장면 Training 
Configuration

I17 (Auto-scale by scene)

COLMAP 경로 설정 / 전환 Training 
Configuration

I23 / I24 / I25

내보내기 파일 더 작게 Enhancements I26 (항상 켜 둘 것)

학습 시간 증가 없이 뷰포트 선명하게 Enhancements I27 (Viewport Scaling → 
MetalFX)

MetalFX가 너무 매끄럽게 만듦 → 대
안

Enhancements I27 (Viewport Scaling → 
Lanczos)

미세 구조에서 마지막 한 방울의 세부 
정보

Enhancements I29 (Perceptual Loss 0.05-0.1)

학습 모니터링 Metrics I30 (진행), I36 (속도), I38 (남은 시
간)

품질 일찍 추정 Metrics I31 (5K 후 Loss < 0.05 = 좋음)SfM 문제 의심 Metrics + Loss 차트 I31 + I39 (5K 후 Loss > 0.08 → 
SfM 재계산)

수렴 vs 막힘 구별 Loss Chart I39 + I40 (Loss 평탄 구간 읽기)Densification 문제 인식 Loss Chart I41 (Gaussian 곡선이 떨어짐 → 버
그)65 / 216
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장

제 3 장 — 설정

설정 창은 RadianceKit → 설정… 또는 표준 단축키 ⌘, 를 통해 열립니다. 두 개의 탭이 있습니다. 
General 과 AI Helpers 입니다. 제 2 장의 인스펙터 값과 달리 이 창의 설정은 앱 전역으로 (모든 프로
젝트에 걸쳐) 적용됩니다 — UserDefaults에 영구화되어 앱 재시작을 견딥니다. General 탭은 세 가지 
콘텐츠 섹션으로 그룹화되어 있습니다: Interface, Viewport, Training. AI Helpers 탭은 SfM 및 학습 
전처리를 위한 온디바이스 머신 러닝 헬퍼 (Vision, CoreML) 를 켭니다. (이전에 여기에 있던 세 개의 야
외 플로터 토글 — Sky Masking, Mid-Training Floater Cleanup, Reconstruct Sky Dome — 은 
v1.6부터 Expert 인스펙터의 Enhancements 섹션으로 이동했으며, 이제 프로젝트별로 저장됩니다. 제 
2 장의 I42–I44를 참고하십시오.)

모든 AI Helpers를 일괄 활성화하거나 비활성화하는 이전의 조작 요소는 현재 버전에서는 더 이상 존재
하지 않습니다 — 따라서 여기에 문서화되지 않습니다. 아직 출시되지 않은 헬퍼를 위한 이전의 “Coming 
Soon” 섹션도 제거되었으며 여기에 참조되지 않습니다.
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General 탭

그림 15:  설정 → General 탭, 인터페이스, 뷰포트, 학습, 실험 섹션 포함
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S1 Default Mode

위치

Settings → General → Interface → Default Mode 선택
기. 연결: AppState.defaultMode. 기본값: .simple .

기술적  설명

다음 시작 후 앱이 두 UI 모드 중 어느 것으로 열릴지를 제어
합니다. “Simple Mode”는 4단계 가이드형 마법사 워크플로 
(가져오기 → 처리 → 미리보기 → 내보내기, 제 10 장 Z1–Z4
에 문서화) 이고, “Expert Mode”는 제 2 장의 Navigator, 
3D 뷰포트, Expert 인스펙터가 있는 고전적인 3 패널 레
이아웃입니다. 값은 재시작 간에 기억됩니다. 메뉴 Mode → 
Simple

Mode (⌘1) / Mode → Expert Mode (⌘2) 와 효과가 동일하
지만, 메뉴는 실행 중인 세션을 전환하는 반면 이 선택기는 향후 
세션의 기본값을 설정합니다. 두 모드 모두 동일한 프로젝트 상
태에 접근합니다 — 모드 전환 시 프로젝트, 카메라, 학습 구성
은 유지됩니다. 모드별 툴바 버튼은 즉시 다시 렌더링됩니다.

간단히  말하면

여기서 RadianceKit이 다음 시작 

시 어떤 인터페이스로 부팅될지 

선택합니다. “Simple Mode”는 초

보자 모드입니다. 네 개의 명확

한 단계, 미리 정의된 기본값, 옵

션 거의 없음. “Expert Mode”는 

제 2 장에서 보이는 모든 조절기

가 있는 전체 도구 상자 레이아

웃입니다. 이미지나 학습 진행을 

잃지 않고 언제든지 “Mode” 메

뉴를 통해 왔다 갔다 전환할 수 

있습니다.

S2 Language

위치

Settings → General → Interface → Language 선택기. 
연결: AppState.language. 기본값: .system  (macOS 
언어를 따름).

기술적  설명

macOS 시스템 언어와 독립적으로 전체 앱 UI의 표시 언어
를 선택합니다. RadianceKit은 17개 언어 ( de , en , pl , 
en-AU , ar-SA 와 추가 12개) 로 현지화되어 있습니다. 

“System”의 경우 앱은 macOS 언어를 따릅니다. 명시적 선
택의 경우 언어 설정은 재시작 간에 기억됩니다. 완전한 적용은 
보통 앱 재시작이 필요합니다. 현지화 번들은 시작 시에만 로드
되기 때문입니다. 프로젝트에 문서화된 298개의 현지화 키는 
모두 고려됩니다. 모든 하위 보기와 도움말 도구 설명의 텍스트
가 포함됩니다.

간단히  말하면

Mac이 영어로 실행 중이지만 독

일어 RadianceKit 인터페이스를 

선호하는 경우 (또는 반대로), 여

기에서 설정합니다. 대부분의 텍

스트가 즉시 전환됩니다. 일부 

대화창은 앱 재시작 후에야 새 

언어로 표시됩니다.
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S3 Viewport Background

위치

Settings → General → Viewport → Background 
선택기. 연결: AppState.viewportBackground. 기본값: 
.darkGray  (RGB 0.1, 0.1, 0.1).

기술적  설명

3D 뷰포트의 기본 배경색을 설정합니다. 세 가지 옵션: “Dark 
Gray” (RGB 0.1, 0.1, 0.1 — 기본값), “Black” (0, 0, 0), 
“White” (1, 1, 1). 설정은 재시작 간에 새 프로젝트와 세션의 
기본값을 영구화하면서 실행 중인 Metal 렌더러도 즉시 업데
이트합니다. 동일한 옵션이 메뉴 Viewport → Background 
(M21, M22, M23) 에 있지만, Settings 선택기는 기본값을 
설정하는 반면 메뉴는 실행 중인 표시를 전환합니다. 스크린샷
과 데모 비디오에 중요: 흰색 배경은 녹색/파란색 플로터를 더 
강하게 강조하고, 어두운 배경은 깨끗한 렌더 촬영에 더 좋습니
다.

간단히  말하면

미리보기 창의 3D 모델 뒤 색

상입니다. 대부분의 장면에 어

울리는 표준은 짙은 회색입니

다. 흰색은 스크린샷에 좋고, 검

정은 렌더 촬영에서 더 고급스

럽게 보입니다. 실행 중인 장면

에 대해 언제든지 “Viewport → 

Background” 메뉴를 통해 색상

을 전환할 수 있습니다 — 이 설

정은 다음에 열 때 어떤 색이 다

시 활성화될지만 정합니다.

S4 Auto-Rotate After Training

위치

Settings → General → Viewport → 
“Auto-Rotate After Training” 토글. 연결: 
AppState.autoRotateAfterTraining. 기본값: false .

기술적  설명

학습 종료 직후 장면 무게 중심을 중심으로 뷰포트 카메라의 연
속 턴테이블 회전 (표준 회전율 ~0.3 rad/s) 을 시작합니다. 
데모 세션, A/B 비교, 그리고 360° 시점에서 장면 가장자리에 
“플로터”가 생성되었는지 직접 평가하는 데 유용합니다. 효과는 
메뉴 Viewport →
Toggle Auto-Rotation (M16, ⌘⌥T) 과 시각적으로 동일
하지만, 여기 토글은 수동 대신 학습 종료 후 자동으로 동작을 
트리거합니다. 나중에 언제든지 메뉴를 통해 또는 뷰포트 클릭 
(회전 일시 정지) 으로 중단할 수 있습니다. 학습 성능에 영향을 
주지 않습니다 — 회전은 학습이 완료된 후에만 실행됩니다.

간단히  말하면

활성화되면 학습이 완료되는 즉

시 3D 장면이 자동으로 회전합

니다 — 회전목마처럼. 야간 학

습에서 아침에 직접 클릭하지 않

고도 결과가 움직이는 것을 보

고 싶을 때 좋습니다. 학습을 모

니터링만 하는 긴 세션에서는 꺼 

두는 것이 좋습니다.
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S5 Live Preview Interval

위치

Settings → General → Training 
→ Live Preview 선택기. 연결: 
AppState.trainingConfig.livePreviewInterval. 기
본값: 0  (Off).

기술적  설명

실행 중인 학습 스냅샷이 3D 뷰포트에 렌더링되는 반복 간격
을 결정합니다. 네 가지 이산 값: 0 (“Off”), 50, 250, 1000 
반복. Live Preview 활성 시 트레이너는 Gaussian 버퍼를 
GPU에서 별도의 렌더 버퍼로 복사하고 뷰포트 재그리기를 트
리거합니다. “Off”의 경우 뷰포트는 학습 완료 후에만 업데이
트됩니다. 성능 비용: M3 Ultra에서 50회 반복마다 ~5–10% 
느려짐, 250회 반복마다 ~1–2% 느려짐, 1000회 반복마다 측
정 불가. 스냅샷 버퍼의 메모리 오버헤드는 간격과 관계없이 일
정 ~2 GB. 값은 새 학습의 기본값으로 사용됩니다. 학습 시작 
후에는 Training 인스펙터가 이 학습의 실제 실시간 값을 표
시합니다. 간격 50에서 시각적 인상은 점 구름의 매끄러운 “성
장”이고, 1000에서는 끊기게 느껴집니다.

간단히  말하면

학습이 실행되는 동안 3D 보기가 

얼마나 자주 업데이트될지 선택

할 수 있습니다. “Off”는 학습 중 

업데이트 없음을 의미합니다 (가

장 빠름). “Every 50 Iterations”는 

장면이 어떻게 만들어지는지 거

의 실시간으로 보여 줍니다 (약

간 느림). 작은 학습을 편안하게 

지켜보려면 “Every 250”이 좋은 

타협안입니다.

S6 Throttle Delay

위치

Settings → General → Training → Throttle 선택기. 연
결: AppState.trainingConfig.throttleDelayMs. 기본
값: 0  (Off).

기술적  설명

학습 반복 사이에 인위적인 지연을 밀리초 단위로 삽입합니다. 
네 가지 이산 값: 0 (“Off”), 2 (“Light”), 5 (“Moderate”), 
10 (“Eco”). 의의: 더 긴 학습 (몇 시간) 의 경우 GPU가 그
렇지 않으면 100% 사용됩니다. 이는 눈에 띄게 느린 시스템 
UI를 야기합니다 (마우스 포인터가 끊김, 다른 앱이 느려짐). 
Throttle 지연은 다른 작업이 실행될 수 있는 GPU 휴식을 제
공합니다. 성능 비용은 상당합니다. 5 ms Throttle에서 일반
적인 40K 학습은 Throttle 없을 때보다 약 50–80% 더 오래 
걸립니다. 성능 모드 “Eco” (10 ms) 에서는 반복당 지연이 반
복 자체보다 더 깁니다 — 2–3배 느림. Throttle 활성 시 선택
기 아래에 “Throttle is on. Training will be slower than 
usual.”이라는 힌트가 나타납니다. 앱 자체는 눈에 띄게 더 잘 
반응하지 않습니다 — 다른 앱만 혜택을 봅니다.

간단히  말하면

Mac이 긴 학습 동안 너무 뜨거

워지거나 다른 프로그램이 너무 

느려지면 여기서 브레이크를 작

동시키십시오. “Off”는 GPU에 풀 

스로틀을 제공합니다 (가장 빠

름). “Light”는 각 단계 사이에 

짧은 휴식을 만듭니다 (약간 느

리지만 시스템이 더 잘 반응함). 

“Eco”는 가장 강한 브레이크입

니다 — 너무 뜨거워지지 않아야 

하는 MacBook의 야간 학습에 좋

습니다.
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AI Helpers 탭

그림 16:  설정 → AI Helpers 탭, 마스터 스위치와 하위 토글 포함
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S11 AI Helpers enabled (Master)

위치

Settings → AI Helpers → 첫 번째 섹션 → “AI Helpers 
enabled” 토글. 연결: AppState.aiHelpersEnabled. 기본
값: true .

기술적  설명

파이프라인의 모든 AI Helpers 기능에 대한 마스터 스위치. 꺼
져 있으면 가져오기 및 SfM 파이프라인이 모든 ML 기반 전
처리 단계를 완전히 건너뜁니다 — Apple Vision 호출 없음, 
CoreML 모델 로드 없음, NPU 깨우기 없음. 켜져 있으면 개별 
하위 토글 (S12–S13) 이 참조됩니다. 값은 재시작 간에 기억됩
니다. 다음 단계에 영향을 줍니다: (a) SfM 전 프레임 품질 사
전 점검 (S12), (b) 루프 폐쇄 감지 (S13). 중요: 꺼져 있으면 
두 하위 토글이 비활성화되고 시각적으로 회색이 됩니다. 푸터 
힌트는 모든 AI Helpers가 엄격하게 온디바이스에서 실행됨을 
강조합니다 — 이미지 업로드 없음, 클라우드 처리 없음. 개인 
정보 보호 보장은 Apple Vision 프레임워크 (Neural Engine
의 로컬) 와 앱 번들에 직접 위치한 CoreML 모델을 독점적으
로 사용함으로써 달성됩니다.

간단히  말하면

AI/머신 러닝을 내부적으로 사용

하는 모든 기능의 메인 스위치입

니다. 표준은 “켜짐”입니다. 헬

퍼는 이미지가 Mac을 떠나지 않

고도 많은 시간을 절약하기 때문

입니다. 완전히 끄고 싶다면 (예: 

전기를 절약하거나 Mac에 NPU

가 없는 경우), 여기서 끄십시오 

— 그러면 아래의 두 하위 옵션이 

자동으로 회색이 되고 아무것도 

하지 않게 됩니다.
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S12 Frame quality check

위치

Settings → AI Helpers → Available 섹
션 → “Frame quality check” 토글. 연
결: AppState.aiHelpersFrameQualityCheck. 기본값: 
true .

기술적  설명

SfM 호출 전 각 가져온 프레임을 분석하는 Frame Quality 
Screener (Phase 3.11) 를 활성화합니다. 프레임당 파이프라
인 단계: (a) Apple Vision의 Laplacian Variance 필터 (블
러 감지 — 임곗값 ~150), (b) 히스토그램 기반 과/저노출 점
검 (임곗값: 픽셀의 >5%가 0 또는 255), (c) 빈 프레임 감
지 (모든 픽셀에 대한 표준 편차 < 5). 세 점검을 모두 통과한 
프레임은 곧바로 통과합니다. 적어도 하나의 점검을 실패한 프
레임은 문제가 있는 각 프레임을 썸네일과 이유와 함께 나열하
고 제거할지 묻는 모달 확인 대화창을 트리거합니다. 중요: 자
동 삭제 없음 — 대화창이 항상 필요하며, 사용자가 최종 결정
을 유지합니다. 성능: M3 Ultra에서 프레임당 ~50 ms, 병
렬 실행. 꺼져 있으면 모든 프레임이 점검 없이 SfM에 전달됩
니다. 마스터 (S11) 가 비활성화되면 이 토글은 시각적으로 회
색이고 효과가 없습니다. 메모리에 따른 출시 상태: SHIPPED 
2026-05-23.

간단히  말하면

실제 학습 전에 앱은 각 사진을 

살펴봅니다. 흔들렸나? 완전히 

어둡거나 흰가? 비어 있나? 그렇

다면 이미지를 버릴지 물어봅니

다 — 자동으로 아무것도 제거하

지 않습니다. 이는 나중에 많은 

시간을 절약합니다. 완전히 흔들

린 단 하나의 이미지가 때로 전

체 학습을 망칠 수 있기 때문입

니다. 표준은 “켜짐”입니다. 노

력은 거의 없고 이익은 크기 때

문입니다.
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S13 Loop closure detection

위치

Settings → AI Helpers → Available 섹
션 → “Loop closure detection” 토글. 연결: 
AppState.aiHelpersLoopClosure. 기본값: true .

기술적  설명

Apple Vision Feature Print 기반 루프 폐쇄 감지를 활성화
합니다. 각 가져온 프레임에 대해 이미지 콘텐츠의 신경 임베
딩을 나타내는 ~768차원 특징 벡터가 계산됩니다. 그 후 모
든 Feature Print는 Cosine Similarity로 쌍별 비교됩니다. 
Similarity > 0.85이고 프레임 인덱스 거리 > 50 인 쌍 (즉 
비인접 프레임) 은 “루프 폐쇄 후보”로 식별되어 프로젝트 폴
더의 사이드카 JSONL 파일에 기록됩니다. 정보용만 — 가져
온 이미지 시퀀스는 수정되지 않습니다. 의의: SfM 솔버 (특히 
COLMAP) 에 이 프레임들이 3D 공간에서 함께 클러스터에 속
한다는 힌트를 제공합니다. Native SfM의 경우 사이드카 정보
는 현재 문서용일 뿐입니다. COLMAP은 커스텀 matches 파
일을 통해 내부적으로 힌트를 사용합니다 (수동 통합 가능, 자
동으로 연결되지 않음). 성능: M3 Ultra에서 프레임당 ~200 
ms, 병렬 실행. 꺼져 있으면 Feature Print가 생성되지 않습
니다. 마스터 (S11) 가 비활성화되면 시각적으로 회색입니다.

간단히  말하면

객체 주위를 사진 찍으며 걷다

가 마지막에 시작점으로 돌아오

는 경우, 이를 알리는 것이 컴

퓨터에 엄청나게 도움이 됩니다. 

이 옵션은 사진 중 어느 것이 “거

의 같은 위치”에서 촬영되었는

지 자동으로 인식하고 작은 도

움말 파일에 기록합니다. SfM 도

구 (특히 COLMAP) 는 이 정보를 

사용하여 더 깨끗한 3D 재구성

을 제공할 수 있습니다. 표준은 

“켜짐”입니다. 사용자가 개입하

지 않고도 실행되며 이미지에 어

떤 변경도 가하지 않기 때문입니

다.

인스펙터 미러 설정

인벤토리 테이블의 나머지 설정 항목 (S17–S33) 은 Expert 인스펙터에서 미러링된 것이며 제 2 장 (인스
펙터 컨트롤 I12–I29) 에 문서화되어 있습니다. 설정 창에 물리적으로 나타나지 않으며, UserDefaults를 
통해 영구화되는 TrainingConfig  속성을 통해 실행되기 때문에 인벤토리에만 나열되어 있고 형식적으
로 설정 성격을 가집니다. 콘텐츠 설명은 거기를 참조하십시오.
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언제 무엇을?

설정 범위 지속성

S1 Default Mode 앱 전역 앱 재시작

S2 Language 앱 전역 앱 재시작

S3 Viewport 
Background

앱 전역 (기본값) + 런타임 앱 재시작

S4 Auto-Rotate 
After Training

앱 전역 앱 재시작

S5 Live Preview 
Interval

새 학습의 기본값 앱 재시작

S6 Throttle Delay 새 학습의 기본값 앱 재시작

S11 AI Helpers 
Master

앱 전역 앱 재시작

S12 Frame quality 
check

앱 전역 앱 재시작

S13 Loop closure 
detection

앱 전역 앱 재시작

앱 전역 = 모든 프로젝트에 적용. 새 학습의 기본값 = 다음에 생성되는 학습에만 적용, 실행 중인 세션은 변
경되지 않음. 현재 학습 = 실행 중인 학습 구성에 즉시 적용되지만 명시적인 재가져오기 없이는 영구화되지 
않음.
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장

제 4 장 — 보조 창

메인 윈도우 (3D 뷰포트와 인스펙터) 외에도 RadianceKit은 일곱 개의 추가 창을 관리하며, 모두 Help 
메뉴를 통해 열립니다. 위에서 아래로의 목록: User Guide (⌘?), Keyboard Shortcuts (⌘/), Open 
Training Logs… (앱 창을 열지 않고 Finder를 엽니다. 따라서 여기서는 더 다루지 않음), Manage 
Storage…, Pareto Dashboard… (⇧⌘D), Holdout Analysis… (⇧⌘H), BayesOpt Console… 
(⇧⌘B). 그 중 세 가지 — Dashboard, Holdout, BayesOpt — 는 독립적인 분석 도구입니다. 각
각 자체 View Model 스택을 가지며 디스크의 JSON 파일을 읽거나 쓰고, 앱 시작 시 창을 특정 
파일에 바로 가리키게 할 수 있는 CLI 인수가 있습니다 ( --dashboard-dir , --holdout-file , 
--bayesopt-autorun ).

네 개의 단순한 창 (User Guide, Keyboard Shortcuts, Manage Storage, 그리고 하위 메뉴 항목 
Open Training Logs / Open Exports Folder) 은 조작 요소당 짧은 항목을 받습니다. 세 분석 창은 더 
자세히 문서화되어 있습니다 — 각각 창에서 무엇을 보는지, 언제 열어야 하는지, 표시된 이미지를 어떻게 
해석할지 설명하는 도입부와 함께.

장 끝에는 메인 윈도우의 인스펙터에 대한 상호 참조 섹션이 있습니다. 실행 중인 학습에서 실시간 Loss 차
트와 Gaussian Count 표시에서 무엇을 의미 있게 읽을 수 있는지에 대한 것입니다.
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User Guide (W1–W4)

그림 17:  User Guide 창, 왼쪽 사이드바와 오른쪽 렌더링된 Markdown 콘텐츠

그것이 무엇인지: 앱에 동봉된 guide_<언어>.md 를 렌더링하는 내장 도움말 창입니다. 언어는 설정 
(General 탭 → Language) 에서 또는 거기에 “System”이 있으면 macOS 언어 환경 설정에서 파생됩
니다. 레이아웃은 고전적입니다: 왼쪽에 모든 헤딩이 있는 사이드바, 오른쪽에 흐름 텍스트.

언제 열까  하나의 항목에 대해 빠른 상기가 필요할 때 — 즉 키워드 대체로. 자세한 참조는 이 매뉴얼입니다. 
내장 도움말 창은 명령줄의 --help 와 비슷합니다. 각 앱 릴리스마다 업데이트되지만 콘텐츠 면에서는 더 
표면적으로 유지됩니다.

W1 NavigationSplitView (사이드바 + 디테일)

위치

Help → User Guide (⌘?)..

기술적  설명

콘텐츠 트리를 위한 좁은 사이드바 (최소 180 pt 폭) 와 실
제 Markdown 콘텐츠를 위한 스크롤 가능한 디테일 영역의 2
열 레이아웃입니다. 창은 최소 크기 700 × 500 pt를 가집니
다. 처음 열 때 창은 앱 번들에서 적절한 guide_<lang>.md
를 로드하고 (대체로 guide_en.md ), 블록 레코드 (H1–H4 
헤딩, 단락, 목록, 테이블, 구분선) 로 파싱하며, 사이드바를 위
한 헤딩 구조를 별도로 추출합니다. 인라인 형식 (Bold, Italic, 
Code Span) 은 내장 Markdown 엔진을 통해 렌더링됩니다. 
언어는 앱 설정에서 읽히며, 중국어 ( zh-Hans ) 와 브라질 포
르투갈어 ( pt-BR ) 의 특수 경우에는 이 변형이 zh 또는 pt와 
다르기 때문에 전체 Locale 태그로 유지됩니다.

간단히  말하면

내장 도움말 텍스트, 왼쪽에 주

제 목록, 오른쪽에 콘텐츠. 언어

는 시스템 설정에 따라 자동으로 

설정됩니다. 오프라인에서 작동

하지만 의도적으로 짧은 버전입

니다 — 전체 참조는 이 매뉴얼입

니다.
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W2 List (헤딩 사이드바)

위치

User Guide 창의 왼쪽 열..

기술적  설명

현재 Markdown 문서의 모든 H2 및 H3 헤딩에 대한 목록입
니다. H2 항목은 들여쓰기 없이 Medium 글자 굵기로 나타나
고, H3 항목은 왼쪽에 16 pt 들여쓰기와 축소된 Foreground 
스타일로 표시됩니다. H4 이하는 무시됩니다. 그 이상의 깊이
는 사이드바를 혼잡하게 만들기 때문입니다. 앵커 ID는 헤딩 텍
스트의 슬러그화 (소문자 + 공백을 대시로
1. 글자/숫자/대시로 필터링) 로 생성됩니다 — GitHub가 

Markdown 앵커에

사용하는 것과 동일한 알고리즘이므로 문서의 외부 URL도 잠
재적으로 같은 앵커에 도달할 수 있습니다. 목록은 네이티브 
macOS 스타일을 사용합니다.

간단히  말하면

왼쪽의 내비게이션 표시줄입니

다. 항목을 탭하면 섹션으로 이

동합니다.

W3 Button (헤딩 → 앵커 점프)

위치

사이드바 행당 하나의 버튼..

기술적  설명

각 사이드바 항목은 현재 앵커를 설정하는 버튼이지만 시각적으
로 목록 항목처럼 보입니다. 관찰자 변수는 그런 다음 0.3초에 
걸친 부드러운 애니메이션으로 해당 앵커에 대한 스크롤 점프를 
트리거합니다. 점프 후 앵커 값은 재설정됩니다 — 그렇지 않으
면 동일한 앵커의 다음 클릭이 다시 발사되지 않을 것입니다 (값
이 변경되지 않았기 때문에 관찰자가 다시 트리거되지 않음).

간단히  말하면

클릭하면 오른쪽 텍스트의 해당 

위치로 이동합니다.

78 / 216



R A D I A N C E K I T 제 4 장 — 보조 창

W4 ScrollView (디테일 콘텐츠)

위치

오른쪽 열..

기술적  설명

Lazy 렌더링이 있는 스크롤 가능한 수직 스택 콘텐츠 영역. 더 
긴 가이드는 쉽게 200개 이상의 Markdown 블록을 가질 수 
있기 때문입니다 — 비 lazy 변형은 모두 동시에 인스턴스화하
게 됩니다. 각 블록은 자체 ID를 받습니다. 헤딩 앵커 (점프 가능
한 H1–H3용) 또는 인덱스 자리표시자. 최대 폭은 720 pt, 패
딩 32 수평 / 24 수직이므로 긴 줄도 잘 읽을 수 있는 레이아웃
을 유지합니다. 테이블은 수평 스택과 구분선과 함께 셀별로 렌
더링되며, 인라인 코드는 내장 Markdown 엔진을 통해 렌더링
됩니다. 실제 코드 블록은 현재 단락으로 처리됩니다 — Help 
창의 알려진 제한입니다.

간단히  말하면

실제 도움말 텍스트입니다. 스크

롤 가능, 잘 읽을 수 있는 폭, 명확

한 타이포그래피.
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Keyboard Shortcuts (W5–W6)

그림 18:  Keyboard Shortcuts 창 — Navigation/Views/Capture/Editor/Training 5개 그룹, 왼쪽에 단
축키 열, 오른쪽에 설명

이미지에 보이는 것  다섯 섹션의 정적 참조 목록입니다. Navigation: Mouse Drag (Orbit/Fly), 
Shift+Drag/Right-Drag (Pan), Scroll (Zoom), WASD (Fly Through 이동), Q/E (Up/Down), 
F (Toggle Orbit/Fly), Double-click (Re-center), Cmd+Scroll (FoV 조정). Views: R (Reset 
Camera), T (Auto-Rotation), P (Camera Playback), B (Background-Cycle), 0–9 (Training 
Cam으로 점프 1=10%/5=50%/0=last), Left/Right Arrow (Prev/Next Cam). Capture: S 
(Screenshot to Desktop), V (Turntable Video), C (Copy Camera Info). Editor: Tab (Edit 
Mode), Click/Drag (Paint-Select), Option+Click (Deselect), X / Delete (선택 삭제), Cmd-
Z (마지막 삭제 되돌리기), [ / ] (브러시 크기 작게/크게), Esc (선택 해제). Training: Start, Pause/
Resume, Cancel, Continue +5K/+10K/+20K는 M9–M14의 메뉴 단축키를 통해.

그것이 무엇인지: 모든 단축키의 단순한 정적 개요 — Navigation, Views, Capture, Editor, Training. 
콘텐츠는 하드 코딩되어 있으며, Markdown 로딩은 없습니다.
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언제 열까  뷰포트에서 어떤 것을 가장 빠르게 하는 방법을 찾을 때. WASD Fly Through, R로 Camera 
Reset, B로 Background Cycling — 모두 여기에 있습니다.

W5 ScrollView (콘텐츠 영역)

위치

Help → Keyboard Shortcuts (⌘/)..

기술적  설명

수직 목록을 포함하는 단순한 스크롤 영역입니다. 주위에 패딩 
20, 사이드바 내비게이션 트리 없음 (목록이 충분히 짧음). 콘
텐츠는 다섯 섹션 (Navigation, Views, Capture, Editor, 
Training) 으로 그룹화되어 있습니다. 키 조합당 두 열의 번역 
가능한 텍스트가 있는 하나의 줄. 왼쪽 열 (키 코드) 은 180 pt 
폭으로 고정되어 오른쪽 설명이 수직 정렬되어 유지됩니다. 스
크롤 외에 상호작용 없음 — 줄 클릭은 아무것도 트리거하지 않
습니다. 단축키는 메뉴와 뷰포트의 실제 키보드 수정자입니다.

간단히  말하면

모든 단축키 키 표. 짧게 참고하

기 위한 정적 치트 시트.

W6 VStack (단축키 섹션)

위치

ScrollView 내부..

기술적  설명

16 pt 간격으로 왼쪽 정렬된 스택형 섹션. 다섯 섹션 내에 각
각 헤딩 + 줄 시퀀스. 헤딩은 보조 Subheadline 스타일을 사
용합니다 — 의도적으로 Title 형식이 아닙니다. 섹션이 내비게
이션 가능할 필요가 없기 때문입니다. 콘텐츠는 의도적으로 평
평합니다 (Disclosure 없음, Search 없음, Filter 없음). 모든 
macOS 버전에서 변경 없이 컴포넌트가 실행되고 파일이 읽을 
수 있도록 유지됩니다.

간단히  말하면

기능별 키 그룹화 (Navigation, 

Views, Editor 등).

81 / 216



R A D I A N C E K I T 제 4 장 — 보조 창

Manage Storage (W7–W12)

그림 19:  Manage Storage 창 — 헤더 “693 items · 16.74 GB total”, 날짜순 정렬된 Export PLY 파일 
테이블, 각각 포맷 핀 + 파일 이름 + 크기 + 날짜

이미지에 보이는 것  RadianceKit이 관리하는 모든 파일의 테이블 뷰. 헤더는 693개 항목, 16.74 GB 총 
크기를 계산합니다. 위 툴바: “Show in Finder” + “Refresh”. 각 줄: PLY 아이콘, 파일 이름 (예: 
training_​20260527T211321Z.ply), 내보내기 날짜, 크기 (7 KB에서 218 MB까지 변동), 돋보기 아
이콘 (Reveal), 휴지통 아이콘 (Move to Trash). 파일은 날짜별로 정렬되며, 최신이 위입니다. 이 데모 
캡처에서는 --benchmark 로 많이 작업했기 때문에 PLY 내보내기가 지배적입니다.

그것이 무엇인지: RadianceKit이 ~/​Documents/​RadianceKit/​ 아래에 저장하는 모든 것에 대한 디스
크 사용량 개요 — Logs, Exports, Scenes, Capture 번들 (iOS 동반자에서), Imports (입력 이미지
의 스테이징 복사본). 항목당 바이트 크기와 두 버튼: “Finder에서 보기”와 “휴지통으로 이동”. 자동 정리
는 아님 — 앱은 스스로 아무것도 삭제하지 않습니다. 항목별로 결정합니다.

언제 열까  디스크가 가득 찰 때. 특히 로그가 쌓입니다 (학습 시도당 하나의 JSONL, 그리고 _​
qualityMetrics.json). 내보내기도 마찬가지입니다 (PLY 100% 원시 데이터, 내보내기당 하나). 크
래시 후에도 유용합니다. Imports 스테이징 디렉터리에 여전히 입력 이미지의 오래된 복사본이 있을 경우 
(“Disk-pressure incident” 참고: dev_​v549f-needle-reduction.md).

82 / 216



R A D I A N C E K I T 제 4 장 — 보조 창

W7 버튼 “Show in Finder”

위치

Storage 브라우저 창 위 오른쪽 헤더..

기술적  설명

전체 RadianceKit 디렉터리 (~/​Documents/​RadianceKit/​
) 를 Finder에서 열어 폴더 구조를 직접 보고 Finder 자체로
도 조작할 수 있게 합니다. 동작은 새 Finder 창을 열고 앱 
Sandbox 컨테이너로 전환하지 않습니다 — ~/​Documents/​
RadianceKit/​는 앱에 정기적으로 접근 가능한 Documents 
도메인이며, Sandboxed 컨테이너 경로가 아닙니다.

간단히  말하면

Finder에서 디렉터리를 열어 파

일을 직접 조작할 수 있도록 합

니다.

W8 버튼 “Refresh”

위치

헤더, Finder 버튼 옆..

기술적  설명

사용자가 초기화한 비동기 작업에서 실행되는 백그라운드 스캔
을 트리거합니다. 큰 디렉터리 트리를 스캔하는 것이 UI를 차
단하지 않도록 합니다. 실제 워크는 모든 알려진 하위 폴더 
(Logs, Exports, Scenes, Captures, Imports) 를 통과하
여 각 직접 자식마다 Storage 항목을 생성합니다. 항목당 재귀
적 크기가 결정됩니다 — 실제 디스크 사용량 (APFS Hardlink 
공유 포함) 우선, 논리적 파일 크기를 대체로 사용.

간단히  말하면

그 사이에 Finder에서 무언가를 

삭제하거나 추가한 경우 목록을 

새로 읽습니다.

W9 List (Storage 항목)

위치

헤더 아래 메인 콘텐츠..

기술적  설명

이 레이아웃의 줄당 목록: 카테고리별 SF Symbol 아이
콘 (로그용 문서, 내보내기용 업로드 화살표, Scene용 큐
브, Imports용 Tray), 이름 + 부제목 (Kind 레이블 + 형
식화된 수정 날짜), 오른쪽 바이트 카운터 (오른쪽 정렬, 
monospaced), Reveal 버튼 (돋보기 기호), Trash 버튼 (휴
지통). 정렬: 주로 Kind 별 (Scene 먼저, 그 다음 Exports, 
Logs, Captures, Imports, Other), 부차적으로 수정 날
짜 내림차순 (최신이 위). 스캔이 아직 실행 중이면 그 위치에 
“Scanning…” 진행이 대신 표시됩니다. 아무것도 발견되지 않
으면 Tray 아이콘과 함께 비어 있는 상태 표시.

간단히  말하면

모든 RadianceKit 데이터의 목록, 

유형과 최신성별로 정렬됩니다. 

항목당 크기를 볼 수 있고 직접 

삭제할 수 있습니다.
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W10 행 버튼 “Reveal in Finder”

위치

줄당, 오른쪽 돋보기 기호..

기술적  설명

Finder를 열고 특정 항목 (파일 또는 폴더) 을 선택합니다. W7
과의 차이: W7은 루트 디렉터리를 엽니다. W10은 정확히 이 
한 항목을 표시합니다. 실용적인 워크플로: 큰 항목을 식별하고 
돋보기를 클릭한 다음, 예를 들어 외부 볼륨으로 복사합니다.

간단히  말하면

Finder에서 이 항목으로 바로 점

프하여 빠르게 찾을 수 있도록 

합니다.

W11 행 버튼 “Move to Trash”

위치

줄당, 돋보기 옆 오른쪽 휴지통 기호..

기술적  설명

확인 대화 상자 (W12) 를 트리거합니다. 확인 후에만 macOS 
표준 동작 “휴지통으로 이동” (즉 가역적, 직접 삭제 아님) 이 실
행됩니다. 성공적인 휴지통 이동 후 항목이 목록에서 제거되고 
총 바이트 카운터가 업데이트됩니다. 오류 시 모달 오류 대화 상
자가 표시됩니다.

간단히  말하면

항목을 휴지통으로 이동합니다. 

대화 상자가 먼저 묻습니다.

W12 ConfirmationDialog (삭제 확인)

위치

W11에 의해 트리거되고 macOS 시트로 표시됨..

기술적  설명

동적 제목 “Delete <name>?”과 항목이 휴지통에 들어가고 
그곳에서 (휴지통이 비워질 때까지) 복원 가능하다는 점을 명시
적으로 지시하는 메시지 줄이 있는 표준 확인 대화 상자입니다. 
두 버튼: “Move to Trash”는 파괴적 동작 (빨간색으로 표시) 
이고 “Cancel”은 자동 Esc 바인딩이 있습니다. 대화 상자는 
이 창만 차단한다는 의미에서 비모달입니다. 전체 앱이 아닙니
다 — 가역 삭제에 대한 macOS 표준입니다.

간단히  말하면

삭제 전 안전 점검. “Move to 

Trash”는 가역적입니다 — 휴지

통이 비워지지 않는 동안.
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Pareto Dashboard (W13–W22)

그림 20:  Pareto Dashboard — 리포트 가져오기 전 비어 있는 상태

비어 있는 상태 (처음 열린 후) — “Open Reports Folder…” 호출 동작이 있는 비어 있는 상태. 학습 리
포트가 로드되면 데이터 포인트가 나타납니다. 다음 캡처 참고.

그림 21:  129개 벤치마크 리포트가 로드된 Pareto Dashboard — Gaussians vs PSNR, Pareto Front, 
Scene/Strategy/Mip 필터

이미지에 보이는 것  헤더 툴바에 “129 reports of 129” 표시 (선택한 폴더의 모든 리포트가 성공적으로 파
싱됨 — 추가 21개 파일은 더 오래된 형식 때문에 파싱되지 않을 수 있음, 오른쪽 힌트 목록 참고). 축: X축 
선택기 Gaussians , Y축 선택기 PSNR (dB) . 산점도: 녹색 점 = Classic 전략, 파란색 점 = MCMC. 
점선 Pareto Front 선은 가장 좋은 PSNR 값을 따라 진행하며 약 500K Gaussian부터 PSNR≈30 
dB에서 안정화됩니다. 오른쪽 필터 칩: 7개의 Scene (bicycle, bonsai, family, flowers, kitchen, 
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stump, truck), 2개의 Strategy (classic, mcmc), 3개의 Mip Splatting 옵션 (All, On, Off). 현재 
모든 필터가 열려 있으므로 조밀한 점 클러스터입니다.

그것이 무엇인지: 다중 실행 비교 도구입니다. 과거에 여러 장면 또는 다른 프리셋으로 동일한 장면을 학
습했습니다 — 각 학습 실행은 ( --benchmark 를 함께 제공했거나 Benchmark 기능을 통해 호출한 경
우) JSON 리포트 파일을 생성합니다. 그것은 무엇보다 최종 PSNR, SSIM, LPIPS, Gaussian Count, 
Wallclock 시간을 포함합니다. Dashboard는 이러한 리포트의 전체 폴더를 동시에 읽고, 선택 가능한 축
이 있는 2D 산점도로 플로팅합니다. 또한 Pareto Front (비지배된 점의 집합) 가 점선으로 표시됩니다.

언제 열까  최소한 세 개 또는 네 개의 학습 리포트를 만든 후. 점이 적으면 Frontier 선이 의미가 없습니
다. 일반적인 사용 사례: 야외 장면을 재구성하려 시도했고 차례로 P3 Balanced (Classic), P4 Quality 
(Classic), P7 MCMC Quality, P9 Outdoor (tuned) 를 시도했습니다 — 이제 어느 구성이 학습 시
간 초당 최고의 PSNR을 제공하는지, 또는 어느 것이 주어진 PSNR에 대해 가장 적은 Gaussian을 필요
로 하는지 알고 싶습니다.

어떻게 해석할까  두 축 모두 자유롭게 선택할 수 있습니다 (X축: GaussianCount, trainingTime, 
psnr , ssim , lpips , …; Y축 동일). ParetoFront2D.indices의 Pareto Front 로직은 각 메트
릭에 대해 “작을수록 좋음” (예: LPIPS, Loss, Time) 또는 “클수록 좋음” (PSNR, SSIM) 을 알고 있습
니다 — 따라서 선은 축 선택에 따라 왼쪽 아래에서 오른쪽 위로 또는 왼쪽 위에서 오른쪽 아래로 항상 도달
한 최선의 조합을 따라 진행합니다. 다른 점이 두 차원 모두에서 최소한 같지 않으면 점은 Pareto 최적입
니다 (즉, 다른 어떤 것도 그것을 지배하지 않음). Pareto 최적 점은 선 위에 있고, 다른 점은 그 오른쪽/위 
(축 방향에 따라) 에 있습니다. 선 위의 점은 “최고의 프리셋”에 대한 진정한 후보입니다. 선에서 멀리 떨어
진 점은 낭비된 학습 시간입니다.

필터 칩  선택을 특정 장면으로 제한할 수 있고 (예: 야외 실행만 비교하려는 경우), 특정 전략 (Classic 또
는 MCMC) 으로 제한하거나 Mip-Splatting on/off로 제한할 수 있습니다 (Phase Q1.5 후 관련 — 
Mip이 opt-in 고급 플래그로 남음).

예제 워크플로  ~/​Documents/​RadianceKit/​Reports/​에 “truck” 장면용 세 개의 리포트가 있습니다: 
Run A (P4 Quality, 40K iter, 524K Gs, 105 s, PSNR 23.4), Run B (P7 MCMC, 200K iter, 
150K Gs, 693 s, PSNR 24.6), Run C (P9 Outdoor, 100K iter, 1.25M Gs, 312 s, PSNR 
25.8). X축을 trainingTime, Y축을 PSNR로 설정합니다. Run B는 오른쪽 위, Run C는 더 오른쪽 
위, Run A는 왼쪽 아래에 있습니다. Pareto Front는 A와 C를 연결합니다 — 둘 다 비지배. Run B
는 “lost”입니다 (C가 Time과 PSNR 모두에서 더 좋음). 통찰: “truck”의 경우 MCMC 기본값은 가치
가 없습니다. 빠름+ok (A) 또는 길다+매우 좋음 (C). C의 구성을 자체 프리셋으로 저장 (인스펙터 → I1 
Save Preset).

다음 동작: 최고 구성을 프리셋으로 저장. 구체적으로: Pareto 점을 살펴봅니다 (호버는 도구 설명에서 
PSNR/SSIM/LPIPS/Gs/Time을 보여 줍니다), 시간 vs 품질 트레이드오프가 가장 잘 맞는 것을 결정하
고, 관련 리포트를 열고 (파일 이름에 실행 타임스탬프 포함), 새 실행에서 학습 구성을 복사하거나 다음 학
습 세션 후 인스펙터를 통해 프리셋으로 저장합니다.
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W13 버튼 “Open Reports Folder…”

위치

툴바 위 왼쪽..

기술적  설명

“Select a folder containing benchmark .json 
reports” 요청과 함께 폴더 선택 대화 상자를 엽니다. 확인 후 
백그라운드 작업이 폴더의 모든 .json  파일을 순차적으로 파
싱합니다. 잘못된 리포트 (손상된 JSON, 잘못된 스키마) 는 수
집되어 사이드바 아래에 “N file failed to parse”로 표시됩니
다 — 크래시 없음. 첫 번째 로드가 아직 실행되는 동안 두 번째 
클릭이 발생하면 이전 작업이 중단되어 두 결과가 동시에 상태
에 쓰이지 않도록 합니다.

CLI를 통해서도: --dashboard-dir /​path/​to/​reports는 
앱 시작 시 폴더를 바로 로드합니다.

간단히  말하면

벤치마크 리포트가 위치한 폴

더를 선택합니다. 표준 경로

는 ~/​Documents/​RadianceKit/​

Reports/​입니다. 그런 다음 모

든 JSON을 한 번에 로드합니다.

W14 선택기 “X-Axis”

위치

차트 위, 왼쪽..

기술적  설명

Dashboard 모듈의 사용 가능한 모든 메트릭 축 (PSNR, 
SSIM, LPIPS, Gaussian Count, 학습 시간 등) 이 있는 메
뉴 선택기. 기본값은 Gaussian Count. 전환 시 호버된 점이 
재설정됩니다. 이전에 하이라이트된 위치가 새 축 좌표계에서는 
의미가 없기 때문입니다. 선택기는 콘텐츠 폭으로 제한되어 전
체 폭에 걸쳐지지 않습니다.

간단히  말하면

수평 축에 표시될 메트릭. 일

반적으로 “학습 시간” 또는 

“Gaussian 수” — 비교하려는 “비

용”이기 때문입니다.

W15 선택기 “Y-Axis”

위치

차트 위, X-Axis 옆..

기술적  설명

W14와 동일하지만 기본값이 PSNR입니다. 축 선택은 독
립적으로 저장되므로 사용자가 무의미한 조합 (X=PSNR, 
Y=PSNR — 모든 점을 대각선에 던짐) 도 선택할 수 있습니
다. 그러나 그러한 조합은 포착되지 않습니다. 의도적인 결정입
니다. “SSIM vs PSNR” 비교가 메트릭이 얼마나 일관되게 동
작하는지 보기 위해 흥미롭기 때문입니다.

간단히  말하면

수직 축에 무엇이 있는지. 일반

적으로 품질 측정값으로 “PSNR” 

또는 “SSIM”.
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W16 토글 “Show Pareto Front”

위치

축 선택기 오른쪽..

기술적  설명

표준 macOS 토글입니다. 활성이면 Pareto 차트에 점 구름 외
에 계산된 2D Pareto Front가 있는 선이 그려집니다. 스타일: 
점선 (대시 패턴 4–4), 회색 반투명, 선 두께 1.5 pt. Pareto 
계산은 메인 스레드에서 실행됩니다 — 일반적인 리포트 수 (≤ 
~50) 의 경우 문제없이 빠릅니다. 토글이 꺼져 있으면 선이 생
략되어 벗은 점만 표시됩니다.

간단히  말하면

“지금까지의 최선” 점을 통과하

는 선을 표시합니다. 선이 방해

된다면 (예: 개별 거래만 비교하

려는 경우) 끕니다.

W17 칩 “Scene” 필터

위치

Dashboard 창 오른쪽 사이드바..

기술적  설명

로드된 리포트에서 발생하는 각 장면에 대한 필터 칩. 폭이 소
진되면 자동으로 칩을 여러 줄로 다시 패킹하는 자체 Flow 
Layout. 활성 칩은 강조 배경을 받고, 비활성 칩은 중립 표준 
Material 배경을 받습니다. 다중 선택 가능 (Set 의미론). 칩이 
선택되지 않은 경우 모든 장면이 “통과”되는 것으로 적용됩니다 
— 즉 Set 로직은 “빈 선택 = 모두”이며, “빈 선택 = 없음”이 
아닙니다.

간단히  말하면

장면 이름을 클릭하면 점이 이 

장면만으로 필터링됩니다. 다중 

선택 가능. 비어 있음 = 모든 장

면.

W18 칩 “Strategy” 필터

위치

사이드바의 Scene 필터 아래..

기술적  설명

W17과 정확히 같지만 학습 전략용 — 일반적으로 두 값 
“classic”과 “mcmc”. 벤치마크 리포트 JSON의 Strategy 
필드에서 파생됩니다. 두 전략의 리포트를 혼합했고 한 종류만 
보고 싶을 때 (예: “Classic을 이미 제외했기 때문에 MCMC 
실행만 표시”) 유용합니다.

간단히  말하면

Classic 또는 MCMC별 필터. 기본

적으로 둘 다 활성입니다.
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W19 칩 “Mip-Splatting” 필터

위치

사이드바의 Strategy 필터 아래..

기술적  설명

3값 필터 (W17/W18처럼 Set이 아님): “All” / “On” / “Off”. 
배경: Mip Splatting은 Phase Q1.5에서 실험적 다중 스케
일 개선으로 평가되었고 최종 verdict는 “내내 좋은 win 없음, 
opt-in 플래그로 유지”였습니다. Mip on/off 비교를 하는 경
우 종종 매우 선명하게 분리할 수 있기를 원합니다. 따라서 “모
두 통과”, “Mip on만”, “Mip off만” 상태가 있는 전용 3진 
필터가 있습니다. 사이드바 섹션은 데이터 집합에 최소 하나의 
Mip 리포트와 최소 하나의 비 Mip 리포트가 있을 때에만 표시
됩니다 (그렇지 않으면 필터링이 의미가 없음).

간단히  말하면

Mip Splatting on/off를 비교하려

면 여기에 3분할 필터. 그렇지 않

으면 무시.

W20 ChipButton (필터 토글, all/on/off)

위치

Helper 컴포넌트, W17/W18/W19에서 사용됨..

기술적  설명

최소한의 버튼 래퍼입니다. 콘텐츠: Caption 글자 크기와 패딩 
10 수평 / 5 수직의 레이블 텍스트. 배경은 조건적: 활성일 때 
→ 흰색 텍스트가 있는 앱 강조 색상. 그렇지 않으면 검은색 텍
스트가 있는 중립 표준 Material 배경. 모양은 Capsule (알약 
같은). Plain 버튼 스타일로 Capsule Material이 시스템 테두
리에 의해 덮이지 않도록 합니다.

간단히  말하면

둥근 필터 버튼 자체. 시각적으

로 iOS 태그와 같습니다.
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W21 Chart (Pareto Scatter)

위치

Dashboard의 중앙 영역..

기술적  설명

두 레이어가 있는 Swift Charts 다이어그램: 1. 리포트당 하나
의 점 — 선택된 X 및 Y 메트릭에서의 위치, Strategy별 색상, 
Mip 상태별 기호. 기호 크기는 보통 80, 강조 표시되었을 때 
200 (ID가 현재 호버된 리포트와 일치하는 경우). 2. Pareto 
Front용 선, 토글이 켜져 있을 때만.

차트 오버레이: 투명 직사각형이 마우스 움직임을 등록합니다. 
프레임당 플롯 프레임에서 유클리드 가장 가까운 점 위치가 결
정되고 거리가 24 px 미만이면 호버된 리포트가 업데이트됩니
다 (그렇지 않으면 재설정). 따라서 클릭하지 않고도 도구 설명
을 받을 수 있습니다 — 호버로 충분합니다.

간단히  말하면

실제 산점도. 각 점은 학습 실행

입니다. 세부 도구 설명을 위해 

호버하십시오.

W22 Tooltip (호버 디테일)

위치

차트 아래, 호버 시 표시..

기술적  설명

수평 스택: 장면 이름 (Headline), Strategy 태그 
(Caption), 구분선, 그런 다음 PSNR/SSIM/LPIPS/Gs/
Time 메트릭을 각각 작은 수직 그룹 (레이블 + monospaced 
값) 으로. Mip이 활성화되었다면 추가로 강조 색상의 “Mip” 
Capsule 태그. 배경은 반투명 블러, 8 pt 반경의 둥근 직사각
형. 마우스가 실제로 점 위에 있을 때에만 표시됩니다. 떠나면 
자동으로 사라집니다.

간단히  말하면

마우스로 점 위로 가면 표시되는 

아래 디테일 카드. 모든 품질 메

트릭과 실행 구성을 한 번에 표

시합니다.
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Holdout Analysis (W23–W29)

그림 22:  Holdout Analysis — transforms.json 로드 전 비어 있는 상태

“Open transforms.json…” 호출 동작이 있는 비어 있는 상태와 빈 상태. NeRF Studio 및 Instant 
NGP 형식을 수용합니다.

비어 있는 상태 (처음 열린 후) — transforms.json 이 로드되면 카메라 마커가 나타납니다. 다음 캡처 
참고.

그림 23:  100개의 NeRF Blender Mic 카메라가 있는 Holdout 글로브, 5개 폴드 × 20개 카메라, Angular 
전략 활성

이미지에 보이는 것  헤더는 로드된 파일 (transforms_​train.json) 과 Cam Count (“100 cameras”) 
를 표시합니다. 왼쪽 사이드바: 두 옵션이 있는 Strategy 선택기 — Angular
(longitudinal) 활성 (구체의 경도/위도 섹터에 따라 폴드를 정렬하므로 각 테스트 폴드가 기하학
적으로 조밀함) vs Linear (round-robin) (순서 기반, k번째 프레임마다 테스트 세트로). k 폴
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드 슬라이더는 5, 테스트 폴드 선택기는 Fold 1. Export 버튼은 Nerfstudio/Instant NGP용 fold-
assignment.json을 생성합니다. 중앙 패널: 모든 100개 카메라의 3D 글로브 투영 — 녹색 점 = Train, 
빨간색 점 = 현재 테스트 폴드 (20개 카메라가 있는 Fold 1). 오른쪽 사이드바 (Angular Correlation): 
폴드당 20개 Cams + Mean Nearest Angle (Fold 1: 7.9°, Fold 2: 7.8°, Fold 3: 7.7°, Fold 4: 
7.0°, Fold 5: 6.3°) — 작은 값은 이 폴드 내의 카메라가 서로 가까이 있다는 것을 의미하므로 Holdout 
분할이 공간적으로 일관됩니다.

그것이 무엇인지: Cross Validation 로직이 있는 카메라 배치를 위한 3D 시각화 도구. 
transforms.json  (Nerfstudio / Instant NGP의 카메라 포즈용 표준 형식) 을 로드하면 앱은 모든 
카메라를 읽고 그 시선 방향을 단위 구체에 투영하고 가상 글로브에 작은 구체 마커로 표시합니다. 그런 다
음 카메라를 (선택된 전략에 따라: angular 또는 linear) k  폴드로 나누고, 학습 부분을 녹색으로, 테스
트 부분 (Holdout) 을 빨간색으로 표시하고, 테스트 폴드가 시선 각도 공간에서 학습 폴드로부터 얼마나 
멀리 떨어져 있는지를 알려 주는 Angular Correlation 점수를 폴드당 계산합니다.

언제 열까  Holdout 평가를 하고 싶을 때 — 즉: 모델이 보이지 않는 시점에서 얼마나 잘 일반화되는가? 
학습의 표준은 “every-8th view를 Holdout으로” (Mip-NeRF360 규약) 이지만 이는 매우 선형적
인 분할입니다. 예를 들어 이미지가 시간적으로 클러스터링된다면 (먼저 객체의 한 쪽, 그 다음 다른 쪽), 
“every-8th”는 대표적이지 않습니다 — 무작위 시퀀스 위치가 테스트에 들어가지만 모든 이웃은 학습에 
있어 너무 쉽습니다. “angular”로는 대신 시선 각도 공간에 걸쳐 계층화됩니다: 각 폴드는 궤도의 모든 영
역에서 카메라를 포함하므로 테스트가 실제로 일반화 격차를 테스트합니다.

어떻게 해석할까  Angular vs Linear: - Angular (표준): 카메라를 경도 각도 (Y축 주위의 φ 좌표) 에 따
라 k 개의 동일한 섹터로 나눕니다. Fold 0은 φ ∈ [0°, 360/k°) 의 카메라, Fold 1은 그 다음, 등입
니다. 장점: 각 폴드가 궤도의 일부를 다루며, 테스트 폴드는 공간적으로 콤팩트하지만 전체 데이터셋에 걸
쳐 넓습니다. 고전적 궤도 촬영에 좋습니다. - Linear (Round-Robin): Fold-Index = (image_index 
modulo k). 단순한 “every-k-th” 분할입니다. 이미지 순서가 공간적 편향이 없을 때 동작합니다 (예: 무
작위로 정렬된 드론 촬영). 이미지가 시간적으로 클러스터링되면 잘 동작하지 않습니다.

3D 글로브에서 즉시 볼 수 있습니다: 녹색 점 (Training) 과 빨간색 점 (Test). 빨간색 점이 모두 한 구석
에 클러스터되면 Holdout이 나쁩니다 (좋은 일반화 테스트가 아님). 녹색 사이에 균등하게 있으면 좋습니
다. 폴드당 Angular Correlation 점수 (오른쪽 사이드바, 도 단위) 는 추가로 말합니다: 작은 값 = 테스트
가 학습에 가까움 (각 테스트 카메라가 가까운 학습 카메라를 가짐, 쉬운 테스트). 큰 값 = 테스트가 학습에
서 멀리 떨어짐 (더 어려운 일반화).

예제 워크플로  Truck 장면을 251개의 이미지로 촬영했고 메뉴 항목 M33 (Export SfM 
transforms.json) 을 통해 nerfstudio 파일을 내보냈습니다. Holdout 창 (⇧⌘H) 을 열고 “Open 
transforms.json…”을 통해 JSON을 로드하고 글로브를 살펴봅니다. k=5 (기본값) 는 5개의 폴드를 제
공합니다. “Fold 3”을 클릭하고 — 빨간색 마커가 어느 정도 균등한지 확인합니다. 그렇다면: “Export 
fold-assignment.json”, 내보낸 파일을 Reports 폴더에 두고, 다음 학습 실행에서 --benchmark  
(또는 해당 인스펙터 설정) 와 함께 정확히 이 폴드 분할이 테스트 Holdout으로 사용됩니다 — 표준 
“every-8th” 대신.
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W23 버튼 “Open transforms.json…”

위치

툴바 위 왼쪽..

기술적  설명

JSON 파일로 제한된 파일 선택 대화 상자를 엽니다. 확인 후 
Holdout 모듈이 파일을 로드합니다. 로더는 nerfstudio 형식 
(카메라 인트린식과 이미지 경로 및 변환 행렬이 있는 프레임 목
록) 과 instant-ngp 형식 (같은 구조) 을 모두 파싱합니다. 프
레임당 시선 방향이 변환 행렬에서 추출되고 (카메라 로컬 베이
스의 z축) 저장됩니다. 파싱이 실패하면 상태 영역에 오류 메시
지가 표시됩니다.

CLI를 통해서도: --holdout-file /​path/​to/​
transforms.json은 로드된 파일과 함께 창을 직접 시작합니
다.

간단히  말하면

카메라 포즈 JSON을 로

드합니다. 표준은 Nerfstudio 

및 Instant NGP 내보내기입니

다. RadianceKit 자체는 Menu 

→ Export → SfM을 통해 

transforms.json을 내보낼 수 있

습니다.

W24 선택기 “Strategy” (angular/linear)

위치

왼쪽 사이드바, 위..

기술적  설명

두 옵션이 있는 라디오 선택기: Angular와 Linear. 전략 변경
은 폴드의 자동 재계산을 트리거합니다. 시선 방향은 구체의 3D 
단위 벡터 목록입니다. Angular 전략은 그것들을 경도 각도 φ
에 투영하고 정렬합니다. Linear 전략은 단순히 프레임 인덱스
에 대한 모듈로 분할을 수행합니다.

간단히  말하면

균등한 궤도 촬영용 Angular (표

준, 안전), 이미지가 공간적으로 

클러스터되지 않을 때만 Linear.

W25 슬라이더 “k Folds”

위치

왼쪽 사이드바, 중간..

기술적  설명

3에서 10까지의 슬라이더, 단계 1. 변경 시 폴드 계산이 자
동으로 다시 시작되어 폴드 목록, 학습/테스트 인덱스, 폴드
별 점수가 즉시 다시 계산됩니다. 선택된 값은 레이블 옆에 
monospaced 자릿수 텍스트로 표시됩니다.

경험 법칙: k=5가 표준 (폴드당 20% 테스트 제공, Cross 
Validation에 일반적). 데이터가 매우 많고 통계적 신뢰성을 위
해 더 많은 폴드가 필요하면 k=10. 데이터가 적으면 k=3.

간단히  말하면

분할에 얼마나 많은 폴드. 5가 표

준이며 거의 항상 적합합니다.
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W26 선택기 “Test Fold”

위치

왼쪽 사이드바, k 슬라이더 아래..

기술적  설명

메뉴 선택기. 옵션은 동적으로 0..<k, 레이블 “Fold 1” 에서 
“Fold N”까지 (UI에서 1 인덱스, 내부에서 0 인덱스). 이전에 
선택된 인덱스가 ≥ k이면 (예: k를 10에서 5로 줄였기 때문
에) 자동으로 0으로 재설정됩니다. 선택된 테스트 폴드는 글로
브에서 빨간색으로 표시되고 다른 모든 폴드는 녹색으로 표시됩
니다.

간단히  말하면

지금 어느 폴드가 테스트 폴드인

지. 클릭하여 넘기면 각 개별 폴

드가 글로브에서 어떻게 보이는

지 볼 수 있습니다.

W27 버튼 “Export fold-assignment.json”

위치

왼쪽 사이드바, 아래..

기술적  설명

기본 파일 이름 fold-assignment.json이 있는 저장 대화 상
자를 엽니다. 확인 후 Holdout 모듈이 현재 분할을 JSON 스
키마로 인코딩합니다 (프레임별 폴드 할당과 Strategy 메타 블
록). 이 파일은 다음 학습에서 --benchmark 와 함께 제공될 
수 있어, 동일한 Holdout이 최종 메트릭 평가에 사용됩니다. 
쓰기 오류는 오류 텍스트로 표시됩니다. 성공은 녹색 텍스트로 
“Saved to (filename)”로 표시됩니다.

간단히  말하면

현재 Train/Test 분할을 JSON으

로 저장합니다. 이 파일을 학습 

시 직접 제공할 수 있어, 동일한 

테스트 세트가 다시 사용됩니다.
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W28 SCNView (3D Camera Globe)

위치

Holdout 창의 중앙 패널..

기술적  설명

SceneKit 글로브 뷰. 장면은 다음으로 구성됩니다: 와이어프레
임 구체 (반경 1.0, 36 세그먼트, 짙은 회색), 세 개의 색이 있는 
축 stub (X/Y/Z용 빨강/녹색/파랑, 각 1.2 길이), 그리고 카메
라당 단위 구체의 해당 시선 방향 위치 (와이어프레임 구체 안으
로 사라지지 않도록 약간 외부) 의 작은 마커 구체 (반경 0.03). 
마커는 각 폴드 변경 시 재구성되지 않습니다 — 재구성은 프레
임 목록이 변경될 때 (즉 새 JSON이 로드될 때) 에만 필요합니
다. 대신 업데이트마다 재료 색상의 인플레이스 업데이트가 실
행됩니다: 테스트 인덱스용 빨강, 학습용 녹색, 둘 다 아닌 경우 
밝은 회색. 따라서 N > 1000 카메라에서도 슬라이더 틱이 성
능적으로 유지됩니다.

카메라 제어가 활성화되어 있습니다 — 마우스로 글로브를 회전
하고 줌하고 팬할 수 있습니다. 조명은 마커가 평평하게 보이지 
않도록 합니다. 배경은 짙은 회색입니다.

간단히  말하면

카메라 위치가 있는 3D 글로브. 

녹색 = Training, 빨강 = Test, 밝은 

회색 = 미할당 (발생하지 않음, 

모든 카메라는 어딘가에 속함). 

마우스로 글로브를 회전하고 줌

할 수 있습니다.

W29 FoldCard (탭하여 폴드 선택)

위치

오른쪽 사이드바, “Angular Correlation” 섹션..

기술적  설명

폴드당 하나의 카드 뷰 — 6 pt 반경의 둥근 직사각형, 패딩 
10, 두 줄의 수직 레이아웃 (위 “Fold N” + 카메라 수, 아래 
“Mean nearest angle:” + 도 단위 값). 배경색은 조건적: 활
성 폴드 = 반투명 강조 색상, 비활성 = 중립 표준 Material. 탭
하면 폴드가 선택되고 글로브가 실시간으로 다시 칠해집니다.

“Mean nearest angle” 점수는 가장 가까운 학습 카메라에 
대한 테스트 카메라당 평균 가장 작은 각도입니다 (내부적으로 
라디안으로 계산, UI에서 도 단위로 표시).

간단히  말하면

폴드당 오른쪽에 카메라 수와 가

장 가까운 학습 카메라에 대한 

평균 거리가 있는 작은 카드. 클

릭하면 이 폴드를 테스트로 선택

합니다.
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BayesOpt Console (W30–W39)

그림 24:  BayesOpt 콘솔 — 시행 시작 전 비어 있는 상태

탐색 공간 선택기 (RadianceKit defaults (6-dim)), 시행 예산 슬라이더 (기본 40), 무작위 Seed 
(42), 그리고 Convergence 차트, Trial Log, 탐색 공간 매개변수 목록을 위한 세 개의 비어 있는 패널이 
있는 비어 있는 상태.

비어 있는 상태 (처음 열린 후) — 실행이 시작되면 Convergence 차트와 시행 테이블이 채워집니다. 다
음 캡처 참고.

그림 25:  40번의 시행 후 BayesOpt 콘솔 — Convergence 차트는 시행 15까지 가파르게 상승, Best 
Value 0.9943, Trial Log에 init/bo/restart 태그

이미지에 보이는 것  위 오른쪽 상태 “Finished — best 0.9943 after 40 trials”. 왼쪽 사이드바: 탐색 공
간 선택기 RadianceKit defaults (6-dim), 시행 예산 40, 무작위 Seed
42. 매개변수 목록은 튜닝할 여섯 하이퍼파라미터를 값 범위와 함께 표시합니다:

mipSmoothing3DScale [0.05, 0.5], mipFilter2DVariance [0.1, 0.6], 
densifyGradThreshold [5e-07, 5e-06], ssimWeight [0.05, 0.5], mcmcNoiseScale 
[1e-05, 0.0001], mcmcRelocationInterval [50, 200]. 중앙: Convergence 차트 (X = 시행 
인덱스 1–40, Y = 목표 값 0–1) — 회색 점 = 초기 샘플 (LHS), 파란색 점 = BayesOpt Acquisition, 
주황색 점 = Restart 시행 (#22와 #31). Best Value 선은 시행 ~7까지 가파르게 상승, 그 후 시행 15까
지 미미한 개선만, 그 이후 0.99+에서 평평한 plateau. 오른쪽 사이드바: 시행 로그 #1–#34, 점수 + 태
그 (init/bo/restart). 오른쪽 위 Save Best Config 버튼은 bayesopt-best.json 을 작성합니다.
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그것이 무엇인지: 하이퍼파라미터 검색을 위한 베이지안 최적화 콘솔. 베이지안 옵트는 가능한 적
은 실험으로 알 수 없는 함수의 최적 점을 찾으려고 시도하는 자동 절차입니다 — 일반적으로: 
“mcmcMaxGaussians, capMultiplier, ssimWeight, gradThreshold의 어떤 조합이 내 장면 클래
스에 대해 최고의 PSNR을 제공합니까?” 6^4 = 1296개의 시행으로 구성된 격자 대신 베이지안 옵트는 
약 40–100개의 정보를 가진 시행을 시도하고 그것으로 최적에 가까이 다가갑니다.

중요: 현재 앱에 출시된 버전은 실제 학습 실행에 대해 최적화를 실행하지 않습니다 (그것은 며칠이 걸릴 것
입니다). 대신 합성 데모 목표 — Hill Climbing 특성과 약간의 노이즈가 있는 다중 모달 풍경 — 에 대해 
실행됩니다. 이는 의도적인 것입니다. 창은 옵티마이저의 동작 (수렴 진행, 샘플 포인트, Best-So-Far) 을 
보여 주고 탐색 공간 정의를 이해할 수 있도록 합니다. 실제 학습 기반 BayesOpt 실행 (Scene Class 프
리셋에 대한 Phase Q7에서처럼) 의 경우 별도의 오프라인 CLI 워크플로가 사용됩니다. 창은 실시간 UI 
변형입니다.

언제 열까  세 가지 사용 사례: 1. BayesOpt가 어떻게 작동하는지 이해하고 싶다 — 데모 실행을 시작하고 
Convergence 차트를 관찰. 2. 내장된 10개 프리셋이 완벽하게 맞지 않는 새 장면 클래스 (예: “수족관” 
또는 “골동품 가구”) 를 계획. 정신적으로 탐색 공간을 정의하고 여기서 “Bowl demo” 또는 “Densify” 
프리셋으로 테스트한 다음 Best Config를 JSON으로 내보내고 실제 학습 실행의 시작점으로 사용. 3. 
RKBayesOpt 패키지에 정의된 기본 탐색 공간 (Mip Subset, RadianceKit Defaults) 을 검사하고 싶
다 — 왼쪽 사이드바의 매개변수 패널에 나열됩니다.

어떻게 해석할까  - Convergence 차트 (중앙 열): Y = 지금까지 달성된 최고의 목표 함수 값. X = 시행 
인덱스. 처음에는 가파르게 상승 (BayesOpt가 초기 샘플을 무작위로 시도하고, 그 중 일부가 운이 좋음), 
그 다음 최적에 가까운 영역이 소진되었으므로 점차 평평해집니다. 선이 20+ 시행 동안 평평하게 유지되
면 실행을 중지할 수 있습니다 — 추가 시행은 더 이상 가져오지 않습니다. 차트의 개별 점은 개별 시행 
값 (즉 “best so far”가 아님) 이며 단계별로 색상이 지정됩니다: 회색 = 초기 샘플, 파랑 = BayesOpt 
Acquisition, 주황 = Restart. - 시행 테이블 (오른쪽 열): #1, #2, #3, … 각각 값과 단계 태그. 지금
까지의 최고 시행은 노란색 별로 표시됩니다. 테이블에서 Best 시행을 식별하고 나중에 내보내기 시 매개
변수 값을 볼 수 있습니다. - 탐색 공간 인스펙터 (왼쪽 사이드바): 선택된 프리셋에 대해 모든 매개변수 
이름과 탐색 범위 [lo, hi] 를 표시합니다. “RadianceKit defaults (6-dim)” 프리셋에 있으면 예: 
“densifyGradThreshold [5e-7, 5e-6]”를 봅니다 — 즉 이 두 값 사이의 로그 균등.

예제 워크플로  프리셋 “RadianceKit defaults (6-dim)”, 시행 예산 40, Seed 42를 선택합니다. 
“Start”를 클릭합니다. 관찰: 처음 8개 시행은 회색 (초기 샘플, LHS-Latin Hypercube), 그 다음은 파
란색 (BayesOpt Acquisition). Convergence 차트는 시행 ~15까지 가파르게 진행되며, 그 후 평평해
집니다. 시행 ~30–40에서 Best 값이 안정화됩니다. “Save Best Config”를 클릭하면 프리셋 이름, 시
행 인덱스, 값, 디코딩된 매개변수 값과 함께 bayesopt-best.json 이 저장됩니다. 이 JSON을 그런 다
음 프리셋 정의에 수동으로 적용할 수 있습니다.
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W30 버튼 “Start”

위치

툴바 왼쪽, Idle/Finished 상태에서..

기술적  설명

시행 목록을 재설정하고 Running 상태로 전환하고 새 실행 ID
를 생성하고 (여러 Start 클릭의 stale 감지를 위해) 새 Pause 
Gate를 생성합니다. 그런 다음 옵티마이저를 비동기 스트림으
로 실행하는 백그라운드 작업을 시작합니다. 초기 샘플 크기는 
min(8, budget /​ 4 + 1) 에서 발생합니다 — 즉 예산 ≥ 
28의 경우 일반적으로 8개의 Latin Hypercube 샘플, 작은 
예산의 경우 더 적음. 시행 업데이트는 점진적으로 수신되어 목
록에 추가됩니다. Stale 실행 보호: 그 사이에 두 번째 Start 클
릭이 실행 ID를 다시 설정하면 이전 실행에서의 업데이트가 폐
기됩니다.

두드러진 버튼 모양을 위한 Primary Action 스타일.

간단히  말하면

현재 탐색 공간, 예산, Seed로 새 

최적화 실행을 시작합니다.

W31 버튼 “Pause”

위치

툴바 왼쪽, Running 상태에서..

기술적  설명

Pause Gate를 활성화하고 Paused 상태로 전환합니다. 실제 
효과: Runner는 다음 목표 함수를 평가하기 전에 50 ms 폴
링 루프에서 기다립니다. 즉, 현재 실행 중인 시행이 끝까지 진
행되지만 (합성이며 마이크로초만 걸림), 더 이상 시행이 시작되
지 않습니다. Resume이 실행되는 즉시 중단된 곳에서 계속됩
니다.

간단히  말하면

실행을 중단합니다. 현재 계산은 

끝까지 실행된 다음 일시 정지됩

니다.

W32 버튼 “Stop”

위치

툴바 왼쪽, Running 및 Paused 상태에서..

기술적  설명

Runner 작업을 중단하고 참조를 null로 설정하고 Pause 
Gate를 해제하고 (paused였다면) Finished 상태로 (시행이 
존재할 때) 또는 Idle 상태로 (없을 때) 전환합니다. 이미 계산
된 시행은 목록에서 보이는 채로 남아 있습니다 — Stop은 그것
들을 삭제하지 않습니다. 파괴적 버튼 역할은 실행을 중단하기 
때문에 버튼을 빨간색으로 표시합니다.

간단히  말하면

실행을 최종적으로 중단합니다. 

시행은 보이는 채로 남으며, 그

래도 Best Config를 내보낼 수 있

습니다.
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W33 버튼 “Resume”

위치

툴바 왼쪽, Paused 상태에서..

기술적  설명

Pause Gate를 해제하고 Running 상태로 다시 전환합니다. 
Runner 작업은 이미 실행 중입니다 (폴링 루프에서 기다림). 
루프가 일시 정지가 해제되었다는 것을 알아차리는 즉시 계속 
실행되고 다음 시행을 시작합니다.

간단히  말하면

일시 정지된 실행을 재개합니다.

W34 버튼 “Save Best Config”

위치

툴바 오른쪽, 항상 표시 (그러나 bestTrial이 없으면 비활성
화)..

기술적  설명

기본 파일 이름 bayesopt-best.json 이 있는 저장 대화 상
자를 엽니다. JSON으로 제한됩니다. 확인 후 Payload 사전
이 구축됩니다: 프리셋 이름, 시행 인덱스, 값 (목표 점수), 매개
변수 (디코딩된 매개변수 이름 → 값의 사전). 디코딩은 정규화
된 탐색 공간 좌표 [0,1]^d 를 원래 값 범위로 다시 투영합니다 
(log-uniform/linear/integer 스케일에 따라). JSON 출력은 
pretty printed이며 정렬된 키가 있습니다. 쓰기 오류 시 (현재 
데모 버전에서) 조용히 무시됩니다 — 오류 UI 없음, 데모 경로
이기 때문에.

시행이 실행되지 않은 동안에는 버튼이 회색입니다.

간단히  말하면

지금까지의 최고 시행의 매개변

수 값을 JSON으로 저장합니다. 

이 값을 그런 다음 수동으로 프

리셋 구성에 적용할 수 있습니

다.
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W35 선택기 “Search Space” 프리셋

위치

왼쪽 사이드바, 위..

기술적  설명

네 프리셋 옵션이 있는 메뉴 선택기: - “RadianceKit 
defaults (6-dim)” — 모든 Q7 하이퍼파라미터가 있
는 전체 표준 탐색 공간. - “Mip subset (2-dim)” 
— mipSmoothing3DScale [0.05, 0.5] log-uniform과 
mipFilter2DVariance [0.1, 0.6] linear만. 장면 클래스에 
대해 Mip Splatting을 튜닝하려는 경우 유용. - “densify-
until + ssim-weight
1. grad-thresh“ — 세 개의 Densify 관련 매개변수 

(densifyGradThreshold

log-uniform, ssimWeight  linear, 
densifyUntilIter  integer). - “Bowl demo (1-dim)” 

— “BayesOpt가 이렇게 작동” 데모를 위한 교육용 단일 매개
변수 탐색 공간.

실행이 활성인 동안 탐색 공간은 변경할 수 없습니다 (옵티마이
저를 혼란시킬 것임).

간단히  말하면

BayesOpt가 검색하는 하이퍼

파라미터 탐색 공간. 표준

은 “RadianceKit defaults”입니

다. 목표 Mip 튜닝 시도용으로는 

“Mip subset”. BayesOpt가 어떻

게 작동하는지 이해하기 위해서

는 “Bowl demo”.

W36 슬라이더 “Trial Budget”

위치

왼쪽 사이드바, Search Space 선택기 아래..

기술적  설명

10에서 200까지 슬라이더, 단계 5. 기본 40. 즉: BayesOpt
는 최대 N 시행을 할 수 있습니다. 그 중 처음 몇 개는 초기 샘
플 (Latin Hypercube), 나머지는 실제 BayesOpt 시행입니
다. 실용을 위한 경험 법칙: d 차원의 탐색 공간은 좋은 최적을 
위해 약 10d에서 20d 시행이 필요합니다. 6차원 기본값의 경
우 60–120, 2차원 Mip Subset의 경우 20–40, 1차원 Bowl 
Demo의 경우 10–20.

실행 중에는 슬라이더가 비활성화됩니다.

간단히  말하면

최대 몇 번의 최적화 시도. 더 많

은 시도 = 더 나은 솔루션이지만 

시간이 더 걸림. 40이 데모 목표

에 좋은 기본값입니다.
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W37 슬라이더 “Random Seed”

위치

왼쪽 사이드바, 예산 슬라이더 아래..

기술적  설명

1에서 100까지 슬라이더, 단계 1. 기본 42. Seed는 초기 
Latin Hypercube 샘플과 데모 목표의 노이즈 구성 요소 모두
에 전달됩니다. 재현성: 같은 Seed + 같은 탐색 공간 + 같은 예
산은 정확히 동일한 시행 시퀀스를 제공합니다. “모든 동료가 데
모를 재구축할 때 같은 실행을 얻을 수 있는가?”에 유용합니다. 
실행 중에는 비활성화됩니다.

간단히  말하면

난수 생성기를 제어합니다. 같은 

Seed = 같은 실행 — 재현용입니

다.

W38 Chart (Convergence)

위치

창의 중앙 열..

기술적  설명

두 레이어가 있는 Swift Charts 다이어그램: 1. 시행당 
“best-value-so-far” 선 — 강조 색상의 단조 증가 또는 동일
한 곡선. 2. 개별 목표 값이 있는 시행당 하나의 점, 단계별로 색
상 지정. 기호 크기
40. 세 개의 단계 레이블: “init” (회색), “bo” (파랑), 

“restart” (주황).

작은 범례는 위 왼쪽에 단계 색상을 표시합니다. 시행 목록이 비
어 있으면 (첫 Start 전), 대신 Chart 아이콘과 힌트 “Press 
Start to begin a BayesOpt run.”이 있는 빈 상태 표시가 표
시됩니다.

간단히  말하면

진행 차트. 실선은 “지금까

지 발견된 최고의 솔루션”입니

다. 점은 개별 시도입니다. 선

이 오랫동안 평평하게 유지되면 

BayesOpt가 최적을 찾은 것입니

다.

W39 Table (Trial Log)

위치

창의 오른쪽 열..

기술적  설명

Lazy 스택형 시행 줄이 있는 스크롤 영역. 줄당 수평 스택: 시
행 번호 (3자리 monospaced, 왼쪽), 값 (monospaced, 오
른쪽 정렬, 70 pt 폭), 단계 태그 (Capsule, 25% Opacity에
서 단계 색상으로 채워짐), 이 시행이 현재 Best일 경우 선택적
으로 노란색 별. 자동 스크롤 메커니즘은 새 시행이 추가되는 즉
시 자동으로 끝으로 점프합니다 — 따라서 자체적으로 스크롤하
지 않고 화면 하단에서 실시간 진행을 함께 읽을 수 있습니다.

간단히  말하면

모든 시도의 테이블. 값, 단계, 

Best용 별. 자동으로 스크롤되

고, 새 시행이 아래에 나타납니

다.
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메인 윈도우: Loss 진행과 Gaussian Count (I39–I41, 상호 참조)

메인 윈도우의 인스펙터 표시 세 가지는 실행 중인 학습 동안 끊임없이 보이고 진행이 건강해 보이는지에 대
한 중요한 경험 법칙이 있기 때문에 별도의 설명이 필요합니다. 표시는 인스펙터의 “Loss Chart” 섹션 (제 
2 장 — Inspector 참고) 에 있으며, 위 보조 창의 Holdout 분석을 보완합니다.

Loss 곡선이 언제 건강한가? 건강한 Loss 곡선은 세 단계를 보여 줍니다: (1) Warmup — 처음 
200–500 반복에서 Loss가 높음 (장면에 따라 L1+SSIM 결합으로 일반적으로 0.15–0.25) 에서 약 
절반으로 가파르게 떨어집니다. 이 단계에서 Loss가 떨어지지 않으면 입력이 보통 잘못된 것입니다 (이
미지 손상, SfM 포즈가 나쁨, 초기 Gaussian 수가 너무 적음). (2) Densification — ~500과 
densifyUntilIteration (고전적으로 15K, MCMC는 20K 또는 25K) 사이에 Loss가 계속 떨어지며, 종
종 Densify 동작이 새 Gaussian을 삽입하고 옵티마이저가 그것을 활용할 때 작은 하향 점프가 있습니다. 
Gaussian Count는 이 단계에서 증가합니다. (3) Refinement — 그 후 Loss는 평평해지는 tail로 실
행됩니다. 일반적인 최종 값: P4 Quality가 있는 Tanks & Temples Truck은 L1 ≈ 0.023, V546과 
함께 Full Classic이 있는 Horse는 L1 ≈ 0.0230, 야외 Mip-NeRF360 장면은 종종 더 나쁨 (0.04–
0.07).

Plateau는 무엇을 의미하는가? Plateau (Loss 곡선이 수천 회 반복 동안 수평으로 진행) 는 두 가지 
해석을 가집니다: (a) 모델이 수렴되어 추가 학습이 더 가져오지 않음 — 좋은 경우. (b) 모델이 막힘 (지
역 최소값, 나쁜 그래디언트 정보, 버퍼 한도의 Cap) — 나쁜 경우. 둘 다 차트에서 동일하게 보입니다. 
구별: Gaussian Count를 봅니다. 그것도 평평하고 MCMC Cap에 가깝다면 (예: .fullMCMC 에서 
150K/150K), 한도에 있습니다 — 그러면 Cap을 늘리거나 Plateau를 수용합니다. Gaussian Count가 
여전히 증가하지만 Loss가 떨어지지 않으면 막힌 것입니다.

언제 중단할지 또는 계속 학습할지? 경험 법칙: 10K 반복 동안 Min Loss의 개선 없음 → 중단, 추가 반
복은 낭비입니다. 그 전에: 한계선 개선이 보이면 Cmd+T (Training 메뉴 → Continue Training → 
+5K iterations) 를 통해 연장을 추가할 수 있습니다. 주의: MCMC에서는 Plateau가 종종 진짜입니다 
— Cap이 자연스러운 한계입니다.

Gaussian Count Plateau는 “완료” 신호가 아닙니다. MCMC가 Cap에 도달했거나 Classic 
Densification이 소진되었다는 것만 의미합니다. 실제 “완료” 질문은 Holdout 분석만이 묻습니다 — 독
립적인 테스트 세트의 PSNR/SSIM/LPIPS, Holdout 창 (W23–W29) 또는 --benchmark  플래그를 
통해 평가됨.

PSNR/Holdout이 진실, Loss는 단지 프록시. Loss는 상대적 메트릭입니다: 모델이 학습 뷰에 적응하
는 동안 떨어집니다. 그러나 낮은 Loss가 자동으로 좋은 모델을 의미하지는 않습니다 — 모델이 학습 이미
지를 암기했다면 (Overfitting) Loss는 작지만 보이지 않은 뷰 (Holdout) 에서의 PSNR은 나쁠 것입니
다. 따라서: 최종 품질 평가를 위해 항상 Holdout 메트릭을 보고 최종 Loss만 보지 마십시오.

경험 법칙 상자

• User Guide와 Keyboard Shortcuts는 정적 도움말입니다 — 키워드 질문에는 빠르지만 깊이를 위해
서는 여기 이 매뉴얼을 사용하십시오.

• 디스크 여유 공간이 10% 미만으로 떨어지면 Manage Storage를 엽니다. 로그와 Imports 스테이징
이 일반적인 원인입니다.

• Pareto Dashboard는 최소 세 개 또는 네 개의 학습 리포트 후에만 의미가 있습니다. X축 = 비용 
(Time / Gs), Y축 = 품질 (PSNR / SSIM). Pareto Front가 효율적인 조합을 보여 줍니다.

• PSNR 벤치마크를 다른 사람들과 공개하기 전에 Holdout Analysis를 사용하십시오 — 테스트 세트가 
실제로 대표적인지 확인합니다.
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• BayesOpt Console은 주로 탐색 공간 정의를 위한 학습 및 검사 도구입니다. 실제 학습 기반 하이퍼파
라미터 튜닝의 경우 오프라인 CLI 워크플로를 사용하십시오.

• Loss Plateau와 Gaussian Count Plateau는 별도로 해석되어야 합니다. Cap 한도는 “완료” 신호
가 아닙니다. 실제 품질은 Holdout PSNR만이 측정합니다.

• Min Loss 개선 없이 10K 반복 → 학습 중지.
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장

제 6 장 — 학습 구성

그림 26:  Preview 프리셋을 JSON으로 내보내고 TextEdit에 표시 — id/name/
category/version/createdAt/description 필드, 모든 관련 매개변수가 있는 trainingConfig 

(maxIterations 5000, densifyUntilIteration 3500, ssimWeight 0.20, renderScale 0.50, 
strategy classic, cameraAlignment applePhotogrammetry, densifyGradThreshold 2.0e-06, 

opacityResetInterval 3000, minOpacity 0.005, 여섯 개의 Bool 토글)

이미지에 보이는 것  일반적인 프리셋 JSON 내보내기입니다. 최상위 필드: id  (UUID), name , 카테
고리 (classic | mcmc | sceneClass | custom), 버전 (스키마 버전), createdAt (타임스탬프), 
description (자유 텍스트). 중첩된 trainingConfig 객체는 재현성에 결정적인 매개변수를 포함합니다 
— 가져오기 시 전체 블록이 TrainingConfig  구조로 역직렬화되고 앱 버전의 기본값이 JSON에 없는 
필드를 채웁니다 (예: 앱 업데이트 후). 다른 Mac에 프리셋을 전달하려는 사람은 단순히 이 JSON 파일을 
보내면 됩니다.

TrainingConfig  구조는 RadianceKit의 모든 학습 실행의 핵심입니다. 학습에 영향을 미치는 모든 매
개변수를 모아 둡니다 — 최대 반복 수에서 여덟 학습률, MCMC, Mip-Splatting, Curriculum, 장면 인
식 Cap 로직의 특수 필드까지. Training Configuration 섹션 (Expert View) 의 사이드바에서 편집하
고, 프리셋으로 저장하거나 JSON 내보내기로 다른 Mac에 전달합니다. 학습 시 정확히 이 객체가 동결되
어 GPU 백엔드에 전달됩니다.
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이 장은 파워 유저와 스크립트 작성자를 위한 참조 자료입니다. 81개의 모든 공개 필드, 9개의 정적 프리셋, 
그리고 하나의 공개 메서드를 나열합니다. 소스 파일은 TrainingConfig.swift입니다 — 의심이 있다면 
거기에 저장된 Doc Comment와 이니셜라이저 기본값이 Source-of-Truth 입니다.

참고  ·  U I  V S .  프리셋 /C L I

81개 필드 중 12개만이 Inspector (Sandboxed App Store 빌드) 에 직접 슬라이더, 토글 또는 
선택기가 있습니다: T1, T2, T17, T20, T22, T38, T56–T58, T60, T61, T73. 나머지 69개 
필드는 선택된 프리셋 (제 7 장) 을 통해 설정되며 CLI 플래그 (제 5 장 참고) 를 통해서만 직접 재정
의할 수 있습니다. 이 분리는 의도적입니다. 기본값은 안정적이고 프로덕션 검증된 상태로 유지되며, 
파워 유저는 그래도 탈출구를 가집니다. 어떤 필드가 특히 흥미롭다면 먼저 제 2 장 (Inspector) 과 
제 5 장 (CLI) 을 확인하여 JSON 조작 없이 도달할 수 있는지 살펴보십시오.

목차:

1. Iteration (T1–T2)
2. Learning Rates (T3–T10)
3. Densification — Classic (T11–T16)
4. Loss (T17–T20)
5. SH-Degree-Progression (T21)
6. Performance (T22–T25)
7. 진단과 점 구름 준비 (T26–T30)
8. 정규화 (T31–T37)
9. Refinement (T38–T44)

10. Sky-Dome (T45–T48)
11. Adam + LR 스케줄 (T49–T55)
12. Post-Processing + Apple AI (T56–T60)
13. MCMC Densification (T61–T73)
14. Mip-Splatting (Q1.5) (T74–T76)
15. Adaptive Densification (Q5) (T77–T79)
16. Curriculum (Q6) (T80–T81)
17. 정적 프리셋 (TP1–TP9)
18. 메서드: resolveMcmcMaxGaussians
19. 어느 필드를 무엇을 위해? (치트 시트)
20. 위험한 필드
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Iteration (T1–T2)

T1 maxIterations

세부  정보

기본값: 30 000 (이니셜라이저), 35 000 ( .full ), 200 
000 ( .fullMCMC ) 범위: 1 000 – 500 000 (UI 슬라이
더), 로직에 하드 상한 없음 정의 위치: TrainingConfig.swift

기술적  설명

백엔드가 통과하는 총 학습 반복 수. 한 반복은 단일 학습 카메
라의 Forward Render, 모든 Loss 구성 요소 (L1 + SSIM + 
선택적 정규화
1. Sky Mask) 에 대한 Backward Pass, 그리고 하나의 

Adam 옵티마이저 단계를

의미합니다. 이 숫자는 다른 스케줄에 직접 영향
을 줍니다: Position 학습률은 0에서 T1  자
체 또는 T49 positionLRScheduleEndIteration까지의 
Cosine Annealing 곡선을 따르고, Densification은 T2 
densifyUntilIteration에서 멈추며, MCMC 노이즈 감쇠
는 T69 mcmcNoiseDecayEnd에서 종료되고, SH-Degree 
업그레이드는 T21 에 정의된 세 표시에서 발생합니다. 고전
적 Densification의 경우 경험적으로 결정된 스위트 스폿은 
20 000–35 000 반복 (Sessions 1–32, V546 테스트), 
MCMC는 60 000–200 000 (V534) 입니다. 프리셋에 저
장된 값을 훨씬 초과하여 극단적으로 늘리면 추가 품질이 거
의 나오지 않습니다 — Adam Momentum이 포화되고, LR 
Decay 종료 없이는 Loss가 정체됩니다. 반대로 ~5 000 미
만으로 떨어지면 완전히 수렴되지 않은 형상으로 이어집니다 
(Density Control이 클론/스플릿할 시간이 너무 적음).

간단히  말하면

앱이 얼마나 오래 계산하는지. 

더 많은 반복 = 더 나은 결과이

지만 어느 시점부터는 눈에 띄

게 더 나아지지 않으면서 훨씬 

더 오래 걸립니다. 프리셋은 생

각하지 않고도 좋은 값을 갖도

록 선택되어 있습니다: Quick 1 
000, Preview 5 000, Balanced 
20 000, Quality 35 000, MCMC 

Quality 200 000. 직접 조정한

다면: MCMC에서는 마음껏 높게 

(100 000–200 000), Classic에서

는 40 000 이상 가지 마십시오 — 

더 이상 가져오지 않습니다.
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T2 densifyUntilIteration

세부  정보

기본값: 15 000 (이니셜라이저), 5 000 ( .full ), 160 
000 ( .fullMCMC ) 범위: 0 – maxIterations 정의 위치: 
TrainingConfig.swift

기술적  설명

Densification이 중지되는 반복. 이때까지 Gaussian은 
T11--T16  (Classic) 또는 T67--T70  (MCMC) 에 
매개변수화된 규칙을 통해 복제, 스플릿, 정리됩니다. 그 
후 Gaussian 수는 일정하게 유지되며 위치, 회전, 스케
일, Opacity, SH 계수만 최적화됩니다 (Refinement 단
계). 3DGS 원본 논문에서는 값이 T1 의 50%이지만 
RadianceKit의 .full  프리셋에서는 약 14% (35 000 중 
5 000) — V310/V338 실험의 결과로, 5 000 반복 후 추가 
Densification이 결과를 악화시키는 경향이 있음을 보여 주었
습니다 (더 많은 플로터, 더 많은 메모리 사용량, 품질 이득 없
음). 반면 MCMC는 Relocation을 T1 의 80%까지 실행합
니다 (V504b). MCMC는 해로운 플로터를 생성하지 않기 때
문입니다. T2 를 너무 작게 (< 1 000) 선택하면 너무 적은 
Gaussian이 생성됩니다. Classic에서 너무 크면 (> T1 의 
50%) Overgrowth와 RGB-Saturation 아웃라이어로 이어
집니다 (Outdoor Overtraining Findings 참고).

간단히  말하면

언제까지 앱이 새 Gaussian을 만

들 수 있는지. 그 후에는 이미 

있는 것을 정제할 뿐입니다. 35 

000 반복의 고전적 학습에서는 

5 000이 적절한 값입니다 — 그 

이상은 장면을 더 흐릿하게 만

듭니다. MCMC에서는 총 반복의 

80%입니다 (즉 200 000 실행에

서 160 000). Quality 프리셋을 변

경한다면 이 필드는 그대로 두는 

것이 좋습니다.
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Learning Rates (T3–T10)

T3 positionLearningRate

세부  정보

기본값: 0.00016 범위: 1e-7 – 1e-3 (권장) 정의 위치: 
TrainingConfig.swift

기술적  설명

학습 시작 시 (Iteration 0) 각 Gaussian의 XYZ 위치에 대
한 Adam 학습률. Cosine Annealing 곡선을 따르고 학습 진
행 과정에서 T4 positionLearningRateFinal로 감소합니
다. 기본값 0.00016은 3DGS 원본 논문 (Kerbl 외 2023) 에
서 가져왔으며 이미지 해상도를 늘려도 RadianceKit에서 스케
일링할 필요가 없습니다 — 위치는 픽셀 공간이 아닌 세계 좌표
계에서 움직입니다. 상당히 높이면 (> 0.0005) Gaussian이 
긴 거리에 걸쳐 점프하고 Loss가 불안정해집니다. 훨씬 낮은 값 
(< 0.00005) 은 잘못 초기화된 점 구름이 자리를 찾지 못하게 
합니다. V414는 Init 값의 두 배를 테스트했습니다 → 16.8% 
더 나쁜 L1 Loss. V544a 튜닝은 논문 기본값을 최적으로 확
인했습니다. 참고: .fullMCMC 에서는 의도적으로 이 값을 기
본값으로 둡니다 — MCMC는 Relocation 로직에 일정한 학
습률이 필요하므로 여기서 튜닝해도 가져오는 것이 없습니다.

간단히  말하면

Splat 점이 공간에서 얼마나 빠

르게 움직일 수 있는지. 기본값

은 매우 잘 조정되어 있고 실제

로 변경할 필요가 없습니다. 이

미지에서 Splat이 “흔들리거나” 

아무것도 거기로 이동하지 않아 

한 모퉁이가 누락된 경우에만 학

습률이 조정 지점이 됩니다 — 그

러나 그러면 일반적으로 다른 것 

(카메라 포즈, 초기 점 구름) 이 

먼저 맞지 않습니다.
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T4 positionLearningRateFinal

세부  정보

기본값: 0.0000016 (이니셜라이저 + 논문), 0.000016 
( .full , .fullMCMC  — 10배 더 높음) 범위: 0 – 
positionLearningRate 정의 위치: TrainingConfig.swift

기술적  설명

Position LR Cosine Annealing 곡선의 최

종 값. 
T1

maxIterations  또는 설정된 경우 
T49 positionLRScheduleEndIteration에서 도달합니다. 
RadianceKit .full  프리셋은 0.000016을 사용합니다 — 
논문 기본값 0.0000016보다 10배 더 높습니다. V420 실
험에서는 최종 값의 0.5배 (0.000008) 가 Loss를 6.4% 
악화시킨다는 것을 보여 주었고, V414는 Init 값의 2배가 
Loss를 16.8% 악화시킨다는 것을 보여 주었습니다. 높은 최
종 값은 트레이드오프가 아니라 의식적인 선택입니다: Decay
가 너무 강하면 Gaussian이 Refinement 단계 동안 새
로 추가된 Densification 후보에 적응하는 능력을 잃습니
다. V431/V433 확장을 통해 스케줄 단계를 단축할 수 있
어 ( T49 < T1 ), T4 가 학습 종료 전에 이미 도달하고 학
습의 나머지가 일정한 미니 LR로 실행됩니다 — 일반적인 구

성: T49 = 20 000 , 
T1 =

35 000 , 따라서 Refinement는 15 
000 반복 동안 0.000016에서.

간단히  말하면

학습이 끝날 때 Position 학습

률이 얼마나 느려질지. 원본 논

문보다 의도적으로 덜 공격적으

로 설정했습니다 — Splat은 끝

까지 약간 흔들릴 수 있고 이로 

인해 더 선명해집니다. 조정한다

면: 더 높음 = 끝에 더 불안한 

Splat, 더 낮음 = 새 Splat이 나타

날 때 Splat이 적응할 수 없음.

T5 shDCLearningRate

세부  정보

기본값: 0.0025 (이니셜라이저 + 논문), 0.005 ( .full 과 
모든 MCMC 프리셋 — 2배) 범위: 0.0001 – 0.05 정의 위
치: TrainingConfig.swift

기술적  설명

Spherical Harmonic 색상의 DC 부분 (degree 0, 즉 일정
한 Albedo) 에 대한 Adam 학습률. SH-DC는 Gaussian의 
방향 독립적 기본 톤에 해당하며, 어떻게 보면 “기본 색상”입
니다. V176 및 V188 실험에서 논문 기본값보다 2배 더 높
은 것이 최적임을 발견했습니다 — 더 빠른 색상 수렴, 특히 짧
은 학습 (예: 5 000 반복) 에서는 그렇지 않으면 SH-DC
가 정상으로 들어오지 않기 때문입니다. 기하학적 LR과 달리 
SH-DC는 Decay가 없습니다. 학습률은 모든 반복에 걸쳐 일
정하게 유지됩니다 (또는 T51 의 선택적 Extended Phase 
Decay만 따름). V416은 4배 0.01로 증가를 테스트했습니다 
→ beta2=0.99 Adam에서 6.4% 더 나쁜 Loss.

간단히  말하면

각 Splat의 기본 색상이 얼마나 

빠르게 적응하는지. 거의 직접 

변경하지 않습니다 — 프리셋이 

올바른 값을 가집니다. 더 높이

면 더 빠르겠지만 불안정한 색상

으로 이어질 수 있습니다.
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T6 shRestLearningRate

세부  정보

기본값: 0.000125 (이니셜라이저 + 논문), 0.00025 
( .full 과 MCMC — 2배) 범위: 0.000001 – 0.005 정의 
위치: TrainingConfig.swift

기술적  설명

더 높은 차수의 SH 계수 (Degree 1, 2, 3 — 즉 하이라이
트, 반사, 부드러운 음영을 담당하는 View Direction 의존 색
상 구성 요소) 에 대한 Adam 학습률. 논문 규약에 따라 T5 보
다 20배 작습니다. 이 계수가 수에서 이차적으로 증가하기 때문
입니다 (Degree 1의 경우 3, Degree 2의 경우 5, Degree 
3의 경우 7 → Gaussian당 총 15 Float) 더 작은 학습률 없
이는 이미지가 과포화될 것입니다. 두 단계로 잠금 해제됩니다 
— T21 shDegreeUpgradeIterations의 첫 번째 마크까지
는 Degree 0만 활성 (즉 T5 만), 그 후 1, 그 다음 2, 마지막
으로 3. 디퓨즈 조명이 많은 장면에서 여기에 낮은 값이 특히 중
요합니다. 매우 광택이 있는 표면 (자동차 페인트, 물) 에서는 조
정해도 가치가 없습니다 — SH 표현 자체가 제한적입니다.

간단히  말하면

방향 의존적 색상 효과 (반사, 광

택) 가 얼마나 빠르게 학습할지. 

기본적으로 매우 작습니다. 그렇

지 않으면 모든 것이 반짝거립니

다. 값은 그대로 두는 것이 좋습

니다 — 하이라이트를 더 잘 처리

하려는 사람은 이 LR보다 MCMC

와 더 긴 학습 시간을 사용하는 

것이 더 좋습니다.

T7 opacityLearningRate

세부  정보

기본값: 0.05 (이니셜라이저 + 논문), 0.1 ( .full , 
MCMC — 2배) 범위: 0.001 – 1.0 정의 위치: 
TrainingConfig.swift

기술적  설명

각 Gaussian의 logit Opacity에 대한 Adam 학습률. 앱은 
Opacity를 제한되지 않은 Float 값으로 저장하고 Sigmoid
로 [0, 1] 로 변환합니다. LR은 Logit Space에서 작용합니다. 
V50 테스트 (Best Single-Run L1 0.1664) 후 논문 기본값 
0.05가 복원되었습니다. V71은 V67의 0.025를 revert했습
니다. V188의 0.1로의 두 배는 Pruning을 더 효율적으로 만
듭니다 — 죽은 Gaussian이 T14 pruneOpacityThreshold 
아래로 더 빨리 떨어집니다. V418은 다음을 보여 주었습니다: 
beta2=0.99 Adam의 0.05는 0.1보다 7.1% 나쁩니다 — 
Adam 구성과의 상호작용은 사소하지 않습니다. 낮은 값 (< 
0.01) 은 “죽은” Gaussian이 영원히 주위에 누워 있고 메모
리를 소비하게 합니다. 너무 높은 값 (> 0.5) 은 Opacity 폭
발로 이어질 수 있으므로 Logit 값이 옵티마이저에서 [−15, 3] 
으로 클램프됩니다 (CLAUDE.md의 “Opacity Explosion 
Prevention” 참고).

간단히  말하면

Splat이 얼마나 빠르게 투명하거

나 불투명해질지. 정리에 중요합

니다 — 기여하지 않는 Splat은 

베일이 생성되지 않도록 빠르게 

사라져야 합니다. 표준값이 맞습

니다, 전문가만 변경합니다.
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T8 opacityLearningRateFinal

세부  정보

기본값: 0.0 (= “Decay 없음”) 범위: 0 또는 0.001 – 
opacityLearningRate 정의 위치: TrainingConfig.swift

기술적  설명

Opacity LR의 선택적 Cosine Decay 최종 값 (V427). 0.0
이면 Decay가 비활성화되고 Opacity LR이 전체 학습에 걸쳐 
T7 에서 일정하게 유지됩니다. V427은 Decay 0.1 → 0.01
을 테스트했습니다 — 결과 11.5% 나쁜 Loss. revert되었으
므로 기본값은 “꺼짐”. 필드 뒤의 가설: Refinement 단계에서 
일정한 Opacity LR이 진동으로 이어질 수 있어, 이미 올바른 
투명도 수준에 도달한 Splat이 무작위 그래디언트 변동에 의해 
다시 이동될 수 있다는 것. 경험적으로 확인되지 않습니다 — 
Logit 클램핑 로직이 어쨌든 이를 잡습니다. 필드는 향후 실험
을 위해 사용 가능한 채로 유지됩니다. 매우 긴 MCMC 실행 (> 
500K 반복) 도 이로부터 혜택을 받을 수 있습니다.

간단히  말하면

Opacity 학습률이 끝쪽으로 작아

져야 할지. 표준: 아니요. 시도해 

보았는데 더 나빴고, 비활성화 

상태로 둡니다. 0에 머무십시오.

T9 scaleLearningRate

세부  정보

기본값: 0.005 (이니셜라이저 + 논문), 0.01 ( .full , 
MCMC — 2배) 범위: 0.0001 – 0.1 정의 위치: 
TrainingConfig.swift

기술적  설명

Log Space의 각 Gaussian의 세 스케일 구성 요소에 대
한 Adam 학습률 (RadianceKit은 스케일이 양수로 유지
되도록 log(scale) 을 저장합니다). 논문 기본값 0.005, 
RadianceKit에서는 최적화된 학습률 구성에서 더 나은 스케일 
수렴을 위해 0.01로 두 배. V423 실험: beta2=0.99 Adam
의 0.005 → 18.7% 더 나쁜 Loss와 눈에 띄게 너무 적은 
Gaussian (Density Control이 클론할 수 없었음, 스케일 업
데이트가 너무 느렸기 때문에). 스케일은 각 Gaussian의 확장
을 제어합니다 — 너무 빠른 학습은 “Needle” Gaussian (극
도로 길고 얇은 Splat, T34 scaleRatioPruneThreshold 
참고) 으로 이어지고, 너무 느린 학습은 Splat이 너무 콤팩트하
게 유지되어 Density Control이 너무 자주 스플릿해야 합니
다.

간단히  말하면

Splat의 모양이 얼마나 빠르게 

적응할지. 표준이 좋습니다. 이

를 올리면 “Needle” Splat을 얻기 

쉽습니다 — 극도로 긴 얇은 방울

이 이미지를 떠다니게 만듭니다.
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T10 rotationLearningRate

세부  정보

기본값: 0.001 (이니셜라이저 + 논문), 0.002 ( .full , 
MCMC — 2배) 범위: 0.0001 – 0.05 정의 위치: 
TrainingConfig.swift

기술적  설명

각 Gaussian의 네 쿼터니언 구성 요소에 대한 Adam 학습률. 
쿼터니언은 각 옵티마이저 단계에서 Adam 업데이트 후 다시 
정규화됩니다 (L2 Norm = 1) — 그렇지 않으면 공분산 행렬이 
퇴화될 것입니다. RadianceKit은 Quality 프리셋에서 논문 
기본값을 두 배로 늘립니다. 스케일/위치에 비해 회전이 더 작
은 절대 그래디언트 크기를 가지기 때문 (단위 구체에서 각 단계
가 짧게 유지됨) 이고 2배 없이는 회전이 35 000 반복 윈도우
에서 상당히 under-converged 될 것이기 때문입니다. V188
에 문서화되어 있습니다. NeRF Blender 장면 (Lego, Chair) 
에서는 회전이 특히 영향을 미칩니다 — 객체의 가장자리는 5 
000–10 000 반복 후에야 올바르게 정렬됩니다.

간단히  말하면

Splat이 얼마나 빠르게 회전을 

배우는지 — 즉 객체의 표면에

서 올바른 방향으로 오는지. 표

준이 맞습니다. 다르게 표현하

면: Splat이 표면에 달라붙는 대

신 비스듬히 누워 있는 블록처

럼 보이면 학습 시간이 너무 짧

은 것이지 이 학습률이 너무 낮

은 것은 아닙니다.
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Densification — Classic (T11–T16)

T11 densifyGradThreshold

세부  정보

기본값: 0.000002 (이니셜라이저, 0.5배 해상도용으
로 보정), 0.0000011 ( .full , 1.0배용으로 보정), 
0.000004 ( .quickTest , 0.25배용으로 보정), 2e-7 
( .fullClassicPaper ) 범위: 1e-8 – 1e-3 (해상도 의존) 
정의 위치: TrainingConfig.swift

기술적  설명

Screen Space에 투영된 그래디언트 dMean2D 의 L2 
Norm 임곗값. 이를 초과하면 Gaussian이 클론 또는 스
플릿용으로 표시됩니다. 절대값은 학습 해상도에 직접 의존
합니다 — dMean2D 는 대략 1/해상도² 처럼 스케일됩니
다 (더 많은 픽셀 = 더 작은 픽셀당 그래디언트). 따라
서 각 T22 trainingRenderScale 단계는 보정된 임곗값
을 필요로 합니다: 0.25× → 4e-6, 0.5× → 2e-6, 1.0× 
→ 5e-8 … 1.1e-6 ( .full ). 논문 기본값 0.0002는 
NDC 정규화되어 있고 RadianceKit의 세계 공간 파이프라
인에서 직접 비교할 수 없습니다. V440에서 활성화된 T52 
adaptiveDensifyThreshold 플래그를 사용하면 값을 현재 
그래디언트 분포의 p98에서 런타임에 계산할 수 있지만 — 
V440은 실제 장면에서 이를 테스트하고 63 K Gaussian을 
생성했습니다 (재앙적인 Pruning 손실). 플래그는 꺼진 채로 
유지됩니다. Q5 (T77–T79) 는 Rolling Median을 통한 대
체 Adaptive 로직을 제공합니다. 이 필드는 위험합니다 — 절
반으로 줄이면 2–4배 더 많은 Gaussian이 생성됩니다 (메모
리 압력, OOM 위험). 두 배로 늘리면 장면이 under-densify
될 수 있습니다.

간단히  말하면

Splat이 너무 적게 표시되어 복

제되어야 하는지 결정할 때 앱

이 얼마나 민감한지. 낮은 값 = 

더 민감 = 더 많은 Splat. 더 높

음 = 더 적은 Splat. 이는 일반적

으로 가장 위험한 값 중 하나입

니다: 너무 낮으면 Mac이 수백만 

Splat으로 메모리를 채우고 아마

도 충돌할 것입니다. 필드를 그

대로 두거나 10% 단위로만 변경

하십시오.
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T12 densifyFromIteration

세부  정보

기본값: 500 범위: 100 – 5 000 정의 위치: 
TrainingConfig.swift

기술적  설명

Densification이 활성화되는 첫 번째 반복. 그 전에는 초기 
SfM 점 구름에서 “벗은” 학습만 발생하고 새 Gaussian이 생
성되지 않습니다. 기본값 500은 3DGS 논문에서 왔으며 초
기화에 안정화될 시간을 제공합니다 — Iteration 0부터 이미 
Densification이 시작되면 잘못 배치된 SfM 점이 올바른 위
치를 찾기 전에 여러 번 복제됩니다. V349는 1000을 테스트
했습니다 → 약간 더 나쁜 Loss. 기본값이 최적입니다.

간단히  말하면

앱이 처음으로 Splat을 클론하

기 시작하는 시점. 그 전에는 

이미 존재하는 점만 학습합니

다. 500이 표준값입니다 — 앱

이 곱하기 전에 자신을 처음으

로 orientation하기에 충분한 시

간을 제공합니다.

T13 densifyInterval

세부  정보

기본값: 100 (이니셜라이저, MCMC), 200 ( .full ) 범위: 
50 – 1 000 정의 위치: TrainingConfig.swift

기술적  설명

두 Densification 단계 사이의 반복 수. 논문 기본값 100 — 
매 100회 반복마다 Densify 후보 목록이 평가되어 클론/스플
릿되고 동시에 Prune 후보 목록 (sigmoid(opacity) < T14 
pruneOpacityThreshold) 이 제거됩니다. V112 테스트는 
.full 의 경우 200이 최적임을 발견했습니다 — 더 적은 재
구성 패스가 실행되므로 GPU 부하가 줄어들고, 각 Gaussian
에게 Clone 작업 후 안정화할 더 많은 시간을 제공합니다. 
V417은 beta2=0.99에서 100을 테스트했습니다 → 5.8% 
더 나쁨 (957 K Gaussian, 과 Densification). MCMC
에서는 동일한 필드가 Relocation Interval로 해석됩니다. 
MCMC 특정 로직은 T67 mcmcRelocationInterval을 참
고하십시오.

간단히  말하면

앱이 얼마나 자주 새 Splat을 찾

는지. 100 = 자주, 200 = 중간. 더 

높으면: 각 Splat이 다시 곱해지

기 전에 정착할 더 많은 시간을 

가집니다. 그게 좋습니다. 50으

로 낮추면 GPU를 지속적으로 바

쁘게 만들 수 있지만 눈에 띄게 

개선되지는 않습니다.
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T14 pruneOpacityThreshold

세부  정보

기본값: 0.005 (이니셜라이저, 논문, MCMC), 0.001 
( .full ) 범위: 0.0001 – 0.1 정의 위치: 
TrainingConfig.swift

기술적  설명

다음 Densification 단계에서 Gaussian이 삭제되는 
Sigmoid Opacity 임곗값. T7 opacityLearningRate 및 
옵티마이저의 Logit Clamp 로직과 함께 작용합니다. V393은 
.full 에서 기본값을 0.005에서 0.001로 낮추었습니다 — 
결과: 이국적인 시점에서만 역할을 하는 Splat이 더 오래 보존
되고 SH 세부 정보에 기여합니다. V394는 0.0001을 테스트
했습니다 → 약간 더 나쁨 (너무 적게 정리됨, 메모리 낭비). 중
요: Density Control은 항상 정리해야 합니다. 다른 조치로 버
퍼 용량이 이미 가득 차 있더라도 (“Density Control Must 
Always Prune” 참고 CLAUDE.md) — 그렇지 않으면 죽은 
Gaussian이 누적되고 카운트가 멈춥니다.

간단히  말하면

Splat이 삭제되기 위해 “충분

히 투명한” 것으로 간주되는 시

점. 0.005는 논문 표준입니다. 

Quality에서는 0.001을 가집니다 

— 즉 Splat에게 더 긴 기회를 줍

니다. 이는 부드러운 빛과 약한 

그림자를 더 잘 나타낼 수 있게 

합니다. 더 높게 설정하면 (0.01 

이상) Splat 수가 빠르게 감소합

니다 — 메모리 부족에 유용할 수 

있지만 세부 정보가 듭니다.

T15 opacityResetInterval

세부  정보

기본값: 3 000 (이니셜라이저 + 논문), 100 000 
( .full  = 효과적으로 비활성화), 200 000 ( .fullMCMC  
= 비활성화) 범위: 1 000 – 100 000+ 정의 위치: 
TrainingConfig.swift

기술적  설명

모든 Gaussian의 Opacity가 낮은 값 (~0.01) 으로 재설정
되는 간격 (반복 수) — “동결된” Splat을 재평가하기 위한 
3DGS 논문의 조치. V194는 RadianceKit의 Warmup + 확
률적 학습 설정 + 2배 학습률에서 Opacity Reset이 5.5% 품
질이 들고 Logit Clamp가 이미 Reset 기능을 다룬다는 것을 
보여 주었습니다. 따라서 .full 에서는 실질적으로 비활성화
됩니다 (100 000 > 35 000 = 절대 트리거되지 않음). V421
은 beta2=0.99로 3 000마다 Reset을 테스트했습니다 → 
4.9% 더 나쁨. revert됨. .fullClassicPaper  (Q1.5-A, 
논문 충실 테스트) 에서는 의도적으로 다시 3 000으로 설정되
어 있습니다 — 논문 규모 Gaussian 예산을 달성하기 위한 레
버 중 하나였습니다.

간단히  말하면

앱이 모든 Splat의 가시성을 “거

의 보이지 않음”으로 재설정하

는 간격 (반복 수) — Opacity용 

Reset 버튼 같은 것. 다른 메커니

즘이 이를 불필요하게 만들기 때

문에 우리에게는 비활성화되어 

있습니다 (값이 너무 높아서 절

대 발생하지 않음). 논문 충실한 

실험에서만 켜십시오.
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T16 maxScreenSize

세부  정보

기본값: 0.0 (= 비활성화) 범위: 0 (off) 또는 > 0 정의 위치: 
TrainingConfig.swift

기술적  설명

Gaussian이 강제로 스플릿되기 전에 도달할 수 있는 Screen 
Space 최대 크기 (투영된 픽셀 단위). 값은 0으로 설정됩
니다 (V48 테스트 및 revert) — RadianceKit의 Density 
Control은 대신 dMean2D  로직의 세계 공간 스케일 임곗값
을 사용합니다. 향후 Mip-Splatting (T74–T76) 이나 장면별 
Splatting 전략 실험이 이로부터 혜택을 받을 수 있기 때문에 
필드 카탈로그에 남아 있습니다. 활성화 (값 > 0, 예: 20) 는 매
우 커진 Splat이 화면에서 강제로 분할되도록 합니다 — 단일 
거대 Splat이 너무 적은 세부 정보를 제공하는 크고 매끄러운 
벽 표면에 관련이 있습니다.

간단히  말하면

단일 Splat이 화면에서 얼마나 

커질 수 있는지에 대한 제한. 우

리에게는 꺼져 있습니다. 켜져 

있으면 거대한 평평한 Splat (예: 

벽에) 이 강제로 여러 작은 것으

로 분해됩니다. 명시적으로 실험

하지 않는 한 꺼 두십시오.

Loss (T17–T20)

T17 ssimWeight

세부  정보

기본값: 0.2 (이니셜라이저 + 논문 + .full ), 0.05 
(모든 MCMC 프리셋) 범위: 0.0 – 1.0 정의 위치: 
TrainingConfig.swift

기술적  설명

결합된 Loss 함수에서 D-SSIM 부분의 가중치 loss =
(1 - λ) * L1 + λ * D-SSIM, 여기서 λ = T17 . 
3DGS 논문 기본값 0.2는 Classic Densification에 최적
입니다 — V383은 0.3을 테스트했습니다 → 28.9% 더 나
쁨. V373b는 0.2를 스위트 스폿으로 확인했습니다. MCMC
의 경우 V521b/V534에서 독립적으로 0.05가 최적임이 밝
혀졌습니다. MCMC가 확률적 탐색을 통해 더 강한 L1 신
호 부분을 필요로 하기 때문입니다 — 더 높은 SSIM 가중치
는 Relocation 결정을 희석할 것입니다. SSIM은 L1보다 계
산 비용이 훨씬 비쌉니다 (전체 이미지에 걸친 로컬 11×11 
윈도우). RadianceKit은 1080p 이미지당 1 ms 미만으
로 유지되는 MPS 가속 구현을 사용합니다. Q7-BayesOpt 
Sweep은 0.05 ( .outdoorPreset : 0.082) 와 0.171 
( .indoorPreset ) 사이의 장면별 최적값을 발견했습니다.

간단히  말하면

“모든 픽셀이 일치한다” 외에 앱

이 “구조가 유사하다”도 얼마나 

중요하게 여기는지. 0.2가 표준

이고 좋은 이미지를 제공합니다. 

더 낮음 = 픽셀 정확하지만 더 부

드러운 전환을 얻을 수 있습니

다. 더 높음 = 더 구조적으로 유

사하지만 세부 정보가 더 부드러

워집니다. 프리셋이 결정하도록 

두십시오.
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T18 ssimWeightRefinement

세부  정보

기본값: 0.0 (= “전환 없음, ssimWeight 유지”) 범위: 0 또는 
0 – 1.0 정의 위치: TrainingConfig.swift

기술적  설명

T2 densifyUntilIteration 후 Refinement 단계의 선
택적 SSIM 값. V428은 Refinement에서 0.2 → 0.3을 
테스트했습니다 → 16% 더 나쁜 Loss (L1과 SSIM 모
두 악화). revert됨, 따라서 기본값 0.0. 필드 뒤의 가설은 
Densification 후 — 더 이상 새 Gaussian이 생성되지 않을 
때 — 더 강한 SSIM 부분이 구조적 선명도를 최대화할 것이라
는 것이었습니다. 경험적으로 잘못됨: SSIM 가중치를 늘리는 
것은 간접적으로 L1 가중치를 낮추는 것을 의미하고, L1은 최종 
Refinement 단계에서 훨씬 더 의미 있는 신호입니다. 필드는 
Perceptual Loss (T60) 또는 Edge Loss (T19) 의 향후 실
험을 위해 사용 가능한 채로 유지되며, 거기서는 Refinement 
특정 Loss 구성이 의미가 있을 수 있습니다.

간단히  말하면

두 번째 학습 단계 (Splat 곱하기 

후 정제) 의 특수 설정. 0.0에서: 

이전과 동일한 SSIM 가중치. 조

정해도 경험적으로 가져오는 것

이 없으므로 꺼져 있습니다.

T19 edgeLossWeight

세부  정보

기본값: 0.0 (= 비활성화) 범위: 0 또는 0.001 – 1.0 정의 위
치: TrainingConfig.swift

기술적  설명

V437 실험적 Loss: L1+SSIM에 추가로 이미지 가장자리를 
직접 비교하는 Sobel Gradient Domain L1 Loss의 가중치 
(Ground Truth Sobel vs Render Sobel). 가설: 가장자리 
정보가 이미지 품질의 인식적 초석이며 명시적 항이 Gaussian
이 가장자리를 더 잘 맞추도록 장려해야 합니다. 테스트 결과: 
가중치 0.1 → 11% 더 나쁜 Loss, 0.01 → 품질 중립이지만 
10% 더 느림. Sobel 패스는 Ground Truth와 Render에 추
가 MPS Forward 비용이 듭니다. 따라서 영구 비활성화. 향후 
사용 사례: 단단한 인공 가장자리 (건축, 가구, 렌더링) 가 있는 
장면이 혜택을 받을 수 있습니다 — Q7-Scene-Class 프리셋
은 이를 선택하지 않고 대신 SSIM 가중치를 스케일 조정했습
니다.

간단히  말하면

가장자리를 특별히 중요하게 여

기는 실험적 추가. 경험적으로 

가져오는 것이 없습니다. 꺼진 

채로 유지됩니다.
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T20 skyMaskingEnabled

세부  정보

기본값: false (이니셜라이저와 모든 프리셋) 범위: boolean 
정의 위치: TrainingConfig.swift

기술적  설명

Sky Masking을 켭니다. 각 이미지에서 Apple Vision 프레
임워크 (VNGenerateForegroundInstanceMaskRequest) 
를 통해 하늘 영역이 마스크되고 이 영역의 Loss가 0으로 설정
됩니다. 의의: 야외 장면은 종종 파란색/회색/흰색 하늘 픽셀이 
앱이 정확히 거기에 Gaussian을 배치하도록 하는 것으로 고통
받습니다 — 이는 “플로터”로 인식됩니다. Sky Mask 없이는 
이 영역의 Loss가 절대 0이 되지 않을 것입니다. 이미지의 하늘
이 약간 변하고 앱이 Splat으로 영원히 다시 만들려고 시도하기 
때문입니다. Vision 마스크는 학습 전에 카메라당 한 번 계산되
어 RAM에 보관됩니다. 일반적으로 T45 skyDomeEnabled
와 함께 활성화됩니다 (Settings View의 UI 로직). 실내 장면
이나 합성 렌더링에서는 비활성화 상태로 두십시오 — 마스크가 
거기서 잘못 천장이나 벽을 “Sky”로 인식할 것입니다.

간단히  말하면

야외 촬영용 특별 모드를 켭니

다: 학습 중에 하늘이 무시되어 

Splat으로 다시 만들려고 시도되

지 않습니다. 모든 야외 장면에 

권장됩니다. 실내 또는 Blender

의 3D 렌더링에서는 꺼 두십시

오.
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SH Degree Progression (T21)

T21 shDegreeUpgradeIterations

세부  정보

기본값: [1_​000, 2_​000, 3_​000] (이니셜라이저), [2_​
000,

5_​000, 8_​000] ( .full , MCMC), [1_000, 2_000]  
( .preview  — Degree 3 건너뜀) 범위: [Int] , 각 
값이 [0, maxIterations]  안에, 단조 증가 정의 위치: 
TrainingConfig.swift

기술적  설명

활성 SH Degree가 0→1, 1→2, 2→3으로 업그레이드되
는 반복. 첫 마크 전에는 DC 구성 요소만 활성 (즉 T5 
shDCLearningRate), 첫 마크 후 DC + 3 Degree-1 계수, 
두 번째 마크 후 + 5 Degree-2 계수, 세 번째 마크 후 모든 
15 계수. Gaussian당 메모리 요구량이 단계로 증가합니다 — 
4 Float → 16 Float → 36 Float → 64 Float. Quality 
프리셋은 이니셜라이저 기본값에 비해 업그레이드를 지연합니
다 (V228). 색상 디테일이 더 높은 주파수로 추가되기 전에 형
상이 먼저 안정화되어야 하기 때문입니다. V384는 .full 에 
대해 [1K, 2K, 3K] 를 테스트했습니다 → 9.3% 더 나쁨 — 
지연을 확인합니다. .preview 는 Degree 2에서 자릅니다. 
Degree 3은 5 000 반복에서 수렴하지 않고 옵티마이저 용량
만 소비하기 때문입니다. Q6 (T80–T81) 는 이 목록을 동적으
로 재정의하는 대체 Curriculum 로직을 제공합니다.

간단히  말하면

학습의 어느 지점에서 앱이 색상

이 다른 시점에서 다르게 보일 

수 있다는 것을 배우는지 (하이

라이트, 반사). 늦게 — 먼저 형

태가 맞고, 그 다음 색상. 프리셋

의 값은 잘 작동하도록 설정되어 

있습니다. 이유를 정확히 모르면 

변경하지 마십시오.
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Performance (T22–T25)

T22 trainingRenderScale

세부  정보

기본값: 1.0 (이니셜라이저, .full , MCMC, Scene-
Class), 0.5 ( .preview ), 0.25 ( .quickTest ) 범위: 
0.05 – 2.0 (일반적으로 0.25, 0.5, 1.0) 정의 위치: 
TrainingConfig.swift

기술적  설명

학습 이미지의 원본 해상도에 상대적인 학습 시 렌더 해상도. 
0.5에서 각 이미지가 50% 폭 × 50% 높이 (즉 픽셀의 25%) 
로 다운샘플링되고 Gaussian 렌더링이 이 더 작은 해상도에서 
발생합니다. 메모리와 계산 오버헤드를 모두 이차적으로 줄입
니다. 중요: T11 densifyGradThreshold가 선택된 해상도
와 일치해야 합니다 — 그래디언트 크기가 1/해상도²로 스케일
되므로 .quickTest  (0.25×) 는 .full  (1.0×, 1.1e-6) 
보다 훨씬 더 높은 임곗값 (4e-6) 을 가집니다. RadianceKit
은 매우 큰 이미지에 경고하고 자동으로 조정합니다 — 3 MP 
목표 해상도. 극단적인 4K 입력 이미지에서는 0.5 또는 심지
어 0.25가 의미가 있습니다. 그렇지 않으면 모든 Mac이 CPU 
Compaction에서 실행됩니다.

간단히  말하면

학습 시 이미지가 얼마나 큰지. 

1.0 = 원본, 0.5 = 절반 크기. 절반 

크기 = 네 배 더 빠르지만 가장 

미세한 세부 정보가 누락됩니다. 

프리셋은 올바른 값을 선택합니

다. 극도로 큰 입력 이미지에서

는 (12메가픽셀 이상) 앱이 자동

으로 낮춥니다.

T23 resolutionWarmupScale

세부  정보

기본값: 0.0 (= 비활성화) 범위: 0 또는 0.1 – 
trainingRenderScale 정의 위치: TrainingConfig.swift

기술적  설명

V133 최적화: Refinement 단계보다 낮은 해상도에서 
Densification 단계 (Iter 0에서 T2 까지) 를 학습합니다. 
V308은 .full 을 다시 비활성화했습니다. T22 = 1.0 과 
Cosine Annealing에서 Time-Win이 미미하고 품질이 최
소로 들었기 때문입니다. 4K 입력과 긴 학습 실행에서 다
시 의미가 있을 수 있기 때문에 필드 카탈로그에 유지됩니
다 — Q6 Curriculum (T80) 이 비슷한 로직을 채택했고 
거기서는 LR 스케줄과 결합되어 있습니다. 활성화되고 T80 
curriculumResolutionRamp도 true이면 Q6가 우선하고 
이 값을 덮어씁니다.

간단히  말하면

특별 기능: 학습 전반부에 더 작

은 이미지로 학습, 후반부에 큰 

이미지로. 시간을 절약합니다. 

새 Q6 변형이 이를 더 잘 해결하

기 때문에 꺼져 있습니다.
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T24 tileSize

세부  정보

기본값: 16 범위: 8, 16, 32 정의 위치: 
TrainingConfig.swift

기술적  설명

픽셀 단위의 래스터화 타일 크기. Gaussian Splatting 렌더링
은 타일 기반입니다: 이미지가 16×16 픽셀 타일로 분해되고 각 
타일이 관련 Gaussian을 모아 깊이별로 정렬한 다음 블렌딩합
니다. 16은 실질적으로 모든 3DGS 구현이 사용하는 표준이며 
RadianceKit Metal 커널에서 하드코딩되어 있습니다. 이 값
을 변경하면 셰이더의 재컴파일이 필요하며 현재 상태에서는 효
과적이지 않습니다. 향후 엔진 버전이 Tile Size를 동적으로 지
원할 경우를 위해 필드로 남아 있습니다.

간단히  말하면

내부 렌더 매개변수. 표준 16, 변

경하지 마십시오.

T25 throttleDelayMs

세부  정보

기본값: 0 (이니셜라이저, .full , MCMC, Scene-
Class), 0 ( .preview ) 범위: 0 – 100 정의 위치: 
TrainingConfig.swift

기술적  설명

학습 반복 사이의 인위적인 지연 (밀리초). 0 = 풀 스피드 (표
준). 더 높은 값은 GPU/CPU가 정기적으로 호흡할 휴식을 받
게 하여 학습 중 Mac을 “사용 가능”하게 만듭니다 — 다른 앱
의 사용성은 증가하지만 학습 시간은 Delay와 선형적으로 증가
합니다. 일반적인 값: 1–2 ms (“가벼운” Throttling, +5% 학
습 시간, Mac이 더 반응적으로 느껴짐), 5 ms (“중간”, +15% 
학습 시간), 10+ ms (“Eco”, 잠재적으로 두 배 학습 시간). 
Inspector의 “Performance”에서 제공되지만 표준 보기에는 
없습니다 — dev_ux-backlog.md 를 참고하십시오. 잘못 이
해되면 학습 시간을 극적으로 연장하기 때문에 Expert View에
서 제거하자고 제안합니다.

간단히  말하면

학습 단계 사이에 앱이 몇 밀리

초의 휴식을 취하는지. 0 = 휴식 

없음, 가능한 빠르게. 더 높은 값

은 학습 중 Mac을 더 잘 사용할 

수 있게 만들지만 — 학습은 그러

면 더 오래 걸립니다. M3 Ultra나 

Mac Studio에서는 0으로 둘 수 

있습니다. MacBook Air에서는 2 

또는 5가 좋은 값입니다.
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진단과 점 구름 준비 (T26–T30)

T26 depthDistortionWeight

세부  정보

기본값: 0.0 (= 비활성화) 범위: 0 또는 0.0001 – 0.05 정의 
위치: TrainingConfig.swift

기술적  설명

V366 실험적: Depth Distortion 정규화 Loss의 가중치. 렌
더 광선을 따라 깊게 배치되어 있지만 개념적으로 같은 표면에 
속하는 Gaussian을 처벌합니다 — 집중된 깊이 분포를 장려하
고 플로터를 줄입니다. 테스트: 0.01 → 4.5% 더 나쁨, 0.001 
→ 8.1% 더 나쁨. 이론적 이점 — Multi-View 일관성을 개선 
— 은 L1 Loss에 반영되지 않습니다. 가설이 SfM 형상이 올
바르다고 암묵적으로 가정하고 Gaussian이 단지 “쌓일” 필요
가 있기 때문입니다. 실제로는 SfM 점 구름이 일반적으로 가
장 약한 구성 요소이지 적재가 아닙니다. 특히 깨끗한 포즈가 있
는 Multi-View 데이터셋 (합성, Ground Truth가 있는 Mip-
NeRF 360) 에 사용 가능한 채로 유지됩니다.

간단히  말하면

동일한 위치에 여러 Splat이 있

는 것을 피하기 위한 실험적 기

능. 테스트에서 가져오는 것이 

없었기 때문에 활성화되지 않습

니다.

T27 singleViewOverfit

세부  정보

기본값: false 범위: boolean 정의 위치: 
TrainingConfig.swift

기술적  설명

진단 플래그: true인 경우 각 학습 반복에서 카메라 풀에서 무
작위로 선택되는 대신 카메라 인덱스 0이 강제로 사용됩니다. 
의의: 모델이 단일 뷰조차 Overfit할 수 없다면 (즉 View 0
의 Loss가 10 000 반복 후에도 0에 가까이 가지 않으면) 
Forward/Backward Pass에 근본적인 버그가 있는 것입니
다. 이 스위치는 Metal 셰이더와 Differentiable Rasterizer 
커널의 개발 중에 집중적으로 사용되었습니다 — V42–V47 단
계. 오늘날은 누군가 백엔드 코드를 수정했고 회귀 테스트를 하
고 싶을 때 Sanity Check로만 사용 가능합니다. CLI에서는 
--single-view .

간단히  말하면

개발자를 위한 테스트 모드. 그

들은 앱이 하나의 이미지에서 어

쨌든 학습할 수 있는지 확인할 

수 있습니다. 일반 사용자에게는 

관련 없음, 항상 꺼 두십시오.
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T28 maxCameras

세부  정보

기본값: 0 (= “모든 카메라 사용”) 범위: 0 또는 1 – N 정의 위
치: TrainingConfig.swift

기술적  설명

V43의 진단 한도: 처음 N개의 카메라로만 학습하고 나머지는 
무시합니다. 원래 의의: 너무 많은 카메라가 그래디언트 충돌을 
생성한다는 가설을 테스트 (같은 Gaussian에 대한 너무 많은 
모순적 Loss 신호). 테스트 결과: 인위적 제한에서 체계적 이점 
없음 — 더 많은 프레임은 실질적으로 항상 더 많은 품질을 가져
옵니다. 대상 실험을 위한 CLI 플래그 ( --max-cameras N ) 
로 유지됩니다 (예: “1 500 이미지 드론 비행의 처음 100 이미
지에서 학습이 작동합니까?”). UI에는 노출되지 않습니다.

간단히  말하면

개발자를 위한 진단 필드 — 

처음 N개의 이미지만 사용하

고 나머지는 무시합니다. 일

반 사용자는 필요하지 않으며, 

값을 0 = 모든 이미지로 둡

니다. 더 많은 이미지 = 더 

나은 결과 (feedback_​more-

frames-better.md 참고).

T29 maxInitialPoints

세부  정보

기본값: 0 (= “모든 SfM 점 사용”) 범위: 0 또는 1 000 – 
200 000+ 정의 위치: TrainingConfig.swift

기술적  설명

V54 보호: 학습이 시작되는 초기 SfM 점의 수를 제한합니다. 
조밀한 COLMAP 재구성은 > 60 000 점을 생산할 수 있으며 
큰 초기 스케일에서 픽셀 오버랩당 200–300 Gaussian으로 
이어집니다 — 학습이 수렴하지 않는 “안개 필드”를 만듭니다. 
~16 000 점으로 서브샘플링 (학습 엔진의 Hard Cap 로직) 
은 초기 밀도를 참조 3DGS가 사용하는 수준으로 가져오고 오
버랩을 극적으로 줄입니다. 매우 조밀한 SfM에서 자동으로 설
정됩니다. CLI에서는 --max-points N .

간단히  말하면

카메라 재구성에서 얼마나 많은 

시작 점이 사용될지. 매우 조밀

한 재구성 (60 000 이상) 에서는 

앱이 자동으로 16 000으로 제한

합니다 — 그렇지 않으면 처음에 

너무 많은 안개가 있습니다. 설

정할 필요가 없습니다. 앱이 처

리합니다.
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T30 cameraClusterOutlierMultiplier

세부  정보

기본값: 10.0 (모든 프리셋 — 절대 덮어쓰지 않음) 범위: 1.0 – 
100.0 정의 위치: TrainingConfig.swift

기술적  설명

Phase 3.10 A.1에서 도입된 카메라 클러스터 아웃라이어 필
터의 승수. 학습 전 학습 엔진은 모든 카메라 위치의 중심
과 카메라의 중심으로부터의 최대 거리를 계산합니다. 중심
으로부터의 거리가 multiplier × maxCameraDistance
를 초과하는 SfM 점은 아웃라이어로 폐기됩니다. 기본값 
10×는 Phase 3.10 이전의 동작을 보존합니다. 미묘한 버
그: 더 타이트한 SfM (카메라가 더 가깝게) → 더 작은 
maxCameraDistance → 더 작은 임곗값 → 더 많은 점이 아
웃라이어로 폐기됨. 더 느슨한 SfM → 더 큰 임곗값 → 더 적은 
점이 폐기. 이는 Phase 3.9 Funnel vs Training 반상관관계
의 원인 중 하나입니다: 더 나은 SfM이 다운스트림에서 더 나쁜 
학습으로 이어질 수 있습니다. 너무 많은 초기 점이 죽기 때문
입니다. 필드는 A.3 Sweep을 위해 CLI 재정의 (--camera-
cluster-outlier-multiplier) 로 있습니다. UI에는 노출
되지 않습니다. 5 미만의 값은 일반적으로 너무 제한적이고, 20 
이상은 효과가 없습니다.

간단히  말하면

카메라 클라우드로부터 멀리 있

는 재구성의 점을 폐기하는 특별 

필터. 10 = 앱이 관대하며 거의 

모든 것을 유지합니다. 멀리 있

는 점 (멀리 있는 산) 이 이미지

에서 떠다니는 덩어리처럼 보이

면 높일 수 있습니다. 비상시에

만 낮추십시오 — 거리에서 세부 

정보를 잃습니다.

정규화 (T31–T37)

T31 coarseToFineBlurRadius

세부  정보

기본값: 0 (= 비활성화) 범위: 0 또는 1 – 10 정의 위치: 
TrainingConfig.swift

기술적  설명

V369 실험적: Densification 단계 시작 시 Ground Truth 
이미지에 적용되고 Densification 종료 ( T2 ) 까지 0으로 선
형 감소되는 Box Blur 반경. 가설: Coarse-to-Fine 학습 — 
먼저 거친 구조를 학습한 다음 세부 정보 — 이 더 안정적인 형
상을 제공해야 합니다. 테스트: r=3 → 9.6% 더 나쁨, r=1 → 
5.1% 더 나쁨. 실패 이유: Densification은 이미지 도메인 그
래디언트를 기반으로 결정하며, 블러는 “여기서 클론해야 함”에 
중요한 신호를 정확히 줄입니다. 다른 Density Control 스킴
으로 향후 테스트를 위해 필드 카탈로그에 남아 있습니다.

간단히  말하면

실험적 “먼저 거칠게, 그 다음 자

세히” 모드. 가져오는 것이 없었

습니다. 꺼진 채로 유지됩니다.
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T32 scaleRegWeight

세부  정보

기본값: 0.0 (= 비활성화) 범위: 0 또는 0.0001 – 0.05 정의 
위치: TrainingConfig.swift

기술적  설명

V370 실험적: 세계 공간 스케일에 대한 L1 정규화. 너무 
커지는 Gaussian을 처벌합니다 — 전체 벽 표면을 하나
의 Gaussian으로 덮는 “Mega Splat”을 방지합니다. 테스
트: 0.01 → 200% 더 나쁜 Loss (2 M Gaussian, 완전
한 폭발), 0.001 → 214% 더 나쁨. 이유: 스케일 정규화는 
Density Control과 충돌합니다 — 더 작은 스케일은 더 많
은 Gaussian이 필요하다는 것을 의미합니다. 따라서 Density 
Control이 더 자주 스플릿하고 이는 더 많은 그래디언트 비용
을 의미합니다. 비활성화되었지만 Mip-Splatting 실험 (T74) 
을 위해 문서화됨: 이 컨텍스트에서는 스케일 하한이 의미가 있
을 수 있습니다.

간단히  말하면

Splat이 작게 유지되도록 강제하

는 정규화. 테스트에서 Splat 폭

발 (수백만 Splat) 을 일으켰습니

다. 활성화하지 마십시오.

T33 anisotropyRegWeight

세부  정보

기본값: 0.0 (= 비활성화) 범위: 0 또는 0.0001 – 0.05 정의 
위치: TrainingConfig.swift

기술적  설명

V445 실험적: max(scale)/min(scale) 비율에 대한 페널
티. 플로터로 인식되는 극도로 늘어난 “Needle” Gaussian
을 방지해야 합니다. 테스트: 0.01 → 69% 더 나쁨, 0.001 
→ 15% 더 나쁨. 이유: 정규화가 Splat을 “둥근” 모양 방향
으로 강제하는데, 평평한 표면 (벽, 테이블, 바닥) 에서는 정
확히 잘못된 것입니다 — 거기서는 평평하고 넓은 Gaussian
이 구형보다 더 효율적입니다. 비활성화됨. V549f는 T34 
scaleRatioPruneThreshold로 대안적이고 더 표적화된 접
근 방식을 제공했고 마찬가지로 revert되었습니다.

간단히  말하면

너무 길고 얇은 Splat을 처벌하

는 정규화. 의미가 있어 보이지

만 테스트에서 더 나빴습니다. 

꺼짐.
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T34 scaleRatioPruneThreshold

세부  정보

기본값: 0.0 (= 비활성화) 범위: 0 또는 5.0 – 100.0 (일반적
으로 10.0 – 30.0) 정의 위치: TrainingConfig.swift

기술적  설명

실험적 후 학습 Pruning. 여기서 설정된 선형 임곗값을 초
과하는 max(scale)/min(scale) 비율을 가진 각 Gaussian
을 삭제합니다. 정규화만으로는 제거할 수 없는 극도로 늘어
난 “Needle/Disc” 플로터를 대상으로 합니다. 테스트에서 
Pruning이 기대한 대로 플로터를 제거했지만 동시에 벽과 바닥
의 의미 있는 평평한 Splat도 제거했습니다 — 이미지가 더 구
멍이 났습니다. 따라서 기본적으로 꺼져 있고 CLI 플래그 (--
scale-ratio-prune N) 는 표적 실험을 위해 사용 가능한 채
로 유지됩니다. 그래도 테스트하려면 권장 값: 30 (매우 보수적, 
극단적인 아웃라이어만 제거), 10 (공격적, 세부 정보가 듦).

간단히  말하면

매우 늘어난 Splat을 학습 후 필

터링하려는 시도. 테스트에서 순 

부정 — 플로터가 사라졌지만 세

부 정보도 사라졌습니다. 꺼짐.

T35 opacityRegWeight

세부  정보

기본값: 0.0 (= 비활성화) 범위: 0 또는 0.0001 – 0.05 정의 
위치: TrainingConfig.swift

기술적  설명

V446 실험적: Opacity를 0 또는 1로 (즉 “반투명”에서 멀리) 
끌어당기는 Binary Cross Entropy 페널티. 가설: 더 선명한 
Opacity 분포가 이미지 선명도를 개선합니다. T33과 결합 테
스트 → 정규화가 품질 비용. 둘 다 비활성화. 비활성화. 주의: 
1.4.3 베타에서 이 필드를 기본값 변경 (이니셜라이저 = 0.01) 
한 버그가 등장하여 Gaussian Count의 대량 멸종 (한 반복에
서 460 K → 5) 으로 이어졌습니다. 1.4.4부터 0.0으로 기본
값 고정.

간단히  말하면

Splat을 완전히 투명하거나 완전

히 단단하게 만드는 정규화. 가

져오는 것이 없고 위험할 수도 

있습니다 (1.4.3 버그 대량 멸종). 

0으로 두십시오.
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T36 opacityDecayFactor

세부  정보

기본값: 0.0 (이니셜라이저 = 비활성화), 0.9995 ( .full , 
.classicBalanced  — HTGS 표준) 범위: 0 (off) 또는 

0.95 – 1.0 정의 위치: TrainingConfig.swift

기술적  설명

HTGS 스킴 (Hierarchical Time-Gating, Eurographics 
2025) 의 V546 구현: 매 T37 opacityDecayInterval 반
복마다 각 Gaussian의 sigmoid Opacity가 이 인수로 곱
해집니다. 0.9995 × 100회 적용은 Densification 단계당 
~95% 잔존을 산출합니다 — 모든 Opacity에 대한 약하지만 
꾸준한 하향 압력으로, 약하게 기여하는 Gaussian이 T14
pruneOpacityThreshold에 안정적으로 가라앉도록 합니
다. 결과: V438 (Decay 없음) 에 비해 Horse Full
에서 14% 더 나은 L1 Loss (3-trial 평균 V546). 
Densification 단계 동안만 활성 ( T2 까지), 그 후 학습
은 Decay 없이 계속 실행되어 Refinement에서 확립된 
Opacity가 안정적으로 유지됩니다. MCMC에서는 사용되지 
않습니다 (MCMC는 T67 mcmcRelocationInterval + 
T68 mcmcDeadOpacityThreshold를 통해 자체 메커니즘이 
있음).

간단히  말하면

학습 시간에 걸친 모든 Splat의 

“부드러운 페이드”. 비활성 Splat

이 더 빨리 투명해져서 정리 

시 사라집니다. V546 업데이트

의 가장 중요한 품질 레버였습니

다: 14% 더 나음. Quality 프리셋

에 내장됨. 정확히 균형 잡혀 있

기 때문에 조정 권장하지 않음.

T37 opacityDecayInterval

세부  정보

기본값: 50 범위: 10 – 500 정의 위치: 
TrainingConfig.swift

기술적  설명

T36 opacityDecayFactor가 적용되는 반복 간격. HTGS 
논문 기본값 50, .full 에서 유지. 긴 간격 (>200) 은 효
과를 부분적으로 상쇄합니다. 두 적용 사이에 Opacity가 다시 
증가할 만큼 충분한 그래디언트 업데이트가 발생하기 때문입니
다. 짧은 간격 (<20) 은 Decay를 너무 공격적으로 만듭니다. 
Densification 단계에서만 활성.

간단히  말하면

“페이드”가 얼마나 자주 적용되

는지. 50 = 50 반복마다 약간의 

페이드 단계. 맞습니다.
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Refinement (T38–T44)

T38 gradientAccumulationSteps

세부  정보

기본값: 1 (= “Adam 단계당 하나의 뷰”) 범위: 1 – 8 정의 위
치: TrainingConfig.swift

기술적  설명

V424 기능: Adam 업데이트가 실행되기 전에 그래디언트가 
누적되는 뷰의 수. > 1 에서 앱은 그래디언트를 별도의 버퍼에 
합하는 별도의 “unfused” Backward Project 경로에서 실
행됩니다. 최종 적용은 크기를 일정하게 유지하기 위해 1/N로 
스케일됩니다. V424는 2-뷰를 테스트했습니다 → 품질 중립이
지만 10% 더 느림 (unfused 경로가 fused 경로보다 비싸기 
때문에). .full 에 대해 revert되었지만 MCMC에 대해서는 
의도적으로 사용 — .fullMCMC 는 함께 실행되지만 V544a 
테스트는 Classic과의 품질 격차가 11% 대신 5%로 줄어든다
는 것을 보여 주었습니다. 이니셜라이저 기본값은 1, 현재 프리
셋도 1, CLI 플래그 ( --accum-steps N ) 로 유지됩니다.

간단히  말하면

Splat을 적응시키기 전에 앱이 

얼마나 많은 이미지를 보는지. 1 

= 각 이미지를 개별적으로. 더 높

음 = 여러 이미지를 동시에 보고 

그 다음 평균값을 적용. 표준 경

우에는 가져오는 것이 없습니다. 

MCMC에서는 2가 약간 도움이 될 

수 있습니다.

T39 testViewIndices

세부  정보

기본값: []  (= 비어 있음, 모든 뷰가 학습에 사용) 범위: 
Set<Int> , 카메라 인덱스의 임의 하위 집합 정의 위치: 

TrainingConfig.swift

기술적  설명

V546 기능: 학습에 사용되지 않고 PSNR/SSIM/LPIPS 
평가용 Holdout으로 저장되는 카메라 인덱스 집합. 
--benchmark  CLI 플래그가 활성일 때 자동으로 설정됩니
다: 그러면 인덱스 0부터 시작하여 매 8번째 뷰 (LLFF 표준, 
Mip-NeRF 360 및 3DGS 논문 규약과 동일). benchmark 
없이는 비어 있음 — 학습이 모든 뷰를 사용합니다. 주의: 인덱
스 이해 없이 이 필드를 수동으로 설정하면 벤치마크가 사용 불
가능해질 수 있습니다 (예: N-50 뷰만 있는데 모든 인덱스가 N 
이상으로 설정됨 → Holdout 없음 → 평가 없음). 자체 프리셋 
내보내기 시 testViewIndices는 영구화되지 않습니다. 장면 
의존적이며 그렇지 않으면 다른 데이터셋 사이에 무의미한 값을 
남길 것이기 때문입니다.

간단히  말하면

품질 측정에 나중에 사용되도

록 학습에서 “제외”되는 이미

지. 직접 설정하지 않습니다. 

--benchmark  플래그가 자동

으로 수행합니다 (매 8번째 이미

지가 테스트). 자체 인덱스를 설

정하면: 위험, 벤치마크를 왜곡

할 수 있습니다.
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T40 refinementPruneInterval

세부  정보

기본값: 0 (= 비활성화) 범위: 0 또는 100 – 5 000 정의 위
치: TrainingConfig.swift

기술적  설명

V425 기능: Refinement 단계 ( T2  후) 동
안 매 N 반복마다 sigmoid(opacity) < T41 
refinementPruneOpacityThreshold의 Gaussian을 제거
하는 추가 Prune 패스가 실행됩니다. 의의: Densification 
동안에는 정기적인 Density Control 호출이 있지만 그 후
에는 없습니다 — Opacity가 계속 감소하는 Gaussian은 
버퍼에 남습니다. V425는 테스트하고 revert했습니다: 추가 
Pruning은 V426 (Two-Phase Densification, 마찬가지로 
0 Gaussian 캐스케이드 실패로 중단) 과 상관관계가 있었습니
다. 비활성화. 실험을 위한 CLI 플래그 사용 가능. 활성화되면 1 
000 또는 2 000이 합리적인 값입니다.

간단히  말하면

Refinement 단계 동안 추가 정

리. 가져오는 것이 없으며, 꺼진 

채로 유지됩니다.

T41 refinementPruneOpacityThreshold

세부  정보

기본값: 0.0 (= “T14 사용”) 범위: 0 또는 0.001 – 0.1 정의 
위치: TrainingConfig.swift

기술적  설명

V425b: Refinement Pruning을 위한 별도의 Opacity 
임곗값. Densification 후 대부분의 Gaussian은 상당히 
더 높은 Opacity (> 0.001) 에 도달하므로 표준 T14 
pruneOpacityThreshold가 너무 느슨합니다. T40 이 활성
이면 이 필드가 자체 임곗값을 결정합니다. 0.0에서는 T14 가 
계속 사용됩니다. T40 > 0일 때만 관련이 있습니다.

간단히  말하면

추가 Refinement 정리 (T40 참고) 

의 임곗값. 두 필드 모두 활성이 

아니므로 관련 없음.
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T42 midTrainingCompactificationIterations

세부  정보

기본값: []  (= 비활성화) 범위: [Int] , 값이 
(densifyUntilIteration, maxIterations) 안에 정의 
위치: TrainingConfig.swift

기술적  설명

V549 기능: Refinement 단계 동안 Compactification 
패스가 실행되는 명시적 반복 지점 (sigmoid(opacity) 
< 0.01 + 아웃라이어 스케일 Gaussian을 제거, T56 
postTrainingCompactification과 같은 로직). 의의: 긴 
Refinement 단계가 SH가 뷰별 아티팩트에 Overfit하는 
Confetti/Floater 누적을 보여 줄 수 있습니다. 활성화된 경우 
일반적인 구성: 40K Classic용 [10000, 20000, 30000]. 
그러나: Family 데이터셋의 V549 A/B 테스트는 모든 구성에
서 더 나쁜 L1을 보여 주었습니다: [10K,20K,30K]\@0.01 → 
−48% Count이지만 +36% L1. [20K,30K]\@0.005  → 
−44% Count이지만 +45% L1. [20K,30K]\@0.001  → 
−17% Count이지만 +87% L1. 따라서 비활성화. CLI 플래그 
--mid-compact "10000,20000"은 시각적 플로터 트레이드
오프 (뷰포트에서 더 적은 Confetti) 를 Loss 회귀보다 선호하
는 경우 사용 가능합니다.

간단히  말하면

학습 중 중간 정리 작업. 테스트

에서 정리가 최종 결과를 더 나

쁘게 만들었습니다 (플로터는 적

지만 세부 정보도 적음). 꺼짐, 플

로터가 약간 더 매끄러운 이미지

보다 더 거슬리면 CLI를 통해 켤 

수 있습니다.

130 / 216



R A D I A N C E K I T 제 6 장 — 학습 구성

T43 frustumCullEnabled

세부  정보

기본값: false 범위: boolean 정의 위치: 
TrainingConfig.swift

기술적  설명

V549b 기능: 학습 후 모든 학습 카메라 Frustum의 합집합 
밖에 있는 모든 Gaussian이 제거됩니다. 이러한 Gaussian은 
Loss 신호에 의해 결코 제약되지 않았으며 항상 플로터입니다. 
Novel View가 카메라 경로 뒤나 옆에 있는 장면 (예: 선형 드
론 비행의 뒷면) 에 특히 효과적입니다 — 거기의 플로터는 학
습 단계에서 결코 보이지 않지만 나중에 3D 뷰어에서 움직일 
때 매우 보입니다. V549b A/B는 드론 비행에서 긍정적인 결
과를 보여 주었으므로 Opt-In으로 사용 가능합니다. 기본값은 
false. 전체 궤도 커버리지가 있는 객체 캡처에서는 Frustum 
Union이 전체 장면을 포함하고 기능이 아무것도 제거하지 않기 
때문입니다 — Settings의 “Floater Reduction”에서 제공되
며 Q9 Outdoor 프리셋에서 T44 frustumCullExpansion
을 통해 암묵적으로 테스트됩니다 (Q7-BayesOpt는 이를 활
성화하지 않았습니다. Outdoor Sky Dome이 같은 문제를 더 
잘 해결하기 때문에).

간단히  말하면

드론 비행이나 선형 촬영을 위한 

특별 필터: 학습 후 어떤 카메라

에서도 “보이지” 않은 Splat이 삭

제됩니다. Settings에서 선택적

으로 켤 수 있습니다. 간단한 객

체 촬영에서는 불필요합니다.

T44 frustumCullExpansion

세부  정보

기본값: 1.1 범위: 1.0 – 2.0 정의 위치: 
TrainingConfig.swift

기술적  설명

T43 frustumCullEnabled에 대한 NDC 마진. 1.0은 이미지 
가장자리에서 정확히 잘릴 것입니다. 이는 가장자리의 흔들리는 
Splat을 너무 많이 자를 것입니다. 1.1 = 정확한 카메라 프레
임을 넘어 10% 패딩 — 약간 오프셋된 Novel View에서 보일 
수 있는 가장자리 픽셀에 대한 약간의 허용 오차를 제공합니다. 
> 1.2 값은 Cull을 실질적으로 비효과적으로 만듭니다. 확장된 
Frustum이 훨씬 더 많은 공간을 포함하기 때문입니다.

간단히  말하면

위에 설명된 필터가 얼마나 엄격

하게 자르는지. 1.1 = 이미지 가장

자리에 약간의 안전 거리. 값을 

그대로 두십시오.
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Sky-Dome (T45–T48)

T45 skyDomeEnabled

세부  정보

기본값: false (이니셜라이저 + P9 Outdoor를 제외한 모든 
프리셋) 범위: boolean 정의 위치: TrainingConfig.swift

기술적  설명

V549e 기능: 학습 시작 전에 구형 점 구름이 생성되고 ( T46  
샘플 포인트가 있는 Fibonacci Sphere), 장면 중심 주위에 
T47

skyDomeRadiusMultiplier × scene_​extent 반경으로 
배치되며, 모든 학습 카메라의 Sky Masked 픽셀의 색상으
로 초기화됩니다 (T20 skyMaskingEnabled 참고). 이 Sky 
Dome Gaussian은 Gaussian 버퍼의 시작에 삽입되고 학
습 중 “동결”됩니다 (Position/Scale/Rotation Gradient = 
0, SH와 Opacity만 최적화 가능). 효과: 멀리 있는 검은 
“Confetti” 영역 대신 사용자가 Novel View에서 실제 하늘을 
봅니다. V549e MVP는 드론 및 풍경 장면에서 매우 잘 작동합
니다. P9 Outdoor 프리셋에서 기본적으로 켜져 있습니다. 실
내 장면에서는 꺼 두십시오 — 구체가 무의미하게 방 밖에 매달
릴 것입니다.

간단히  말하면

장면 주위에 인공 “하늘 돔”을 켭

니다. 야외 촬영을 훨씬 더 멋지

게 만듭니다: 이미지 가장자리의 

검은 덩어리 대신 앱이 실제 하

늘을 보여 줍니다. 드론 비행과 

풍경에 필수, 실내 공간에는 무

의미.

T46 skyDomeSampleCount

세부  정보

기본값: 5 000 범위: 1 000 – 50 000 (일반적으로 2 000 
– 10 000) 정의 위치: TrainingConfig.swift

기술적  설명

Sky Dome 구체의 Fibonacci Sphere 샘플 포인트 수. 더 
높은 값 → 더 조밀한 Sky Dome (큰 해상도와 많이 보이는 
하늘에 더 좋음), 그러나 더 많은 메모리 요구량. 5 000은 4K 
렌더링용 스위트 스폿입니다. 더 낮은 해상도에서는 2 000–3 
000으로 충분합니다. 점은 해당 Sky Masked 픽셀로 각 학습 
카메라 View 벡터에 대한 Cosine Distance에 따라 초기화됩
니다 — View Cone에 카메라가 보이지 않는 샘플 포인트는 낮
은 Opacity 초기값으로 뒤에 남지만 학습에서 변경되지 않습니
다 (동결).

간단히  말하면

인공 하늘이 얼마나 조밀한지. 5 

000 포인트가 보통 충분합니다. 

더 많음 = 멀리서 더 나은 전환이

지만 약간의 메모리 비용.
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T47 skyDomeRadiusMultiplier

세부  정보

기본값: 30.0 (이니셜라이저 + 대부분의 프리셋), 59.0 (P9 
Outdoor, Q7 BayesOpt 최적) 범위: 5.0 – 200.0 정의 위
치: TrainingConfig.swift

기술적  설명

장면 범위 (= 카메라 위치 사이의 평균 거리) 에 상대적인 Sky 
Dome 구체 반경. 30 = 구체가 카메라 클라우드의 30배 직
경을 가집니다. 너무 작음 (< 5) → Sky Dome이 장면 자체
와 간섭 (예: Sky Dome Splat이 전경에 떨어짐). 너무 큼 (> 
100) → Sky Dome 위치의 float32 정밀도 손실로 거리에서 
렌더 글리치 트리거. Q7 BayesOpt는 Bicycle (Mip-NeRF 
360) 에서 야외용 장면별 최적값으로 59.0을 발견했습니다 — 
이는 표준 30.0이 깊은 풍경에 너무 작고 Sky Dome 픽셀이 
이미지 가장자리 영역에서 “벽”으로 보이게 렌더링됨을 시사합
니다.

간단히  말하면

인공 하늘 돔이 얼마나 멀어야 

하는지. 30 = 꽤 멀리. 큰 풍

경에서는 50–60이 더 좋습니다 

(Outdoor 프리셋이 자동으로 수

행). 너무 작으면 렌즈 바로 앞에 

덩어리가 있는 것처럼 보일 것입

니다.

T48 frozenGaussianCount

세부  정보

기본값: 0 (= 동결된 Gaussian 없음) 범위: 0 또는 1 – T46  
정의 위치: TrainingConfig.swift

기술적  설명

옵티마이저에서 Position/Scale/Rotation Gradient가 0으
로 설정되는 버퍼 시작 부분의 Gaussian 수 — 전체 학습에 걸
쳐 공간적으로 경직된 상태로 유지됩니다. Density Control은 
이를 클론, 스플릿 또는 Prune해서는 안 됩니다. Sky Dome 
Injection에 사용됩니다 ( T45  참고): Sky Dome이 켜져 있
으면 이 필드가 자동으로 T46 skyDomeSampleCount로 설정
됩니다. 수동 설정이 가능합니다 (예: LiDAR 스캔의 사전 배치
된 점 구름을 동결하기 위해) 만 UI에서 직접 액세스할 수 없습
니다. 중요: 버퍼의 처음 N Gaussian은 항상 동결됩니다 — 명
시적 인덱스가 아니라 버퍼의 순서가 결정합니다.

간단히  말하면

처음에 얼마나 많은 Splat이 고

정되어 움직일 수 없는지. Sky 

Dome이 켜져 있을 때 자동으로 

Sky Dome 수로 설정됩니다. 직

접 조정할 필요가 없습니다.
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Adam + LR 스케줄 (T49–T55)

T49 adamResetIteration

세부  정보

기본값: 0 (= 비활성화) 범위: 0 또는 100 – maxIterations 
정의 위치: TrainingConfig.swift

기술적  설명

V430 기능: Adam 옵티마이저 Momentum Accumulator 
(m1, m2) 가 0으로 재설정되는 반복. 그 후 Bias 보정
은 iter  대신 (iter - adamResetIteration)로 실
행됩니다. V430은 5 000에서 Reset을 테스트했습니다 
(Densification 종료 후) → 12.8% 더 나쁜 Loss. 이유: 
Densification 동안 구축된 Adam Momentum이 일반적인 
그래디언트 크기에 대한 정보를 가지고 있고 Refinement 단계
를 가속화합니다. 이를 버리면 Refinement의 처음 ~500 반
복의 수렴 비용이 듭니다. 비활성화. 연구 실험을 위한 CLI 플
래그.

간단히  말하면

내부 Adam 옵티마이저 “메모

리”의 Reset 버튼. 테스트에서 해

를 끼쳤습니다, 꺼진 채로 유지

됩니다.

T50 positionLRScheduleEndIteration

세부  정보

기본값: 0 (이니셜라이저 = “maxIterations 사용”), 20 000 
( .full  — maxIter=35K에도 불구하고 Cosine이 20K에
서 종료), 30 000 ( .fullClassicPaper ) 범위: 0 또는 1 
000 – maxIterations 정의 위치: TrainingConfig.swift

기술적  설명

V431 기능: Position LR Cosine Annealing 곡선이 최
솟값에 도달하는 반복. 0이면 T1 maxIterations 와 동
일합니다. > 0이면 스케줄이 이 값까지 실행되고 그 후 
T4 positionLearningRateFinal에서 일정하게 유지됩니
다. 이는 최소이지만 일정한 학습률로 “확장된 Refinement 단
계”를 허용합니다 — 새 Decay 없이 위치를 천천히 정제합
니다. .full 은 이를 수행합니다 (스케줄 종료가 20K, 학습
이 35K까지 실행). V434c/V434d는 다음을 확인했습니다: 
15K와 25K가 거의 같음, 20K가 미세하게 최적. 확장 단계에
서 비 Position LR도 수정하기 위해 T51 과 함께 사용됩니다.

간단히  말하면

언제 앱이 Position 학습률을 더 

낮추는 것을 멈출지. 최대 반복

보다 낮으면 그 후 일정한 미니 

비율로 실행됩니다 — 매우 느리

지만 매우 안정적으로 정제합니

다. Quality 프리셋에 내장됨, 조

정할 필요 없음.
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T51 extendedPhaseLRDecay

세부  정보

기본값: 0.0 (= 비활성화, 일정한 LR) 범위: 0 또는 0.01 – 
1.0 정의 위치: TrainingConfig.swift

기술적  설명

V433 기능: “확장 단계”에서 비 Position LR (스케일, 회
전, Opacity, SH) 의 최소 승수 — 즉: T50 이 도달되
어 Position LR이 이미 T4 에 있은 후. 0.1이면 스케일/
회전/Opacity/SH가 1.0 (= 표준 LR) 에서 표준의 0.1×로 
cosine-decay됩니다. 0.0 (기본값) 이면 일정하게 유지됩니
다. V457은 전체 Decay (0.0 = 0까지 Decay) 를 no-
decay에 대해 테스트했고 다음을 발견했습니다: 평균 0.0400 
(2 Run) = Decay 없는 V438과 같은 Loss. Decay로 동작
이 더 깨끗하지만 측정 가능하게 더 나음은 아닙니다. 따라서 비
활성화. CLI에 --nonpos-lr-scale F로 유지됩니다.

간단히  말하면

후반 정제 단계에서 색상과 형태 

학습률도 더 작게 만듭니다. 학

습을 “더 안정적”으로 만들지만 

경험적으로 더 나음은 아닙니다. 

꺼짐.

T52 adaptiveDensifyThreshold

세부  정보

기본값: false 범위: boolean 정의 위치: 
TrainingConfig.swift

기술적  설명

V440 실험적: true인 경우 앱은 각 Densification 단계에서 
현재 그래디언트 분포의 p98을 계산하고 동적 임곗값으로 사용
합니다 (구성된 T11  값의 최소 0.5×에 클램프되어 너무 많이 
벗어나지 않도록 함). 가설: 현재 장면 단계에 대한 자동 적응이 
Density Control을 더 강건하게 만들 것 — 예: 처음에는 더 
엄격한 Pruning, 나중에는 더 느슨하게 또는 그 반대. V440
은 테스트하고 revert했습니다: 63 K Gaussian으로의 재앙
적 하락 (Mass Pruning, 처음 반복에서 p98이 극도로 높고 
그 다음 거의 아무것도 임곗값을 초과하지 않기 때문에). 고정
된 임곗값이 이미 잘 보정되어 있고 동적 적응이 도움이 되기보
다 해를 끼칩니다. Q5 (T77) 는 Rolling Median을 통한 대체 
Adaptive 로직을 제공하여 문제를 우회합니다.

간단히  말하면

Densify 임곗값의 적응 버전. 테

스트에서 재앙적 (Splat 수가 63K

로 충돌). 꺼짐. Q5에는 더 나은 

변형이 있습니다.

135 / 216



R A D I A N C E K I T 제 6 장 — 학습 구성

T53 mergeAfterDensification

세부  정보

기본값: false (이니셜라이저), true ( .full , 
.classicBalanced , .fullClassicPaper ) 범위: 

boolean 정의 위치: TrainingConfig.swift

기술적  설명

V438 기능: Densification 단계 종료 시 (Iter T2 ) 유사한 
스케일과 색상으로 가까이 있는 Gaussian을 결합하는 일회성 
Merge 패스가 수행됩니다. 가시적 품질 손실 없이 Gaussian 
수를 일반적으로 5–15% 줄입니다. 의의: 강한 Clone 후 거의 
동일한 Gaussian 클러스터가 발생하며 이는 새로운 것을 기
여하지 않습니다 — Merging은 다른 영역에 옵티마이저 용량
을 해제합니다. Classic Quality 프리셋의 표준. MCMC에서
는 사용되지 않습니다. MCMC가 Relocation 로직을 통해 이
러한 클러스터가 처음부터 발생하지 않게 하기 때문입니다.

간단히  말하면

Splat 곱하기 단계 종료 시 거의 

동일한 클론을 결합합니다. 가시

적 효과 없이 데이터 양을 줄입

니다. Quality 프리셋에서 기본적

으로 켜져 있습니다.

T54 densifyPhase2FromIteration

세부  정보

기본값: 0 (= 비활성화) 범위: 0 또는 T2  – T1  정의 위치: 
TrainingConfig.swift

기술적  설명

V426 실험적: Refinement 일시 정지 후 이 반복에서 시
작하여 T55 까지 실행되는 두 번째 Densification 단계
를 가능하게 합니다. 가설: Refinement 단계 후 그래디언트 
Accumulator가 더 안정적인 크기를 가지고 추가 Gaussian
이 필요한 영역을 더 정확하게 말할 수 있을 것입니다. V426
은 테스트하고 revert했습니다: Two-Phase Densification
이 0 Gaussian 캐스케이드 실패에 빠짐 (V425 Refinement 
Pruning과 결합하여 버퍼를 파괴함). 비활성화. 실험을 위한 
CLI 플래그 사용 가능.

간단히  말하면

일시 정지 후 두 번째 곱하기 라

운드. 테스트에서 Splat 재고를 

파괴했습니다. 꺼짐.

T55 densifyPhase2UntilIteration

세부  정보

기본값: 0 범위: 0 또는 T54  – T1  정의 위치: 
TrainingConfig.swift

기술적  설명

V426 Two-Phase Densification의 종료. T54 > 0 일 때
만 관련 있음. 두 필드 모두 비활성화.

간단히  말하면

두 번째 곱하기 라운드의 종료 

(T54 참고). 둘 다 꺼짐.
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Post-Processing + Apple AI (T56–T60)

T56 postTrainingCompactification

세부  정보

기본값: true (모든 Production 프리셋), false 
( .quickTest , .preview ) 범위: boolean 정의 위치: 
TrainingConfig.swift

기술적  설명

V443 기능: 학습 종료 후 sigmoid(opacity) < 0.01의 
Gaussian이 하드 제거됩니다 (실질적으로 더 이상 이미지에 
기여하지 않음). 가시적 품질 손실 없이 Gaussian Count
를 일반적으로 58%, 내보내기 파일 크기를 55% 줄입니다. 
Production 프리셋에서 표준으로 활성 — 최종 결과를 가능한 
한 콤팩트하게 제공해야 합니다. .quickTest 에서는 꺼짐. 
진단 실행이 어쨌든 내보내지지 않기 때문입니다. T42
midTrainingCompactificationIterations (V549) 와 
달리 Compactification은 끝에서만 발생합니다 — 
Refinement는 그때까지 모든 Gaussian을 사용할 수 있습니
다.

간단히  말하면

학습 후 정리: 거의 보이지 않

는 Splat이 제거됩니다. 내보내

기 파일을 품질 손실 없이 약 절

반 크기로 만듭니다. 필수 기능, 

진단 실행에서만 꺼 둡니다.

T57 metalFXUpscaling

세부  정보

기본값: false 범위: boolean 정의 위치: 
TrainingConfig.swift

기술적  설명

V444 기능: 3D Viewer 출력에서 Bilinear Interpolation 
대신 Apple의 MetalFX Spatial Upscaler를 활성화합니다. 
학습 해상도 < 뷰포트 크기 (예: 0.5× 학습, 전체 해상도 뷰포
트 표시) 인 경우 MetalFX는 훨씬 더 선명한 이미지를 제공할 
수 있습니다. 뷰포트에서 실시간으로 변경됩니다. 재학습 필요 
없음. T58 mpsLanczosScaling과 상호 배타적 — MetalFX
가 우선합니다. 권장: 이미지가 예상 세부 정보에 비해 뷰어에서 
“흐릿”하게 나타나면 켜십시오.

간단히  말하면

3D Viewer의 Apple ML 기반 이미

지 선명화. 더 낮은 해상도에서 

학습했고 결과를 전체 화면으로 

보여 줄 때 도움이 됩니다. 실시

간 토글, 시도해 보십시오.
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T58 mpsLanczosScaling

세부  정보

기본값: false 범위: boolean 정의 위치: 
TrainingConfig.swift

기술적  설명

V444 기능: Bilinear Interpolation 대신 뷰포트 스케일링용 
MPSImageLanczosScale. Lanczos는 Bilinear보다 훨씬 
더 선명한 결과를 최소한의 오버헤드로 제공하는 고전적 Sinc 
기반 재샘플링 절차입니다. 실시간 토글. 둘 다 켜져 있으면 
T57 에 의해 덮어쓰여집니다.

간단히  말하면

3D Viewer를 위한 고전적 선명

화 절차 (Lanczos). MetalFX (T57) 

는 ML 기반이며 보통 더 좋습니

다. Lanczos는 덜 공격적인 대안

입니다.

T59 livePreviewInterval

세부  정보

기본값: 50 (이니셜라이저와 대부분의 프리셋) 범위: 0 (off) 
또는 10 – 5 000 정의 위치: TrainingConfig.swift

기술적  설명

학습 중 3D Viewer가 현재 Gaussian으로 업데이트되는 빈
도. 50 = 50회 반복마다 Viewer에 새 Render — 학습을 느
리게 하지 않고 진행을 관찰하기에 충분히 좋음. 0 = Viewer
가 전혀 업데이트되지 않음 (백그라운드 학습, 최대 속도). 일반
적인 조정: .quickTest 에서 10으로 낮춤 (모든 단계를 보고 
싶음), 긴 MCMC 실행에서 500–2000으로 높임 (Update 
오버헤드가 합계로 눈에 띔).

간단히  말하면

학습 중 3D 미리보기가 얼마나 

자주 업데이트되는지. 50 = 50 

반복마다. 더 높음 = 덜 자주 = 약

간 더 빠름, 하지만 진행을 덜 자

주 봅니다. 0 = 미리보기 없음 (최

대 속도용).

T60 perceptualLossWeight

세부  정보

기본값: 0.0 (= 비활성화) 범위: 0 또는 0.001 – 0.5 정의 위
치: TrainingConfig.swift

기술적  설명

V444 미래 기능: MPSGraph (VGG와 비슷한 작은 네트워
크) 를 통한 Perceptual Loss 항의 가중치. L1+SSIM보다 더 
높은 의미 수준에서 구조적 및 텍스처 유사성을 포착할 것입니
다 — “Pixel-Perfect”가 “사실적으로 보임”보다 덜 중요한 연
구 파이프라인에서 일반적입니다. 구현은 아직 보류 중 (Code 
Stub 존재하지만 Forward Pass는 구현되지 않음). 기본값 
0.0. 향후 활성화를 위해 필드 카탈로그에 유지됩니다. CLI 플

래그 
--percep-weight

F  예약.

간단히  말하면

AI 도움으로 “자연스럽게 보이

는” 것을 목표로 하는 계획된 기

능 (Pixel-Perfect 대신). 아직 완

전히 구현되지 않음.
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MCMC Densification (T61–T73)

T61 densificationStrategy

세부  정보

기본값: .classic  (이니셜라이저 + Classic 프
리셋), .mcmc  (모든 MCMC 프리셋 + Scene-
Class) 범위: .classic  또는 .mcmc  정의 위치: 
TrainingConfig.swift

기술적  설명

Classic Densification (Clone/Split/Prune, Kerbl 외 
2023) 과 MCMC Densification (Relocation을 사
용한 Stochastic Gradient Langevin Dynamics, 
Kheradmand 외 NeurIPS 2024) 사이의 선택. 
.classic 에서는 T11--T16 이 평가되고, .mcmc 에서는 
T62--T73 이 평가됩니다. 전환 시 주의: Classic 기본값과 

MCMC 기본값은 완전히 다르게 보정되어 있습니다 — Expert 
View의 선택기를 Flip하는 사람이 적절한 프리셋을 로드하
지 않으면 1.4.3 버그 스타일 대량 멸종 (한 반복에서 460 
K → 5) 의 위험이 있습니다. MCMC OpacityReg 0.01이 
Classic Opacity를 죽이기 때문에. 따라서 MCMC Init 기본
값은 의도적으로 “부드럽게” (모든 Reg 값 0.0).

간단히  말하면

Splat 곱하기에 어떤 알고리즘이 

사용되는지. Classic = 원래 방법 

(빠름, 많은 Splat). MCMC = 새 방

법 (더 느림, 훨씬 적은 Splat, 대

신 더 콤팩트). 프리셋이 올바른 

것을 선택합니다. 자체적으로 전

환은 적절한 프리셋 (P5–P7 또는 

P8–P10) 도 로드할 때만 하십시

오.
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T62 mcmcMaxGaussians

세부  정보

기본값: 150 000 (이니셜라이저 + .fullMCMC  + 
.mcmcBalanced ), 100 000 ( .mcmcPreview ), 1 500 

000 ( .fullMCMCMip  — 10× 예산이 있는 Mip-
Splatting 변형), 1.19 M ( .renderPreset ), 1.25 M 
( .outdoorPreset ), 670 K ( .indoorPreset ) 범위: 0 
(= “버퍼 용량 사용”) 또는 10 000 – 5 000 000 정의 위
치: TrainingConfig.swift

기술적  설명

MCMC 전략에서 Gaussian 수의 하드 상한. 수는 이 Cap까
지 Relocation 단계당 T70 mcmcGrowthRate  (일반적으로 
5%) 로 점진적으로 증가합니다. V473/V531은 150 K를 스
위트 스폿으로 발견했습니다 — 200 K 이상에서는 Splat 품
질이 희석됩니다 (너무 많은 작은, 중복된 Gaussian). 100 
K 미만에서는 장면이 under-densify 상태로 유지됩니다. 매
우 큰 장면 (예: 158 K SfM 초기화의 1 545 사진 드론 비
행) 에서는 150 K가 너무 낮습니다 — 따라서 1.4.5 확장 T72 
mcmcCapMultiplier + T73 mcmcAutoScaleByScene. 
Q7 BayesOpt는 670 K (Indoor) 에서 1.25 M (Outdoor) 
사이의 장면별 최적값을 발견했습니다. 값 0에서 엔진은 전체 
버퍼 용량을 Cap으로 사용합니다.

간단히  말하면

MCMC에서 최대 Splat 수. 150 

000이 표준이며 대부분의 장

면에 충분합니다. Outdoor 및 

Render 프리셋 (P8, P9) 은 더 세

부 정보가 풍부한 장면을 위해 

100만+로 올라갑니다. 높이면 세

부 정보를 가져올 수 있지만 메

모리 비용. 낮추는 것은 비상 브

레이크에 가깝습니다.

T63 mcmcNoiseScale

세부  정보

기본값: 0.00005 (5e-5 = 논문 기본값) 범위: 1e-6 – 1e-3 
정의 위치: TrainingConfig.swift

기술적  설명

각 MCMC 반복에서 각 Gaussian의 위치에 추가되는 
Gaussian 노이즈의 승수 (SGLD 로직). 더 높음 = 더 많
은 탐색 (Gaussian이 더 많이 방황, 잠재적으로 더 나은 자리
를 찾음), 더 낮음 = 더 많은 이용 (Gaussian이 이미 좋은 곳
에 머무름). V467과 V536은 5e-5를 최적으로 확인했습니다 
— 1e-5/2e-5는 너무 적은 탐색, 1e-4는 너무 많음 (Splat
이 흩어짐). 학습 시간에 걸쳐 T69 mcmcNoiseDecayEnd까지 
cosine-decay됩니다 — Decay 범위 종료 시 노이즈가 효과
적으로 0이고 Gaussian이 수렴합니다.

간단히  말하면

Splat이 스스로 최선의 위치를 

찾을 수 있도록 앱이 얼마나 많

은 무작위 “흔들림”을 허용하는

지. 표준값이 최적 테스트되었습

니다. 이를 높이면 Splat이 불안

해집니다.
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T64 mcmcOpacityRegWeight

세부  정보

기본값: 0.0 (= RadianceKit 기본값에서 비활성화, 논
문: 0.01) 범위: 0 또는 0.001 – 0.05 정의 위치: 
TrainingConfig.swift

기술적  설명

Opacity에 대한 MCMC 특정 L1 페널티. 논문 기본값 0.01 
(사용되지 않은 Gaussian을 0으로 누르고, Relocation에 사
용할 수 있게 만듭니다). 그러나 V464b는 RadianceKit에서 
Reg 없이 측정 가능하게 더 나음을 보여 주었습니다 (Session 
28 확인). 이유: T68 mcmcDeadOpacityThreshold로 정의
된 Pruning 기준만으로 충분합니다 — 추가 L1 페널티는 가치 
있는, 낮은 Opacity Gaussian도 죽도록 강제합니다. 따라서 
기본값 0. 주의: 1.4.3 베타 빌드에서 이니셜라이저 기본값이 
잘못 0.01이었고 대량 멸종 버그를 초래했습니다 (T61 설명 참
고). 1.4.4부터 0.0으로 고정.

간단히  말하면

MCMC 특수 정규화. 다른 MCMC 

메커니즘 (T68의 임곗값) 이 이

미 다루기 때문에 꺼짐. 0으로 두

십시오.

T65 mcmcScaleRegWeight

세부  정보

기본값: 0.0 (= 비활성화, 논문: 0.01) 범위: 0 또는 0.001 – 
0.05 정의 위치: TrainingConfig.swift

기술적  설명

스케일 고유값에 대한 MCMC 특정 L1 페널티. 논문 기본값 
0.01. V464b: Reg 없이 더 나음, T64와 같은 이유. 모든 
RadianceKit MCMC 프리셋에서 비활성화. T64와 같은 주
의: 1.4.3 버그.

간단히  말하면

T64와 비슷하지만 Splat 크기용. 

꺼짐.
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T66 mcmcRelocationInterval

세부  정보

기본값: 100 (이니셜라이저 + 모든 MCMC 프리셋, 논문 표
준), 155 (P9 Outdoor — Q7 BayesOpt 최적) 범위: 50 – 
500 정의 위치: TrainingConfig.swift

기술적  설명

MCMC가 죽은 Gaussian (sigmoid(opacity) < T68
mcmcDeadOpacityThreshold) 을 새 위치로 재배치하는 반
복 간격. V537은 50을 테스트했고 (너무 파괴적, Loss 변동) 
200을 테스트했습니다 (미세하게 더 나쁨, MCMC가 반응성
을 잃음). 100이 최적입니다. Q7 BayesOpt는 Bicycle에서 
야외용 장면별 최적값으로 155를 발견했습니다 — 약간 더 긴 
간격은 Adam이 다음 Reloc 이벤트가 압력을 가하기 전에 새
로 배치된 Gaussian을 통합할 더 많은 시간을 줍니다.

간단히  말하면

매 몇 반복마다 MCMC가 죽은 

Splat을 다른 곳으로 옮기는지. 

100이 표준. 직접 조정할 필요 없

음 — Outdoor 프리셋이 이미 최

적값을 가집니다.

T67 mcmcWarmupIterations

세부  정보

기본값: 500 범위: 100 – 5 000 정의 위치: 
TrainingConfig.swift

기술적  설명

아직 MCMC Relocation이 발생하지 않는 초기 반복 수. 이 
Warmup 후에만 Reloc 로직이 시작됩니다. 의의: 처음 반복
에서 Opacity 값이 아직 안정화되지 않았습니다 — Reloc로 
바로 시작되면 Gaussian이 잘못된 위치에 배치되어 바로 다시 
이동되어야 하며 이는 Adam Momentum을 파괴합니다. 논문 
기본값 500. RadianceKit은 V464b가 강건함을 보여 주었
기 때문에 이 값을 채택합니다.

간단히  말하면

MCMC가 Splat 재배치를 시작하

기 전에 얼마나 많은 반복을 

“도착”할 수 있도록 허용하는지. 

500이 표준이며 맞습니다.
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T68 mcmcDeadOpacityThreshold

세부  정보

기본값: 0.005 (이니셜라이저, 논문 표준), 0.01 
( .fullMCMC  와 모든 MCMC 프리셋 — V535 최적) 범위: 
0.001 – 0.05 정의 위치: TrainingConfig.swift

기술적  설명

sigmoid(Opacity) 임곗값. 이 아래에서 Gaussian이 “죽
음”으로 간주되어 Relocation 대상이 됩니다. V535는 0.01
을 최적으로 발견했습니다 (0.005는 미미함, 0.02는 더 나쁨). 
더 높음 = 더 공격적인 Reloc (더 많은 Gaussian이 이동됨), 
더 낮음 = 더 신중함. 0.01은 대략 “0.5% 시각적 가시성”에 
해당합니다. P10 Indoor는 Q7 BayesOpt를 통해 0.0142를 
최적으로 사용합니다.

간단히  말하면

어떤 투명도에서 Splat이 “죽

음”으로 간주되어 MCMC가 다른 

곳으로 이동하는지. 0.01이 우리

의 테스트에서 최적입니다. 직접 

조정할 필요 없음.

T69 mcmcNoiseDecayEnd

세부  정보

기본값: 0 (이니셜라이저 = “Decay 없음”), 160 
000 ( .fullMCMC  = 200K의 80%), 96 000 
( .mcmcBalanced  = 120K의 80%), 40 000 
( .mcmcPreview ) 범위: 0 또는 1 000 – maxIterations 
정의 위치: TrainingConfig.swift

기술적  설명

T63 mcmcNoiseScale  노이즈가 완전히 0으로 감쇠되는 반
복 (Iter 0부터 여기까지 Cosine Decay). V497c/V502는 
maxIterations의 80%를 최적으로 발견했습니다 — MCMC
에 충분한 탐색 시간을 주지만 마지막 20%를 노이즈 없이 수렴
에 남깁니다. 0 = 모든 반복에 걸쳐 일정한 노이즈 (거의 의미가 
없음, MCMC가 수렴할 수 없음).

간단히  말하면

Splat의 무작위 “흔들림”이 언제 

멈출지. MCMC 프리셋에서는 총 

반복의 80%에서 — 먼저 탐색, 그 

다음 수렴. 값을 그대로 두십시

오.
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T70 mcmcGrowthRate

세부  정보

기본값: 0.05 (논문 표준 = 5%) 범위: 0.01 – 0.2 정의 위
치: TrainingConfig.swift

기술적  설명

Relocation 단계당 MCMC 인구 대상의 성장률. 로직: 각 
Reloc 이벤트에서 대상 인구 크기가 (1 + growthRate) 만
큼 증가하여 T62 mcmcMaxGaussians (또는 T72/​T73을 통해 
스케일된 변형) 에 도달합니다. V512/V522는 0.05를 최적으
로 발견했습니다 — 더 높은 값은 너무 빠른 성장으로 이어집니
다 (Adam Momentum이 통합할 수 있기 전에 Gaussian이 
삽입됨), 더 낮은 값은 종료 시 under-densified 장면으로 이
어집니다.

간단히  말하면

MCMC에서 Splat 수가 얼마나 빠

르게 성장하는지. 단계당 5%가 

최적. 값을 그대로 두십시오.

T71 mcmcSigmoidK

세부  정보

기본값: 100.0 범위: 10.0 – 500.0 정의 위치: 
TrainingConfig.swift

기술적  설명

MCMC 노이즈 감쇠를 위한 Sigmoid Sharpness 매개변
수. SGLD 단계에서 Gaussian당 노이즈는 sigmoid(K × 
logit_opacity) 로 감쇠됩니다 — 높은 Opacity Gaussian 
(Logit이 양수) 은 낮은 Opacity보다 기하급수적으로 적은 노
이즈를 받습니다. K = 100은 선명하며, 즉 Opacity 0.5 주위
에서 “풀 노이즈”에서 “노이즈 없음”으로의 전환이 매우 빠르게 
발생합니다. V484–V487은 K = 100을 최적으로 발견했습니
다 — 더 작은 값 (10–50) 은 높은 Opacity Gaussian도 흔
들리게 합니다 (수렴된 Gaussian 파괴), 더 큰 값 (> 500) 은 
전환을 인위적으로 단단하게 만들고 죽은 Gaussian이 전혀 이
동되지 않습니다.

간단히  말하면

MCMC가 “이동하기 충분히 투

명”과 “단단함, 건드리지 마”를 

얼마나 선명하게 구별하는지를 

결정하는 특수 매개변수. 표준값

이 최적. 조정하지 마십시오.
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T72 mcmcCapMultiplier

세부  정보

기본값: 3.0 (이니셜라이저 + .fullMCMC ), 2.0 
( .mcmcPreview ), 2.5 ( .mcmcBalanced ), 2.98 (P8 
Render), 5.32 (P9 Outdoor), 1.76 (P10 Indoor) 
범위: 0 (= 비활성화) 또는 1.0 – 10.0 정의 위치: 
TrainingConfig.swift

기술적  설명

1.4.5 기능: 장면 적응 Cap 스케일링. T73
mcmcAutoScaleByScene이 true이면 효과적 Cap이 
max(T62, initialPointCount × T72) 로 계산됩니다 (버퍼 
용량에 클램프). 배경: 큰 장면에서 (예: 1 545 사진 드론 비
행 → 158 K SfM 초기화) T62 = 150 000 은 너무 낮습
니다 — Density Control이 전혀 성장할 수 없을 것입니다. 
Multiplier 3.0으로 이 예에서 Cap이 474 K로 스케일됩니다 
(158 K × 3.0). Q7 BayesOpt는 장면별 최적값을 발견했습
니다: Outdoor는 높은 Multiplier (5.32 → 156 K bicycle 
초기화에서 ~830 K Cap) 로부터 혜택, Indoor는 1.76으
로 만족 (벽이 어쨌든 더 빨리 포화). Cap의 전체 해상도는 
resolveMcmcMaxGaussians 메서드 참고.

간단히  말하면

Splat Cap을 장면 크기에 자동으

로 적응시키는 승수. 큰 장면 = 

더 많은 시작 점 = 더 높은 Cap. 

표준 3×는 대부분의 장면에 맞

습니다. Outdoor 프리셋은 5×로 

갑니다 (큰 깊이 범위), Indoor는 

1.76×로 (벽이 어쨌든 제한합니

다).

T73 mcmcAutoScaleByScene

세부  정보

기본값: true (이니셜라이저 + 모든 MCMC 프리셋) 범위: 
boolean 정의 위치: TrainingConfig.swift

기술적  설명

1.4.5 기능: 장면 인식 Cap 로직의 마스터 스위치 (T72
1. resolveMcmcMaxGaussians 참고). false이면 T62 

mcmcMaxGaussians만

Cap으로 사용됩니다 (1.4.4 동작으로 되돌림). 1.4.3의 큰 장
면에서 대량 멸종 문제가 그렇지 않으면 반복되기 때문에 기본
적으로 켜져 있습니다. 명시적으로 하드 Cap을 설정하려는 경
우에만 수동으로 비활성화 — 예: 종료 크기가 계획 가능한 150 
K 변형을 학습하기 위해.

간단히  말하면

Splat Cap의 장면 크기에 대한 자

동 적응을 켭니다. 표준은 켜짐. 

특정 Splat 수를 정확히 원할 때

만 꺼 두십시오.
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Mip-Splatting (Q1.5) (T74–T76)

상태: Q1.5는 14번의 자율 반복 + Overnight 1.5M Confidence Check 후 2026-05-25에 
“closed no-win”으로 폐기되었습니다 (max Δ@2× = +0.27 dB, 원래 Gate는 0.5×/2×에 대해 
평균 ≥ +1.5 dB을 요구했는데 0/11 Pair Scene에서 FAIL). 필드는 연구 실험을 위해 opt-in으로 
유지됩니다. 모든 Production 프리셋은 useMipSplatting = false입니다. Verdict 참고: docs/​
plans/​2026-05-25-phase-q1.5-final-verdict.md.

T74 useMipSplatting

세부  정보

기본값: false (모든 Production 프리셋), true 
( .fullMCMCMip  — 연구 형제) 범위: boolean 정의 위치: 
TrainingConfig.swift

기술적  설명

Mip-Splatting (Yu 외 CVPR 2024) 을 활성화합니다: 가장 
조밀한 학습 카메라 샘플링 비율의 Nyquist 한계로 Gaussian
당 주파수를 제한하는 3D Smoothing 필터 + 2D 필터 + 
α 보상. 이론적 목표: 학습 외 스케일 (0.5× 또는 2× 학
습 해상도) 에서의 렌더링 시 Aliasing 제거. Preprocess 및 
Backward Projection 셰이더에서 활성화되었으며 Q1.5-D 
테스트에서 기능적으로 정확하다고 검증됨. 그러나: 원래 수용 
Gate (Δ@1× ≥ +0.3 dB 그리고 avg(Δ@0.5×, Δ@2×) ≥ 
+1.5 dB) 가 11개의 Pair Scene 중 어느 것에서도 달성되
지 않았습니다. 최대 관찰: family 750K classic Δ@2× = 
+0.270 dB. 야외 장면 (Truck, Flowers) 은 1×와 0.5×에
서 악화를 보였습니다. 가설: 3D Smoothing이 high-Gs에
서 MCMC Relocation과 경쟁합니다. 필드는 올바른 Mip-
NeRF-360 방법론을 사용한 향후 Multi-Scale 재평가를 위
해 유지됩니다 (벤치마크 경로의 O3 백로그 참고).

간단히  말하면

2024년 논문의 Aliasing 필터. 이

론적으로 훌륭하지만 실제로 우

리 테스트에서 가져온 것이 없었

고 때로는 해를 끼쳤습니다. 실

험자를 위해 사용 가능하지만 권

장하지 않습니다. 꺼 두십시오.
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T75 mipSmoothing3DScale

세부  정보

기본값: 0.2 (논문 기본값) 범위: 0.05 – 1.0 정의 위치: 
TrainingConfig.swift

기술적  설명

3D Smoothing 스케일 매개변수 (Yu 외 §3.3, 논문 기본
값 0.2). 더 큼 = Gaussian당 더 많은 세계 공간 평활화 
(= 더 많은 Anti-Aliasing, 그러나 기본 스케일에서 더 많
은 흐림), 더 작음 = 더 선명하지만 Aliasing에 더 취약. T74 
useMipSplatting = true일 때만 참조됩니다. Q1.5 테스트
에서 더 이상 최적화되지 않았습니다 — A/B Gate가 이미 논문 
기본값 0.2로 졌습니다, 추가 Sweep은 무의미할 것입니다.

간단히  말하면

Mip-Splatting 매개변수. Mip이 

켜져 있지 않다면 관련 없음.

T76 mipFilter2DVariance

세부  정보

기본값: 0.3 (= 정확히 V242 Legacy 동작) 범위: 0.1 – 1.0 
정의 위치: TrainingConfig.swift

기술적  설명

Σ_2D 대각선에 추가되는 2D Mip 필터 분산 (분산 직접, 제
곱 아님). 0.3은 Mip-Splatting 전 커널에 하드코딩되어 있
던 정확히 V242 Legacy 값입니다. T74 useMipSplatting 
= false이면 커널이 이 값을 완전히 무시하고 하드코딩된 
0.3을 작성합니다 — 따라서 Baseline이 회귀할 수 없습니다 
(Codex Round 1 S3-1 보증). useMipSplatting = true이
면 여기서 설정된 값이 사용됩니다. Mip Sweep을 위해 필드 
카탈로그에 유지됩니다.

간단히  말하면

추가 Mip-Splatting 매개변수. 

Mip 꺼짐: 관련 없음.

147 / 216



R A D I A N C E K I T 제 6 장 — 학습 구성

Adaptive Densification (Q5) (T77–T79)

T77 adaptiveDensification

세부  정보

기본값: false 범위: boolean 정의 위치: 
TrainingConfig.swift

기술적  설명

Q5 기능: 고정 T11 densifyGradThreshold의 대안으
로 Rolling Median 추적기. true이면 각 Densify 단계에
서 현재 임곗값이 median(last N avgGrad samples) 
× T79 adaptiveDensifyMultiplier로 덮어쓰여집니다. 
N = T78 adaptiveWindow . V440 p98 (재앙적 63 K 
Pruning 함정) 보다 엄격함, 중앙값 + 2×는 Steady State
에서 그래디언트 분포의 p70–p80에 앉습니다. Q5 테스트: 독
립적으로 FAIL 0/3 장면, 그러나 Q6 (T80/T81 참고) 와 함
께 PASS 1/3 장면 — Q5+Q6 번들은 2026-05-25에 opt-
in으로 통과되었으며 CLI --adaptive-densify 를 통해 활
성화할 수 있습니다. 거기서 Q6가 품질 이득의 “Carrier”이고 
Q5는 안정성에 기여합니다.

간단히  말하면

자체 학습 Densify 임곗값. 고정

된 감도 대신 앱이 장면에 적응

합니다. 단독 테스트에서 더 나

음 없음, Q6의 Curriculum과 함

께 그렇습니다. 둘을 함께 켜거

나 둘 다 꺼 두십시오.

T78 adaptiveWindow

세부  정보

기본값: 1 000 범위: 100 – 10 000 정의 위치: 
TrainingConfig.swift

기술적  설명

Densification 이벤트의 Rolling Median 윈도우 (반복이 아
님 — 각 T13 densifyInterval 단계가 하나의 샘플을 제
공). 기본값 1 000 — densifyInterval = 100에서 이는 마
지막 100 000 학습 반복이 중앙값에 기여한다는 의미이며 일
반적으로 여기까지의 전체 학습 기록입니다. 초기 단계 (T78 
샘플 전): 추적기는 nil 반환 → 고정 임곗값 T11 로 대체. 
adaptiveDensification = true일 때만 관련 있음.

간단히  말하면

T77의 중앙값에 얼마나 많은 오

래된 Densify 단계가 흘러들어가

는지. 표준 1000이 좋습니다. Q5 

Adaptive 켜짐일 때만 관련 있음.
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T79 adaptiveDensifyMultiplier

세부  정보

기본값: 2.0 범위: 1.0 – 4.0 정의 위치: 
TrainingConfig.swift

기술적  설명

적응 임곗값에 대한 Rolling Median 승수. 기본값 2.0은 대
략 일반적인 그래디언트 분포의 p70–p80에 해당합니다. 더 낮
음: 더 공격적인 성장 (더 많은 클론), 더 높음: 더 엄격함 (더 적
은 클론). Q5 테스트는 1.5–3.0 범위에서 — 2.0 최고 기본값. 
adaptiveDensification = true일 때만 관련 있음.

간단히  말하면

T77/T78의 인수. 표준 2.0 = 일반 

중앙값보다 엄격함. 조정하지 마

십시오.

Curriculum (Q6) (T80–T81)

T80 curriculumResolutionRamp

세부  정보

기본값: false 범위: boolean 정의 위치: 
TrainingConfig.swift

기술적  설명

Q6 기능: 학습 해상도가 0.5×에서 시작하여 T50
positionLRScheduleEndIteration /​ 2 (T50이 설정되
지 않은 경우 또는 T1
maxIterations /​ 2) 에서 T22 trainingRenderScale
로 전환됩니다. Q1.5.1 에서 개발된 resize/​
restoreImageBuffers 인프라를 사용합니다. 활성화되
면 T23 resolutionWarmupScale을 덮어씁니다. Q6는 
Q5+Q6 번들에서 “품질 이득의 Carrier”로 통과되었습니다 
(T77 참고) — 단계별 해상도 증가는 앱에 미세한 세부 작업으
로 전환하기 전에 더 낮은 해상도에서 거친 형상을 찾을 시간을 
줍니다. CLI를 통해: --curriculum-resolution.

간단히  말하면

학습 해상도용 “먼저 거칠게, 그 

다음 미세하게”. 전반부에 절반 

해상도, 그 다음 전체 해상도. 어

떤 장면에서는 도움이 되고 다른 

장면에서는 그렇지 않습니다 — 

T81과 함께 가장 잘 켜집니다.
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T81 curriculumSHProgression

세부  정보

기본값: false 범위: boolean 정의 위치: 
TrainingConfig.swift

기술적  설명

Q6 기능: T21 shDegreeUpgradeIterations를 [maxIter/​
4,

maxIter/​2, maxIter*3/​4]로 덮어씁니다. 즉 SH 업그레이
드를 Front Load 대신 학습 시간에 걸쳐 균등하게 분배합니
다. 가설: 안정적인 형상은 색상 세부 정보 폭발 전에 확립되며, 
이는 View Direction 의존 광택 효과를 더 정확하게 위치시킵
니다. Q5+Q6 함께 PASS 1/3 장면, Q6가 이득의 Carrier 
(Q5 단독 FAIL). CLI를 통해: --curriculum-sh .

간단히  말하면

“먼저 형태, 그 다음 색상” — 광

택 효과가 학습 후반에만 잠금 

해제되어 Splat이 먼저 위치와 

크기를 찾습니다. T80과 함께 켤 

수 있습니다. 단독으로는 그렇게 

많이 가져오지 못합니다.

정적 프리셋 (TP1–TP9)

여기서는 이니셜라이저 기본값과의 구조적 차이만. 11개 UI 프리셋 P1–P11의 전체 마케팅 설명은 제 7 장
에서 찾을 수 있습니다.

TP1 .preview

세부  정보

≥ 10 GB RAM 시스템용 진단/미리보기 프리셋. 이
니셜라이저에 대한 재정의: - maxIterations 30 000 
→ 5 000 - densifyUntilIteration 15 000 → 3 
500 (maxIter의 70%) - positionLearningRateFinal 
1.6e-6 → 1.6e-5 (10배 더 높음, 덜 공격적인 Decay) 
- shDC/shRest/opacity/scale/rotation LRs 각 2배 
(V176) - opacityResetInterval 3 000 → 100 000 
(효과적으로 꺼짐, V172: Reset이 짧은 학습 파괴) - 

shDegreeUpgradeIterations 
[1K,

2K, 3K]  → [1K, 2K]  
(V182: Degree 3이 2K Iter에서 수렴하지 않음) - 
trainingRenderScale 1.0 → 0.5

간단히  말하면

새로 가져온 이미지 시리즈의 모

든 초기 평가 — 2–3분 대기 시

간, 결과는 “Quality 실행이 가치

가 있는가?” 라는 이진 질문에 충

분합니다.
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TP2 .full

세부  정보

Production-Quality Classic. 재정의: - maxIterations 
30 000 → 35 000 (V550: 40K 테스트 Truck 과학
습 +10.7% Gs에 −1.3% L1) - densifyUntilIteration 15 
000 → 5 000 (V310 스위트 스폿, V338 7K 더 나쁨) - 모
든 LR 2배 (V188) - positionLearningRateFinal 1.6e-6 
→ 1.6e-5 (V45 10배) - densifyGradThreshold 2e-6 
→ 1.1e-6 (V335) - densifyInterval 100 → 200 (V112) 
- pruneOpacityThreshold 0.005 → 0.001 (V393) 
- opacityResetInterval 3 000 → 100 000 (V194 
비활성화, V421 확인) - shDegreeUpgradeIterations 

[1K, 2K, 3K]  → 
[2K, 5K,

8K]  (V228 지연) - 
opacityDecayFactor 0.0 → 0.9995 (V546 HTGS, 
14% 개선) - opacityDecayInterval 50 (변경되지 않
음, V546) - mergeAfterDensification false → true 
(V438) - positionLRScheduleEndIteration 0 → 20 
000 (V431) - postTrainingCompactification true 
(V443, .full에 대해 이미 이니셜라이저 기본값)

간단히  말하면

< 500 이미지의 모든 표준 사

진 촬영 (객체, 작은 방, 조각상). 

V546에서 발표된 V438 대비 14% 

Loss 개선이 Horse Full에서 3-

trial 평균으로 확인되었습니다.

TP3 .fullClassicPaper

세부  정보

TP2의 Q1.5-A 테스트 형제, 논문 충실 Classic. TP2에 대한 
재정의:
• maxIterations 35 000 → 30 000 (논문 표준) - 

densifyUntilIteration 5

000 → 15 000 (논문: maxIter의 50%) - 
positionLearningRateFinal 1.6e-5 → 1.6e-6 (논문 기
본값) - opacity/scale/rotation LR 논문 기본값으로 복
귀 (0.05, 0.005, 0.001) - densifyGradThreshold 
1.1e-6 → 2e-7 (Bicycle에서 ~1-2M Gs용으로 보정) - 
densifyInterval 200 → 100 (논문)
• pruneOpacityThreshold 0.001 → 0.005 (논문 기본
값) -

opacityResetInterval 100 000 → 3 000 (논문 
§5.2, 위험 — V194 회귀를 트리거할 수 있음) - 
opacityDecayFactor 0.9995 → 0.0 (논문에 Decay 없
음)
• positionLRScheduleEndIteration 20 000 → 30 000 

(Cosine이 maxIter의

100%에서 실행)

간단히  말하면

Mip-Splatting 테스트에 논문 규

모 Gaussian 예산 (1–2 M) 이 필요

한 Q1.5 연구 실험. Q1.5 “closed 

no-win” Verdict 후 프리셋은 고

급 사용자가 접근할 수 있지만 

Production 권장은 아닙니다.
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TP4 .fullMCMC

세부  정보

Production-Quality MCMC. 이니셜라이저에 대한 재정
의: - maxIterations 30 000 → 200 000 (V534, 
MCMC가 Classic보다 5배 더 많은 Iter 필요) - 
densifyUntilIteration 15 000 → 160 000 (V504b 
maxIter의 80%) - positionLearningRateFinal 1.6e-6 
→ 1.6e-5 - LR 스케줄 TP2처럼 (모두 2배) - ssimWeight 
0.2 → 0.05 (V521b/V534: MCMC에 더 강한 L1 신호 필
요)
• shDegreeUpgradeIterations [1K, 2K, 3K]  → 

[2K, 5K, 8K]  -

densificationStrategy .classic  → .mcmc  - 
mcmcMaxGaussians 150 000 (이니셜라이저에 이미 있
음, 프리셋에서 확인) - mcmcNoiseScale 5e-5 (V467/
V536 최적) - mcmcDeadOpacityThreshold 0.005 → 
0.01 (V535 최적)
• mcmcNoiseDecayEnd 0 → 160 000 (maxIter의 

80%, V497c/V502) -

mcmcCapMultiplier 3.0 (이니셜라이저에 이미 있음) - 
mcmcAutoScaleByScene true (이니셜라이저에 이미 있
음) - opacityResetInterval 3 000 → 200 000 (효과적으
로 꺼짐, MCMC는 Reset 대신 Reloc 사용)

간단히  말하면

웹 배포, 세부 정보 요구 객체 

캡처, 드론 비행 (P9 Outdoor가 

더 나은 경우에도). Classic 대비 

71% 적은 Gaussian으로 비슷한 
L1.

TP5 .fullMCMCMip

세부  정보

Mip-Splatting + 논문 규모 MCMC 예산이 있는 
TP4의 Q1.5-D 테스트 형제. TP4에 대한 재정의: - 
mcmcMaxGaussians 150 000 → 1 500 000 (10배, 논
문 규모) - useMipSplatting false → true (Mip 켜짐)

간단히  말하면

다른 모든 필드는 TP4와 동

일. Q1.5 D-PASS는 Bicycle 

2026-05-24 에서 (12-Iter Multi-

Scale FAIL 연속을 깸). Q1.5 최

종 평결 2026-05-25 그럼에도 

closed-no-win — 11개의 Pair 

Scene에 걸쳐 Mip-Splatting 이득

이 재현되지 않음. 프리셋은 opt-

in으로 유지됩니다.
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TP6 .classicBalanced

세부  정보

Mid-Tier Classic. TP2에 대한 재정의: - maxIterations 
35 000 → 20 000 (V149: 20K = 30K, 33% 적은 시간
으로) - positionLRScheduleEndIteration 20 000 → 0 
(Cosine이 maxIter = 20K에서 실행, 확장 단계 없음)

간단히  말하면

더 짧은 대기 시간의 표준 사례. 

V149가 스위트 스폿으로 식별됨.

TP7 .mcmcPreview

세부  정보

MCMC 진단. TP4에 대한 재정의: - maxIterations 200 
000 → 60 000 (V494b) - densifyUntilIteration 160 
000 → 48 000 (80%) - mcmcMaxGaussians 150 
000 → 100 000 (V473b) - mcmcNoiseDecayEnd 160 
000 → 40 000 (V494b) - mcmcCapMultiplier 3.0 → 
2.0 (1.4.5: Preview = 가벼운 스케일링)

간단히  말하면

빠르게 MCMC 결과를 보고 TP4 

또는 Scene-Class 프리셋이 가치

가 있는지 평가합니다.

TP8 .mcmcBalanced

세부  정보

Mid-Tier MCMC. TP4에 대한 재정의: - maxIterations 
200 000 → 120 000 (V518) - densifyUntilIteration 
160 000 → 96 000 (80%) - mcmcNoiseDecayEnd 
160 000 → 96 000 (80%) - mcmcCapMultiplier 3.0 
→ 2.5 (Preview 2.0과 Full 3.0 사이)

간단히  말하면

전체 200K 실행 없는 MCMC. 

~120 K 반복은 품질과 대기 시간

의 좋은 타협입니다.

TP9 .quickTest

세부  정보

순수 기능 테스트. 이니셜라이저에 대한 재정
의: - maxIterations 30 000 → 1 000 
- densifyUntilIteration 15 000 → 500 - 
densifyGradThreshold 2e-6 → 4e-6 (0.25배 해
상도용으로 보정) - densifyInterval 100 → 50 - 
opacityResetInterval 3 000 → 100 000 (꺼짐, 너무 짧
기 때문에) - trainingRenderScale 1.0 → 0.25

간단히  말하면

Sanity Check “학습이 어쨌든 의

미 있게 시작됩니까?”. M3 Ultra

에서 지속 시간 < 30 s. 보장된 흐

릿함.

메서드: resolveMcmcMaxGaussians

시그니처: public func resolveMcmcMaxGaussians(initialPointCount: Int, 
bufferCapacity: Int) -> Int 정의 위치: TrainingConfig.swift
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기술적  “MCMC가 최대 얼마나 많은 Gaussian으로 성장하도록 허용해야 하는가?”라는 질문에 대
한 유일한 Source-of-Truth. 세 입력에서 계산됩니다: 구성된 T62 mcmcMaxGaussians (0이면 대
량 멸종 Floor 150 000), initialPointCount (SfM 초기화 점의 수), bufferCapacity (사전 할당된 
Gaussian 버퍼 크기). 로직:

1. base = T62 > 0 ? T62 : 150_​000 (대량 멸종 Floor가 1.4.3 대량 멸종 사건 같은 이니셜라이저 
기본값 버그로부터 보호)

2. 만약 T73 mcmcAutoScaleByScene && initialPointCount > 0 && T72 
mcmcCapMultiplier > 0:
• scaled = max(base, ceil(initialPointCount × T72)) 그렇지 않으면

scaled = base
3. 만약 bufferCapacity > 0 : return min(scaled, bufferCapacity)
4. 그렇지 않으면 return scaled

예: Bicycle (Mip-NeRF 360, 194 사진 프레임) → SfM 초기화 ~156 K 점, T62 = 150 000 , 
T72 = 5.32 , 버퍼 용량 8 M. Resolved Cap = min(8M, max(150K, ceil(156K × 5.32))) = 
min(8M, 830K) = 830 K. 이는 MCMC Relocation 로직이 준수하는 효과적인 성장 Cap입니다.

간단히 말하면  MCMC에서 실제 최대 Splat 수를 계산합니다. 설정 (mcmcMaxGaussians) 을 가져오
고, 장면이 초기에 몇 개의 점을 가지고 있는지 살펴보고, 자동 적응이 켜져 있는 경우 Multiplier로 스케일
합니다. 따라서 Cap이 장면에 적응하며, 작은 장면과 거대한 장면에 같은 값을 강제하는 대신. 메서드를 직
접 호출할 필요가 없습니다 — 학습이 내부적으로 사용합니다.
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어느 필드를 무엇을 위해? (치트 시트)

목표 조정할 필드

거리에 더 많은 세부 정
보

T62 mcmcMaxGaussians 높음, T72 mcmcCapMultiplier 5+

일반적으로 더 많은 세
부 정보 (Classic)

T1 maxIterations  높음 (≤ 40K), T2 densifyUntilIteration T1
의 ≤ 14%

드론 비행에서 플로터 
감소

T43 frustumCullEnabled 켜짐, T20 skyMaskingEnabled 켜짐, 
T45 skyDomeEnabled  켜짐

야외 장면에서 멋진 하
늘

T45 skyDomeEnabled  켜짐, T47 skyDomeRadiusMultiplier 30–
60

더 작은 내보내기 파일 전략 .mcmc  (T61), T56 postTrainingCompactification 켜짐, T62 
mcmcMaxGaussians ≤ 200K

더 빠른 학습 T22 trainingRenderScale 0.5, T1 maxIterations  절반 — 그러나 
둘 다는 아님!

더 나은 하이라이트 T21 shDegreeUpgradeIterations를 [2K, 5K, 8K] 로 (Early Front 
Load 없음), MCMC + 200K iter

Mac 반응적 유지 T25 throttleDelayMs 5–10 (~15% 학습 시간 비용)

실시간 미리보기 더 자
주

T59 livePreviewInterval 10–20으로 낮춤

그림자의 더 부드러운 
전환

T17 ssimWeight  약간 높음 (0.15–0.25), 그러나 0.3 이상은 아님

실내 콤팩트하게 유지 P10 Indoor 프리셋 (mcmcMaxGaussians = 670 K, T72 = 1.76 )

위험한 필드

이러한 필드는 잘못된 구성 시 OOM, 앱 충돌, Gaussian의 대량 멸종 또는 사용 불가능한 벤치마크 데이
터로 이어질 수 있습니다. 주의해서 다루십시오:

• T11 densifyGradThreshold — 절반으로 줄이면 2–4배 더 많은 Gaussian이 생성되어 GPU 메
모리를 빠르게 폭발시킵니다. 또한 주의: T22 trainingRenderScale과 일치해야 합니다 (1.0× → 
1e-6, 0.5× → 2e-6, 0.25× → 4e-6).

• T72 mcmcCapMultiplier — > 200 K SfM 초기화 점이 있는 큰 장면과 Multiplier > 5에서 수백
만 Gaussian의 Resolved Cap이 생성됩니다. 36GB RAM Mac에서 OOM 가능. Outdoor 프리셋 
5.32는 Mip-NeRF 360 Bicycle이 156 K init 점을 가지기 때문에만 작동합니다 → 830 K Cap.

• T39 testViewIndices — 수동 설정은 벤치마크를 사용 불가능하게 만들 수 있습니다 (모든 인덱스 > 
N → Holdout 없음). --benchmark  플래그가 이를 설정하도록 두십시오.

• T64 mcmcOpacityRegWeight와 T65 mcmcScaleRegWeight — 1.4.3 베타에서 0.01로 설정되어 
대량 멸종으로 이어졌습니다 (한 반복에서 460 K → 5 Gaussian). 1.4.4부터 0.0으로 고정되었지만 
수동 증가는 문제를 재현할 수 있습니다.
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• T15 opacityResetInterval — 100 000+ (효과적으로 꺼짐) 이 아니고 학습이 10 000 반복 미만
이면 Reset이 수렴을 파괴합니다. .preview 가 maxIterations = 5 000에도 불구하고 100 000
인 이유입니다.

• T54/​T55 densifyPhase2* — Two-Phase Densification은 테스트에서 0 Gaussian 캐스케이드
에서 중단되었습니다. 둘 다 0으로 두십시오.

• T74 useMipSplatting — Q1.5 closed-no-win 2026-05-25, 일부 야외 장면에서는 PSNR을 
악화시킬 수도 있습니다. 기본값 off, 연구용 opt-in.

이 목록에 있는 필드를 변경하려면 먼저 현재 프리셋의 백업 (JSON으로 내보내기) 을 만들고 결과를 재현 
가능하게 측정할 수 있는지 고려하십시오 — 그렇지 않으면 나중에 개선을 가져왔는지 악화시켰는지 알 수 
없습니다.
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장

제 7 장 — 내장 품질 프리셋

그림 27:  네 그룹이 모두 펼쳐진 Presets 섹션 — CAPTURE CLASS (4 프리셋: Drone/Aerial, 
360° Walkaround, 360° Walkaround (High Detail), Photo/Object), CLASSIC (5 프리셋: Quick/

Preview/Balanced/Quality/Ultra Detail), MCMC (3 프리셋, “No threshold tuning” 안내), HYBRID 
(1 프리셋: Balanced (Hybrid))

이미지에 보이는 것  인스펙터의 Presets 섹션, 네 그룹이 모두 펼쳐져 있습니다. CAPTURE CLASS에는 
네 개의 큐레이션된 실제 촬영용 프리셋 (Drone / Aerial, 360° Walkaround, 360° Walkaround 
(High Detail), Photo / Object) 이 있습니다 — 이것이 기본 그룹이며 Simple Mode에서는 유일하
게 보이는 그룹입니다. CLASSIC에는 Quick (1K iters), Preview (5K iters, 파란색 체크 마크와 함
께 활성 선택), Balanced (20K iters), Quality (35K iters), Ultra Detail (35K iters)이 있습니
다. MCMC에는 부제목 “No threshold tuning”이 붙어 있습니다 — MCMC는 Densify-Until 임곗
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값이 필요하지 않습니다: Preview (60K iters, 100K 가우시안), Balanced (120K, 150K), Quality 
(200K, 150K). HYBRID에는 Balanced (Hybrid) (20K iters, 150K 가우시안) 가 있습니다. 푸터 동
작 행: Save…, Export…, Import…

프리셋은 학습을 위한 사전 준비된 구성입니다. RadianceKit은 네 그룹에 걸쳐 열세 개의 내장 프리셋
을 제공합니다: 네 개의 Capture-Class 프리셋 (P9–P12) — 실제 커뮤니티 자료에 대해 육안으로 검
증한, 실제 촬영 방식 (드론, 360° 산책, 사진 객체) 을 위한 큐레이션된 레시피이며 v1.6 이후의 기본 
축 —, 다섯 개의 Classic 프리셋 (P1–P5: Quick/Preview/Balanced/Quality/Ultra Detail), 세 개의 
MCMC 프리셋 (P6–P8), 그리고 Classic과 MCMC 전략을 결합한 한 개의 하이브리드 프리셋 (P13). 
이전의 “Scene-Class” 프리셋 (Render/3D, Outdoor, Indoor, Phase Q7에서 Mip-NeRF 360 및 
NeRF Blender 장면에 대해 학술적으로 튜닝됨) 은 v1.6에서 보이는 그룹으로는 철회되었습니다 — 실제 
자료에 대해 육안으로 검증된 Capture-Class가 이제 기본 축이며, Q7 튜닝된 구성은 내부적으로만 유지
됩니다. 사이드바의 Presets 영역에서 또는 Simple Mode의 가져오기 시 프리셋을 선택합니다. +  버
튼은 자체 프리셋을 옆에 만드는 대화창을 엽니다 — 열세 개의 내장은 삭제할 수 없지만 복제할 수 있습
니다.

Expert View에서는 프리셋이 촬영 방식과 전략별로 (Capture Class / Classic / MCMC / 하이브리
드) 그룹화되어 표시됩니다. 항목 클릭은 저장된 학습 구성을 현재 상태에 작성합니다. 이는 스냅샷이 아닙
니다 — 그 후 슬라이더를 조정하면 상태가 변경되지만 프리셋 자체는 변경되지 않습니다. 그러면 색깔 있는 
힌트가 “modified”를 표시합니다.

어느 프리셋이 언제 적절한지는 주로 장면 유형과 하드웨어에 달려 있습니다. 장 끝의 세 표 형식 개요가 이
를 요약합니다.

P1 — Quick

위치

인스펙터 → Presets 섹션 → “Classic” 그룹 → “Quick” 항
목. UUID 접미사 …001 .

기술적  설명

1 000 반복, 고전적 (적응) Densification 전략, 0.25배 학
습 해상도 스케일링 (입력 이미지가 학습 전에 25%로 축소됨) 
이 있는 진단 프리셋. 장면을 제공하는 것이 아니라 설정 (카메
라 포즈, 점 구름, 이미지 시리즈) 이 Loss 값에서 의미 있는 움
직임을 보여 주는지 빠르게 확인해야 합니다. M3 Ultra에서 일
반적으로 50–200 이미지에서 30초 미만. 작은 해상도는 실제 
이미지 품질을 가리지만 메모리 요구량과 렌더 비용을 매우 낮
게 유지합니다. 시스템에 10 GB RAM 미만이 있는 경우 첫 시
작 시 자동으로 기본값으로 선택됩니다.

간단히  말하면

빠른 기능 테스트. 이미지 입력, 

30초 미만 대기, 장면의 거친 윤

곽이 나타나는지 확인. Viewer에

서 이미지가 흐릿한 얼룩처럼 보

이면 — 맞습니다, 그래야 합니

다. 어두운 점이나 완전히 왜곡

된 형태만 보이면 카메라 포즈가 

잘못된 것입니다 (제 9 장 참고). 

보여줄 수 있는 결과를 위해서는 

최소한 P2나 P3가 필요합니다.

158 / 216



R A D I A N C E K I T 제 7 장 — 내장 품질 프리셋

P2 — Preview (Classic)

위치

인스펙터 → Presets 섹션 → “Classic” 그룹 → “Preview” 
항목. UUID 접미사 …002 .

기술적  설명

5 000 반복 Classic Densification, 0.5배 해상도 스케일
링, 표준 대비 두 배 학습률. Densification (Clone + Split) 
은 처음 2 500 반복에 걸쳐 활성, 그 후 Pruning만. ≥ 10 GB 
RAM 시스템의 기본 프리셋. M3 Ultra에서 일반적으로 200 
이미지 장면에 90초에서 3분. 형상과 카메라 포즈의 사용 가능
한 인상을 제공하지만 텍스처는 눈에 띄게 부드럽게 표현됩니다 
— 학습률이 절반 해상도에 맞게 보정되어 있기 때문에 0.5× 렌
더 해상도는 P3 또는 P4로 재학습하여 직접 우회할 수 없습니
다.

간단히  말하면

“잠깐 보기”의 표준입니다. 방금 

새 이미지를 가져왔고 장면이 재

구성 가능한지 보고 싶다면 적절

한 단계입니다. 약 2–3분 대기 시

간, 그 다음 3D Viewer에서 회전

하고 추가 학습 실행 구매가 의

미가 있는지 평가할 수 있습니

다. 미리보기 결과가 이미 좋아 

보일 때만 Balanced 또는 Quality

가 가치가 있습니다.

P3 — Balanced (Classic)

위치

인스펙터 → Presets 섹션 → “Classic” 그룹 → 
“Balanced” 항목. UUID 접미사 …005 .

기술적  설명

전체 이미지 해상도에서 20 000 반복 Classic 
Densification. Densification은 처음 15 000 반복에 걸
쳐 실행되며, Iter 3 000부터 100의 Densify 간격으로. 경
험적으로 문서화된 학습 세션의 “스위트 스폿”: Horse Full과 
Truck의 고전적 Densification에서 L1 Loss가 Iter 18 000
과 22 000 사이에서 안정화되며, 더 긴 학습은 Quality (P4) 
미만에서 더 이상 유의미한 개선을 가져오지 않습니다. M3 
Ultra에서 일반적으로 200 이미지에서 30–60초, 1 000+ 이
미지에서 5–8분.

간단히  말하면

“좋은 타협”. 대부분의 장면은 한 

시간을 기다리지 않아도 이미 잘 

보입니다. 결과를 어딘가에서 보

여 주려면 (소셜 미디어, 웹사이

트, 고객 데모) 종종 충분합니다. 

Splat 모델로 줌인하거나 표면 

텍스처의 세부 정보가 필요한 경

우에만 P4 Quality 또는 P7 MCMC

로의 점프가 가치가 있습니다.
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P4 — Quality (Classic)

위치

인스펙터 → Presets 섹션 → “Classic” 그룹 → “Quality” 
항목. UUID 접미사 …003 .

기술적  설명

V546 “Opacity Decay” (HTGS, Eurographics 2025) 
가 있는 35 000 반복 Classic Densification: 각 Densify 
Cycle 후 모든 기존 Gaussian의 Opacity가 < 1.0 인수로 곱
해집니다. 이는 비활성화된 Gaussian을 Pruning에서 안정적
으로 제거하고 따라서 동일한 Iter 수에서 고전적 35 000 실
행보다 14% 더 나은 L1 Loss를 달성합니다. SSIM Loss
가 활성화됨 ( ssimWeight=0.05 ). M3 Ultra에서 일반적으
로 200 이미지에서 2–4분. NeRF Blender (Lego, Chair, 
Drums) 에서 최종 L1 ≈ 0.023 제공 — 560+ 문서화된 실험
에서 최고의 Classic 변형. 참고: ~3–5 GB GPU 메모리 필
요. 8 GB 시스템에서는 P3가 안전한 선택입니다.

간단히  말하면

최고의 고전적 변형. 특히 객

체 촬영 (조각상, 의자, 꽃병) 에

서 선명한 텍스처와 미세한 형

상을 제공합니다. 큰 야외 장면

이나 방에서는 Balanced와 차이

를 거의 알아채지 못합니다 — 

거기서는 MCMC 프리셋 (P6–P8) 

이나 Capture-Class 프리셋 (P9–

P12) 으로 전환이 P3에서 P4로의 

점프보다 더 가치가 있습니다. 

Classic 계열의 절대적인 최대치

를 원한다면 P5 Ultra Detail을 선

택하십시오.

P5 — Ultra Detail (Classic)

위치

인스펙터 → Presets 섹션 → “Classic” 그룹 → “Ultra 
Detail” 항목. UUID 접미사 …008 .

기술적  설명

약 35 000 반복 Classic Densification — Quality 매
트릭스의 Held-out 실행 (2026-06-10) 우승자. 테스트된 
세 Mip-NeRF 360 장면 모두에서 Ultra Detail은 비슷한 
Wall-Clock 시간에 내장 MCMC “Quality” 프리셋 (P8) 을 
약 +0.94 dB PSNR 차이로 능가합니다. 따라서 Classic 그
룹에서 가장 강력한 Quality 프리셋이자 RadianceKit이 제공
하는 가장 선명한 Classic 변형입니다. M3 Ultra에서 일반적
으로 P4 Quality와 같은 시간 범위 (200 이미지에서 2–5분) 
이지만 GPU 메모리가 약간 더 필요합니다. 8 GB 시스템에서
는 P3가 안전한 선택으로 남습니다.

간단히  말하면

가장 선명한 Classic 단계이자 

우리 품질 테스트의 Held-out 

우승자: 실제 장면에서 MCMC 

“Quality” 변형보다 약 1 데시

벨 더 좋습니다 — 비슷한 대

기 시간으로. 검증된 고전적 

Densification으로 최대 디테일

을 원하고 GPU 메모리가 충분

하다면 첫 선택입니다. 메모리

가 부족하거나 가능한 한 작은 

내보내기 파일이 필요하다면 P4 

Quality나 MCMC 프리셋에 머무

십시오.
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P6 — Preview (MCMC)

위치

인스펙터 → Presets 섹션 → “MCMC” 그룹 → “Preview” 
항목. UUID 접미사 …006 .

기술적  설명

100 000 Gaussian Cap에서 60 000 반복 MCMC 
Densification (3DGS-MCMC, NeurIPS 2024). MCMC
는 휴리스틱 Clone/Split 로직을 Markov Chain Monte 
Carlo Relocation으로 대체합니다: 죽은 Gaussian이 
Sigmoid 가중 샘플링 깊이를 통해 새로 배치되어 제어되고 
재현 가능한 Gaussian 수를 산출합니다. Cap은 최대 수를 
100K에서 하드 제한합니다 — 이는 메모리와 렌더 시간을 절
약하지만 세부 정보가 듭니다. M3 Ultra에서 일반적으로 200 
이미지에서 5–8분. “MCMC 기능 테스트”로 적합 — P7 또는 
P8에 더 많은 시간을 투자하기 전에 Classic에서 MCMC로 
전환이 의미가 있는지 평가하는 데 도움이 됩니다.

간단히  말하면

P2 Preview와 비슷하지만 새 

MCMC 절차로. 종종 Classic 변형

보다 더 콤팩트하고 균일하게 분

산된 Splat 클라우드를 제공합니

다. 장면의 첫 평가에는 5–8분

이면 보통 충분합니다. 미리보기 

결과가 마음에 들면 다음 단계

는 P7 (Balanced) 또는 P8 (Quality 

MCMC) 로 직접.

P7 — Balanced (MCMC)

위치

인스펙터 → Presets 섹션 → “MCMC” 그룹 → 
“Balanced” 항목. UUID 접미사 …007 .

기술적  설명

150 000 Gaussian Cap에서 120 000 반복 MCMC. 중간 
MCMC 단계 — P8 Quality의 거의 최종 Gaussian 수이지
만 반복은 60%만. 경험적으로 L1 Loss는 문서화된 학습 세션
에서 Horse Full에서 0.026–0.028, P8의 0.0246에 비해 
— 즉 약 7% 더 높지만 대기 시간은 절반. M3 Ultra에서 일반
적으로 200 이미지에서 8–15분. 입력 SfM 점 구름의 점 밀도
에 효과적인 Gaussian Cap을 스케일링하는 절차를 사용합니
다 (제 6 장 T75 참고).

간단히  말하면

적절한 세부 정보 깊이가 있는 

MCMC, 그러나 P8의 긴 풀 실행 

없이. 대부분의 장면에 충분합니

다. 특히 점심 시간 시간 프레임

에 MCMC 실행을 압축하려는 경

우. 메모리가 부족한 경우 (예: 16 

GB만 있는 M 프로세서) 여기에 

머무십시오 — P8은 더 많은 GPU 

메모리가 필요합니다.
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P8 — Quality (MCMC)

위치

인스펙터 → Presets 섹션 → “MCMC” 그룹 → “Quality” 
항목. UUID 접미사 …004 .

기술적  설명

150 000 Gaussian Cap에서 200 000 반복 MCMC, 
SSIM Loss 0.05, 반복의 80% 이상에 걸친 MCMC Noise 
Decay. 560+ 실험에서 Best Single Run L1: Horse Full
에서 0.0238, 3 trial 평균 0.0246 (같은 장면의 P4 0.0230 
대비). MCMC는 71% 적은 Gaussian (150K vs ~524K) 
을 제공합니다 — 더 작은 클라우드가 상당히 작은 내보내기 파
일을 생성하므로 결과를 웹에 제공하려는 경우 결정적입니다. 
M3 Ultra에서 학습 시간은 일반적으로 200 이미지에서 20–
35분. 1 000+ 이미지 세트에서는 1–2 시간. 최소 종료 크기에
서 최대 이미지 품질이 원하는 경우 최선의 선택.

간단히  말하면

최고의 MCMC 변형. 매우 깨끗

하고 콤팩트한 Splat 클라우드를 

제공합니다 — 결과를 나중에 웹 

3D Viewer로 임베드하거나 파일

로 보내려는 경우 이상적입니다 

(파일은 비슷한 광학 품질에서 

P4 Quality보다 더 작음). 그러나 

인내가 필요합니다 — 큰 촬영에

서는 한 시간 이상 대기 시간. 차

라리 “야간 실행”으로 계획하십

시오.
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그림 28:  네 개의 큐레이션된 실제 촬영용 프리셋이 모두 펼쳐진 CAPTURE CLASS 그룹 — Drone / Aerial 
(MCMC, 40K iters, Cap 1.5 M), 360° Walkaround (MCMC, 40K, Cap 1.5 M), 360° Walkaround 
(High Detail) (Hybrid, 40K, Cap 1.5 M, opt-in) 및 Photo / Object (Hybrid, 40K, Cap 1.5 M). 이 

그룹은 맨 위에 있으며 Simple Mode에서는 유일하게 보이는 그룹입니다.

이미지에 보이는 것  CAPTURE CLASS 그룹이 펼쳐진 인스펙터 — v1.6 이후의 기본 프리셋 그룹이며 
Simple Mode에서는 유일하게 표시되는 그룹입니다. 각 항목은 실제 커뮤니티 자료에 대해 육안으로 검
증한, 구체적인 촬영 방식 (드론, 360° 산책, 사진 객체) 을 위한 레시피이며, 학술적 테스트 세트에 대해 
최적화된 값이 아닙니다. 클릭으로 선택하면 저장된 학습 구성이 현재 상태에 작성됩니다.
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P9 — Drone / Aerial

위치

인스펙터 → Presets 섹션 → “Capture Class” 그룹 → 
“Drone / Aerial” 항목. UUID 접미사 …010 .

기술적  설명

건물과 풍경의 항공 및 드론 궤도용 Capture-Class 프리셋. 
MCMC Densifier, 40 000 반복, Cap 150만 Gaussian, 
SSIM Loss 0.5 더하기 Edge-Aware 항 0.1. 결정적인 것은 
비율 임곗값 6에서 가중치 0.003의 이방성 페널티입니다 — 드
론 자료가 생성하는 전형적인 바늘 모양 아티팩트에 맞서는 “스
파게티 킬러”입니다. Pensford 고가교 위를 비행한 실제 DJI 
4K 드론 비행으로 검증됨 (메트릭뿐 아니라 육안으로 점검).

간단히  말하면

공중에서의 촬영용 — 건물 주위 

드론 비행, 풍경 위, 외벽을 따

라. 강력한 이방성 페널티가 드

론 자료가 즐겨 생성하는 바늘 

내지 스파게티 모양 아티팩트를 

치웁니다. 자료가 지면에서 촬영

된 경우 Photo / Object나 Classic 

프리셋이 더 적절합니다.

P10 — 360° Walkaround

위치

인스펙터 → Presets 섹션 → “Capture Class” 그룹 → 
“360° Walkaround” 항목. UUID 접미사 …011 .

기술적  설명

360° 산책 영상용 Capture-Class 프리셋. MCMC 
Densifier, 40 000 반복, Cap 150만 Gaussian, SSIM 
Loss 0.5 더하기 Edge-Aware 항 0.1, 부드러운 이방성 페
널티 (비율 임곗값 15에서 가중치 0.001). 인물 및 하늘 마스
크가 활성. 이 프리셋은 360° Equirect 영상을 기대하며, 학
습이 시작되기 전에 내부적으로 약 90° 폭의 원근 Crop으로 
다시 투영됩니다. 셀카봉을 이용한 8K 360° 산책으로 검증됨 
(Monument 장면, 육안으로 점검).

간단히  말하면

360° 산책 영상용 — 360° 카

메라나 셀카봉을 들고 방을 통

과하거나 객체 주위를 돕니다. 

RadianceKit이 구형 파노라마를 

직접 일반 시야각으로 분해하고 

행인과 하늘을 마스킹합니다. 같

은 자료에서 최대 선명도를 원하

면 High Detail 변형 (P11) 도 추가

로 시도해 보십시오.
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P11 — 360° Walkaround (High Detail)

위치

인스펙터 → Presets 섹션 → “Capture Class” 그룹 → 
“360° Walkaround (High Detail)” 항목. UUID 접미사 
…013  (Opt-in).

기술적  설명

최대 디테일을 위한 360° 산책 영상용 Opt-in Capture-
Class 프리셋. 하이브리드 Densifier (고전적 Abs-
Gradient Clone/Split + MCMC Noise
1. Relocation), 40 000 반복, Cap 150만 Gaussian, 비
율 임곗값 15에서

이방성 페널티 0.0015, SSIM Loss 0.2, Edge-Aware 항 
0 — 잠긴 “r50” Screen-Split 레시피. 360° 자료에서 표
준 MCMC 프리셋 “360° Walkaround” (P10) 을 PSNR, 
LPIPS, 가시적 컨페티에서 능가하며, 그것도 약 3분의 1의 
Splat 수로. 더 많은 장면에서 검증될 때까지 의도적으로 표준 
360 프리셋 옆에 opt-in으로 놓여 있습니다.

간단히  말하면

표준 360 프리셋 (P10) 의 더 선

명한 대안: 더 많은 디테일, 더 적

은 컨페티, 훨씬 작은 파일. 대체

하지 않고 의도적으로 옆에 놓여 

있습니다 — 지금까지 손에 꼽을 

정도의 장면에서 확인됨. 360° 

산책이 깔끔하게 촬영되었다면 

이 프리셋을 먼저 시도하고 결과

를 P10과 비교하십시오.

P12 — Photo / Object

위치

인스펙터 → Presets 섹션 → “Capture Class” 그룹 → 
“Photo / Object” 항목. UUID 접미사 …012 .

기술적  설명

선명한 개별 사진 (영상 아님) 의 객체 궤도용 Capture-
Class 프리셋. 하이브리드-t1 Densifier (Relocation 포함), 
40 000 반복, Cap 150만 Gaussian, SSIM Loss 0.5 더
하기 Edge-Aware 항 0.1, 부드러운 이방성 페널티 (비율 임
곗값 15에서 가중치 0.001), 50 반복마다 Opacity Decay 
0.9995, 마스킹 없음. 해골의 163장 고해상도 41 MP 사진으
로 검증됨 (육안으로 점검). 적은 뷰 (약 600까지) 는 하이브리
드 Collapse 임곗값 아래에 머뭅니다.

간단히  말하면

선명한 개별 사진의 객체 촬영용 

— 조각상, 모델, 제품을 카메라

로 돌면서 영상 대신 사진을 찍

습니다. 선명한 사진은 대개 깨

끗한 배경을 가지므로 마스킹 없

음. 영상 소스에는 대신 360° 또

는 Drone 프리셋을 사용하십시

오.
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P13 — 균형 (하이브리드)

위치

인스펙터 → Presets 섹션 → “하이브리드” 그룹 → “균형 (하
이브리드)” 항목. UUID 접미사 …009 .

기술적  설명

하이브리드 Densification 전략의 20 000 반복: 고전적 그
래디언트 기반 Clone/Split이 Loss가 필요로 하는 곳에 용
량을 배치하고, MCMC SGLD 노이즈가 계속 탐색하며, 죽
은 Gaussian은 Pruning으로 손실되는 대신 재배치됩니다. 
Opacity Decay (V546) 가 Opacity 리셋을 대체합니다; 이
방성 페널티 (가중치 0.001, 비율 임곗값 15) 가 바늘 모양 
Splat을 억제합니다. Gaussian Cap은 장면에 따라 스케일됩
니다 (150K 기본, scene-aware ×3.0). 같은 예산의 순수 
MCMC에 대해 5개 장면에서 검증됨: 평균 +0.45 dB PSNR, 
20–30 % 적은 Gaussian (stonehenge +1.23, family 
+0.82, garden +0.47 dB). M3 Ultra에서 일반적으로 200 
이미지에서 5–10분.

간단히  말하면

최종 결과를 위한 강력한 첫 선

택: MCMC 프리셋과 비슷하게 콤

팩트한 파일에서 더 선명한 세

부 정보를, P8 학습 시간의 일

부만으로 제공합니다. 품질 실

행 하나에만 시간이 있고 어느 

Capture 클래스도 명확히 맞지 

않는다면 여기서 시작하십시오. 

빠른 테스트에는 여전히 Classic 

프리셋이 더 좋고, 장면이 해당 

촬영 방식 중 하나와 명확히 일

치하는 경우 Capture-Class 프리

셋 (P9–P12) 이 첫 선택입니다.

언제 어느 프리셋?

시나리오 첫 테스트 본 실행

새 이미지 기능 테스트, < 30초 P1 Quick —

선명한 개별 사진의 객체 궤도 P2 Preview P12 Photo / Object

단일 객체 스캔 (영상), < 500 
사진

P2 Preview P4 Quality 또는 P8 Quality 
MCMC

360° 산책 영상 P6 Preview MCMC P10 360° Walkaround (선명: 
P11 High Detail)

항공/드론 궤도, 풍경 P6 Preview MCMC P9 Drone / Aerial

웹 배포 (작고 콤팩트) P2 P8 Quality MCMC (전체 품질
에서 가장 작은 파일)

짧은 시간에 선명한 세부 정보, 
콤팩트한 내보내기

P2 또는 P6 P13 균형 (하이브리드)

최대 디테일, Classic 전략 P3 또는 P6 P5 Ultra Detail

인쇄, 마케팅, 전체 세부 정보 P3 또는 P6 P4 Quality (Classic) 또는 P5 
Ultra Detail
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빠른 비교

프리

셋

전략 Iters Max-
Gs

렌더 스케일 일반적인 시간 (200 이미지, M3 
Ultra)

Q Sweep

P1 Quick Classic 1 000 ∞ 0.25× ~30 s —

P2 Preview Classic 5 000 ∞ 0.5× 2–3 min —

P3 BalancedClassic20 000 ∞ 1.0× 30–60 s —

P4 Quality Classic35 000 ∞ 1.0× 2–4 min V546 
HTGS

P5 Ultra 
Detail

Classic ~35 
000

∞ 1.0× 2–5 min Matrix 
Δ+0.94 

dB

P6 Preview 
MCMC

MCMC60 000 100 
K

1.0× 5–8 min —

P7 Balanced 
MCMC

MCMC 120 
000

150 
K

1.0× 8–15 min —

P8 Quality 
MCMC

MCMC 200 
000

150 
K

1.0× 20–35 min V544a

P9 Drone / 
Aerial

MCMC40 000 1.5 
M

1.0× 10–25 min 육안 / Viadukt

P10 360° 
Walkaround

MCMC40 000 1.5 
M

1.0× 10–25 min 육안 / Monument

P11 360° 
Walkaround 

(High 
Detail)

하이브리

드

40 000 1.5 
M

1.0× 10–25 min 육안 
(opt-
in)

P12 Photo / 
Object

하이브리

드

40 000 1.5 
M

1.0× 10–25 min 육안 / 
해골

P13 
균형 
(하
이브

리

드)

하이브리

드

20 000 150 
K

1.0× 5–10 min Matrix 
Δ+0.45 

dB

자체 프리셋

Presets 섹션의 Save… 버튼 (제 2 장 I1) 을 통해 현재 학습 구성을 자체 프리셋으로 저장합니다. 자체 
프리셋은 “Built-in”이 아니며 이름을 바꾸고, 내보내고 (JSON으로), 드래그 앤 드롭으로 공유하고, 복제
하고, 삭제할 수 있습니다. 열세 개의 내장 프리셋 P1–P13은 삭제 버튼의 영향을 받지 않습니다.
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경험 법칙: 더 자주 필요할 프리셋의 무언가를 변경하는 경우 — Sky-Dome 켜짐, 특정 장면 클래스를 위
한 더 높은 SSIM 가중치, 다른 Iter 수 — 변형을 자체 프리셋으로 저장하십시오. 그러면 다음 실행에서 표
준과 다른 구성임을 즉시 알 수 있습니다.
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장

제 8 장 — 내보내기 형식

그림 29:  Simple Mode의 내보내기 형식 선택 — 6개의 형식 카드

그림 30:  flowers-Bouquet에서 5K-Iter 학습 후 실시간 내보내기 형식 그리드 — 동적 크기 계산이 있는 모
든 6개 카드 (PLY 742 KB 선택, SPZ 74 KB, glTF 708 KB, .splat 96 KB, Orbit Video ~Zero KB, 

Web Viewer 133 KB), 오른쪽에 이미 저장된 PLY가 있는 Export History

이미지에 보이는 것 (IP-clean 테스트 세트로 Bjoern의 합성 Blender Bouquet의 2 991 
Gaussian, SH degree 3): 각 형식 카드 아래의 크기 정보는 현재 Gaussian Count와 형식 오버헤
드에서 실시간으로 계산됩니다 — 하드코딩되지 않습니다. 2 991 Gaussian (SH degree 3) 에서 742 
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KB PLY, 74 KB SPZ (양자화를 통해 ~10× 작음), 708 KB glTF (KHR_​gaussian_​splatting 확장
과 함께 거의 PLY 동등), 96 KB .splat (압축된 Gaussian당 24 바이트 형식) 가 생성됩니다. Orbit 
Video는 “~Zero KB”를 표시합니다. 크기는 MP4 인코딩 후에야 알려지기 때문입니다. Web Viewer 
(133 KB) 는 내장된 WebGL Viewer와 압축된 Splat 데이터가 있는 독립형 HTML 파일을 묶습니
다 — Viewer 오버헤드 때문에 순수 .splat보다 큽니다. 오른쪽 Export History는 형식 핀과 Reveal 
in Finder 동작이 있는 이미 완료된 PLY 내보내기 (“training_20260527T211321Z.ply, 743 KB, 
23:13”) 를 나열합니다.

완료된 학습은 Gaussian Cloud를 제공합니다 — 함께 장면을 재구성하는 수십만에서 수백만의 3D 
Gaussian 분포의 모음. RadianceKit은 이 클라우드를 디스크에 쓰는 10가지 방법을 알고 있습니다. 그 
중 6개는 순수 3D 데이터 형식 (PLY, Compressed PLY, SPZ, SOG, glTF, .splat) 이고, 1개는 클
라우드를 완성된 HTML Viewer와 함께 묶고 (Web Viewer), 1개는 Orbit 카메라 이동에서 MP4 파
일을 렌더링하고 (Orbit Video), 2개는 Gaussian 콘텐츠를 내보내지 않고 단지 다른 학습 파이프라인
에서 재사용할 SfM 결과 (카메라 포즈와 거친 점 구름) 만 내보냅니다 (transforms.json + COLMAP 
Workspace).

어느 형식이 언제 적절한지는 목표에 따라 다릅니다. 품질 손실 없이 전체 데이터를 보관하려면 PLY를 사용
합니다. 자체 사이트의 Web Viewer에는 보통 .splat이나 내장 Web Viewer로 충분합니다. 파일이 최소
여야 한다면 SPZ나 SOG가 가치가 있습니다. Nerfstudio, Postshot 또는 Brush에서 SfM 결과를 재
사용하려면 transforms.json과 COLMAP Workspace가 올바른 경로입니다.

모든 내보내기 기능은 “Export” 메뉴와 Simple Mode의 마지막 마법사 단계에 있습니다. 대부분의 형식
은 완전히 Sandbox 호환이며 App Store 버전에서 작동합니다. SOG만이 외부 바이너리 ( cwebp ) 가 
필요하며 App Store 빌드에 반드시 존재하지는 않습니다 — 자세한 내용은 E4 참고.
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E1 — PLY (.ply)

위치

메뉴 바 → Export → 3D Formats → Export PLY… (⌘E). 
Simple Mode: 마법사 단계 Export → 형식 카드 “PLY”. 
크기: 일반적으로 100% (참조 값). 호환: SuperSplat, 
PolyCam, 모든 3DGS Viewer.

기술적  설명

PLY는 3D Gaussian Splatting의 표준 저장 형식입니다. 
RadianceKit은 표준화된 3DGS 속성 레이아웃이 있는 바이
너리 Little-Endian 파일을 작성합니다: Gaussian당 3 성분 
위치, 항상 0으로 설정된 3 노멀, 기본 RGB 색상용 3 DC 
SH 계수 ( f_dc_0..2 ), 그 후 Kerbl 2023 논문에 정의
된 transposed Channel-Major 배열 (먼저 모든 R 채널 계
수, 그 다음 모든 G, 그 다음 모든 B) 의 최대 45개 추가 SH 
계수 ( f_rest_0..44 ), 그 다음 Logit Opacity (원본 사
전 Sigmoid 값), 3개의 Log Space 스케일, 하나의 wxyz 
쿼터니언 회전. 최대 내보낸 SH 정도는 사용자 희망과 실제로 
학습된 정도의 최솟값으로 클램프됩니다. 기본값은 3 (45개의 
Rest 계수). 쓰기 전에 Payload 크기가 64비트 정수로 계산
되어 극도로 큰 Cloud에서 오버플로를 잡습니다. 파일은 원자
적으로 작성되며, 큰 Cloud에서는 잠시 두 배의 디스크 공간을 
점유합니다.

간단히  말하면

“원본 파일”입니다. 가장 큰 파

일, 가장 높은 호환성, 손실 없음. 

어느 형식을 선택해야 할지 모르

겠다면 PLY를 사용하십시오 — 

거의 모든 3DGS 도구에서 열립

니다. 100만 Gaussian의 경우 SH 

정도에 따라 200에서 800 MB. 파

일이 너무 커지면 E2 (압축 PLY) 

나 E3 (SPZ) 를 살펴보십시오.
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E2 — Compressed PLY (.ply)

위치

메뉴 바 → Export → 3D Formats → Export 
Compressed PLY…. Simple Mode: 형식 카드 
“Compressed PLY”. 크기: PLY 대비 약 10–20% (5 10
배 압축). 호환: SuperSplat, PlayCanvas Engine, 웹 기반 
Viewer.

기술적  설명

Chunked 양자화가 있는 PLY 형식의 PlayCanvas 변형. 
Gaussian이 256개 청크로 그룹화됩니다. 청크당 Position, 
Scale, Color의 Min/Max Bound가 헤더에 별도로 저장
됩니다. 개별 Gaussian은 이러한 Bound에 대해 상대적으
로 값을 참조하고 각각 32비트로 압축됩니다: Position과 
Scale은 11-10-11 비트 패킹으로, Rotation은 2-10-10-10 
비트 “Smallest-Three” 쿼터니언으로, Color는 8-8-8-8 
RGBA로. 더 높은 SH 계수는 구성 요소당 8비트로만 양자화됩
니다 (Gaussian당 shCoeffCount * 3  uchar). 형식 자
체는 여전히 ASCII Header PLY이며 따라서 기본적으로 PLY 
도구로 검증 가능하지만 Vertex Properties는 uint  필드로 
선언됩니다. 압축을 최대화하기 위해 SH 정도는 기본적으로 0
입니다 (Rest 계수 없음) — 더 높은 SH 정도는 명시적으로 선
택할 수 있습니다.

간단히  말하면

공간 절약 PLY 변형. 일반 PLY와 

동일한 엔진 호환성이지만 5 10

배 더 작습니다. SuperSplat과 

PlayCanvas가 네이티브로 읽습

니다. 웹 배포에는 거의 항상 일

반 PLY보다 더 좋습니다. 양자화

로 인한 품질 손실은 장면이 극

도로 고주파 세부 정보를 포함하

지 않는 한 시각적으로 거의 인

식되지 않습니다.
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E3 — SPZ (.spz)

위치

메뉴 바 → Export → 3D Formats → Export SPZ…. 
Simple Mode: 형식 카드 “SPZ”. 크기: PLY 대비 약 
10% (90% 더 작음). 호환: Niantic Scaniverse, Niantic 
Spatial Fields, MetalSplatter.

기술적  설명

Niantic의 SPZ v2 형식. 위치는 24비트 Fixed Point로 패
킹됩니다 (약 0.25 mm 해상도 산출). 스케일은 Log 공간에
서 8비트 양자화로, 회전은 8비트 Smallest-Three (v2에서
는 xyz만 저장되고 w는 디코더에서 쿼터니언 Norm에서 파
생) 로, Opacity는 Sigmoid 처리된 8비트 값으로. DC SH는 
SPZ 특정 Pack 공식 (dc_​raw * 0.15 * 255 + 0.5 * 
255) 으로 저장되고, 더 높은 SH 밴드는 계수당 5비트 (Band 
1) 또는 4비트 (Band 2-3) 로. 전체 패킹된 바이너리 Blob
은 그 다음 표준 gzip (RFC 1952) 으로 압축되어 Magic 
Bytes 1f 8b 가 있는 gzipped 컨테이너 형식을 산출합니
다. RadianceKit은 이를 위해 시스템 gzip 을 호출합니다. 
Apple의 내장 zlib API가 Spatial Fields나 MetalSplatter
의 SPZ 리더와 호환되지 않는 독점 Apple Framing을 생성하
기 때문입니다. 시스템 gzip 은 macOS Sandbox 내에서도 
Spawn 가능한 채로 유지됩니다.

간단히  말하면

가장 작은 표준 파일. Niantic의 

Scaniverse를 안다면 — 이것이 

그 앱이 사용하는 형식입니다. 

매우 작고, 모바일 앱에 매우 로

드 친화적. Niantic의 자체 Cloud 

Viewer (Spatial Fields) 에서 직접 

사용 가능합니다. 동일한 데이터

의 PLY보다 약 90% 더 작고, 대부

분의 장면에서 광학적으로 거의 

구별할 수 없습니다.
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E4 — SOG (.sog)

위치

메뉴 바 → Export → 3D Formats → Export SOG…. 
Simple Mode: 형식 카드 “SOG”. 크기: PLY 대비 약 5 6% 
(15 20배 압축 — 가장 작은 옵션). 호환: PlayCanvas 
Engine, SuperSplat Editor.

기술적  설명

“Spatially Ordered Gaussians” — 여러 무손실 WebP 이
미지에 Cloud를 GPU 준비 상태로 저장하는 PlayCanvas 형
식. 먼저 모든 Gaussian이 3D Morton Code (30비트 Z 
Order, 축당 10비트) 로 공간적으로 정렬되어 이미지가 렌
더러에서 나중에 Cache Locality를 가지게 합니다. 그 다음 
Position이 대칭 Log 변환 (더 나은 동적 범위를 위해) 으
로 16비트 값으로 양자화되어 두 RGBA 이미지로 분할됩니다 
( means_l.webp 는 하위 8비트, means_u.webp 는 상위). 
Rotation은 RGBA 이미지의 2비트 Mode
1. 3×8비트의 Smallest-Three로 인코딩됩니다 (Mode는 

252 + largest 로

Alpha에 들어감). Scale과 DC SH는 각각 256 항목 코드북
으로 양자화됩니다 (모든 값에 대해 백분위 기반 분포). 인덱스
는 scales.webp 와 sh0.webp 에 저장됩니다. 다섯 이미지
와 Codebook 및 Bound가 있는 meta.json 은 ZIP 파일
로 패키징되고 (사용자 정의 인코더, Sandbox가 시스템 zip
을 차단하기 때문) .sog  확장자로 저장됩니다.

Sandbox 주의: SOG는 외부 바이너리가 필요한 유일한 형식 
옵션입니다. WebP 인코더 단계는 /​usr/​local/​bin/​cwebp 
또는 /​opt/​homebrew/​bin/​cwebp에서 cwebp 를 호출합니
다. cwebp 바이너리가 발견되지 않으면 코드는 원시 PNG 인
코딩으로 대체됩니다 — 그러나: PNG 대체는 SuperSplat에
서 작동하지 않습니다. App Store 버전에서는 빌드 변형에 따
라 가용성을 평가하십시오. Developer 변형에서는 cwebp가 
Homebrew ( brew install webp ) 를 통해 설치되어 있
어야 합니다.

간단히  말하면

가장 작은 3DGS 형식이며 SPZ

보다 상당히 작습니다. 그러나: 

RadianceKit이 모든 이미지 형식

을 생성할 수 없기 때문에 Mac

에 cwebp  도구가 필요합니다. 

Homebrew로 한 번 설치하면 모

든 것이 작동합니다. App Store 

버전에서는 완전히 작동하지 않

을 수 있습니다 — 내보내기에서 

WebP 대신 PNG가 나오면 파일을 

SuperSplat에서 직접 열 수 없습

니다. Homebrew 없이 작업하는 

사람은 대신 SPZ (E3) 를 사용합

니다.
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E5 — glTF (.glb)

위치

메뉴 바 → Export → 3D Formats → Export glTF…. 
Simple Mode: 형식 카드 “glTF”. 크기: PLY와 비슷. 호환: 
KHR_​gaussian_​splatting 확장 (Khronos Draft 표준) 이 
있는 glTF Viewer.

기술적  설명

KHR_​gaussian_​splatting 확장 사양에 따라 자체 포함된 
.glb  바이너리 파일 (별도 Bin 파일 첨부 없음) 을 작성
합니다. Position은 일반 glTF POSITION  Vertex 데이터 
(float3) 로 저장되고, 다른 모든 속성 (Rotation은 float4, 
Scale은 float3, Opacity는 float, SH 계수는 float3 × 
shCoeffCount) 은 추가 Vertex 속성에 있고 확장을 통
해 참조됩니다. 중요: glTF는 오른손 Y up 좌표계를 사용하
고, COLMAP/3DGS는 Y down/Z forward로 작업합니다. 
따라서 내보내기는 X축 주위로 180도 회전을 적용합니다 — 
Position은 (x, -y, -z) 로 다시 작성되고, Quaternion
은 (w, x, -y, -z) 로 조정됩니다. 이는 glTF Viewer에서 
기하학적으로 올바르고 핸드 (거울이 아닌) 표현을 산출합니다. 
GLB 표준이 요구하는 대로 JSON과 바이너리 청크는 4바이트 
정렬로 패드됩니다.

간단히  말하면

3D 데이터용 공식 Khronos 표준 

형식, Gaussian Splat을 위한 새

로운 확장과 함께. 장점: glTF는 

모든 주요 3D 엔진 (Babylon.js, 

Three.js, Unity, Unreal) 에 널

리 퍼져 있습니다. 단점: 확장은 

2026년에도 여전히 Draft 단계이

며 많은 Viewer가 아직 읽을 수 

없습니다. 특히 Splat 데이터를 

기존 glTF 파이프라인에 통합하

거나 이미 glTF 가능한 Viewer를 

작성하는 경우 의미가 있습니다.
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E6 — Splat (.splat)

위치

메뉴 바 → Export → 3D Formats → Export .splat…. 
Simple Mode: 형식 카드 “.splat”. 크기: Gaussian
당 정확히 32 바이트. 호환: gsplat.js, 웹 기반 Viewer 
(antimatter15 참조), 대부분의 브라우저 3DGS 데모.

기술적  설명

antimatter15 .splat  형식 — Gaussian당 32 바이트, 
헤더 없음, 간접 참조 없음. 항목당 레이아웃: 3 × float32 
Position (세계 좌표), 3 × float32 Scale (내부 버퍼
의 Log Space에서 exp 변환), 4 × uint8 RGBA 색상 
( SH_C0 = 0.282... 로 스케일된 DC SH 계수, [0,255] 
에 클램프), 4 × uint8 쿼터니언 (w,x,y,z, 정규화되고 바이

트 범위에 
128

+ 128*q 로 인코딩). DC SH만 저장 — 더 높은 
SH 밴드는 폐기됩니다. 이는 형식을 극도로 콤팩트하게 만들지
만 반사나 Specular Highlight에서 발생하는 View 의존 색
상 변경 비용이 듭니다. 쓰기 순서는 정확히 Cloud의 인덱스 순
서입니다 (공간 정렬 없음), gsplat.js  같은 웹 Viewer가 
이를 기반으로 렌더링합니다.

간단히  말하면

gsplat.js 로 자체 웹 Viewer

에서 Splat을 표시하려는 경

우 선택의 형식. 매우 콤팩트 

(Gaussian당 32 바이트) 이지만 

더 높은 SH 정도가 없음 — 따라

서 시점에 따른 반짝이는 반사나 

미세한 색상 변경이 없습니다. 

대부분의 웹 응용 프로그램에 문

제 없음. DC 색상이 완전히 충분

하고 누락된 View 의존성이 거의 

눈에 띄지 않기 때문입니다.

그림 31:  Firefox에서 열린 Web Viewer — 주변 카메라 마커 구체와 함께 렌더링된 Bjoern의 Bouquet 
Splat, 위에 보이는 브라우저 탭 바, CDN/서버 설정 필요 없음. Finder에서 더블 클릭으로 기본 브라우저에서 
직접 연 독립형 flowers-01.html  — 내장된 WebGL2 프로그램이 네트워크나 서버 없이 Gaussian 
Cloud를 즉시 렌더링합니다. Bouquet 주위의 검은 마커는 학습 카메라이며 선택적으로 표시 가능합니다. 마우

스 드래그로 회전, 스크롤로 줌.
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E7 — Web Viewer (.html)

위치

메뉴 바 → Export → Media → Export Web Viewer…. 
Simple Mode: 형식 카드 “Web Viewer”. 크기: Splat 데이
터 base64 인코딩 (≈ 4/3 오버헤드) + 약 5 KB HTML/JS 
셸. 호환: WebGL2가 있는 모든 최신 브라우저 (모든 데스크
톱, iOS 15+, Android 5+).

기술적  설명

완전히 인라인으로 작성된 WebGL2 렌더러와 함께 
Gaussian Cloud를 단일 .html  파일로 묶습니다. CDN 
의존성이 없고, WASM이 없고, 두 번째 파일이 없습니다. 
Cloud는 먼저 .splat  바이너리로 인코딩되고 (E6과 같
은 32 바이트 로직), 그 다음 base64로 임베드되고, 그 다
음 브라우저에서 atob 로 디코딩됩니다. 내장 렌더러는 자체 
WebGL2 정렬, 마우스 Orbit 제어, 프레임당 CPU 정렬을 수
행합니다. 전체 JS 코드 (셰이더, 수학, 루프) 가 출력 HTML
에서 볼 수 있습니다. 저장-렌더러 경계의 축 규약은 E5와 
정확히 동일합니다: Position (x, -y, -z) , Quaternion 
(w, x, -y, -z) . 선택적으로 브랜딩 오버레이를 표시할 수 
있습니다 (Free Tier 스위치). 모든 것이 인라인이기 때문에 
파일은 file:/​/​ 프로토콜에서도 직접 작동합니다 — 테스트에 
로컬 웹 서버 필요 없음.

간단히  말하면

누군가에게 이메일로 보내거나 

웹페이지에 임베드할 수 있는 단

일 HTML 파일. Finder에서 더블 

클릭하면 브라우저가 마우스 회

전과 함께 장면을 표시합니다. 

클라우드 업로드 필요 없음, 두 

번째 파일 없음, 서버 없음. 고객 

프레젠테이션, 포트폴리오, 이메

일 첨부에 이상적입니다. 단점: 

base64 인코딩 때문에 파일이 순

수 .splat 보다 약 1/3 더 큽니

다 — 매우 큰 장면의 경우 따라

서 .splat  파일을 표준 Viewer

와 함께 별도로 호스팅하는 것이 

가치가 있습니다.

그림 32:  flowers-01.mp4에서 추출한 단일 프레임 — 프로필 렌더에서 Bjoern의 Bouquet, 카메라 마커가 
있는 보이는 흰색 플랫폼, 검은색 배경 (기본 뷰포트 배경, Settings에서 변경 가능). 카메라는 파라메트릭 궤도
에서 장면을 둘러쌉니다 (Elevation + 거리 고정, Yaw 회전), 일반적으로 30 또는 60 fps에서 6–10초 지속 

시간. 프레임 해상도는 VideoPreset을 통해 480p에서 8K까지 스케일 가능합니다.
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E8 — Orbit Video (.mp4/.mov)

위치

메뉴 바 → Viewport → Record Turntable Video 또는 
메뉴 바 → Export → Media → Export Orbit Video…. 
Simple Mode: 3–30 s 지속 시간 슬라이더가 있는 형식 카
드 “Orbit Video”. 크기: 지속 시간, 해상도, 비트레이트에 따
라 다름. 호환: 모든 플랫폼 (H.264과 HEVC가 Apple 표준).

기술적  설명

파라메트릭 Orbit 카메라 이동을 따라 Gaussian Cloud를 
렌더링하고 AVAssetWriter를 통해 각 프레임을 MP4 또는 
MOV 파일로 인코딩합니다. Orbit 구성은 회전 속도 (회전 
수), 거리, Elevation, FOV, 지속 시간, Ease In/Out 인수
를 제어합니다. Orbit 비디오 내보내기는 전체 SH 평가와 함께 
RadianceKit 자체의 ForwardPass를 거칩니다 — 인앱 뷰포
트와 픽셀 단위로 동일합니다 (WYSIWYG). 프레임당 World 
적응 매트릭스 (내부 좌표를 Y up Orbit 세계로 회전시키기 
위해 렌더러가 계산) 가 카메라와 곱해진 후 카메라 규약 뒤집
기 (camFlip: Orbit Y up → COLMAP Y down) 가 적용
됩니다. 오프스크린 렌더 타깃은 인코더용 CVPixelBuffer에 
IOSurface를 통해 끌어내립니다. 인코더는 H.264와 HEVC, 
구성 가능한 비트레이트 및 480p에서 8K까지의 해상도를 지
원합니다. 첫 프레임 전에 렌더러는 초기 Splat 정렬이 완료되
도록 200 ms를 기다립니다. 이 내보내기는 GPU 제한입니다 
— 8K와 수백만 Gaussian에서 프레임당 렌더 시간이 몇 초이
며, 따라서 6초 비디오에 총 렌더 시간 10–30분 가능.

간단히  말하면

장면 주위 회전이 있는 완성된 

MP4 파일. 소셜 미디어, 마케

팅, 프레젠테이션에 완벽. 지속 

시간 (3–30초), 회전 방향, 속도

를 설정할 수 있습니다. 파일은 
YouTube, Instagram, PowerPoint 

및 다른 모든 곳에 직접 임베드

할 수 있습니다. 부분적으로 느

림. 앱이 각 프레임을 완전히 렌

더링해야 하기 때문입니다 — 8K 

비디오의 경우 Gaussian 수에 따

라 5분에서 30분을 예상할 수 있

습니다.
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E9 — SfM Transforms (transforms.json)

위치

메뉴 바 → Export → Photogrammetry → Export 
SfM (transforms.json)…. 크기: 일반적으로 1–10 KB 
(Pose + Intrinsic만, 이미지 없음, Gaussian 없음). 호환: 
nerfstudio, Brush, gsplat, OpenSplat, Meshroom, 모
든 현대 Feed Forward 3DGS Trainer.

기술적  설명

공유 Intrinsics가 있는 카메라 포즈 목록이 있는 nerfstudio 
transforms.json  형식을 작성합니다. 카메라당 View 매
트릭스 (RadianceKit 내부: COLMAP 규약의 World to 
Camera) 가 반전된 다음 카메라 로컬 Y와 Z 베이스 벡터가 미
러링되어 nerfstudio 규약 (OpenGL 스타일, 카메라가 -Z
를 따라 보고, +Y 가 위) 으로 변환됩니다. 최종 4×4 매트릭
스는 각 프레임의 transform_matrix  필드의 row-major 
nested array of Doubles로 저장됩니다. Intrinsics는 최
상위에 저장됩니다 (초점 거리 x/y, 주점 x/y, 이미지 폭/높
이, camera_​model = "OPENCV", Distortion Coefficient 
k1, k2, p1, p2 ) — 내보내기가 여러 다른 Intrinsics 세
트를 감지하지 않는 한, 그 경우 프레임당 작성됩니다. 이미지 
경로는 JSON 파일에 상대적인 images/​<filename>으로 작
성됩니다. 사용자는 학습 사진이 있는 형제 images/​ 폴더를 만
들어야 합니다.

간단히  말하면

이 JSON 파일은 각 사진에 대

해 카메라가 어디에 있었고 어

디를 보고 있었는지 설명합니다. 

파일 자체는 작고 쓸모가 없습

니다 — 폴더에서 원본 이미지

와 함께 사용됩니다. Nerfstudio, 

Brush 및 몇몇 다른 Trainer가 정

확히 이 형식을 읽으며, 카메라 

재구성을 다시 계산할 필요 없이 

RadianceKit SfM 결과를 다른 도

구로 전달할 수 있습니다. 큰 장

면에서 시간을 절약합니다.
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E10 — COLMAP Workspace (sparse/0/)

위치

메뉴 바 → Export → Photogrammetry → Export SfM 
(COLMAP Workspace)…. 크기: 세 바이너리 파일 함께 일
반적으로 4–8 MB — points3D.bin 이 지배 (Sparse 
Cloud의 3D 점당 한 줄), images.bin 과 cameras.bin
은 각각 100 KB 미만. 호환: COLMAP 자체, Nerfstudio, 
Postshot, Meshroom, COLMAP sparse/​ 디렉터리를 예
상하는 모든 도구.

기술적  설명

세 바이너리 파일이 있는 표준 COLMAP sparse/​0/​ 
레이아웃을 작성합니다: cameras.bin , images.bin , 
points3D.bin . 형식 참조는 공식 COLMAP 문서입니
다. cameras.bin 은 중복 제거된 Intrinsics 목록 (동일한 
Intrinsics + 이미지 크기를 가진 카메라가 단일 항목으로 결
합됨) 을 포함합니다. 사용된 Camera Model은 OPENCV  
(Model 4) 이며 fx/fy/cx/cy + 네 개의 Distortion 
Coefficient k1/k2/p1/p2가 있습니다. images.bin 은 이
미지당 wxyz  쿼터니언으로 Pose + Translation, 그 다
음 Camera ID와 파일 이름을 나열합니다. 2D-3D 대응
은 저장되지 않습니다. points3D.bin 은 Position, Color 
(0-255 RGB), Reprojection과 Track Length의 기본값
이 있는 SfM 점 구름을 포함합니다. 모두 Little-Endian으로 
작성됩니다. RadianceKit으로의 재가져오기는 File 메뉴 → 
“Import COLMAP/Metashape Workspace…”를 통해 작
동합니다 (SfM 백엔드 장의 Q3 참고).

간단히  말하면

공식 COLMAP 형식. 학습을 

Postshot, Nerfstudio 또는 다른 

COLMAP 가능 소프트웨어에서 

계속하려면 이것이 경로입니다. 

세 작은 파일과 원본 이미지, 

그리고 대상 프로그램은 마치 

COLMAP 자체가 소스 프로그램

이었던 것처럼 이를 받아들입니

다. transforms.json 형식 (E9) 보

다 더 많은 프로그램이 이를 이

해하며, 동시에 텍스트 기반 대

신 바이너리이기 때문에 약간 덜 

편리합니다.

어느 형식을 언제?

목표 형식

자체 사이트의 Web Viewer E7 Web Viewer (.html)

gsplat.js 가 있는 Web Viewer E6 Splat (.splat)

Postshot / Nerfstudio의 파이프라인 재사
용

E9 transforms.json + E10 COLMAP Workspace

SuperSplat 편집 E1 PLY 또는 E2 Compressed PLY

Niantic Scaniverse / Spatial Fields E3 SPZ

최대 압축 E4 SOG (cwebp 필요)

마케팅/소셜 비디오 E8 Orbit Video
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빠른 비교

형식 확장자 Sandbox 크기 (1M Gauss) Best Use

E1 PLY .ply 예 ~250 MB 아카이브, 최고 
호환성

E2 Compressed 
PLY

.ply 예 ~40 MB Web + 
SuperSplat

E3 SPZ .spz 예 (gzip-
Spawn)

~40 MB Niantic + 모
바일

E4 SOG .sog 조건부 
(cwebp)

~20 MB 최대 압축

E5 glTF .glb 예 ~250 MB Khronos 파
이프라인

E6 Splat .splat 예 ~32 MB gsplat.js 
Web Viewer

E7 Web 
Viewer

.html 예 ~45 MB 독립형 브라우
저 파일

E8 Orbit 
Video

.mp4 / .mov 예 가변 소셜/마케팅

E9 SfM Transforms .json 예 ~5 KB Pose 전달

E10 
COLMAP Workspace

디렉터리 예 ~4–8 MB Pose 전달 바
이너리

크기 열은 SH 정도 3의 100만 Gaussian에 대한 대략적인 기준값입니다. 실제 값은 장면의 압축성에 따
라 다릅니다. SH 정도 0은 PLY/glTF를 4배 줄입니다.
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장

제 9 장 — SfM 백엔드

그림 33:  인스펙터의 Camera Alignment 선택기가 있는 Expert 모드 (Apple Photogrammetry / 
Native (Beta))

그림 34:  Native (Beta) 가 활성인 인스펙터 — Camera Alignment 선택기에서 두 번째 옵션이 선택되었고 
다른 모든 학습 구성 매개변수는 변경되지 않음

이미지에 보이는 것  인스펙터의 Camera Alignment 선택기는 두 옵션이 있는 세그먼트 컨트롤입니다 — 
Apple Photogrammetry (App Store 빌드의 기본값, 완전 Sandbox 호환) 와 Native (Beta) 
(RadianceKit 자체의 FAST+BRIEF+GLOMAP 파이프라인 백엔드, Phase 3.8/3.9 개발, 2026-05 
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기준). Native (Beta) 는 궤도 전용으로 검증되었고 ≥1 000 프레임에서 Apple Photogrammetry보다 
빠르지만 Phase 3 §5 품질 게이트 (finalLoss ≤ 0.0115) 를 아직 충족하지 못합니다 — 따라서 Beta 
태그. Metashape, COLMAP 또는 다른 Photogrammetry 소프트웨어에서의 외부 SfM 결과는 추가
로 File 메뉴를 통해 가져올 수 있습니다 (Q3 COLMAP 텍스트 형식, Q6 Workspace 가져오기) — 선
택기가 전환되지 않지만 가져온 포즈는 SfM 결과를 대체합니다.

SfM은 Structure from Motion 을 의미합니다. 겹치는 사진 세트에서 소프트웨어는 각 이미지에 대해 
공유 3D 좌표계에서 카메라의 위치와 시선 방향을 재구성합니다. 그 과정에서 거친 3D 점 구름이 생성되
며 Gaussian Splatting의 학습을 초기화합니다. SfM 결과는 실제 학습의 입력이며 이후 이미지 품질을 
결정적으로 좌우합니다.

RadianceKit은 5개의 SfM 경로를 제공합니다: 앱에 내장된 두 백엔드 (Q1 Apple Photogrammetry, 
Q4/Q5 Native), 외부 도구에서의 두 가져오기 경로 (Q3 COLMAP 텍스트 형식, Q6 바이너리 
Workspace 가져오기), 그리고 App Store 외부의 Developer 빌드에서만 사용 가능한 Q2 COLMAP 
Binary. 어느 것이 적절한지는 장면 유형 (객체 주위 궤도, 실내 공간, 드론 비행) 과 외부 소프트웨어가 이
미 재구성을 제공하는지에 따라 다릅니다.

Q1 — Apple Photogrammetry

위치

Expert View → 인스펙터 → Training Configuration 
→ Camera Alignment 선택기, 항목 “Apple 
Photogrammetry”.

기술적  설명

원래 Object Capture용으로 개발된 Apple의 내장 
Photogrammetry 프레임워크를 래핑합니다. Apple은 내부
적으로 독점 파이프라인 (단계는 공개적으로 문서화되지 않
음) 으로 특징을 추출하고, Multi View 매칭을 통해 검증하
고, Apple Silicon Neural Engine + GPU에서 Bundle 
Adjustment를 해결합니다. 백엔드는 완전히 App Store 호
환 (외부 바이너리 없음, Sandbox=true, on-device) 이
지만 카메라 포즈와 거친 점 구름만 제공합니다 — Track 
Length나 Reprojection Error 같은 진단 메트릭은 없습니
다. Apple의 권장에 따라 수백 이미지까지 확장됩니다. 선형 드
론 비행이나 큰 야외 장면에서 ~500 프레임을 초과하면 재현 
가능한 충돌이나 개별 카메라의 조용한 폐기가 관찰되었습니다.

간단히  말하면

가장 간단한 경로입니다. 이미지 

입력, 앱이 계산. 고전적 객체 스

캔 (가구나 조각상 주위를 걸으

며 50–200 사진 촬영) 에 매우 잘 

작동합니다. 풍경 위 드론 비행

이나 매우 많은 이미지 (500 이

상) 에서는 Apple의 절차가 종종 

불안정해집니다. 그러한 장면에

는 Native 백엔드 (Q4/Q5) 를 테스

트하거나 카메라를 Metashape

에서 계산하고 Workspace 가져

오기 (Q6) 를 통해 불러오십시오.

P OW E R - U S E R

Q2 COLMAP Binary — 외부 COLMAP 프로그램을 서브 프로세스로 Spawn하므로 App Store 
버전 (Sandbox) 에서는 사용할 수 없습니다. App Store 외부의 Developer 빌드에서만 작동합
니다. COLMAP이 제공하는 품질을 위해 App Store 버전에서는 Workspace 가져오기 (Q3 또는 
Q6) 가 있습니다: COLMAP이나 Metashape에서 외부적으로 SfM을 계산하고 결과를 로드하십
시오.
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Q3 — COLMAP 텍스트 형식 (Metashape / ETH3D)

위치

메뉴 “File → Import COLMAP / Metashape 
Workspace…” (Cmd+⇧+I) 또는 sparse/​0/​
cameras.txt가 있는 폴더의 드래그 앤 드롭.

기술적  설명

표준화된 COLMAP 텍스트 내보내기를 읽습니다 — 
sparse/​0/​ 하위 폴더의 세 텍스트 파일 cameras.txt , 
images.txt , points3D.txt  — 그리고 내부 SfM 결
과 모델로 변환합니다. COLMAP 바이너리 내보내기와 동
일한 형식 정의이며, 바이너리 대신 ASCII로 작성됩니
다. Agisoft Metashape, RealityCapture, PolyCam, 
ETH3D 벤치마크가 정확히 이 레이아웃으로 출력합니다. 파
서는 Binary 파서와 카메라 모델 감지를 공유합니다 (모든 
일반적인 모델: SIMPLE_PINHOLE, PINHOLE, OPENCV, 
OPENCV_FISHEYE, FULL_OPENCV). 주석 줄과 빈 줄에 
강건. 테스트에서 ~1 400 카메라 (ETH3D Tunnel) 까지 문
제없이 확장됩니다.

간단히  말하면

이미 Metashape, RealityCapture 

또는 다른 상용 Photo 3D 소

프트웨어로 작업했고 결과를 

내보냈다면 — 그 내보내기를 

RadianceKit이 다시 계산하지 않

고도 직접 로드할 수 있습니다. 

이는 몇 시간의 대기 시간을 절

약합니다. 단순히 File 메뉴를 통

해 전체 폴더를 로드하거나 창으

로 드래그하십시오.
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Q4 — Native SfM (증분)

위치

Expert View → 인스펙터 → Training Configuration → 
Camera Alignment 선택기, 항목 “Native (Beta)”. 증분
이 이 백엔드의 기본 모드 — 인스펙터에 별도의 매퍼 선
택기는 없습니다. CLI를 통해 모드를 명시적으로 설정하려면 
--native-sfm  또는 --sfm-mapper incremental을 사
용합니다.

기술적  설명

전체 SfM 파이프라인의 자체 GPU 가속 구현: FAST+BRIEF 
특징량 또는 CoreML을 통한 SuperPoint+LightGlue 
( --coreml-features  포함), 그 다음 Hamming KNN 
매칭, RANSAC 기본 행렬, Track 구축, 초기 페어 선택, 
2 View Bootstrap (F→E + DLT), PnP 등록과 Multi 
View 삼각측량을 사용하는 Greedy 증분 매퍼, 마지막으
로 Huber Loss와 해석적 Jacobian을 Cholesky Solve
로 사용하는 Schur 축소 Levenberg-Marquardt Bundle 
Adjustment. 완전 App Store 호환: 외부 바이너리 없
음, Sandbox=true. Phase 3.10에서 제공된 R2 Collapse 
Detector 포함: 앱이 입력 프레임의 60% 미만을 등록하거나 
카메라당 점 비율이 13 아래로 떨어지면 자동으로 글로벌 매퍼 
(Q5) 로 폴백합니다. 경험적으로 궤도/턴테이블 장면에서 깨끗
합니다. 더 일반적인 움직임 (드론 비행, 복잡한 형상의 실내 공
간) 에서는 성공률이 더 낮습니다 — 그러나 Detector가 이러
한 케이스를 잡습니다. ~200 카메라까지 안정적으로 확장되며, 
그 이상은 상당히 더 긴 실행 시간으로.

간단히  말하면

Apple의 강점 (App Store 호환, 궤

도에서 빠름) 에 추가 진단 값을 

더한 것. 객체 캡처처럼 객체 주

위를 걷는 경우 특히 적합합니

다. 더 복잡한 녹화 (드론 비행

이나 거실) 에서는 RadianceKit

이 자동으로 이것이 잘되지 않

을 것을 감지하고 글로벌 프로세

스로 전환합니다. “Beta”로 표시

된 이유는 아직 테스트 중이기 

때문입니다 — 표준 권장은 여전

히 간단한 객체 스캔에는 Apple 

Photogrammetry, 까다로운 야외 

세트에는 Workspace 가져오기 

(Q3 또는 Q6) 입니다.
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Q5 — Native SfM (글로벌)

위치

증분 매퍼 (Q4) 가 Collapse Detector를 트리거한 경우 (입
력 프레임의 60% 미만이 등록되거나 카메라당 점 비율이 13 
미만) 자동으로 호출됩니다. CLI --sfm-mapper global을 
통해서만 수동으로 강제 가능합니다. 인스펙터에서 글로벌 방법
은 별도의 선택기를 통해 접근할 수 없습니다 — 앱이 전환 시점
을 자체적으로 결정합니다.

기술적  설명

네이티브 파이프라인의 글로벌 변형. 먼저 Q4와 같이 특징 추
출 + 매칭, 그 다음 모든 검증된 페어의 상대 Pose 추정, 그 
다음 Rotation Averaging (세계 좌표계 내 모든 카메라 회전
을 동기화) 과 Translation Averaging (큰 카메라 수에서 정
수 오버플로를 피하기 위해 행렬 자유 Sparse Formulation의 
LSQR 기반). 원칙적으로 ~5 000 카메라까지 확장되지만 실
제로는 수백 카메라를 초과하면 품질이 저하됩니다 — K-1351
에서의 Phase 3.8 §5 수용 게이트 측정은 목표 0.0115 대신 
finalLoss 0.07을 산출했습니다. “Fallback Tier”로 처리됩
니다: 증분 매퍼가 퇴화될 때 등장하지만 자체적으로는 품질이 
다시 확인되지 않습니다.

간단히  말하면

네이티브 엔진의 Plan B 경로. 더 

빠른 증분 경로가 실패하면 자

동으로 호출됩니다. 사용 가능한 

결과를 제공하지만 매우 크거나 

어려운 장면에서는 일반적으로 

Metashape이나 외부 COLMAP 설

치에서 얻을 수 있는 것만큼 정

확하지 않습니다. Native가 표준 

워크플로가 되면 그러한 경우에

는 Workspace 가져오기 (Q3 또는 

Q6) 의 우회가 가치가 있습니다.
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Q6 — Metashape / COLMAP 텍스트 Workspace 가져오기 (Phase Q7)

위치

File 메뉴 → “Import COLMAP / Metashape 
Workspace…” (Cmd+⇧+I). sparse/​0/​cameras.
{bin,txt} 와 images/​가 있는 폴더의 드래그 앤 드롭.

기술적  설명

드래그 앤 드롭 또는 Open 패널에서 선택된 폴더가 세 
COLMAP Workspace 레이아웃 (sparse/​0/​, sparse/​, 또
는 루트) 중 하나에 해당하는지, 그리고 재구성이 바이너리 
( cameras.bin ) 인지 텍스트 ( cameras.txt ) 인지를 자
동 감지합니다. 바이너리 경로는 COLMAP 바이너리 파서를 사
용하고, 텍스트 경로는 ETH3D 로더를 사용합니다 — 둘 다 동
일한 SfM 결과 모델을 생성하며 파이프라인의 나머지 (이미지 
가져오기, MCMC 학습 시작) 는 소스에 무관합니다. 이미지는 
앱 Sandbox 북마크 시스템을 통해 Security Scoped로 열
리므로 가져오기는 App Store 버전에서도 작동합니다. 특히 
“재구성 없이 Metashape 내보내기를 다시 계산” 케이스용으
로 의도되었습니다. File 메뉴 항목에서 언급된 감지는 선택된 
폴더가 인식 가능한 Workspace가 아닐 경우 앱 로그에 경고
합니다.

간단히  말하면

특히 Metashape 사용자용 기능. 

Metashape이나 RealityCapture 

라이선스가 있고 거기서 카메라 

재구성을 수행했다면 내보내기 

폴더를 여기에 쉽게 드래그하여 

즉시 학습을 시작할 수 있습니

다. RadianceKit이 SfM 자체를 실

행하지 않기 때문에 큰 장면에서 

몇 시간의 계산 시간을 절약합니

다.

어느 백엔드를 언제?

시나리오 권장 백엔드

객체 스캔, 50–200 사진 Q1 Apple Photogrammetry

큰 야외 / 드론 / >500 이미지 Q6 Workspace 가져오기 (Metashape 또는 COLMAP에서 계산 후 
로드)

Metashape/RealityCapture 
내보내기 존재

Q6 가져오기 (SfM 필요 없음)

ETH3D / 학술 COLMAP 텍스
트 세트

Q3 COLMAP 텍스트 가져오기

엄격한 App Store 호환 + 궤도 
장면

Q4 Native 증분

Q4 실패 Q5 Native 글로벌 (자동)

ETH3D 벤치마크 데이터 Q3 (autotest precomputed)
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빠른 비교

백엔드 App Store Sandbox 외부 바이너리 Best Use 최대 ~Cams

Q1 Apple 
PG

✅ ✅ — 궤도 객체 ~300

Q2 
COLMAP 

Binary

❌ 
(Developer 
빌드만)

— colmap/glomap 야외 대형 ~5 000

Q3 
COLMAP 
텍스트 가
져오기

✅ ✅ — Bench rigs ~1 500

Q4 
Native 증
분

✅ ✅ — 궤도 객체 ~200

Q5 
Native 글
로벌

✅ ✅ — Q4 폴백 ~1 351

Q6 Workspace 
가져오기

✅ ✅ — Metashape 
재사용

소스 별
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장

제 10 장 — 초보자 모드

초보자 모드 (영어 Simple Mode, Cmd+1) 는 3D Gaussian Splatting 장면을 처음 재구성하는 모든 
사람을 위한 가이드형 워크플로입니다. 인스펙터 필드로 가득한 사이드바를 표시하는 대신 앱이 네 단계를 
안내합니다: 먼저 이미지나 비디오를 가져오고 품질 프리셋을 선택, 그 다음 처리가 실행 (SfM + 학습), 그 
다음 완성된 장면을 3D 미리보기에서 평가할 수 있고, 마지막으로 원하는 형식으로 내보냅니다. 창 상단 가
장자리의 좁은 진행률 표시줄은 항상 어느 단계에 있는지 표시합니다.

모든 컨트롤 필드를 동시에 보여 주는 Expert 모드 (Cmd+2) 와 비교하여 초보자 모드는 사용되지 않는 
옵션을 숨기고, 이미지가 너무 적거나 나쁘면 검증 경고를 제공하며, 각 단계에서 현재 상태에서 의미 있는 
버튼만 제공합니다. 언제든지 초보자 모드와 Expert 모드 사이를 전환할 수 있고 (Cmd+1 / Cmd+2), 전
체 상태 — 가져온 이미지, 선택된 프리셋, 현재 실행 중인 학습, 완성된 점 구름 — 가 유지되며 각 다른 모
드에서 즉시 사용할 수 있습니다.

Z1 — 가져오기 (이미지와 프리셋 선택)

그림 35:  초보자 모드 1단계 — 이미지 가져오기 전 빈 드롭 영역, 위에 Crumb Trail (Import → Frame 
Quality → Cameras → Training → Preview → Export), 형식 핀 JPG/PNG/TIFF/HEIC/MP4/MOV/

PLY/SPZ/SPLAT/SCENE/COLMAP

이미지에 보이는 것  Crumb Trail (Import 활성) 이 4단계 워크플로를 보여 줍니다. 세 CTA가 있는 왼쪽 
드롭 영역: “Browse Files” (NSOpenPanel), “Try Sample Scene” (번들된 데모), “Download 
Sample Photos (~427 MB)” (Mip-NeRF360 flowers 하위 집합). 그 아래의 형식 핀은 모든 허용
된 파일 유형을 나열합니다. 오른쪽에 카운터 “0 images”와 빈 상태 “No files imported yet”가 있는 
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“Imported Files”. 아래에 Quality 선택기 (기본값: Preview) 와 “Start Processing” (이미지가 없는 
동안 비활성).

첫 번째 단계는 앱에 이미지 자료를 제공하는 것입니다. 중간의 큰 점선 필드로 드래그 앤 드롭, “Browse 
Files” 버튼을 통해, 또는 동봉된 Sample 장면을 클릭하여. 오른쪽에 해상도와 파일 크기가 있는 모
든 가져온 이미지 목록이 나타납니다. 아래의 떠 있는 도구 모음에서 품질 프리셋을 선택하고 “Start 
Processing”으로 파이프라인을 시작합니다. 검증 경고 (< 3 또는 < 10 이미지에서 빨강, 10–19 이미지
에서 주황) 는 앱이 의미 있는 재구성을 기대하는지 여부를 나타냅니다.

C-01 ProgressIndicator (단계 표시)

위치

워크플로 위, 항상 표시.

기술적  설명

Stage Allocation이 있는 전체 파이프라인 (Frame-Quality 
→ SfM → Training) 에 걸친 수평 진행률 표시줄을 표시합
니다: Frame-Quality는 0–5% (Phase 3.11, 매우 짧음) 를 
차지하고, SfM은 표시줄의 0–30%, Training은 30–100%. 
그 옆에 상태 텍스트와 단계 이름 백분율 표시 (“SfM 41%”, 
“Training 12 500/20 000”) 가 있어 사용자가 “41% SfM 
→ 25% Training” 의 명백한 후퇴를 오류로 읽지 않도록 합니
다 — 표시줄은 전체 파이프라인 진행을 보여 주며 하위 단계가 
아닙니다. ETA 계산은 충분한 학습 속도가 측정된 즉시 시작됩
니다 (일반적으로 처음 100 반복 후). 같은 표시는 Expert 모
드의 인스펙터 위에서도 사용됩니다.

간단히  말하면

맨 위의 좁은 표시줄은 워크플로

를 통한 당신의 지도입니다. 앱

이 지금 무엇을 하고 있는지 (카

메라 정렬, 학습 실행, …) 말해줄 

뿐만 아니라 전체적으로 얼마나 

진행되었는지도 말해줍니다. 분

배는 의도적으로 카메라 계산이 

표시줄의 첫 1/3을, 실제 학습이 

뒤의 2/3를 차지하도록 되어 있

습니다 — 그렇지 않으면 SfM 후 

갑자기 0으로 돌아간 것처럼 보

일 것입니다. 따라서 편안히 기

대어 앉아 표시줄을 한번 보면 

대략적인 단계를 볼 수 있습니

다. 그 옆의 텍스트는 SfM 단계 

(예: “SfM 41%”) 에 있는지 학습 

(예: “Training 12 500/20 000”) 에 

있는지 말해 주어 숫자가 혼란스

럽지 않게 합니다. ETA가 표시되

지 않으면 학습이 아직 너무 어

린 것입니다 — 앱은 충분한 속도

를 측정한 후에야 추정합니다.
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C-03 DropZoneView (드래그 앤 드롭 영역)

위치

Import 단계의 왼쪽, 기호가 있는 큰 점선 직사각형. 초보자 모
드에서는 레이블 “Drop photos or a video here”와 함께 
표시됩니다.

기술적  설명

드래그 항목이 필드 위에 떠 있는 즉시 기호를 잠시 뛰게 하
고 배경을 채색하는 드롭 영역. JPG, PNG, TIFF, HEIC, 
MP4, MOV, PLY, SPZ, .splat, .radiancescene 번들과 
디렉터리를 받아들입니다. 유형별 드롭 라우팅: 이미지는 수집
되고 정렬되어 전달되며, 비디오는 프레임 샘플링 경로를 트
리거하고, Splat 파일은 미리보기를 직접 열고, Scene 번들
은 읽힙니다. 디렉터리는 열거되고 포함된 모든 이미지가 가
져옵니다. Sandbox 호환 액세스를 위한 Security Scoped 
Bookmark가 올바르게 가져와지고 해제됩니다. 지원되지 않는 
확장자는 5초 동안 경고 배너로 표시됩니다.

간단히  말하면

큰 점선 필드는 첫 단계의 주요 

조작입니다. 사진이나 비디오 또

는 전체 폴더를 끌어 놓기만 하

면 — 앱이 알고 있는 모든 것

을 가져가고 나머지는 무시합니

다. 필드가 파랗게 되고 기호가 

잠시 뛰면 앱이 드래그를 인식한 

것입니다. 놓으면 가져오기가 즉

시 시작됩니다: 이미지는 오른쪽 

목록으로 이동하고, 비디오는 자

동으로 프레임 샘플링 단계를 트

리거하며, 이미 학습된 .ply /

.spz / .splat  파일은 미리보

기를 직접 엽니다. 형식이 전혀 

맞지 않으면 (예: PDF 또는 BMP) 

상단에 짧은 힌트가 나타납니다 

— 앱은 알 수 없는 자료를 조용

히 삼키지 않습니다.

C-05 Browse Files 버튼

위치

드롭 영역 내, 두드러진 버튼.

기술적  설명

JPG, PNG, TIFF, MP4, MOV, 폴더, 앱 자체 Scene 형식의 
파일 유형과 다중 선택으로 macOS 파일 대화창을 여는 버튼. 
결과 URL은 Security Scoped이며 드래그 앤 드롭과 같은 가
져오기 경로를 통해 전달됩니다. 사용자가 폴더를 선택하면 이
미지에 대해 재귀적으로 열거됩니다.

간단히  말하면

드래그 앤 드롭이 불편하다면 이 

버튼을 클릭하고 macOS 파일 대

화창에서 사진으로 이동하기만 

하면 됩니다. 동시에 여러 파일

을 선택하거나 (개별 이미지에 

Cmd 클릭) 전체 폴더를 선택할 

수 있습니다 — 앱이 그러면 폴

더에서 지원되는 모든 이미지 유

형을 재귀적으로 검색합니다. 촬

영이 하위 폴더에 중첩되어 있

을 때 (예: “shoot-day1/”, “shoot-

day2/”) 특히 편리합니다 — 메인 

폴더의 한 번의 클릭으로 충분

합니다. 기능적으로 버튼은 드래

그 앤 드롭과 정확히 같은 작업

을 수행합니다. 더 편안한 방법

을 선택하기만 하면 됩니다.
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C-06 Try Sample Scene 버튼

위치

드롭 영역 내, 앱 번들이 Sample 장면을 포함하고 아직 이미
지/Splat이 가져오지 않은 경우에만 표시됩니다.

기술적  설명

(a) 앱 번들에 sample-scene.splat , .spz  또는 .ply
가 있고 그리고 (b) 아직 이미지/비디오가 가져오지 않았고 점 
구름이 없는 경우에만 나타납니다. 클릭 시 완성된 점 구름 (가
장 작은 형식 선호 — .splat  ~3 MB, .spz  ~1.4 MB, 폴
백 .ply ) 을 로드하고 400 ms 후 미적으로 의미 있는 입력 
시점을 위해 꽃 장면의 원본 메타데이터에서 하드코딩된 카메라 
값을 설정합니다.

간단히  말하면

앱을 처음 시작하고 최종적으로 

나오는 것이 무엇인지 보고 싶다

면 — 여기를 클릭하십시오. 이

는 앱이 계산할 필요 없이 즉시 

회전하고 내보낼 수 있는 완성

된 학습된 꽃 장면을 엽니다. 카

메라는 미적으로 의미 있는 입

력 시점에 사전 설정되어 있으므

로 즉시 멋진 것을 볼 수 있습니

다. 자체 촬영으로 가기 전에 3D 

컨트롤과 내보내기 단계를 위험 

없이 시도하기에 완벽합니다. 자

체 이미지를 가져오는 즉시 버튼

이 자동으로 사라집니다 — 프로

젝트가 완전히 비어 있을 때에만 

표시됩니다.

C-07 Download Sample Photos 버튼

위치

드롭 영역 내, “Try Sample Scene” 옆; 동일한 가시성 조건.

기술적  설명

Repo github.com/​bkindler/​radiancekit-sample-
photos에서 다운로드를 트리거하여 약 427 MB의 960
개 전체 해상도 프레임을 로드하고 앱에 공급합니다. 다운로
드 중에는 버튼이 비활성화됩니다. 진행은 상단 진행 표시줄에 
“Downloading X %”로 자체 단계로 표시됩니다. 이 단계는 
자체 0–100% 스케일을 유지하고 이후 SfM 단계와 겹치지 않
습니다.

간단히  말하면

Sample 장면과 정확히 같지만 

완성된 결과 대신 시작 사진으

로. 따라서 전체 파이프라인을 

한 번 직접 실행하고 SfM과 학

습이 Mac에서 실제로 얼마나 오

래 걸리는지 볼 수 있습니다. 다

운로드는 큽니다 (DVD의 약 절반 

= 427 MB) 만 한 번만 발생합니

다 — 그 후 사진은 로컬이고 다

른 프리셋으로 파이프라인을 원

하는 만큼 자주 다시 시작할 수 

있습니다. 다운로드가 실행되는 

동안 상단 진행 표시줄이 현재 

다운로드 상태를 백분율로 표시

하므로 언제 시작될지 추정할 수 

있습니다. 팁: 빠른 WLAN이나 유

선 네트워크를 사용하십시오 — 

그렇지 않으면 427 MB가 끌립니

다.
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C-09 Quality Presets 선택기

위치

Import Overlay의 떠 있는 하단 도구 모음, Start 버튼 왼쪽.

기술적  설명

레이블 “Quality”가 있는 조작 요소는 사용 가능한 프리셋을 카
테고리별로 (Classic / MCMC / Custom) 그룹화합니다. 내
장 프리셋은 카테고리별로 그룹화됩니다. 섹션 헤더는 하드코딩
되어 있습니다. Custom 프리셋은 존재하는 경우에만 표시됩
니다. Locked 상태: Free 목록 (Quick + Preview) 에 없

는 프리셋은 사용자가 구매하지 않은 경우 이름에 “🔒” 접미사
를 받습니다. 선택 시 선택기가 Preview로 되돌아가고 자동으
로 Purchase Sheet를 엽니다. 선택 시 프리셋이 적용되어 전
체 학습 구성이 대체됩니다.

간단히  말하면

여기서 앱이 얼마나 정확하고 얼

마나 오래 계산해야 할지 선택합

니다. “Quick”과 “Preview”는 구

매 없이 사용할 수 있으며 몇 분 

안에 첫 결과를 제공합니다 — 이

미지가 의미 있는지 테스트하는 

데 이상적입니다. “Balanced”와 

“Quality”는 정식 버전을 필요로 

하며 상당히 깨끗한 모델을 제

공하지만 분 대신 몇 시간이 걸

립니다. MCMC는 더 적은 Gauss 

Splat으로 잘 작동하는 다른 전

략입니다 — 모델을 나중에 콤팩

트하게 내보내거나 웹에 올리려

는 경우 좋습니다. Premium 프

리셋은 이름에 작은 자물쇠 기호

로 식별할 수 있습니다. 라이선

스 없이 하나를 탭하면 선택기가 

Preview로 되돌아가고 구매 시트

가 자동으로 열립니다. 경험 법

칙: 항상 Preview로 시작하고 결

과를 본 다음 더 긴 실행이 가치

가 있는지 결정하십시오.

C-10 Start Processing 버튼

위치

Import Overlay의 떠 있는 하단 도구 모음, Preset 선택기 오
른쪽.

기술적  설명

이미지나 비디오가 가져오지 않은 동안 회색으로 유지되는 버
튼. 클릭 시 파이프라인이 시작되고 단계 머신이 Frame-
Quality → SfM → Training 순서로 전환됩니다. 버튼 자체에
는 추가 상태가 없습니다. 실행 중인 처리는 대신 별도의 처리 
화면으로 나타납니다.

간단히  말하면

“시작” 버튼. 회색인 동안에는 

여전히 입력 이미지나 비디오가 

없습니다. 사진을 끌어 들어오는 

즉시 활성화되며 SfM과 학습을 

순차적으로 시작하기 위해 클릭

합니다. 그때부터 앱이 전체 시

퀀스를 인계받고 자동으로 처리 

화면 (Z2) 에 도착합니다. 더 클

릭할 필요가 없습니다 — 학습

이 끝난 후에야 앱이 다시 미리

보기 (Z3) 로 전환됩니다. 마음이 

다시 바뀌면 그 후에도 언제든지 

Cancel로 중단할 수 있습니다.

193 / 216



R A D I A N C E K I T 제 10 장 — 초보자 모드

C-11 Video Sampling 슬라이더

위치

오른쪽 이미지 목록, 비디오 (이미지 대신) 가 가져왔을 때만 표
시.

기술적  설명

0.5 fps에서 30 fps의 슬라이더, 0.5 단계. 변경 시 프레임 
밀도가 업데이트되고 추가로 대상 프레임 수 (최소 10) 가 밀
도와 비디오 길이에서 계산됩니다. 슬라이더는 이미지 목록 밖
에 있습니다. 목록 요소가 슬라이더의 마우스 이벤트를 차단하
기 때문입니다. 슬라이더 아래에는 계산된 대상 프레임 (“247 
frames”) 과 비디오 길이 (“1m23s video”) 가 있습니다. 도
구 설명은 다음과 같이 경고합니다: “Doubling the density 
doubles the number of frames and increases SfM 
time by ~100%.”

간단히  말하면

사진 대신 비디오를 가져왔다면 

이 슬라이더가 앱이 비디오에서 

추출해야 할 개별 이미지 수를 

결정합니다. 더 많은 이미지 = 더 

나은 품질, 그러나 선형적으로 

더 많은 계산 시간. 30초 궤도 비

디오의 경우 5 fps (150 이미지) 

가 좋은 시작입니다. 1분 촬영의 

경우 종종 3 fps로 완전히 충분합

니다. 슬라이더 아래에 앱이 현

재 설정에서 몇 프레임이 나오는

지 실시간으로 표시합니다 — 따

라서 약 100–300 이미지의 의미 

있는 범위에 도달했는지 즉시 볼 

수 있습니다. 결과가 나쁘면 슬

라이더를 오른쪽으로 끌고 다시 

시도하십시오. 그러나 프레임 비

율을 두 배로 늘리면 SfM 지속 시

간도 대략 두 배가 됩니다.

C-12 Clear All 버튼

위치

오른쪽 이미지 목록, 오른쪽 아래; 이미지가 가져왔을 때만 표
시.

기술적  설명

빨간색 버튼. 클릭은 “Clear all imported files?” 제목과 “N 
images will be removed.” 메시지가 있는 확인 대화 상자를 
엽니다. 확인은 모든 가져온 이미지/비디오, 스테이징 디렉터리, 
점 구름, 학습 상태, SfM 결과, 모든 캐시를 비웁니다. 단계가 
Import로 돌아갑니다. Cancel에서는 모든 것이 유지됩니다. 
대화 상자는 파괴 없는 기본 경로 (파괴 버튼이 빨간색으로 표
시) 로 구성됩니다.

간단히  말하면

완전히 새로 시작하려면 여기를 

클릭하십시오. 삭제가 이미 계산

된 카메라와 학습 결과를 포함

한 모든 현재 가져오기를 폐기하

므로 — 되돌릴 수 없으므로 — 

확인 질문이 나타납니다. 선택된 

이미지 자료를 완전히 교체하거

나 새 것을 시작하기 전에 오래

된 프로젝트를 없애려는 경우 의

미가 있습니다. 참고: 개별 이미

지를 빼는 것은 오른쪽 목록을 

통해 (다음 항목 참고) 이며 이 버

튼을 통해서가 아닙니다. 디스크

의 파일은 삭제되지 않습니다 — 

앱은 그저 참조를 잊어버립니다.
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C-13 File List ForEach (개별 이미지 제거)

위치

오른쪽 이미지 목록, 각 항목.

기술적  설명

Swipe to Delete가 있는 가져온 이미지 목록. 이미지당 아
이콘, 파일 이름, 해상도 (“1920 × 1080”), 파일 크기 (KB/
MB로 형식화) 가 있는 한 줄. 해상도는 인터페이스를 차단
하지 않도록 이미지 헤더에서 비동기적으로 채워지는 메타데
이터 캐시에서 옵니다. 삭제 동작은 macOS 스타일 Swipe 
Delete (줄에서 트랙패드 스와이프 왼쪽) 와 선택된 줄에서 
키보드 Delete를 제공합니다. 참고: 명시적 마이너스 버튼, 
Backspace, Cmd-Z로 되돌리기가 있는 확장된 이미지 삭제 
경로는 Expert 모드만 의 Project Navigator에 추가되었습
니다 — 초보자 모드에서는 Swipe Delete로 남아 있습니다.

간단히  말하면

오른쪽 목록은 가져온 각 이미

지의 해상도와 파일 크기를 보

여 줍니다 — 고해상도와 저해상

도 자료를 함께 혼합했는지 한

눈에 보는 데 실용적입니다. 개

별 이미지를 빼려면 트랙패드에

서 두 손가락으로 왼쪽으로 스

와이프하십시오 — iOS Mail처럼 

— 또는 선택하고 Delete를 누

르십시오. 앱은 파일 자체를 삭

제하지 않습니다. 현재 프로젝

트에서 제거할 뿐입니다. 적절

한 마이너스 버튼이나 Cmd-Z 되

돌리기가 필요하면 Expert 모드 

(Cmd+2) 로 전환하십시오. 거기

에는 Project Navigator에 있습니

다. 초보자 모드에서는 의도적으

로 단순한 Swipe 패턴으로 유지

됩니다.
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C-15 Validation Warnings (3단계 등급)

위치

이미지 목록 아래, Clear All 버튼 위.

기술적  설명

가져온 이미지 수 (이미지가 있고 비디오가 없을 때만 활성) 
를 기반으로 한 세 가지 연속 임곗값: - < 3 이미지: 빨간
색 배너 (red octagon), 텍스트 “At least 3 images are 
required. Camera alignment cannot be computed 
from fewer images.” - 3–9 이미지: 빨간색 배너, 텍스
트 “With fewer than 10 images, SfM often fails and 
the trained scene tends to overfit […]. 15–20 images 
minimum recommended; 30+ for object captures.” 
- 10–19 이미지: 주황색 배너 (warning triangle), 텍스
트 “Workable, but quality usually improves with 20+ 
images and good coverage around the scene.”

20개 이미지부터 배너가 사라집니다. 임곗값은 하드코딩되어 
있고 경험적 560+ 학습 실험을 기반으로 합니다.

간단히  말하면

앱은 몇 개의 이미지를 가져왔는

지 보고 색이 있는 평가를 제공

합니다. 빨강은 의미합니다: 높

은 확률로 잘되지 않을 것 — SfM

이 카메라를 계산할 수 없거나 

학습이 너무 적은 자료에 Overfit

합니다. 주황은 의미합니다: 작

동할 수 있지만 알고리즘이 이

미지 사이에 적은 오버랩을 찾

기 때문에 최고 품질을 기대하지 

마십시오. 배너 없음은 의미합니

다: 좋은 전제 조건, 충분한 자료

가 있음. 정말 깨끗한 모델을 원

한다면 모티프 주위에 균등하게 

분포된 최소 30–50개의 촬영을 

목표로 하십시오 — 야외 장면이

나 큰 방에서는 훨씬 더 많이도 

좋습니다. 경고에도 불구하고 시

작할 수 있지만 SfM이 의견 없이 

중단되거나 모델이 구멍이 난 것

처럼 보여도 놀라지 마십시오.
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C-16 COLMAP Workspace 감지

위치

폴더 드롭 시 — 보이는 버튼이 아니라 감지 로직.

기술적  설명

디렉터리 드롭 시 세 표준 Workspace 레이아웃 중 하나
가 포함되어 있는지 확인됩니다: sparse/​0/​cameras.bin, 
sparse/​cameras.bin 또는 루트에 직접 cameras.bin . 
해당되면 표준 이미지 열거가 중단되고 대신 사용자에게 기존 
재구성을 사용할지 또는 이미지를 Apple Photogrammetry
를 통해 다시 보낼지 묻는 모달 경고가 열립니다. Text Format 
Workspace (cameras.txt) 와 ETH3D 내보내기에도 같은 
경로. 자세한 내용은 제 9 장 Backend Q6 참고. Expert 모드
와 마찬가지로 초보자 모드에서도 작동합니다.

간단히  말하면

이미 Metashape, RealityCapture 

또는 COLMAP과 작업했고 거

기서 카메라 계산을 실행했

다면 내보내기 폴더를 여기

에 쉽게 끌어 놓을 수 있습

니다. RadianceKit은 콘텐츠에

서 COLMAP Workspace 임을 자

동으로 인식하고 (sparse/​0/​, 

cameras.bin  등을 확인) 완성

된 계산을 인계받을지 또는 자

체적으로 다시 계산할지 묻습니

다. 인계는 큰 장면에서 SfM이 

완전히 건너뛰어지기 때문에 몇 

시간의 대기 시간을 절약합니다 

— 학습이 즉시 시작됩니다. Text 
Format Workspace (cameras.txt) 

와 ETH3D 내보내기도 인식됩니

다. 이 기능은 Expert 모드와 마

찬가지로 초보자 모드에서도 사

용할 수 있습니다. 자세한 내용

은 제 9 장의 Backend Q6에 있습

니다.

언제 다음 단계로?

(a) 최소 하나의 이미지나 비디오가 가져와졌고 (b) 검증 배너가 주황색이거나 사라졌으면 Start 
Processing을 클릭할 수 있습니다. 빨간 배너에서는 앱이 어쨌든 시작하게 하지만 높은 확률로 처리를 즉
시 다시 중단할 수 있습니다. 권장: 최소 20개의 선명한 이미지, 연속된 촬영 사이에 명확한 오버랩이 있고 
모두 모티프로부터 대략 같은 거리에서. 시작 전에 시간 예산에 맞는 프리셋을 선택하십시오 — 30개 이미
지와 Quick 프리셋이라면 몇 분 만에 완료됩니다. Quality에서는 1–2 시간이 걸립니다.
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Z2 — 처리 (SfM + 학습)

그림 36:  Z2 SfM 단계 — 큰 원에 41%가 있는 Stage 아이콘 “Structure from Motion”, 위 상태 표시줄 
“SfM 25%”, 오른쪽 아래 Cancel 버튼

SfM 단계 (카메라가 정렬됨): 큰 진행 원이 하위 단계 진행을 보여 줍니다 (여기서는 실행 중인 Apple 
Photogrammetry 세션의 41%). 왼쪽 위 상태 텍스트 “Aligning cameras…”. Crumb Trail은 
“Cameras”를 활성 단계로 표시합니다. 위 상태 표시줄은 파이프라인 전체 진행을 보여 줍니다 (25%) — 
SfM이 표시줄의 첫 절반을 차지합니다. 배경의 떠 있는 와이어프레임 카메라는 포즈가 추정되고 있음을 나
타냅니다.

그림 37:  Z2 학습 단계 — 6%가 있는 Stage 아이콘 “Training Gaussians”, 위 라이브 메트릭 (Training: 
400/5000 — Loss: 0.1642 — 138.7 it/s), ETA 33s, 아래 Pause/Cancel

학습 단계 (Gaussian이 최적화됨): 하위 단계 아이콘이 “Training Gaussians”로 전환되고 백분율이 
선택된 프리셋의 반복을 셉니다 (여기서는 Preview 프리셋의 경우 400 / 5 000 = 단계의 8%). 라이브 
메트릭 줄은 Loss 값 (0.1642), 초당 반복 (138.7 it/s), ETA (33 s) 를 표시합니다. 파이프라인 전체 진
행은 이 단계 동안 50%에서 100%로 올라갑니다. Pause 버튼 (SfM 단계의 Cancel Only 대신) 은 나
중에 Resume을 허용합니다. Cancel은 학습 결과를 폐기하고 Z1로 돌아갑니다.
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파이프라인이 실행되는 즉시 앱은 Import Overlay를 숨기고 전체 화면 처리 화면을 보여 줍니다. 중앙에
는 단계 아이콘, 상태 텍스트, 백분율 숫자가 있는 큰 진행 원 (220 × 220 픽셀) 이 실행됩니다. 배경에
는 절제된 Splat 애니메이션이 실행 중인 계산을 상징적으로 시각화합니다. 왼쪽 위에는 학습과 SfM의 실
시간 메트릭을 보여 주는 정보 패널을 표시할 수 있습니다. 아래에는 Pause/Resume, Cancel, 오류 시 
Retry 버튼이 있습니다.

C-18 SplatTrainingView (배경 애니메이션)

위치

진행 원 뒤의 전체 화면 배경, 중단이나 오류 시 숨겨짐.

기술적  설명

파이프라인 진행 (0…1) 에 따라 점점 더 많은 작은 애니메
이션 Splat 입자를 렌더링하는 장식 애니메이션. 소스는 SfM 
단계를 0–0.2에, 학습을 0.2–1.0에 (Frame-Quality를 0–
0.05에) 매핑하는 계산된 진행 값입니다. 따라서 학습이 실행되
는 동안 Splat이 가시적으로 “구축”됩니다. 순수 장식 — 표시
는 현재 학습의 실제 중간 결과를 보여 주지 않습니다 (그것은 
Expert 모드의 Live Preview). Cancel이나 Failure 시 숨겨
지고 상태 원만 보이게 됩니다.

간단히  말하면

배경에 춤추는 점들의 작은 애니

메이션이 실행되어 계산 중에 화

면이 너무 비어 있어 보이지 않

도록 합니다. 이는 실제 3D 모델

이 아닙니다 — 그것은 Z3 단계

의 학습 후에야 봅니다. 그러나 

애니메이션은 같은 톤을 가지고 

있어 대략적인 농축 정도에서 학

습이 얼마나 진행되었는지 읽을 

수 있습니다. 처음에는 몇 개의 

점만 보이고 끝쪽으로 배경이 상

당히 더 조밀하게 채워집니다 — 

원의 백분율 표시 외에 멋진 시

각적 표시기입니다. 애니메이션

이 거슬리면 (예: 백그라운드에

서 다른 작업을 하고 싶다면) 그

것이 사라지는 Expert 모드로 전

환할 수 있습니다.
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C-19 큰 진행 원

위치

처리 화면 중앙, 220 × 220 픽셀.

기술적  설명

두 개의 겹친 링: 외부에 절제된 트랙 링, 내부에 강조 또는 빨
강 스트로크가 있는 채워진 진행 링 (오류 시 빨강). 원 안
에 단계 아이콘 (학습용 뇌, SfM용 카메라, 비디오 프레임 추
출용 필름, Frame-Quality용 Sparkles), 단계 제목, 32 포
인트 Rounded 폰트의 실시간 애니메이션 백분율 숫자. 처
리가 활성인 동안 아이콘이 부드럽게 펄스합니다. 표시는 30 
Hz 타이머에서 실제 현재 진행 방향으로 부드럽게 보간합니다 
— Constant Creep (프레임당 0.0003) 과 Proportional 
부분 (Gap의 4%), 다음 예상 마일스톤의 80%에 설정하는 
Soft Ceiling (SfM의 경우 하드코딩된 마일스톤 테이블에서). 
따라서 실제 SfM 업데이트가 몇 초마다만 도착해도 진행이 유
연하게 보입니다.

간단히  말하면

중앙의 큰 원은 앱이 계산하는 

동안 주 표시입니다. 실제 계산 

업데이트가 몇 초마다만 와도 부

드럽게 채워집니다 — 이는 동결

된 백분율을 몇 분 동안 응시하

는 대신 무언가 일어나고 있다는 

느낌을 줍니다. 중앙의 기호는 

프레임이 추출되는지 (필름 아이

콘), 카메라가 정렬되는지 (카메

라 아이콘), Gaussian이 학습되

는지 (뇌 아이콘) 에 따라 변경됩

니다. 백분율 숫자는 현재 부분 

단계를 가리킵니다 — 전체 파이

프라인은 맨 위의 좁은 표시줄에

서 봅니다. 오류 시 링이 파랑 대

신 빨강으로 변하고 아이콘이 더 

이상 펄스하지 않으므로 무엇이 

잘못되었는지 즉시 알 수 있습니

다.

C-22 Info 버튼 (메트릭 표시)

위치

처리 화면 왼쪽 위, 32 × 32 픽셀.

기술적  설명

Material Background가 있는 단순한 버튼. 정보 패널을 켜
고 끕니다. 활성일 때 아이콘이 Info Circle Outline과 Info 
Circle Filled 사이에서 변경됩니다. 부드러운 페이드 인 애니
메이션. 도구 설명 “Show detailed processing metrics”.

간단히  말하면

기본적으로 화면은 의도적으로 

정돈되어 있습니다 — 큰 진행 원

만 처음에 보입니다. 기술적으로 

관심 있는 사용자로서 무엇이 일

어나는지 더 정확하게 알고 싶다

면 (어느 반복, Loss가 얼마나 높

은지, 얼마나 많은 Gaussian) 왼

쪽 위의 i 기호를 클릭하십시오. 

작은 패널이 아래에서 열려 모든 

실시간 값을 보여 줍니다. 다시 

클릭하면 다시 숨겨집니다. 설정

은 영구적이지 않습니다 — 각 새 

학습 실행에서 패널은 처음에 다

시 숨겨집니다. 초보자를 놀라게 

하지 않도록 의도적으로 이렇게 

선택되었습니다.
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C-23 Info Panel (실시간 메트릭)

위치

처리 화면 왼쪽 아래, showProcessingInfo == true 일 때
만 표시.

기술적  설명

Ultra Thin Material Background가 있는 2열 패널. 왼
쪽 열: 단계별 정보 줄 — SfM의 경우 상태 텍스트와 백분
율. 학습의 경우 Iteration, 결합된 Loss, L1 Loss, D-SSIM 
Loss, Gaussian Count (주황색으로 표시), Speed (it/s), 
Elapsed Time, 계산된 ETA, SH Degree, Learning Rate. 
오른쪽 열: 상태 텍스트, Time Info String, 인라인 Loss 차
트 (C-28 참고), Discoverability Nudge (C-32 참고). 모
든 값은 각 학습 틱에서 업데이트되는 학습 상태에서 읽힙니다.

간단히  말하면

Info Panel은 Expert 모드에서 인

스펙터 사이드바에 영구적으로 

있을 모든 실시간 값을 표시합

니다: 현재 반복, Loss 값 (작을

수록 더 좋음), Gaussian 수, 속

도, 추정 남은 시간, SH Degree, 

Learning Rate. 오른쪽에는 추가

로 작은 Loss 곡선이 함께 실행

되며 학습이 올바른 방향으로 진

행되고 있는지 한눈에 알려 줍니

다. 학습이 답답해 보이면 여기

를 보는 것이 도움이 됩니다 — 

더 이상 떨어지지 않는 Loss나 더 

이상 줄어들지 않는 ETA는 문제

를 시사합니다. Loss가 폭발하면 

(갑자기 거대해짐) 또는 NaN을 

표시하면 학습이 불안정해진 것

이고 Cancel + Retry 또는 다른 프

리셋으로의 전환이 의미가 있습

니다.
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C-25 Pause/Resume 버튼

위치

하단 내비게이션 표시줄, 학습 단계 동안만 (SfM 동안 아님) 처
리가 실행되는 동안에만 표시.

기술적  설명

Bordered 버튼. 상태에 따라 Pause 또는 Resume를 호
출합니다. 레이블은 “Pause” (Pause 아이콘과 함께) 와 
“Resume” (Play 아이콘) 사이에서 변경됩니다. SfM 단계 동
안에는 버튼이 표시되지 않습니다. Apple Photogrammetry
가 Pause 의미론을 알지 못하기 때문에. Pause 상태는 
Iteration, Gaussian 상태, Optimizer Momentum을 완전
히 유지합니다 — Resume은 이전에 중지된 곳에서 계속합니
다.

간단히  말하면

학습이 실행되는 동안 언제든

지 중지하고 나중에 계속할 수 

있습니다. Mac에서 많은 GPU

가 필요한 다른 작업을 잠시 

하려는 경우 (예: 비디오 편집, 

게임 테스트, 다른 앱에서 렌

더 내보내기) 의미가 있습니다. 

Pause 클릭, 자신의 일을 하고, 

Resume 클릭, 학습이 정확히 있

던 곳에서 계속합니다. Iteration 

카운터, Gaussian 수, Optimizer 

Momentum이 그대로 유지되며 

Pause 상태는 품질에 비용이 들

지 않습니다. SfM 단계 동안에

는 Pause를 사용할 수 없습니다 

— Apple Photogrammetry는 중

지 기능을 알지 못합니다. 비상

시 Cancel로 작업해야 합니다.

C-26 Cancel 버튼

위치

하단 내비게이션 표시줄, 처리 (SfM 또는 학습) 가 실행되는 동
안 표시.

기술적  설명

빨간색 Bordered 버튼. “Stop and discard progress?” 
제목과 “Discard Progress” (파괴) 및 “Keep 
Running” (Cancel) 버튼이 있는 확인 대화 상자를 엽니다. 
확인 시 Cancel 플래그가 설정되고 학습 작업이 종료되며 필요
한 경우 SfM 서브 프로세스가 종료되고 중단 상태가 있는 요약 
줄이 JSONL 로그에 기록됩니다. Pause와 달리 학습 버퍼와 
상태가 폐기됩니다.

간단히  말하면

중단 버튼. Pause와 달리 이는 최

종적입니다 — 그 후에 다시 시작

하려면 처리가 처음부터 실행되

고 이미 학습된 모든 반복이 손

실됩니다. 프리셋을 잘못 선택했

거나 학습이 너무 느리게 실행

되거나 앱이 명백히 쓰레기 결과

를 생성하고 기다리고 싶지 않을 

때 의미가 있습니다. 실제 중단 

전에 앱은 확인 대화 상자를 통

해 다시 묻습니다. 따라서 실수

로 몇 시간의 계산 시간을 잃지 

않습니다. 잠시 중단하려는 경우 

Pause를 선호하십시오.
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C-27 Retry 버튼

위치

하단 내비게이션 표시줄, 파이프라인이 실패한 경우 표시 (SfM 
상태가 “SfM failed”로 시작하거나 학습이 오류 상태).

기술적  설명

강조 버튼. 전체 파이프라인을 새로 시작합니다. 시작 전에 가져
온 이미지/비디오가 아직 있는지 확인됩니다. 이전 오류 로그는 
JSONL 디렉터리에 유지됩니다. 새 실행은 현재 타임스탬프가 
있는 새 로그 파일을 작성합니다.

간단히  말하면

SfM이나 학습이 오류 메시지로 

중단되면 여기서 다시 시도할 수 

있습니다. 많은 단계 (RANSAC, 

Densification) 에 무작위 부분이 

있고 두 번째 시도가 첫 번째

가 실패한 곳에서 성공할 수 있

기 때문에 때로는 도움이 됩니

다. 그러면 전체 파이프라인이 

처음부터 다시 실행됩니다 — 새 

JSONL 로그 파일에서 SfM과 학

습. 두 번째 시도도 실패하면 보

통 입력 이미지가 문제입니다 

(너무 적음, 너무 적은 오버랩, 움

직임 흐림, 나쁜 빛). 그러면 Back

으로 돌아가 자료를 교환하십시

오. 팁: 동시에 Training Logs를 

보십시오 (Help → Open Training 

Logs). 거기에 구체적으로 어디

서 막혔는지 더 자세하게 있습니

다.
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C-28 Inline Loss Chart

위치

Info Panel, 오른쪽 열, 비어 있지 않은 진행 기록이 있는 학습 
동안에만 표시.

기술적  설명

콤팩트한 드로잉 영역 (40 픽셀 높이), Loss History를 강
조 색상의 1픽셀 선으로 그립니다. 데이터는 유한 값에 대해 필
터링됩니다 (불안정한 학습의 NaN 보호). Min/Max는 전체 
History에 대해 계산됩니다 — 따라서 차트는 값 범위에 자동 
줌됩니다. 마지막 Loss 값은 차트 위 오른쪽 위에 있습니다. 
History 자체는 각 학습 틱에서 앱 상태에서 구축됩니다 (일반
적으로 100 반복마다).

간단히  말하면

학습이 “수렴”하는지 (선이 오른

쪽으로 떨어짐) 또는 막혀 있거

나 폭발하는지 (선이 평평하거

나 오름) 한눈에 보여 주는 작

은 Loss 곡선. 건강한 학습에서

는 선이 처음에 가파르게 떨어지

고 그 다음 평평해집니다 — 그

것이 예상되는 진행이며 이등분 

곡선과 비슷합니다. 차트는 현재 

값 범위에 자동으로 줌하므로 학

습 종료 시의 작은 개선도 가시

적으로 유지됩니다. 선이 갑자기 

위로 쏘거나 얼어붙으면 무언가 

잘못되고 있다는 좋은 신호입니

다 — 자료가 문제이거나 다른 프

리셋이 더 적합할 것입니다. 차

트는 왼쪽 위의 i 기호로 표시하

는 Info Panel에서 찾을 수 있습

니다.
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C-32 Discoverability Nudge (Expert Mode 힌트)

위치

Info Panel, 오른쪽 열 아래, 학습 중이고 초보자 모드일 때만 
표시.

기술적  설명

눈 아이콘과 Caption 텍스트 “Switch to Expert Mode 
(⌘2) for live splat preview”가 있는 작은 줄, 절제된 톤
과 10 포인트 글꼴. 상호작용 요소 없음, 힌트만. 클릭에 반응
하지 않음 — 사용자가 실제로 Cmd+2를 누르거나 Mode → 
Expert Mode 메뉴를 클릭해야 합니다.

간단히  말하면

Expert 모드에서 학습 중에 3D 모

델의 현재 중간 버전이 뷰포트에 

실시간으로 보인다는 절제된 힌

트. 초보자 모드에서는 인터페이

스를 조용하게 유지하기 위해 의

도적으로 숨겨져 있습니다 — 그

러나 많은 사용자가 이 기능이 

있는지 전혀 모르기 때문에 여기

서 부드럽게 가리킵니다. Cmd+2

를 누르면 학습이 백그라운드에

서 계속 실행되는 동안 모델이 

눈앞에서 어떻게 조립되는지 볼 

수 있습니다. 이는 또한 수천 반

복 후에 결과가 무언가 될지 또

는 차라리 중단하고 새로 시작

할지 추정하는 좋은 도구입니다. 

Cmd+1은 언제든지 초보자 보기

로 다시 데려갑니다.

언제 다음 단계로?

학습이 성공적으로 완료되는 즉시 앱이 자동으로 Z3 (Preview) 로 전환됩니다 — 클릭할 필요가 없습니
다. 하단 내비게이션 표시줄이 그러면 Pause/Cancel에서 Back 버튼 (Import로 돌아감) 과 Export 버
튼 (Export로 앞으로) 으로 변경됩니다. 오류 시 (빨간색 오류 메시지, 단계 아이콘이 X) Retry가 대신 나
타나며, 다시 시작할지 또는 Back으로 Import로 돌아가 이미지 자료를 변경할지 결정해야 합니다.
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Z3 — 미리보기 (3D 모델 회전)

그림 38:  3D Viewer가 있는 초보자 모드 Preview 단계

그림 39:  학습 완료 후 Z3 Preview — Bjoern의 Blender Bouquet 재구성, 헤더가 “Training complete 
— 3,022 Gaussians in 13s” 표시, 아래에 Back과 Export 버튼

이미지에 보이는 것  Crumb Trail이 “Preview”를 활성 단계로 표시합니다. 전체 화면 3D 뷰포트가 완성된 
학습된 Bouquet 장면을 렌더링합니다 (Bjoern의 합성 Blender 테스트 세트, 960 반구체 Cam에서 
60 프레임 하위 집합). 헤더 상태 표시줄: “Training complete — 3 022 Gaussians in 13 s” — 최
종 Gaussian 수와 학습 시간을 제공합니다. 뷰포트의 드래그는 카메라를 회전합니다 (Yaw/Pitch). 스크
롤 휠은 View Direction을 따라 줌합니다. “Back” 버튼 (왼쪽 아래) 은 Resume이나 Re-Run을 위해 
Z2로 돌아갑니다. “Export” 버튼 (오른쪽 아래, primary) 은 Z4로 더 이동합니다.

학습 완료 후 앱이 자동으로 미리보기에 도착합니다. 여기서 완성된 Gaussian Splatting 모델을 전체 화
면 Metal 뷰에서 보고 마우스와 트랙패드로 회전, 줌, 팬할 수 있습니다. 뷰포트 위쪽에 카메라 제어와 정보
가 있는 작은 오버레이가 있습니다 — 자동 회전, 학습 통계, 리셋 버튼. 다음 단계 (내보내기) 전에 다양한 
각도에서 모델을 확인하여 재구성이 깨끗한지 확인하는 것이 좋습니다.
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C-36 SplatViewportView (3D 메인 뷰)

위치

Preview 단계의 전체 화면 배경.

기술적  설명

완성된 점 구름을 렌더링하는 Metal 기반 3D 뷰포트. 렌더러
는 RadianceKit 자체의 ForwardPass 래스터라이저 — 학
습 중에 이미 Splat을 렌더링하는 바로 그것 — 이므로 진정한 
WYSIWYG입니다 (학습된 것이 정확히 동일하게 표시되고 내
보내집니다). Order Independent Transparency를 사용하
는 타일 기반 렌더링 파이프라인. 렌더러를 초기화할 수 없는 
경우 (예: 시스템에서 Metal을 사용할 수 없음) 대신 “Metal 
not available” 텍스트가 있는 검은색 배경이 나타납니다. 뷰
는 Safe Area를 무시하므로 모델이 창 가장자리까지 도달합니
다.

간단히  말하면

메인 뷰포트. 여기서 사진에서 

재구성된 완성된 3D 모델을 GPU

에서 실시간으로 렌더링하여 봅

니다. 왼쪽 마우스 버튼으로 클

릭하고 끌어 회전합니다. 스크

롤 휠이나 두 손가락 트랙패

드 제스처로 줌. 오른쪽 마우스 

버튼이나 Cmd+드래그로 팬. 모

델은 수만 개의 반투명 3D 타

원체 (“Gaussian”) 로 구성되어 

장면을 사실적으로 재구성합니

다 — 각각은 학습이 학습한 위

치, 방향, 모양, 색상을 가집니

다. Mac이 Metal을 지원하지 않

는 드문 경우 대신 힌트 메시지

가 있는 검은색 배경을 봅니다 — 

RadianceKit은 Metal 가능 GPU가 

절대적으로 필요합니다.

C-37 CameraControlsOverlay (제어 오버레이)

위치

뷰포트 위, 떠 있음.

기술적  설명

Auto-Rotation (Turntable), Reset-Camera, 배경 선택 
(Gray/Black/White), Save-Screenshot, Toggle-Info-
Panel 버튼이 있는 콤팩트한 UI 오버레이. 카메라 매개변수 (거
리, 방위각, Elevation, Target, FOV) 에 바인딩하고 자동 
Turntable을 제어합니다. 학습 중 (사용자가 Expert 모드에서 
뷰포트가 실행되는 것을 보고 싶을 때) 오버레이는 추가로 콤팩
트한 학습 상태 줄을 표시합니다.

간단히  말하면

모델 위의 작은 떠 있는 표시줄. 

여기서 Auto-Rotation (모델이 자

체적으로 회전, 스크린샷과 짧은 

데모에 좋음) 을 시작하고, Reset

으로 카메라를 시작 위치로 되돌

리고 (길을 잃었다면), 배경을 변

경하고 (중립용 회색, 최대 대비

용 검은색, 밝은 모델용 흰색),  /

Pictures 아래에 저장되는 스크

린샷을 직접 만듭니다. 전체 모

델을 내보내지 않고 매우 특정한 

각도에서 특정 세부 정보를 보

여 주고 싶을 때 실용적입니다. 

Auto-Rotation은 또한 모델이 모

든 면에서 똑같이 잘 보이는지 

또는 누락된 촬영으로 인해 발생

한 “지저분한 면”이 있는지에 대

한 좋은 테스트입니다.
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C-38 Export 버튼 (내비게이션 표시줄)

위치

Z3의 하단 내비게이션 표시줄.

기술적  설명

레이블 “Export”와 Share 아이콘이 있는 강조 버튼. 클릭은 
Z4로의 전환을 트리거합니다. 그 전에 상위 보기는 정식 버전이 
잠금 해제되었는지 확인합니다 — 그렇지 않으면 Export 단계 
대신 잠금 보기가 표시됩니다 (U-06 참고).

간단히  말하면

결과에 만족하면 Export를 클릭

하면 형식을 선택하고 저장하는 

마지막 단계에 도착합니다. 구매

된 정식 버전 없이는 잠금 힌트

와 구매 버튼이 있는 화면 잠금

에 도착합니다 — 앱은 정식 버

전을 강요하지 않지만 내보내기

는 Premium 기능 중 하나입니다. 

구매를 완료하는 즉시 앱이 잠

금 해제된 상태로 직접 계속 실

행되며 익숙한 내보내기 단계에 

도착합니다. 다시 마음이 바뀌면 

Back 버튼을 통해 미리보기로 돌

아가 모델을 계속 회전할 수 있

습니다.

언제 다음 단계로?

내보내기 전에 모델을 완전히 한 번 회전시키고 확인하십시오: 입력 이미지에서 다룬 모든 영역이 존재합니
까? 떠 있는 “Floater” (공기 중에 자유롭게 떠 있는 Gauss Splat 클라우드) 가 있습니까? 배경/하늘이 
깨끗하게 또는 번져 보입니까? 심각한 문제는 재학습으로만 수정할 수 있습니다 — 더 많은 이미지, 다른 프
리셋 또는 Expert 모드의 Floater Reduction 설정으로.
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Z4 — 내보내기 (형식 선택과 저장)

그림 40:  형식 카드가 있는 초보자 모드 Export 단계

그림 41:  Z4 Export 카드 — 6 형식 (PLY 742 KB 선택, SPZ 74 KB, glTF 708 KB, .splat 96 KB, 
Orbit Video, Web Viewer 133 KB), 이미 내보낸 PLY가 있는 오른쪽 Export History 사이드바

이미지에 보이는 것  Crumb Trail이 “Export”를 활성 단계로 표시합니다. 모든 6개 옵션이 있는 왼쪽 카
드 그리드 “Choose Export Format”: PLY (표준 3DGS, 742 KB, 전체 SH 계수와 함께 — 여기서 
파란색 체크 마크와 함께 미리 선택됨), SPZ (압축 3DGS 형식, PLY보다 ~90% 작음, 74 KB), glTF 
(KHR_​gaussian_​splatting 확장과 함께, 708 KB), .splat (antimatter15을 통한 Web Viewer 호
환, 96 KB), Orbit Video (장면의 360° MP4, 실시간 크기 계산), Web Viewer (내장된 3D Viewer
가 있는 독립형 HTML, 133 KB). 크기 정보는 현재 Gaussian Count와 형식 오버헤드에서 실시간으
로 계산됩니다. 오른쪽 “Export History”는 형식 핀, 파일 이름, 타임스탬프와 함께 이미 완료된 내보내
기를 나열합니다 — 클릭은 Finder에서 표시합니다. 왼쪽 아래 Primary CTA: “Export PLY (3DGS 
Standard)”와 Gaussian 부제목 “2,991 Gaussians · SH degree 3”.
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마지막 단계에서 2열 카드 그리드를 통해 6개의 내보내기 형식 (PLY, SPZ, glTF, .splat, Orbit Video, 
Web Viewer) 에서 선택하고 Export를 클릭하고 macOS 대화 상자에서 저장 위치를 선택합니다. 오른
쪽에 이전 모든 내보내기의 History가 실행됩니다 — 카드 선택에서 각 카드 아래에 추정 파일 크기가 즉시 
표시되므로 예: 웹으로 가려면 SPZ를 선호하고 (작음) 다른 소프트웨어 (SuperSplat, Postshot, 플러그
인을 통한 Blender) 로 가져오려면 PLY를 선호합니다 (크고 완전).

C-39 2열 형식 그리드

위치

Export 단계의 왼쪽 메인 페이지.

기술적  설명

두 개의 유연한 열과 12 포인트 간격이 있는 카드 그리드. 초
보자 모드에서 제공되는 형식 위에서 반복합니다 — 가장 중요
한 6개 형식만 포함하는 전체 형식 목록의 필터링된 하위 집
합: PLY, SPZ, glTF, .splat, Orbit Video, Web Viewer. 
Compressed PLY와 SOG는 Expert 모드에서만 제공됩니
다.

간단히  말하면

초보자 모드에서 관련 있는 6 형

식이 있는 카드 그리드: PLY (다

른 3D 도구용 표준 형식), SPZ (웹

용 압축 변형), glTF (공식 Web3D 

표준), .splat (antimatter15 Web 

Viewer용), Orbit Video (보여 주

기 위한 완성된 MP4), Web 

Viewer (내장 3D Player가 있는 독

립형 HTML 파일). 따라서 사용 사

례의 90%를 다룹니다. 덜 일반

적인 형식 (Compressed PLY 또는 

극도 압축용 SOG) 중 하나가 필

요하면 Expert 모드로 전환하십

시오. 거기에는 모든 8 형식이 사

용 가능합니다. 여기의 콤팩트한 

선택은 의도적으로 초보자가 다

양성에 압도되지 않도록 합니다.
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C-40 Format Card 버튼

위치

그리드의 각 카드.

기술적  설명

카드 레이아웃이 있는 단순한 버튼: 위에 아이콘 (예: PLY용 
Document Zipper, SPZ용 Archive Box, Orbit Video
용 Video Icon), Format Name을 Headline으로, 설명 캡
션 (2줄로 단축), 그 아래에 추정 파일 크기 (형식, Gaussian 
Count, SH Degree에서 실시간으로 계산되고 KB/MB로 형
식화). 클릭 시 형식이 선택됩니다. 선택된 카드는 강조 배경, 강
조 테두리, 오른쪽 위의 체크 마크 아이콘을 받습니다. 도구 설
명은 형식 설명입니다.

간단히  말하면

형식당 하나의 카드. 하나를 클

릭하면 강조 색상과 체크 마크

로 강조되고 그 아래의 Export 

버튼이 텍스트를 조정합니다 

(“Export PLY”, “Export SPZ” 등). 

각 카드는 적절한 기호, 이름, 두 

줄 짧은 설명, 현재 학습 결과

의 추정 파일 크기를 표시합니

다. 크기는 의미 있게 선택하는 

데 도움이 됩니다 — 결과를 이

메일로 보내려면 가장 작은 변

형을 사용하십시오 (보통 SPZ 또

는 .splat). 다른 3D 소프트웨어

에서 계속 작업하려면 가장 좋은 

호환성을 가진 것을 사용하십시

오 (일반적으로 PLY). 카드 위에 

호버하면 도구 설명에 더 자세한 

설명이 표시됩니다. 형식 간의 

차이가 불분명한 경우에 대비.

C-41 Video Duration 슬라이더

위치

Format Grid 아래, 비디오 형식 (Orbit Video 또는 Social 
Video) 이 선택된 경우에만 표시.

기술적  설명

3–30초 슬라이더, 1초 단계, 앱 상태의 Video Length에 바
인딩. 최대 폭 300 픽셀. 비디오 형식이 선택된 경우에만 표시
됩니다. 비디오가 아닌 형식에서는 슬라이더가 보기에서 완전히 
제거됩니다 — 죽은 공간 없음.

간단히  말하면

내보내기로 Orbit Video를 선택

하면 여기서 길이를 결정할 수 

있습니다. 3초 = 매우 빠른 회

전, 30초 = 모델 주위의 느리고 

차분한 회전. 소셜 미디어 Reel 

(Instagram, TikTok) 의 경우 보통 

6–10초가 이상적입니다 — 모델

을 보여 주기에 충분히 길고 시

청자가 이탈하지 않을 만큼 짧

음. 프레젠테이션이나 포트폴리

오 비디오의 경우 15–20초도 좋

습니다. 슬라이더는 비디오 형식

이 선택된 경우에만 나타납니다. 

PLY나 SPZ 같은 파일 형식에서는 

무의미하고 숨겨져 있습니다.
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C-42 Export 버튼

위치

Format Grid 아래 (그리고 비디오가 선택된 경우 Duration 
Slider 아래).

기술적  설명

큰 강조 버튼. 레이블: “Export {Format Name}”, Share 
Icon. 클릭 시 형식에 맞는 확장자와 기본 파일 이름 “scene.
{ext}” 가 있는 macOS 저장 대화 상자가 열립니다. 확인 시 
내보내기가 선택된 URL에 작성됩니다. 학습 결과가 없거나 내
보내기가 이미 실행 중인 경우 비활성화됩니다.

간단히  말하면

클릭, macOS 대화 상자에서 저

장 위치 선택, 완료 — 앱이 파

일을 선택된 형식으로 선택된 

위치에 작성합니다. 기본 이름

은 “scene.{확장자}”입니다 (예: 

“scene.ply” 또는 “scene.spz”). 

저장하기 전에 대화 상자에서 원

하는 대로 변경할 수 있습니다. 

학습 결과가 아직 없거나 (여기

서는 절대 발생하지 않아야 함. 

그렇지 않으면 내보내기 단계에 

있지 않을 것임) 다른 내보내기

가 이미 실행 중인 동안 버튼이 

회색입니다. 내보내기가 실행되

는 즉시 그 아래에 진행 표시가 

나타납니다. 앱은 사용 가능한 

채로 유지되므로 다음 내보내기

를 이미 준비할 수 있습니다.

C-43 Export 진행 표시줄

위치

Export 버튼 아래, 내보내기가 실행되는 동안에만 표시.

기술적  설명

최대 폭 300 픽셀의 진행 표시, 그 아래에 캡션 “Exporting… 
N %”. 값은 0에서 1로 실행되며 쓰기 중에 업데이트됩니다 — 
PLY의 경우 10 000 Gaussian의 청크로, SPZ의 경우 양자
화 후 한 번, Orbit Video의 경우 프레임 간격으로.

간단히  말하면

내보내기가 실행되는 동안 여기

에 좁은 표시줄과 백분율 표시로 

진행을 봅니다. PLY는 파일이 단

순히 바이너리로 작성되기 때문

에 보통 몇 초 내에 완료됩니다. 

SPZ는 데이터가 양자화되고 압

축되기 때문에 약간 더 오래 걸

립니다. Orbit Video는 가장 시간

이 많이 드는 내보내기입니다 — 

여기서는 각 개별 프레임이 새로 

렌더링됩니다. 해상도와 길이에 

따라 1분 이상 걸릴 수 있습니다. 

내보내기 동안 앱은 사용 가능한 

채로 유지되므로 다음 형식을 이

미 준비하거나 뷰포트에서 계속 

클릭할 수 있습니다.
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C-44 Export Error Display

위치

Progress Bar 아래, 마지막 내보내기에서 오류가 발생한 경우
에만 표시.

기술적  설명

Warning Icon과 오류 텍스트가 있는 빨간색 줄. 빨간색 8% 
배경 Opacity, 둥근 모서리. 최대 폭 400 픽셀. 일반적인 오류 
원인: SOG는 시스템 PATH에 cwebp 를 기대 (App Store 
호환 아님). 가득 찬 디스크 공간에서의 쓰기 오류. 허용된 영역 
외부의 저장 대상에서의 Sandbox 오류.

간단히  말하면

내보내기가 잘못되면 여기에 빨

간색으로 문제에 대한 짧은 일

반 텍스트 설명이 나타납니다. 

보통 원인이 명백합니다 — 디스

크에 공간 없음, 대상 폴더에 쓰

기 권한 없음, Sandbox 허용 영

역 외부의 대상. 특히 SOG 형식

의 경우 시스템에 cwebp 가 누

락되어 있을 수 있습니다. 그 경

우 SOG를 사용할 수 없고 SPZ로 

전환해야 합니다. 오류 메시지가 

명확하지 않으면 로그 디렉터리 

(Help → Open Training Logs) 를 

살펴보십시오. 거기에 무엇이 잘

못되었는지 더 자세하게 있습니

다. 의심이 가는 경우 다른 저장 

위치를 선택하는 것이 도움이 됩

니다 — 예: 바탕 화면.

C-46 Export History List

위치

Export 단계의 오른쪽.

기술적  설명

내보내기 기록 (UserDefaults에 JSON으로 영구적으로 저장
되고 각 성공적인 내보내기 후 유지) 에 대한 목록. 각 줄은 형식 
배지 (작음, 강조 색상), 타임스탬프 (HH:mm), 파일 이름 (1줄
로 단축), 형식화된 파일 크기를 표시합니다. 줄 클릭은 Finder
를 선택된 파일과 함께 엽니다. 빈 상태: “No exports yet”.

간단히  말하면

이전 내보내기 목록 — 형식, 시

간, 파일 이름, 크기, 시간순. 줄

을 클릭하면 파일이 Finder에서 

강조 표시되어 직접 폴더를 탐

색할 필요가 없습니다. 한 시간 

후 마지막 내보내기가 다시 필요

하고 어디에 저장했는지 더 이

상 기억할 수 없을 때 실용적

입니다 — History가 이를 기억

합니다. 아직 아무것도 내보내

지 않았다면 친절한 힌트 “No 

exports yet”이 있습니다. 목록은 

UserDefaults에 저장되기 때문에 

앱 재시작을 견딥니다.
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C-48 History 컨텍스트 메뉴 (마우스 오른쪽 클릭)

위치

History 줄 마우스 오른쪽 클릭.

기술적  설명

두 동작이 있는 각 목록 항목의 컨텍스트 메뉴: “Reveal in 
Finder” (Finder를 선택된 파일과 함께 엽니다. 단순 클릭과 
같음) 및 “Copy Path” (전체 파일 경로를 텍스트로 클립보드
에 둠). 후자는 다른 앱으로의 드래그 앤 드롭 또는 명령줄에의 
전달에 유용합니다.

간단히  말하면

History 항목의 마우스 오른쪽 클

릭은 두 동작이 있는 작은 메뉴

를 엽니다. “Reveal in Finder”는 

일반 클릭과 같은 일을 합니다 — 

Finder를 선택된 파일과 함께 열

어 즉시 볼 수 있습니다. “Copy 

Path”는 전체 파일 경로를 클립

보드에 두므로 예: 터미널 명령

에, 다른 앱에 또는 메모에 붙여 

넣을 수 있습니다. 내보내기를 

누군가에게 전달하거나 경로 입

력으로 작동하는 다른 프로그램

에서 열려는 경우에 특히 실용적

입니다. 기능적으로 작지만 도움

이 되는 세부 사항이며 Mac 스타

일 작동 패턴에 의존합니다.

언제 워크플로가 완료되는가?

성공적인 내보내기 후 디스크의 파일로 3D 모델을 가지고 있고 History가 새 항목을 표시합니다. 
“Done” 버튼이 없습니다 — 다시 학습하지 않고 다양한 형식의 임의의 수의 내보내기를 추가할 수 있습니
다. 미리보기로 돌아가려면 (예: 카메라 시점을 다시 확인하기 위해) 하단 내비게이션 표시줄의 Back 버튼
을 사용하십시오. 완전히 새 장면을 시작하려면 Back을 통해 Z1로 가서 거기서 Clear All을 사용하거나 
File → New Project (Cmd+⇧+N) 를 사용하십시오.

Expert 모드로 전환

언제든지 Cmd+2를 누르거나 Mode → Expert Mode ( M8 ) 를 선택하십시오. 전체 상태가 유지됩니
다: 가져온 이미지, 선택된 프리셋, 실행 중이거나 완성된 학습, 완성된 점 구름, Export History, 심지
어 현재 단계까지. Expert 모드에서는 4단계 단계 대신 모든 ~150 컨트롤 필드가 있는 전체 인스펙터 사
이드바가 표시됩니다. 특히: Project Navigator (제 2 장 참고) 가 확장된 이미지 작업 (마이너스 버튼, 
Backspace Delete, Cmd-Z Undo, Quick Look 미리보기), 학습 중 뷰포트의 Live Preview, 모든 
Loss, MCMC, Densification, Mip-Splatting 매개변수를 제공합니다. Cmd+1은 초보자 모드로 다시 
전환합니다 — 이것도 상태를 잃지 않습니다.

자주 묻는 질문

왜 Start Processing 버튼이 회색으로 유지됩니까?
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이미지나 비디오를 아직 가져오지 않았습니다. 최소한 하나의 파일을 드롭 영역에 끌거나 “Browse 
Files”를 사용하십시오. 오른쪽 이미지 목록에 최소한 하나의 항목이 포함되는 즉시 버튼이 활성화됩니다. 
(1–2 이미지에서만 시작되지만 SfM이 오류로 직접 중단됩니다 — 빨간색 검증 배너 참고.)

왜 Export 버튼이 잠겨 있습니까?

초보자 모드에는 두 단계가 있습니다: (a) 학습 파이프라인이 아직 완료되지 않았고 가지고 있는 
gaussianCloud가 없다면 버튼이 비활성화됩니다 — 먼저 Z2를 완료해야 합니다. (b) 정식 버전을 아직 
구매하지 않은 경우 (PurchaseManager.hasAccess == false) Export 단계 대신 자물쇠 아이콘과 
구매 시트를 여는 “Unlock Full Version” 버튼이 있는 잠금 보기를 봅니다. Quick과 Preview 프리셋은 
무료 학습을 허용하지만 Export는 Premium입니다.

왜 프리셋을 선택할 수 없습니까?

선택할 수 있습니다 — 그러나 정식 버전을 구매하지 않고 Premium 프리셋 (Balanced, Quality, 
MCMC 변형) 을 탭하면 선택기가 자동으로 Preview로 다시 점프하고 Purchase Sheet가 열립니다. 
Quick과 Preview는 무료로 사용 가능한 유일한 프리셋입니다.

왜 이미지를 끌어넣어도 드롭 영역이 비어 있고 점선 회색이 유지됩니까?

아마도 UTI 유형 불일치입니다. 앱은 JPG, PNG, TIFF, HEIC, MP4, MOV와 앱 자체 Splat 형식을 받
아들입니다. 다른 이미지 형식 (BMP, GIF, WebP, RAW 형식) 은 인식되지 않습니다. 이미지 유형이 있어
야 한다고 확신한다면 파일 이름 확장자를 확인하십시오 — 앱은 주로 확장자에 따라 가며 파일 내용에 따라 
가지 않습니다.

왜 30개 이미지만 가지고 있는데 SfM이 그렇게 오래 걸립니까?

Apple Photogrammetry는 선형으로 확장되지 않습니다 — 일부 이미지 구성에서 (복잡한 텍스처가 있
는 실내 공간, 움직임 흐림, 나쁜 빛) 이미지 수가 시사하는 것보다 상당히 더 오래 걸립니다. 30 이미지에
서 10+ 분 후에도 SfM이 여전히 멈춰 있다면 중단하고 더 나은 자료로 다시 시도하거나 Expert 모드로 전
환하고 COLMAP/Native SfM을 시도하십시오 (Cmd+2 → 인스펙터 → Camera Alignment).

학습 로그는 어디에서 찾습니까?

Help → Open Training Logs (Cmd+⇧+L). 이는 ~/​Documents/​RadianceKit/​Logs/​를 엽니다. 
각 학습 세션은 파일 이름에 타임스탬프가 있는 자체 JSONL 파일을 작성합니다 — 첫 줄은 구성이며, 그 
다음 100 반복마다 진행 줄이 따르고, 마지막 줄은 Final Loss와 Success Flag가 있는 요약입니다.
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